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Preface

Intended Audience

Welcome to the Oracle Fusion Middleware Oracle E-Business Suite Adapter User’s Guide, 12
c(12.2.1)

This documentation is written for the technical consultants, implementers and system
integration consultants who use Oracle Fusion Middleware Oracle E-Business Suite
Adapter (formerly known as Adapter for Oracle Applications).

This guide assumes you have a working knowledge of the following;:

® The principles and customary practices of your business area.
® Oracle E-Business Suite.

® Oracle BPEL Process Manager.

¢ Oracle JDeveloper.

® Oracle Database, Oracle Fusion Middleware, Oracle WebLogic Server, and PL/SQL
technology.

® Oracle E-Business Suite Integration Interfaces.

® Oracle integration technologies, including Web services, WSDL, XML Gateway, EDI
Gateway, and the Business Event System.

e B2B, A2A and BP integrations.

If you have never used these products, Oracle suggests that you attend training classes
available through Oracle University.

See Related Information Sources on page xii for more Oracle E-Business Suite product
information.
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Structure

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.
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Related Information Sources

xii

You can choose from many sources of information, including online documentation,
training, and support services, to increase your knowledge and understanding of Oracle
Fusion Middleware Oracle E-Business Suite Adapter.

Documentation

You may want to refer to other Oracle Fusion Middleware guides when you set up and
use Oracle Fusion Middleware Oracle E-Business Suite Adapter. You can read the
guides online by reading from the Oracle Fusion Middleware or Oracle Database
Documentation Library CD included in your media pack, or on the Oracle Technology
Network (OTN).

To download free release notes, installation documentation, white papers, or other
collateral, please visit the main OTN page.

Training



Oracle offers a complete set of training courses to help you and your staff master Oracle
Fusion Middleware 12¢ and reach full productivity quickly. These courses are
organized into functional learning paths, so you take only those courses appropriate to
your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by
Oracle University at any one of our many Education Centers, you can arrange for our
trainers to teach at your facility, or you can use Oracle Learning Network (OLN), Oracle
University's online education utility.

Tip: For information about upcoming instructor-led training, please
refer to Oracle University's course offerings.

In addition, Oracle training professionals can tailor standard courses or develop custom
courses to meet your needs. For example, you may want to use your organization's
structure, terminology, and data as examples in a customized training session delivered
at your own facility.

Support

From on-site support to central support, our team of experienced professionals provides
the help and information you need to keep Oracle Fusion Middleware 12¢ working for
you. This team includes your Technical Representative, Account Manager, and Oracle's
large staff of consultants and support specialists, with expertise in your business area,
managing an Oracle Database, and your hardware and software environment.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an
Oracle E-Business Suite form can update many tables at once. But when you modify
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite
automatically checks that your changes are valid. Oracle E-Business Suite also keeps
track of who changes information. If you enter information into database tables using
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
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Overview

What's New in This Guide

This chapter introduces significant changes that are described in this guide for Oracle
E-Business Suite Adapter and provides pointers to additional information.

For a list of known issues (release notes), see the "Known Issues for Oracle SOA
Products and Oracle AIA Foundation Pack" at

http://www .oracle.com/technetwork/middleware/docs/soa-aiafp-knownissuesindex-364
630.html.

Significant Documentation Changes in this Document for 12¢ (12.2.1)

For Oracle E-Business Suite Adapter 12c (12.2.1), the runtime configuration for Oracle
E-Business Suite Adapter that appeared within an Appendix in the 12c (12.1.3) version
of this guide has been moved to its own chapter called Runtime Configuration for
Oracle E-Business Suite Adapter, page 11-1. Therefore, the Appendix has been
removed.
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2

Introduction to Oracle E-Business Suite

Overview

Adapter

Oracle E-Business Suite is a set of integrated business applications that runs entirely on
the Internet. Oracle E-Business Suite offers you the following;:

e Reduced costs
e Increased value across front-office and back-office functions
e Access to current, accurate, and consistent data

Oracle E-Business Suite are built on a unified information architecture that consolidates
data from Oracle and non-Oracle applications and enables a consistent definition of
customers, suppliers, partners, and employees across the entire enterprise. This results
in a suite of applications that can give you information, such as current performance
metrics, financial ratios, profit and loss summaries. To connect Oracle E-Business Suite
to non-Oracle applications, you use Oracle Fusion Middleware Oracle E-Business Suite
Adapter.

Oracle E-Business Suite Adapter (formerly known as Adapter for Oracle Applications)
not only provides comprehensive, bidirectional, multimodal, synchronous, and
asynchronous connectivity to Oracle E-Business Suite, but also supports for all modules
of Oracle E-Business Suite in Release 12 and Release 11.5.10 including custom
integration interfaces in various versions of Oracle E-Business Suite.

Important: The support for various versions of Oracle E-Business Suite
has the following conditions:

¢ The required Oracle E-Business Suite database version for Oracle
E-Business Suite Adapter 12¢ (12.2.1) is listed in the following table:

Introduction to Oracle E-Business Suite Adapter 2-1



Major Features

Oracle Oracle Oracle Oracle
Database Database 11g Database 11g Database 12¢
Release Release 1 Release 2 Release 1
Minimum 11.1.0.7 or 11.2.0.3 or 12.1.0.1 or
Required higher higher higher
Database

Version

® Oracle E-Business Suite Adapter supports Oracle E-Business Suite
Release 11.5.10 (OWF.G.Rollup 7 required) as well as Release 12.0
and above.

¢ To enable the native Oracle E-Business Suite connectivity using
J2EE data sources feature, the minimum requirement for Oracle
E-Business Suite Release 11i is 11i.ATG_PF.H.Delta.6 (RUP6), and
for Oracle E-Business Suite Release 12 is Release 12.0.4.

See My Oracle Support (formerly OracleMetaLink) Knowledge
Document 787637.1 for details.

Oracle E-Business Suite Adapter provides the following features:

It leverages the Integration Repository to provide the information from the source
of truth on integration.

It supports the widest range of integration interface types. They are PL/SQL APIs,
Business Events, Open Interface Tables, Concurrent Programs, XML Gateway
Interfaces, e-Commerce Gateway Interface, and Interface Views.

It generates adapter metadata as WSDL files with JCA extension.

Note: For more information, see Oracle Fusion Middleware User’s
Guide for Technology Adapters.

It works under the securely configured connection between Oracle E-Business Suite
and Oracle Fusion Middleware using just the FND User name and password for
authentication.

It leverages and supports Oracle User Management function security feature to
allow only authorized users to access and execute APIs that they are exposed as

2-2 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



Architecture

Web services to update Oracle E-Business Suit applications.

e It implicitly takes care of applications context without bothering about the
complexities of initiating the same explicitly.

e It supports multiple languages and multiple organization access control (MOAC)
setup.

® It uses a JDeveloper based design-time tool for dynamically browsing the Oracle
E-Business Suite application interfaces and configuring the adapter metadata. The
design-time tasks are wizard driven, user-friendly, and intuitive providing superior
user experiences.

e [t provides the global transaction control support implementing two-phase commit
by leveraging the underlying JCA standards compliant framework.

e It supports multiple versions of Oracle E-Business Suite from the same instance of
Adapter at design time as well as run time.

¢ It provides flexfield support for PL/SQL APIs and Open Interface Tables so that
flexfield information can be displayed at design time and run time.

Oracle E-Business Suite Adapter is based on JCA 1.5 standards and deployed as a
resource adapter within the Oracle WebLogic Server container. The architecture of
Oracle E-Business Suite Adapter is similar to the architecture of technology adapters.

Introduction to Oracle E-Business Suite Adapter 2-3



Oracle E-Business Suite Adapter Architecture

JDeveloper
Adapter Wizard

) Oracle Fusion
Files/FTP ' 4—— Middleware Adapters

JZEE
™ Applications
JMS/AQ r—
Oracle Service
J':-.lﬁl. BLIS
Database a—| WSIF
BPEL
Oracle PM
E-Business Suite —

Oracle WeblLogic
Server

For more information on technology adapters, see Oracle Fusion Middleware User’s Guide
for Technology Adapters.

Installing Oracle E-Business Suite Adapter

Oracle E-Business Suite Adapter and Oracle JCA Adapters are available as part of the
Oracle Fusion Middleware install. In addition, these adapters support both Oracle
WebLogic Server and middle tier deployments.

For more information, see Oracle Fusion Middleware Installation Guide for Oracle SOA
Suite and Oracle Business Process Management Suite.

Integration with Oracle Fusion Middleware

Oracle E-Business Suite Adapter integrates with the JCA Binding Component of the
Oracle Fusion Middleware platform; therefore, it integrates with service engines, such
as Oracle BPEL Process Manager (Oracle BPEL PM) and Oracle Medjiator.

Oracle E-Business Suite Adapter can easily expose public integration interface within
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Oracle E-Business Suite as standard Web services. These services can be created and
configured in the Oracle JDeveloper at design time while integrating with Oracle BPEL
PM and Oracle Mediator. At run time, Oracle E-Business Suite integration flows are
deployed in the Oracle WebLogic Server for execution of the services to complete the
integration.

® Oracle BPEL Process Manager

Based on the service-oriented architecture (SOA), Oracle BPEL Process Manager
(BPEL PM) provides a comprehensive solution for creating, deploying, and
managing Oracle BPEL Process Manager business processes.

e QOracle Mediator

Oracle Mediator provides a lightweight framework to route data from service
providers to external partners. In addition, it can subscribe to and publish business
events, as well as transform data using XSL Transformations.

For example, a Mediator can accept data contained in a text file from an application
or service, transform it to a format appropriate for updating a database that serves
as a customer repository, and then route and deliver the data to that database.

Design Time

While integrating with Oracle BPEL PM and Oracle Mediator, Oracle E-Business Suite
Adapter uses Oracle JDeveloper as the design-time tool to create SOA Composite
applications and generate WSDL and JCA files for the Web services.

When you create a partner link in Oracle JDeveloper BPEL Designer, the Adapter
Configuration Wizard starts and allows you to select and configure Oracle E-Business
Suite Adapter or other adapters. With proper database and service connection setups,
you are presented with a functionally organized list of inbound and outbound
interfaces available in your Oracle E-Business Suite instance for which you select the
one that fulfill your requirements. When configuration is complete, the wizard
generates a WSDL file corresponding to the XML schema for the partner link.

Additional process activities are added to the BPEL process if necessary to assign
parameters and invoke the service.

Run Time

Oracle E-Business Suite Adapter is based on the JCA 1.5 specification. A Composite
application including the BPEL processes, Mediator services, and partner link
definitions generated at design time is deployed to the Oracle WebLogic Server. A JCA
Binding Component acts as the glue layer that integrates the standard JCA 1.5 resource
adapter with the Oracle BPEL Process Manager during run time. The JCA Binding
Component acts as a pseudo JCA 1.5 container.

Note: Only the JCA 1.5 integration allows the BPEL PM to receive
inbound events (from EIS to J2EE/BPEL PM). The Oracle BPEL Process

Introduction to Oracle E-Business Suite Adapter 2-5



Manager acts as a pseudo JCA 1.5 container and implements the JCA
1.5-specific System Contracts. The JCA 1.5 resource adapter and the
BPEL PM instance must be deployed in the same Oracle WebLogic
Server container.

The Web service invocation launched by the BPEL Invoke activity contained in the SOA
Composite is converted to a JCA CCI (Common Client Interface) outbound interaction,
and the JCA response is converted back to a Web service response. This end-to-end
invocation is synchronous.

Testing the SOA Composite Application at Run Time

After deploying the SOA Composite application, you should validate the design by
testing the BPEL process contained in the deployed SOA Composite application to test
the interface integration.

For detailed design-time and run-time tasks for each integration interface, see the
individual interface chapter explained later in this book.

Integration with Oracle WebLogic Server

Oracle WebLogic Server is a scalable, enterprise-ready Java Platform, Enterprise Edition
(Java EE) application server. Its infrastructure enables enterprises to deploy
mission-critical applications in a robust, secure, highly available, and scalable
environment and is an ideal foundation for building applications based on
service-oriented architectures (SOA). SOA is a design methodology aimed at
maximizing the reuse of application services.

In addition, Oracle WebLogic Server consists of a JCA container for hosting JCA
resource adapters. JCA defines standard Java interfaces for simplifying the integration
of a J2EE server with various back-end applications. All client applications run within
the Oracle WebLogic Server environment.

Design Time

Oracle JDeveloper is used to create Web services represented in WSDL files and XML
Schema Definition (XSD) files for the adapter request-response service.

The Oracle WebLogic Server clients use these XSD files during run time for calling the
JCA outbound interaction.

Run Time

Oracle E-Business Suite Adapter is based on the JCA 1.5 specification and is deployed
as resource adapter within the Oracle WebLogic Server container. The JCA 1.5
specification addresses the life-cycle management, message-inflow (for Adapter Event
publish), and work management contracts.

For more information about using Oracle WebLogic Server with Oracle JDeveloper, see
the Using WebLogic Server with Oracle JDeveloper section, Oracle Fusion Middleware
Installation Guide for Oracle Developer.
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Oracle E-Business Suite Adapter Features

Overview

Oracle E-Business Suite Adapter enables you to orchestrate discrete data into a
meaningful business process and creates Web services for various interface types within
Oracle E-Business Suite. It plays the role of service provider for Oracle E-Business Suite
to allow seamless integration between business partners, processes, applications, and
end users in heterogeneous environment.

Oracle E-Business Suite Adapter provides the following features which are further
discussed in this chapter:

Support for Various Integration Interface Types, page 3-1.
Support for Oracle Integration Repository, page 3-3

Support for Custom Integration Interfaces in Various Versions of Oracle E-Business
Suite, page 3-4

High Availability, page 3-6

Monitoring Oracle E-Business Suite Adapter Configurations, page 3-7

Support for Various Integration Interface Types

Oracle E-Business Suite Adapter acts as a highly flexible integration interface for Oracle
E-Business Suite. It supports the following interface types for integrating with Oracle
E-Business Suite applications:

PL/SQL APIs

These APIs enable you to insert and update data in Oracle E-Business Suite using
PL/SQL.
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e Business Events

A business event is an occurrence in an internet application that might be
significant to other objects in a system or to external agents. An example of a
business event can be the creation of a new sales order or changes to an existing
order.

The Business Event System is an application service that leverages the Oracle
Advanced Queuing (AQ) infrastructure to communicate business events between
systems. The Business Event System consists of the Event Manager, which lets you
register subscriptions to significant events.

When a local event occurs, the subscribing code is executed in the same transaction
as the code that raised the event. Subscription processing can include executing
custom code on the event information, sending event information to a workflow
process, and sending event information to other queues or systems.

Business Event Groups

A business event group is a type of event containing a set of individual business
events. Once an event group is defined, a subscription that is registered for an event
group will be executed when any of the individual events within it is triggered.

With the support for business event groups, different business events belonging to
an even group can be handled through a single partner link. Service created for an
event group would be able to dequeue payloads corresponding to any of the events
within the group.

¢ Open Interface Tables

Interface tables enable you to insert or update data into Oracle E-Business Suite.
The associated concurrent program should be running to move the data from the
interface tables to base tables.

¢ Concurrent Programs
Concurrent programs enable you to move data from interface tables to base tables
or execute any application logic.

® Oracle XML Gateway

XML Gateway enables bidirectional integration with Oracle E-Business Suite. It
helps you to insert and retrieve data from Oracle E-Business Suite. XML Gateway is
a higher-level interface that exposes OAGIS-formatted XML documents for
commonly used Oracle E-Business Suite business objects and business interfaces.
XML Gateway integrates with interface tables, Oracle Workflow Business Event
System (BES), and interface views to insert and retrieve data from Oracle
E-Business Suite. It maps the underlying table data to XML and back.

® Oracle e-Commerce (EDI) Gateway

Oracle e-Commerce Gateway provides a common, standards-based approach for
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Electronic Data Interchange (EDI) integration between Oracle E-Business Suite and
third party applications.

e Interface Views

Interface views help you to retrieve data from Oracle E-Business Suite using the
application tables.

Please note that Oracle E-Business Suite Adapter also supports the following custom
integration interface types that are exposed by the Oracle E-Business Suite Module
Browser, not by Oracle Integration Repository:

Custom PL/SQL APIs

Custom Business Events

Note: Business events integration interface type is also exposed by
Oracle E-Business Suite Module Browser, not by Oracle Integration
Repository.

Custom XML Gateway Maps

Customized Concurrent Programs

Support for Oracle Integration Repository

Oracle Integration Repository, an integral part of Oracle E-Business Suite, is a prebuilt
catalog of information about the numerous public integration interfaces delivered with
Oracle E-Business Suite. It provides a comprehensive view of the integration interfaces
with details for Oracle E-Business Suite.

Oracle Integration Repository can only provide information about an integration
interface that has been specifically annotated by the developer to make it public. Oracle
E-Business Suite Adapter takes advantage of the annotations that have already been
created to make the following integration interface types visible in the Oracle
E-Business Suite Module Browser:

¢ XML Gateway message maps
e PL/SQL APIs

¢ Concurrent programs

¢ Open Interface tables

e Interface views
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¢ e-Commerce Gateway EDI messages
These integration interfaces are exposed as Web services, and are available for process
orchestration through the Oracle BPEL Process Manager.

For more information about Oracle Integration Repository, see the Navigating Through
Oracle Integration Repository section, Oracle E-Business Suite Integrated SOA Gateway
User’s Guide. This guide is part of the Oracle E-Business Suite Documentation Library
which can be accessed on the Oracle Technology Network (OTN).

Note: Oracle Integration Repository is integral part of Oracle
E-Business Suite Release 12.0 and onwards.

Support for Custom Integration Interfaces in Various Versions of Oracle
E-Business Suite

Oracle E-Business Suite Adapter leverages Integration Repository for Oracle E-Business
Suite Release 11.5.10 and Release 12 as the source of truth for the integration content.

Oracle E-Business Suite Adapter supports selecting custom integration interfaces from
the Integration Repository for the following versions of Oracle E-Business Suite:

® Release 12, page 3-5

* Release 11.5.10, page 3-6

Important: Please note that the support for various versions of Oracle
E-Business Suite has the following conditions:

e The required Oracle E-Business Suite database version for Oracle
E-Business Suite Adapter 12¢ (12.2.1) is listed in the following table:

Oracle Oracle Oracle Oracle
Database Database 11g Database 11g Database 12¢
Release Release 1 Release 2 Release 1
Minimum 11.1.0.7 or 11.2.0.3 or 12.1.0.1 or
Required higher higher higher
Database

Version

® Oracle E-Business Suite Adapter supports Oracle E-Business Suite
Release 11.5.10 (OWF.G.Rollup 7 required) as well as Release 12.0
and above.
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¢ To enable the native Oracle E-Business Suite connectivity using
J2EE data sources feature, the minimum requirement for Oracle
E-Business Suite Release 11i is 11i. ATG_PF.H.Delta.6 (RUP6), and
for Oracle E-Business Suite Release 12 is Release 12.0.4.

See My Oracle Support Knowledge Document 787637.1 for details.

From the business service creation and run-time perspectives, Oracle E-Business Suite
Adapter supports custom PL/SQL APIs as far as the packages are available in the APPS
schema. The Oracle E-Business Suite Module Browser can expose these custom PL/SQL
APIs for integration purposes during the design time.

Support for Oracle E-Business Suite Release 12

From Release 12, Oracle Integration Repository is shipped as part of the Oracle
E-Business Suite which enables Oracle E-Business Suite Adapter to directly connect to
the live database of Oracle Integration Repository querying for the public interfaces and
then displaying the list of custom integration interfaces under the Other Interfaces
> Custom Objects node in the Oracle E-Business Suite Module Browser.

Supporting Custom Integration Interfaces in Release 12

& Oracle Applications Module Browser E

Object Mame: ‘ |:| Tables |[Viens []APIs [JCP [ ]¥MLGstewsy []EDI [ ]BusinessEvents Browse

& ProductFamilies
- (% Advanced Planning (SCP_PF)
- (3 Applications Technology (ATG_PF)
- (% Contracts Suite (OK_PF)
- (% Discrete Manufacturing (OMF_PF)
- (% Financial Globalizations Suite (FINGB_PF)
- (% Financial Payables Suite (FINARP_PF)
- (% Financial Receivables Suite (FINAR _PF)
- (% Financial Services Applications (SEM_PF)
- (% Financials (FIN_PF)
- (% Human Resources Suits (HR_PF)
- (% Interaction Center (CC_PF)
- (% Marketing Suite (MKT_PF)
- (% Marketing and Sales Suite (MAS_PF)
- (% Order Management Suite (OM_PF)
- (% Process Manufacturing (OPM_PF)
- (% Procursment (PRC_PF)
- (% Product Lifecyels Management (PLM_PF)
- (3 Projects Suite (P1_PF)
- (% Public Sector (PS_PF)
- (4 Sales Suits (SLS_PF)
- (% Service Suite (SRV_PF)
- (% Supply Chain Management (SCM_PF)
- (% University (UNV_PF)
(= G Other Interfaces
- (3 Business Events
= @ Custom Obiects
+-- (53 PLSQL APTS
-3 XMLGateway Maps
- Concurrent Programs

Cancel

Please note that Oracle E-Business Suite Adapter allows you to extract the Integration
Repository data file from the live database you connect to Oracle E-Business Suite and
create a local copy of the Integration Repository data file in your workplace. Next time
when you look for public interfaces, the system can retrieve data from the cache in your
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workplace.

For detailed information about connecting to Oracle E-Business Suite Release 12, please
refer to the Creating a Partner Link or Adding a Partner Link design-time task for each
integration interface.

Support for Oracle E-Business Suite Release 11.5.10

To support Oracle E-Business Suite Release 11.5.10, Oracle E-Business Suite Adapter
provides the Integration Repository data file bundled as part of the product in xml
format. During design time, Oracle E-Business Suite Adapter queries public interfaces
from the native XML data file of the Integration Repository shipped with Adapter.
Custom integration interfaces are queried directly from the live database and displayed
under the Other Interfaces > Custom Objects node in the Module Browser.

Supporting Custom Integration Interfaces in Release 11.5.10
> X

Object Name:| [ ] Tables | Views [ | APIs JCP  [] XML Gateway EDI [] Business Events ‘ﬁruwse‘

T Contracts Suite (OF_PF)
Q Discrete Manufacturing (DMF_PF)
(53 Exchange Suite (EXCHG_FF)
3 Financial Clobalizations Suite (FINGB_PF)
(53 Financial Payables Suite (FINAP_PF)
53 Financial Receivables Suite (FINAR_PF)
S Financials (FIN_PF)
(53 Healthcare Suite (HC_PF)
€3 Human Resources Suite (HR_PF)
3 Interaction Center (CC_PF)
(53 Marketing Suite (MKT_PF)
Q Marketing and Sales Suite (MAS_PF)
G2 Order Management Suite (OM_PF)
(53 Process Manufacturing (OPM_PF)
Q Procurement (PRC_PF)
(€3 Product Lifecycle Management (PLM_PF)
(53 Projects Suite (P_PF)
€3 Public Sector (PS_PF)
(53 Sales Suite (SLS_PF)
3 Service Suite (SRV_PF)
3 Supply Chain Management (SCM_PF)
(3 Other Interfaces
- 3 Business Events
= G Custom Objects
- C3 PLSQL APIS
- €3 XMLCateway Maps
= Q Concurrent Programs
.. ADS Batch Import (ADSBATCHIMP)
.. ADS Batch Import’S<hR> (ADSBAT
.. ADS Financials (ADSFINS)
.. ADS Financials's <hR> (ADSFINS)
i._lADS Purge Order Transactions (AC
£, ADS Purge Order Transactions'S<!
E_ADS Receive (ADSRFOY Cancel

RN

L I - = B = B = = S = I

&8

TR

High Availability

Oracle E-Business Suite Adapter supports high availability by completely relying on the
functionality of the underlying Oracle Database Adapter and Oracle AQ Adapter to
support the scenarios, such as Real Application Cluster (RAC) database configuration
or clustering configuration.

For information about Oracle Database Adapter and Oracle AQ Adapter, see Oracle
Fusion Middleware User’s Guide for Technology Adapters.
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Monitoring Oracle E-Business Suite Adapter Configurations

To effectively diagnose and troubleshoot potential configuration issues, Adapter
configuration reports can be enabled and displayed in the Oracle Fusion Middleware
Control.

For information about these configuration reports, see the Monitoring Oracle JCA
Adapters chapter, Oracle Fusion Middleware Administering Oracle SOA Suite and Oracle
Business Process Management Suite.
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Oracle E-Business Suite Adapter Concepts

Overview

This chapter discusses some essential concepts for Oracle E-Business Suite Adapter. It
provides basic understanding about how applications context, security, logging, and
flexfields are used or supported as well as how errors and exceptions are handled.
Detailed concepts described in this chapter are:

¢ Understanding Applications Context, page 4-1

¢ Understanding the Oracle E-Business Suite Module Browser, page 4-14
® Understanding Oracle E-Business Suite Adapter Security, page 4-20

e Flexfield Support for PL/SQL APIs and Open Interface Tables, page 4-27
* Logging, page 4-124

¢ Enhanced Error and Exception Handling, page 4-132

e Secured Connection Between Oracle E-Business Suite and Oracle Fusion
Middleware SOA Suite Using J2EE Data Source Implementation, page 4-155

Understanding Applications Context

Applications context is required for invoking interfaces within Oracle E-Business Suite.
Applications context is a combination of Username, Responsibility, Responsibility
Application, and Security Group. These elements may be required for executing an
interface successfully within Oracle E-Business Suite.

Applications Context in Multiple Organizations

You can define multiple organizations and the relationships between them in a single
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installation of Oracle E-Business Suite. These organizations can be sets of books,
business groups, legal entities, operating units, or inventory organizations.

Multilevel organization hierarchies can be defined with a business group at the top of
each hierarchy. When you define new organizations, they are automatically assigned to
the business group associated with your current session. Each organization is part of a
business group. The business group is usually the top box on an enterprise organization
chart.

Business Group Hierarchy

Business Group

Org Org

Orgg Crg Oy Org

Org Org O Ong Org g Org g

Example of a Multiple-Organization Setup

Using the accounting, distribution, and materials management functions in Oracle
E-Business Suite, you define the relationships among inventory organizations,
operating units, legal entities, and sets of books to create a multilevel company
structure, as shown in the following diagram.
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A Multiple-Organization Transaction

—_— French
Customer Invoice Sales Office
/ .
c Sales Order \
ustomer T Intercompan
Payment Invoi.I:Je ¥
Product Shipment
~— German
Warehouse

Consider two different organizations in your company: One is a French sales office and
the other is a German warehouse. There is a sales order transaction with the customer,
and this illustrates how the entire Order-to-Deliver process would work:

1. The customer places a sales order with the French sales office.
2. The German warehouse delivers the product shipment to the customer.
3. The German warehouse issues an inter-company invoice to the French sales office.

4. The French sales office makes the inter-company payment to the German
warehouse.

5. The French sales office sends the customer invoice to the customer.
6. The customer makes payment to the French sales office.

The database architecture is the same for a multiple-organization and
non-multiple-organization installation, and uses the standard install tools feature that
automatically creates synonyms in the APPS schema for each base product table and
defines these synonyms with the same name as the base product tables. For example,
the PO Oracle schema has a table named PO_HEADERS_ALL and the APPS schema
has a corresponding synonym of the same name, PO_HEADERS_ALL. The
PO_HEADERS_ALL synonym can be used to access unpartitioned data.
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Schema Synonyms

Apps Schema PO Oracle Schema

PO HEADERS ALL table

PO_HEADERS_ALL
{Svinonyvin to the Crrg_Id P _Header_Id
PO_HEADERS_ALL table)

PO_HEADERS

(ulti—Crg view: //"

select based on 2 13

CLIENT_INFO .

where CLIENT INFO="1") 3 14
2 13

Multi-Organization Access Control (MOAC) Security by Operating Units

While setting up the system profile values, the username and responsibility are tied up
with the organization or operating units.

Multiple-Organization System Profiles

Application _ Respansibiley Uszer

Prufile Option Mame Sita | [Purchasing, Visian Operati|

l|MD: Default Oparating Unit || | | 2

|MD: Distribufed Environment _ND | | |

[M0: Operating Unie :\'Tsfan Operations | il.l'nimn Operations

M0 Security Profile [ [ [ |

|MD: Top Reparting Leeel :Cqmmdng Unit | | l—

| | I |

[ | | I

| | |

| | | |

| | | -
] G

To have a secured way for users to allow access or report on data for the operating units
they have access to, many of the interfaces within Oracle E-Business Suite make use of
the MOAC security feature to determine the operating unit access privileges and derive
the Organization ID based on relevant profile values. Oracle E-Business Suite Adapter
can implicitly perform the requisite MOAC setup. If ORG_ID is passed, data access
would be set to the passed Organization ID.

With MOAUC, a system administrator can predefine the scope of access privileges as a
security profile, and then use the profile option MO: Security Profile to associate the
security profile with a responsibility. By using this approach, multiple operating units
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are associated with a security profile and that security profile is then assigned to a
responsibility. Therefore, through the access control of security profiles, users can access
data in multiple operating units without changing responsibility.

Security profiles are defined based on organization hierarchies. For example, a sales
company consists of USA and UK operating units; the USA operating unit has Western
Region Sales and East Region Sales. Sales managers are responsible for both USA and
UK sales, supervisors are responsible for either USA or UK, and sales representatives
are only responsible for their designated sales regions. The Sales organization hierarchy
can be illustrated as follows:

Sales Organization Hierarchy

Vision
Corporation

Vision UK Vision USA

—

Eastern Western
| | Region Region

To secure sales data within the company, relevant operating units can be associated
with predefined security profiles. For example, all sales data access privileges are
grouped into the Vision Sales security profile. A USA Sales security profile is created for
USA related data, and a regional security profile is created for designated regional data.
The system administrator can associate these security profiles containing multiple
operating units with users through appropriate responsibilities. Therefore, sales
supervisors can easily access sales data in the Eastern or Western region without
changing their responsibilities. The following diagram illustrates the relationship
between security profiles, responsibilities, and operating units for this sales company:
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Relationship Diagram Between Security Profiles, Responsibilities, and Operating Units

Responsibility Security Profile Operating Unit
Sales fq .| Vision Sales | _ Vision USA
Manager Manager Security Profile Ai;‘u’isiun UK
Vision

Corporation

L . s
Sales i | USASales Vision USA
Supervisor . Security Profile | Eastern
Supervisor Region
Western
Region
&
Sales Eastern Region | Eastern
Representative Sales Security Profile | Region

Responsibility Determines Operating Units

Because responsibilities are associated with security profiles that linked to operating
units, your responsibility is the key in determining which operating units you will have
the access privileges.

1. When integrating with Oracle E-Business Suite using PL/SQL APIs or Concurrent
Programs, applications context is set based on the values passed for the header
properties Username, Responsibility, Responsibility Application and Security
Group.

Note: For backward compatibility reasons, no context related
exceptions or errors would be thrown if none of the following
header properties are passed - Responsibility Application, Security
Group, and NLS Language.

2. MOAC setup is done based on the Responsibility Application to which the user
belongs. If Organization ID is passed, the Organization access would be set to the
passed Organization.

3. If the user needs the invocation of the interface to happen in a desired language,

then the header property NLS Language can be passed. Default value for NLS
Language would be the language specified in the user's preference in Oracle
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E-Business Suite.

To integrate business processes with Oracle E-Business Suite, it is essential to propagate
these applications context values through a flexible mechanism, which is provided by
Oracle E-Business Suite Adapter through the header properties.

The following topics are discussed in this section:

® Support for Normalized Message Properties, page 4-7
e Support for Multiple Organization Access Control (MOAC), page 4-11

* Support for Multiple Languages, page 4-12

Support for Normalized Message Properties

To effectively set applications context values required in a BPEL process or to populate
mandatory header variables for XML Gateway inbound transactions to be completed
successfully, Oracle E-Business Suite Adapter provides a flexible mechanism that allows
each context value and header variable to be set and passed in the adapter user interface
directly through the Invoke activity. This message normalization feature not only
provides a flexible solution on header support, but also simplifies the design-time tasks
without using an Assign activity to pass header values.

Setting Message Properties for Applications Context

The following header properties are used in setting applications context for PL/SQL and
Concurrent Program interfaces:

® Jjca.apps.Username

® Jjca.apps.Responsibility
® Jjca.apps.ORG _ID

® Jjca.apps.RespApplication

® jca.apps.SecurityGroup

Note: Existing header property jca.apps.Responsibility used in
the earlier releases can now take Responsibility Key as well as
Responsibility Name as input. If the header property
jca.apps.NLSLanguage is set, and Responsibility Name is passed,
the value passed for jca.apps.Responsibility is expected to be in
the same language. However, Responsibility Key as well as all other
header properties are language independent.

All these header properties would be used together to set the
application context. Alternatively, passing just the Username and
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Responsibility would work as it did in the earlier releases.

In the case of a null or empty value, the default Username is SYSADMIN, the default
Responsibility is System Administrator, the default Security Group Key is
Standard, and the default NLS Language is US.

Setting Message Properties for XML Gateway Inbound Transactions

The following header message properties are used in setting XML Gateway information
required for XML Gateway inbound/enqueue transactions:

* ca
* ca.
* Jjca.
* Jjca.
* fca.
* ca.
* Jca.
* Jjca.
* Jjca.
* fca.
* ca.
* ca.
* Jjca.
* Jca.
* ca.
* ca.

.apps.ecx.

apps

apps

apps

apps

apps

apps

apps

apps

apps

apps.

apps.

apps.

apps.

apps.

apps.

.eCcx.

ecx

.eCX.

ecx

.eCcx

.eCcx.

ecx.

.eCX.

ecx.

.eCX.

.eCcx.

ecx.

.eCX.

ecx.

.eCX.

TransactionType

TransactionSubtype

.PartySiteId

MessageType

.MessageStandard

.DocumentNumber

ProtocolType
ProtocolAddress
Username
Password
Attributel
Attribute?2
Attribute3
Attributed
Attributeb

Payload

Design-Time Tasks for Message Properties Support

Oracle E-Business Suite Adapter uses the following procedures to complete the
design-time tasks to support message normalization:

1. Create a new SOA Composite application with BPEL process, page 5-8

2. Create a partner link, page 5-13
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3. Configure an Invoke Activity, page 5-64
This activity involves the following tasks:
o Configure basic information in the General tab:

Configure an Invoke activity by linking the activity to the partner link you just
created. This opens the General tab in the Edit Invoke dialog box with Partner
Link and Operation information populated.

You can create an Input Variable and a Output Variable for the Invoke activity.
For detailed instructions, see Configure basic information in the General tab,
page 5-25

e Set the Header Message Properties in the Properties tab:
This is to set the necessary message properties for the following purposes:
¢ To set XML Gateway header variables for an inbound transaction.

For example, locate XML Gateway header property
jca.apps.ecx.TransactionType first and then enter a value (such as
'PO") for the selected property.
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Entering a Selected Property Value
O EditInvoke 24

Documentation = Targets = Sources  Skip Condition = Headers
General Correlations Properties Assertions Annotations

To

From  Properties: 4 / *®

Mame Value

@ To Property

Mame: | -

@ .ujca.apps.ecx.ProhJcolAddress

~ lica.apps.ecx.ProtocolType
cha.apps.ec{ TransactionSubtype
jca.apps.ecx. TransactionType

lica. apps.ecx.Username

Help [
lica.aq. Attempts

ca.aq. Correlation
;'ca.aq.DEIay

Help Apply | Ok . Cancel

For detailed instructions, see Setting ECX Header Message Properties, page
5-28.

* To set applications context for Oracle E-Business Suite to identify the
application user, responsibility, and the user's associated organization
information.

For example, locate the jca.apps.Username property from the property
list and then enter ' OPERATIONS' as the property value.
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© Edit Invoke &

Documentation  Targets  Sources  Skip Condition | Headers

General Correlations Properties Assertions Annotations
To
From  Properties: :ﬂ- / ®
Mame Value
o
@ To Property ﬂ
Mame: | v|

lica.apps. HeaderDocument
lica.apps.ML5Language
I:jca.apps.OF'.G_ID
lica.apps. RespApplication
lica.apps. Responsibility
Help lica.apps. SecurityGroup

ﬁgca.apps.ec{.htﬁibut&l

(@

L |

1I

Help Apply oK Cancel

For detailed instructions, see Setting the Header Properties for Applications
Context, page 7-44.

Support for Multiple Organization Access Control (MOAC)

Oracle E-Business Suite Adapter allows Organization ID to be passed as a header
property which is available as jca.apps.ORG_ID within the Properties tab of an
Invoke activity during the design time.

On Oracle E-Business Suite subsequent to Release 12.0, MOAC setup is automatically
done using the call MO GLOBAL.INIT (<Application Name>).Subsequently, if
ORG_ID is passed, the call to MO_GLOBAL.set policy context('S', <ORG_ID>)
would be made to set the Organization access to the specified ORG_ID.
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Setting Header Message Properties

Set Values Message Properties

SYSADMIN l——-" Username

System Administrator || [ Responsibility
OM Responsibility Application

MLS Language = *US’ i—:[ NLS Language

Standard |

ORG_ID =207’ I_ Organization ID

With the example described earlier in the Multiple Organization Setup section, when a
change order is placed within the French sales office, a sales manager from the French
office logs on to the system to update the order which invokes a PL/SQL API for that
change. If the Organization ID contained in the header has been assigned with a
property value, such as 207 for the French sales office, the Organization ID associated
with the sales manager will be set to French sales office for the invocation of the API.

Security Group

Support for Multiple Languages

By leveraging the message normalization feature addressed earlier and the Multiple
Language Support (MLS) feature from Oracle E-Business Suite, Oracle E-Business Suite
Adapter provides a comprehensive language support mechanism that allows an
appropriate language to be dynamically set at run time.

NLS Language Property Value Takes the Priority

When an application user retrieves data from the system for a transaction or receives
error messages while executing APISs, the session language of data or error messages
can be determined based on the following conditions:

1. The NLS Language value can be set by using the header property
jca.apps.NLSLanguage. If a valid language value is passed (i.e. language is
enabled in Oracle E-Business Suite instance), the session language is set to the
corresponding language.
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2. In case the NLS Language header property is not passed, Oracle E-Business Suite
Adapter will use the default language of the user, based on the user preferences, to
set the session language.

3. If the user's default language is not found or set, NLS Language (
jca.apps.NLSLanguage) property value would be set to 'US' (American).

This mechanism allows an appropriate session language to be dynamically set at run
time first based on the passed NLS Language property value, then the user's default
language, and last determined by the default NLS Language property value 'US'".

For more information about how to set NLS Language property value by using
jca.apps.NLSLanguage, see Support for Normalized Message Properties, page 4-7.

Determining a User's Default Language

To identify the default language used in the database session for data query and
retrieval, Oracle E-Business Suite Adapter will first examine the ICX: Language profile
value at all levels including user, responsibility, application, and site. If it is not set at
any of those levels, Oracle E-Business Suite Adapter then takes NLS LANGUAGE
parameter from the database instance National Language Support (NLS) parameters.
The NLS parameters initialized in the session are:

* NLS LANGUAGE

* NLS_ SORT

* NLS_DATE FORMAT

* NLS_DATE LANGUAGE

* NLS NUMERIC CHARACTERS
* NLS TERRITORY

For example, when a user with a default language Japanese logs into the system and
performs a transaction through the execution of an API that the user defined in the
Partner link of the BPEL process, Oracle E-Business Suite Adapter will first examine if
the NLS Language property value is passed. If it is passed with a valid language, then
the session language will be set based on the passed value regardless of the default
language. If the NLS Language property is not passed, Oracle E-Business Suite Adapter
will set the session language to the preferred / default language of the user. In case that
cannot be found, the language would be set to 'US' (American). The default language
is set in the General Preferences page of Oracle E-Business Suite.

Note: The default language set in the General Preference page updates
the ICX: Language profile option.

When the applications context is set, user preferences like date formats, time zone
information, etc. would be taken care automatically.
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Please refer to the Set Preferences section, Getting Started with Oracle E-Business Suite
chapter, Oracle E-Business Suite User’s Guide for the information on how to set the user
preferences.

Understanding the Oracle E-Business Suite Module Browser

Oracle E-Business Suite Module Browser, formerly known as Oracle Applications
Module Browser, is a key component of Oracle E-Business Suite Adapter. In addition to
the interfaces that are made available through Oracle Integration Repository, Oracle
E-Business Suite Adapter enables you to use business events and event groups, custom
PL/SQL APIs, and custom XML Gateway maps, all of which you can explore using the
Oracle E-Business Suite Module Browser.

Use the Module Browser to select the interface needed to define a partner link. It can be
used in the following ways to locate desired interfaces:

¢ Locating interfaces by Search
¢ Locating interfaces by Browse

Searching Interfaces

Enter desired interface name or partial values containing wildcard characters in the
Object Name field and click Search to locate the desired interface in the Module
Browser.
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Searching Interfaces Through Oracle E-Business Suite Module Browser

@) Oracle Applications Module Browser @

Object Mame: [0F_ORDER_PUB | [ITables [Jviews [#]&P1s []cP [ |¥M Gateway [ ]EDI [ ] BusinessEvents Search Browse

[=-{= OE_ORDER_PUB
-3 Order Management Suite
-3 Supply Chain Management
B-[= Other Interfaces
&+ Custom Objects
&-E PLSQL APIs
) OE_ORDER_PUE (OE_ORDER _PUB)

Cancel

Browsing Interfaces Through Tree Structure

The Module Browser combines interface data from Oracle Integration Repository along
with additional interfaces supported by Oracle E-Business Suite Adapter.
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Browsing Interfaces by Expanding Tree Structure

© Oracle Applications Module Browser (]
Object Name: [ | [ITsbles [Jviews [apls  []CB [|¥MLGateway [JEDI [ ]BusinessEvents Browse
=63 ProductFamilies Name Type Injout
(55 Advanced Planning (SCP_PF) 1_File_Path VARCHAR2 In
(5 Applications Technology (ATG_PF) 1_File_Name VARCHARZ2 n
-8 Contracts Suite (OK_PF) 1_Debug_Mode VARCHARZ In
(3 Discrete Manufacturing (DMF_PF) 1_Run_Import VARCHAR2 In
-3 Financial Globalizations Suite (FINGB_PF) I_Num_Instances VARCHARZ In
- 153 Finandial Payables Suite (FINAP_PF) 1_Transaction_Type VARCHARZ In
(53 Financial Receivables Suite (FINAR_PF) 1_Map_1d VARCHAR2 In
-3 Finandial Services Applications (SEM_PF) 1_Data_File_Characterset VARCHARZ In

(E8 Financials (FIN_PF)
-[5% Human Resources Suite (HR_PF)
- 153 Interaction Center (CC_PF)
(E8 Marketing Suite (MKT_PF)
154 Marketing and Sales Suite (MAS_PF)
= - (5 Order Management Suite (OM_PF)
(58 Transportation Execution (FTE)
[} 5% Order Management (ONT)
53 Sales Agreement (ONT_SALES_AGREE
=}~ (3 Sales Order (ONT_SALES_ORDER)
[ XMLGateway
- EDI
8 OUTBOUND: Purchase Order £
£, OUTBOUND: Purchase Order
§m INBOUND: Grocery Purchase (
[Ersa
[ Openinterfaces
[ CONCURRENT_PROGRAMS
(5 INTERFACE_VIEWS
- 158 Configurator (CZ)
(8 Advanced Pricing {QP)
53 Shipping Execution Comman (WSH)
- 5% Release Management (RLM)
(58 Process Manufacturing (OPM_PF)
-5 Procurement (PRC_PF)
(5 Product Lifecyde Management (PLM_PF) oK Cancel

The supported interfaces are organized in a tree hierarchy as follows:

ProductFamilies
|- [product family]
| | - [product]
| |- [business entity]
| | -XML Gateway ([n])
| |-EDI ([n])
| [-PLSQL ([n])
| | | - [package name]
| | -OpenInterfaces ([n])
| |- [OpenInterface name]
| |-Tables ([n])
| |-Views ([n])
| | -ConcurrentPrograms ([n])
| -Other Interfaces
| -Business Events
| =Inbound
| -Outbound
| -Groups
|- [business event name]
| -Custom Objects
| -PLSQL APIs
| | - [package name]
| -XMLGateway Maps
| =Inbound
| —-Outbound
| -Concurrent Programs
| -[concurrent program name]
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¢ The items under Other Interfaces, as well as certain PL/SQL APIs
and concurrent programs under the [product family] hierarchy, are
available through Oracle E-Business Suite Adapter, but not through
Oracle Integration Repository.

e The number of interfaces indicated by [n] only appears in case of
an Oracle E-Business Suite 11.5.10 instance is used. It will not be
displayed if you are connecting to an Oracle E-Business Suite
release 12 instance.

Browsing Interfaces by Product Family

The Oracle Integration Repository interface data populates the [product_family]

sections, grouped according to the products and business entities to which they belong.

Browsing Interfaces by Product Family

@) Oracle Applications Module Browser

(i

- (% Financials (FIN_PF)
(58 Human Resources Suite (HR,_PF)
-[54 Interaction Center (CC_PF)
- 158 Marketing Suite (MKT_PF)
(58 Marketing and Sales Suite (MAS_PF)
-5 Order Management Suite (OM_FF)
(58 Transportation Execution (FTE)
(=} (54 Order Management {ONT)
- (5% Sales Agreement (ONT_SALES_AGREE
- (5 Sales Order (ONT_SALES_ORDER)
-[B xMLGateway
=-fREN
, OUTBOUND: Purchase Order /
8 OUTBOUND: Purchase Order (
-8, INBOUND: Grocery Purchase (
(R PLSQL
[ Openinterfaces
[ CONCURRENT_PROGRAMS
[ INTERFACE_VIEWS
- 5% Configurator (CZ)
- 5% Advanced Pricing (QF)
(Z8 Shipping Execution Comman (WSH)
- (53 Release Management (RLM)
(58 Process Manufacturing (OPM_PF)
(58 Procurement {PRC_PF)
- (% Product Lifecyde Management (PLM_PF) oK Cancel

Object Hame: [ | [lTsbles [Jviews [Japts  []CP  [|XMi Gatewsy [ |EDI [ |BusinessEvents Browse
68 ProductFamilies Name Type Injout
(5% Advanced Planning (SCP_PF) 1_File_Path VARCHAR2 In
(5% Applications Technology (ATG_PF) 1_File_Name VARCHAR2 n
-5 Contracts Suite (OK_PF) 1_Debug_Mode VARCHAR2 In
- (5% Discrete Manufacturing (DMF_PF) I_Run_Import VARCHARZ In
(E8 Financial Globalizations Suite (FINGE_PF) I_Num_Instances VARCHAR2 In
-3 Finandal Payables Suit= (FINAP_PF) 1_Transaction_Type VARCHARZ In
(5 Financial Receivables Suite (FINAR _PF) 1_Map_1d VARCHARZ In
(53 Finandial Services Applications (SEM_PF) 1 Data File_Characterset VARCHAR2 In

Browsing Business Events and Custom Interfaces Under 'Other Interfaces'

Business events and custom interfaces are displayed under the Other Interfaces note.
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Browsing Other Interfaces

© Oracle Applications Module Browser

==

Object Name: | | [Tsbles [Jviews [JaPls []cP [ ]xM Gatewsy [ |EDI [ |BusinessEvents

Browse

= @ ProductFamilies

(&3 Advanced Planning (SCP_PF)

(5% Applications Technology (ATG_PF)

(53 Contracts Suite (OK_FPF)

(G3 Discrete Manufacturing (DMF_PF)

53 Financial Globalizations Suite (FINGB_PF)
(53 Financial Payables Suite (FINAP_PF)

(&3 Financial Receivables Suite (FINAR_PF)
(5% Financial Services Applications (SEM_PF)
(53 Financials (FIN_PF)

(58 Human Resources Suite (HR_PF)

(58 Interaction Center {CC_PF)

(53 Marketing Suite (MKT_PF)

(G Marketing and Sales Suite {MAS_PF)

(5% Order Management Suite {OM_PF)

(53 Process Manufacturing (OPM_PF)

(8 Procurement (PRC_PF)

(58 Product Lifecycle Management (PLM_PF)
(53 Projects Suite (PJ_PF)

(3 Public Sector (PS_PF)

(58 Sales Suite (SLS_PF)

(58 Service Suite (SRV_PF)

(&8 Supply Chain Management (SCM_PF)
(58 University (UNV_PF)

]

2} (8 Business Events
(53 Inbound(Raise Business Events into Orac|
(53 Outbound(Listen to Business Events frof
=} (5 Custom Objects
(5 PLSQL APTs
3 XMLGateway Maps
& % Concurrent Programs

Cancel

® Business Events and Business Event Groups

Business events and business event groups appear under the Other Interfaces node

from the Oracle E-Business Suite Module Browser.

A business event group is a type of event containing a set of individual business
events. Clicking the Other Interfaces > Business Events > Outbound > Groups

node displays the business event groups.

= 54 Other Interfaces
= (28 Business Events
(53 Inbound(Raise Business Events into COracle Apps)
B 5% Outbound(Listen ko Business Events From Oracle Apps)
@} E Groups
----- s ORACLE.APPS. AP .PROCESSPAYMENT. COMFIR.M
----- E?D ORACLE.APPS.FTE.SSMOD, CONFIRM
----- E‘:D ORACLE.APPS.PER. KI.COMNFIRM
----- E‘:D QA SAMPLING REDUCED IMSPECTION
..... £77 QA SKIPLOT FREQUENCY CHAMGE
----- E“:D aracel, apps.po.event.update_asl
----- E‘:D aracle.apps.alr.response.receive
----- E':D aracle. apps.ams.approval. Objectapproved
----- &7 oracle. apps. ams.campaign. ExecuteSchedule
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Custom Interfaces

Custom interfaces are displayed under the Other Interfaces > Custom Objects
node from the Oracle E-Business Suite Module Browser.

Browsing Custom Interfaces

© Oracle Applications Module Browser

=)

Object Name: | |

[ Tables

[ views

[]aPls  [Jc [ ]XMLGateway [ |EPI [ ]BusinessEvents Browse

=

- (53 Other Interfaces

ProductFamilies

(53 Advanced Planning (5CP_PF)

(5% Applications Technology (ATG_PF)

(55 Contracts Suite (OK_PF)

(4 Discrete Manufacturing (DMF _PF)

(& Finandial Globalizations Suite (FINGE_PF)
(S Finandial Payables Suite (FINAP_PF)

(53 Finandal Receivables Suite (FINAR_PF)
(53 Finandial Services Applications (SEM_PF)
(53 Finandals (FIN_PF)

(5% Human Resources Suite (HR_PF)

(5% Interaction Center (CC_PF)

(G Marketing Suite (MKT_PF)

(4 Marketing and Sales Suite (MAS_PF)

(53 Order Management Suite (OM_PF)

(53 Process Manufacturing (OPM_FF)

(53 Procurement (PRC_PF)

(53 Product Lifecycle Management (FLM_PF)
(52 Projects Suite (P1_PF)

(5% Public Sector (PS_PF)

(4 Sales Suite (SLS_PF)

(4 Service Suite (SRV_PF)

(% Supply Chain Management (SCM_PF)
(S University (UNV_PF)

- 53 Business Events
(5% Inbound(Raise Business Events into Ora
(5% Outbound(Listen to Business Events froi
- (58 Custom Obiects g

4 PLSQL APIs

% XMLGateway Maps

= (3§ Concurrent Programs

. ADS Archive Demand Plan (ADSAR
ADS Batch Import (ADSEATCHIMP)
ADS Cross currency lockbox flat f
ADS Customer Listing - Detail (AD*

14 30 00 0

Cancel

The supported custom interfaces are listed as follows:

Custom PL/SQL APIs

Custom PL/SQL APIs appear in two places:

® Procedures within a package that's already exposed via Oracle Integration
Repository appear under the package name within a product family

hierarchy.

® Procedures within a completely new package appear under the package

name, under Other Interfaces > Custom Objects.

Custom XML Gateway Maps

Custom XML Gateway maps are categorized as either Inbound or Outbound.
Select either one of the nodes to display custom XML Gateway maps.

Customized Concurrent Programs

Clicking the Concurrent Programs node under the Custom Objects node
displays all the custom concurrent programs.
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Understanding Oracle E-Business Suite Adapter Security

Security is the most critical feature that is designed to guard application content from
unauthorized access. By leveraging Oracle User Management security mechanism,
Oracle E-Business Suite Adapter provides a security feature which only allows users
with authorized privileges to execute APIs that they are exposed through the BPEL
process to update Oracle E-Business Suite. This protects application programming
interfaces (APIs) from unauthorized access or execution without security checks.

Function Security with Role-Based Access Control (RBAC)

Function security is the basic access control in Oracle E-Business Suite. It restricts user
access to individual menus and menu options within the system regardless of which
application data in the row. Since APIs are stored procedures that enable you to insert
and update data in Oracle E-Business Suite, when having the function security layer
enforced on the access to an AP], it actually implicitly restricts the data access to the
Oracle E-Business Suite application.

Building on function security, data security provides another layer of security control to
model or enforce security authorizations of specific data records. In other words, data
security further refines the security of accessing application records down to the data
level.

To provide granular security control and allow only appropriate users with right
privileges to execute APIs, Oracle E-Business Suite Adapter leverages Oracle User
Management Role-Based Access Control security (RBAC) to reinforce the function
security through user roles. Whether a user can access an APl is determined by the roles
granted to the user. This approach builds upon data security and function security, but
it goes beyond both of them.

Function Security with Role-Based Access Control

I—

Role-Based Access Control

I | I
Data Security

I | I—

Function Security

To better understand how the security works for Oracle E-Business Suite Adapter, the
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following topics are included in this section:

¢ Function Security Support for Overloaded Functions, page 4-21

¢ Function Security Support through Profile Option, page 4-22

Function Security Support for Overloaded Functions

Oracle E-Business Suite Adapter provides a way to handle access control for overloaded
PL/SQL APIs. This feature works in conjunction with the grants created from the
Integration Repository user interface, and it does not depend on any profile options.

Note: This security support would work with all interfaces which are
available in the Integration Repository. For other interfaces, you need to
enable the function security through the profile option mentioned in
the section Function Security Support through Profile Option, page 4-
22.

For this purpose, two new JCA properties are introduced:

® DataSecurityCheck
® TRepOverloadSeqg

If a user wants the Function Security Authorization check to be performed, the
following property information needs to be added in the WSDL file (XX apps.Jjca):

<property name="DataSecurityCheck" value="yes"/>

However, the other property IRepOverloadSeq is derived automatically by Oracle

E-Business Suite Adapter at the design time during creation of the partner link. Based
on these two properties, the function security check would be done for the username,
which is passed as a header property.

Creating Security Grants through Integration Repository

This type of data security check for overloaded functions works in conjunction with
security grants created through the Integration Repository user interface. This security
grant can be performed in the Create Grant page for a given interface type to control the
method at a very granular level.

An integration repository administrator can select one or more methods in a PL/SQL
API and then authorize a user, user group, or all users to execute the selected method(s)
by creating appropriate security grants.
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Creating Grants in Integration Repository

ORACL_E Integration Repository

n Mavigator v B Favorites ™ Home Logout Preferences Help Diagnostics

Integration Repository | Administration

Integration Repositoryy = PLSQL Interface | Payment Instrurment Registration =
Create Grants

Cancel Apply

Selected Methods

Name Internal Name Overloaded
Query Payment Instrument ORAINSTRING +
Query Payment Instrument ORAINSTRING +

Grant all Selected

Grantee Type | Specific User M
Grantes Marme Q

Cancel Apply

Integration Reposi Administration Home Logout Preferences Help Diagnostics

Aboutthis Page  Pri men Copyright (¢) 2006, Oracle. All rights resenied

In the Integration Repository user interface, each overloaded function contained in an
interface can be uniquely granted to a specific user, user group, or all users through the
create grant feature. If you select more than one overloaded function in the Procedures
and Functions region (or the Methods region), in the Create Grant page an Overloaded
column appears in the selected methods table indicating more than one overloaded
function is selected for the grant.

For more information on how to create security grants using the Integration Repository
user interface, see Managing Security Grants, Administering Native Integration
Interfaces and Services chapter, Oracle E-Business Suite Integrated SOA Gateway
Implementation Guide for details.

Function Security Support through Profile Option

Based on the function security with Role-Based Access Control (RBAC), security access
control is defined through user roles and whether a user can access an APl is
determined by the roles granted to the user. A role can be configured to consolidate the
responsibilities, permissions, permission sets, and function security policies that users
require to perform a specific function. This simplifies mass updates of user permissions
because changes can be done through roles which will inherit the new sets of
permissions automatically. Based on the job functions, each role can be assigned a
specific permission or permission set if needed. For example, a procurement
organization may include 'Buyer', Purchasing Manager', and 'Purchasing Support'
roles. The Purchasing Manager' role would include a permission set that contains all
Purchase Order (PO) Creation, PO Change, and Contract PO related APIs allowing the
manager role to perform a job function while the Buyer or Support role may not have
the access privileges.

In Oracle E-Business Suite Adapter, all annotated APIs that reside in Oracle Integration

4-22 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



Repository are registered on the FND_FORM_FUNCTIONS table so that the function
security (FND_FORM_FUNCTIONS) can be applied. This allows the creation of a
secured function for each APL

By leveraging the concept of permission sets, Oracle E-Business Suite Adapter allows
related APIs to be grouped and sequenced under one permission set; each permission
set can be associated with a function role and then assigned to users through security
grants.

Enabling Function Security

Oracle E-Business Suite Adapter provides this security support as an optional feature. If
you want all the login users to access and execute APIs without security checks, you can
turn the security feature off using the "EBS Adapter for BPEL, Function Security
Enabled" (EBS_ADAPTER_FUNCTION_SEC_ENABLED) profile option.

Note: Using "DataSecurityCheck" described in the earlier section for
overloaded functions is the preferred way for interfaces listed in the
Integration Repository because it is easy to create the security grants
and doesn't depend on any profile options.

e Ifitissetto "Y', then the function security feature is enabled and all API calls for
PL/SQL APIs, Oracle e-Commerce Gateway, and concurrent programs will be
checked for user security before they are invoked.

e Ifitissetto'N'(default value), then the function security feature is disabled. No
security check is implemented during the invocation of all API calls.

When a user tries to invoke an API within the Oracle E-Business Suite through a BPEL
process, if the function security profile is enabled, the invocation of the API would
happen only after validation of the authorization privileges on the API.

For example, if a user does not have the access privileges for a PL/SQL API exposed
through a BPEL process, the execution of that BPEL process will fail while trying to
invoke the PL/SQL API. Without the authorized privileges, the Function Security
Validation Exception message will be raised indicating that the user does not have the
privilege for a specific PL/SQL APL

For more information about this feature, see My Oracle Support Knowledge Document
787637.1 for details. For more information on Function Security and RBAC security
models, see "Function Security and Role-Based Access Control (RBAC) in Oracle
E-Business Suite", My Oracle Support Knowledge Document 1537100.1 and Oracle
E-Business Suite System Administrator’s Guide - Security for details.

Creating Security Grants through User Roles

To secure the API invocation only to a user with appropriate execution privileges, the
following steps need to be performed on Oracle E-Business Suite to create security
grants for the user using user roles:
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1. Creating a Permission Set, page 4-24
2. Creating a User Role, page 4-26
3. Granting a Permission Set to a User Through a Role, page 4-27

Creating a Permission Set

Use the following steps to create a permission set:

1. Log in to Oracle E-Business Suite using the System Administrator responsibility.
2. Select Application: Menu from the Navigator to access the Menus window.

3. Enter the following menu information:
* Menu: Enter an appropriate menu name (such as 'OE_PROCESS_LINE_PS').

® User Menu Name: Enter an appropriate user menu name (such as 'Order
Manager Process Line Permission Set').

* Menu Type: Permission Set

® Description: Enter description information for this menu.

4. Add all the functions that you want to group on this Permission Set by entering
values for Seq and Function.

1. Enter the Seq field.

2. In the Function column, search for the functions you want to assign to this
permission set.

Select an appropriate function name by performing a search in the Functions
window. For example the syntax for searching public PL/SQL APIs is:
PLSQL:<package name>:<procedure name>. You can enter $PLSQL:0E%
in the Find field and click Find to execute the search.
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Searching for Functions

Functions

Find|%PLSOLOES

Jser Function Mame Function Mame Description

Celete Crder PLSALOE_ORDE.. Llse this procedure to
Celete Crder Line FLEQL.OE_DQRDE... Llse this procedure to
Get Sales Qrder PLSQAL.OE_DRDE... Llse this procedure to
I To Walue PLSQLOE_ORDE.. Llse this procedure to
Laock Sales Qrder FLSALOE_ORDE.. Llse this procedure to
Maintain Sales Qrder FPLEAL.OE_DRDE... Llse this procedure to
Process Order Header PLSQLOE_DRDE. . llse this procedure to

F r Line LOE_ORDE..  Usethis procedure to
pdate Order Header FLEQL.OE_DQRDE... Llse this procedure to
Jpdate Order Line PLSQLOE_DRDE.. Lse thizs procedure to
Walue To 1D PLSALOE_ORDE.. Llse this procedure to
T T T A T Rr | [

Based on your Composite application, select appropriate functions and then
grant permissions to the API that you will be invoking from the BPEL process
or Mediator.

For example, for a sales order line change BPEL process, you select sales order
line change related functions contained in the order change PL/SQL API and
group them as a permission set, and then grant the permission set to an
appropriate user through a role.

See: Creating a User Role, page 4-26.
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Permission Set Menu

Menu

User Menu Name
Menu Type
Description

Seq Prompt
1

Iz

OE_PROCESS_LINES_PS
Order Manager Process Lines Permission Set
Permizsion Set

Order Manager Process Lines Permission Set

Submenu Function
Process Order Line

Delete Order Line

5.  Save the Permission Set.

Creating a User Role

Wiew Tree. ..

Description Grant
v (=]

Permission sets are granted through user roles. Therefore, you must first create a role
and then assign the role to a user.

Use the following steps to create a user role:

1. Log in to Oracle E-Business Suite using the User Management responsibility.

2. Select Roles & Role Inheritance from the Navigator to access the Roles & Role

Inheritance page.

3. Click Create Role to access the Create Role page.

4. Enter the following information to create a role:

* Category: Select Miscellaneous from the drop-down list.

* Role Code: Enter an appropriate role code (such as 'EBS_ADAPTER_ROLE).

e Display Name: Enter appropriate information for the display name (such as
'EBS Adapter Role').

¢ Description: Enter appropriate information for the description (such as 'EBS

Adapter Role').
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* Application: Select an appropriate application (such as 'Application Object
Library').

¢ Active Date: Enter an appropriate date which is earlier than or equal to today's
date so that the role can become valid right away.

Save the information and click Create Grant.

Enter the following information in the Create Grant: Define Grant page:

e Name: Enter an appropriate name (such as 'EBS_ADAPTER_GRANT").

¢ Description: Enter description information for this grant.

Click Next.

In the Create Grant: Define Object Parameters and Select Set page, select the
Permission Set you created earlier in the Creating a Permission Set section, page 4-
24 and click Next.

Click Finish.

Granting a Permission Set to a User Through a Role

Use the following steps to grant a permission set to a user through a role:

1.

Log in to Oracle E-Business Suite using the User Management responsibility.
Select Users from the Navigator to access the User Maintenance page.

Search for the user you want to assign the role and click Go.

Select the Update icon next to the user name that you want to assign the role.

In the Update User page, click Assign Roles to have the Search window populated
which allows you to search for the role that you created earlier.

Select the role (such as 'EBS_ADAPTER_ROLE') and save your update.

Flexfield Support for PL/SQL APIs and Open Interface Tables

Oracle E-Business Suite Adapter provides flexfield support for PL/SQL APIs and Open
Interface Tables (OIT). If a PL/SQL API or an OIT table is configured with flexfields,
flexfield information including flexfield data and mapping will not only be displayed at
design time, but also be included in the XSD. This helps integration developers to create
mappings between third party data elements with more meaningful business object

elements. Additionally, this feature allows Oracle E-Business Suite Adapter run time to
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work in the context of flexfields.

Note: This feature is available for PL/SQL APIs and Open Interface
Tables only and is for Oracle E-Business Suite Release 12 and above.

What is a Flexfield?

Flexfield is one of the essential features in Oracle E-Business Suite. It provides a flexible
way to represent objects or to implement context-sensitive fields that appear only when
needed. It is a field made up of sub-fields, or segments. Two flexfield types (key and
descriptive flexfields) are used to let you customize Oracle E-Business Suite features
without additional programming. To provide the unique, customized information that
conforms to your business needs, Oracle E-Business Suite Adapter provides flexfield
support for PL/SQL APIs and Open Interface Tables that contain flexfields.

How Flexfield Data is Configured at Design Time

At design time during the partner link creation, if a PL/SQL API or an open interface
table is configured with flexfields, appropriate flexfield information is displayed along
with the API parameters or table columns in the right pane of the Oracle E-Business
Suite Module Browser. You can optionally modify or create a new flexfield mapping for
the selected interface, or proceed with the partner link creation without configuring the
interface with flexfields.

To configure flexfield data, Oracle E-Business Suite Adapter allows you to either use an
existing flexfield mapping that has been created earlier, or to create a new mapping if
desired. In the case of creating a new mapping, a mapping flexfield wizard appears
guiding you through each configuration page where you can add key and descriptive
flexfields with desired mapping for the selected interface.

Key Features

Flexfield feature provided in Oracle E-Business Suite Adapter includes the following
key features:

e It displays flexfield information which contains the mapping of API parameter or
interface table column names and the corresponding flexfield segment names in the
Oracle E-Business Suite Module Browser.

¢ Itlets you configure and modify both key flexfields and descriptive flexfields.
e [t provides a flexible mapping support mechanism for a selected API or an open

interface table that you can configure a new mapping or reuse a previously created
mapping through import.

Note: A flexfield can be mapped only once. Duplicate flexfields are
not allowed.

e It allows you to use more than one open interface table during the partner link
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creation. Flexfields can be configured individually for each table.

®  Once a flexfield mapping is completed and partner link is created, an enhanced
schema (XSD) is generated using flexfield names instead of the generic parameter
or column names.

¢ It allows the Oracle E-Business Suite Adapter run time to work in conjunction with
the support from Oracle Database Adapter to handle the enhanced schema.

Understanding Key Elements in Flexfield Configuration

Oracle E-Business Suite Adapter supports both key flexfields and descriptive flexfields
referenced by an API or open interface table.

e Key Flexfields

Use key flexfields as identifiers for entities. Generally, the identifier you create
using a key flexfield is required by the application. For example, an Accounting
Flexfield is used to create and display account numbers. This key flexfield is owned
by Oracle General Ledger, but its values can be used by many of the applications.

A key flexfield structure usually consists of multiple segments and each segment
contains meaningful information. For example, the Accounting Flexfield structure
can consist of five segments such as Company, Department, Account, Sub-Account,
and Product.

* Descriptive Flexfields

Use descriptive flexfields to gather additional specialized, important, and unique
information required by your business. In other words, this type of flexfield is used
to collect information beyond what is collected by Oracle E-Business Suite.

A descriptive flexfield typically uses multiple structures. Each of these structures
can have different segments to gather different data. Each segment's value is stored
in a column in one of the application's base tables. The column name reflects the
type of flexfield data it holds.

In general, key flexfields store their data in columns called SEGMENTn; descriptive
flexfields store their data in columns called ATTRIBUTEn, where n is a number. Use
key flexfields to define your own structure for many of the identifiers required by
Oracle E-Business Suite; use descriptive flexfields to gather additional information
about your business entities beyond the information required by Oracle E-Business
Suite.

For more information about flexfields, see the Oracle E-Business Suite Flexfields Guide.
Flexfield Mapping Concepts

Each flexfield regardless of its type has its owner application. For example, an
Accounting Flexfield is owned by Oracle General Ledger application. During the
flexfield configuration, you need to first select an application to which a flexfield
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belongs, and then select a flexfield name (such as Accounting Flexfield) contained in the
selected application (such as General Ledger).

Key Flexfield Mapping for PL/SQL APIs
The following diagram illustrates the high level key flexfield mapping concepts for

PL/SQL APIs:
Basic Key Flexfield Mapping Concepts for PL/SQL APIs
Flexfield Application Flexfield Flexfield Table Columns API Parameters
[~ Bpmimtre |
AOL Structure
| Flexield ! S t1 JI Mapping Parameter 1
General egmen !
Ledger » | Flexfield 2

| [Mappin
Segment 2 L'F Ppng Parameter 2
St:.:gmentn}:'| Mapping| | parameter n
|

[ I DataType

Payroll

i i

Receivables »| Flexfield n

IR

In this diagram, Flexfield 2 (Accounting Flexfield) belongs to General Ledger
application, and it contains multiple segments (segment 1 to segment n) which can be
grouped by data type.

The main part of flexfield configuration is mapping. Once a flexfield with a desired
application is selected, the matching segments (segment 1 to segment n) are derived
from the Oracle E-Business Suite database along with the related API parameters based
on the flexfield metadata for your mapping.

For PL/SQL APIs, parameters are displayed based on the selected data type (parent
type or record type). API parameters and the flexfield table columns can be mapped
either manually or automatically by using Auto Map.

¢ Parent type: Parent type is a pseudo type to allow all the scalar
parameters at the procedure level to participate in the mapping. It
can be used for simple APIs that just have scalar parameters.

* Record type: Record type can be selected if it's for a complex API
that has record types in addition to scalar types. When a record
type occurs multiple times in the API, the list of paths is displayed
for reference. If the parameters from a record type are mapped to
the flexfield table columns, then the same mapping would be
applicable to all the paths it occurs.

Supported record types include array, nested tables, and associated
arrays.

Note: Automapping feature maps all the table columns to the
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parameters which have the column name as part of the parameter
name. For examples, parameter P_ATTRIBUTE1 would be mapped to a
column name called ATTRIBUTE], and parameter P_ATTRIBUTE2
would be mapped to a column name called ATTRIBUTE2.

Once mapping is completed, you will need to select a flexfield structure for a key
flexfield.

Note: A flexfield structure is a specific configuration of segments. If you
add or remove segments, or rearrange the order of segments in a
flexfield, you get a different structure. The segments that make up a
particular structure are logically or functionally related. The structure
and segment definition is created in Oracle E-Business Suite through
the Application Developer responsibility.

For more information about flexfields, see the Oracle E-Business Suite
Flexfields Guide.

Key Flexfield Mapping for Open Interface Tables

Similar to the mapping for PL/SQL APIs, once a flexfield with a desired application is
selected for an Open Interface Table, the matching segments (segment 1 to segment n)
are derived from Oracle E-Business Suite database along with the related open interface
table columns based on the flexfield metadata for your mapping. Mapping can be
performed either manually or automatically by using Auto Map.

Note: Please note that datatype is used for PL/SQL APIs only.

Automapping feature maps all the flexfield table columns to the open
interface table columns which have the flexfield table column name as
part of the interface table column name. For examples, interface table
column name TP_ATTRIBUTE1 would be mapped to a flexfield table
column name called ATTRIBUTE]1, and interface table column
TP_ATTRIBUTE2 would be mapped to a flexfield table column name
called ATTRIBUTE2.

The following diagram illustrates the high level key flexfield mapping concepts for
Open Interface Tables:
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Basic Key Flexfield Mapping Concepts for Open Interface Tables

Open Interface
Table Columns

Column 1

Column 2

Column n

Flexfield Application Flexfield Flexfield Table Columns
[~ ehmietre I
AOL Structure
General Flexfield 2 f Bl
g I'| Segment 2 e Ppng
Payroll : : :
: : I : I
. | |
| | :
. » Mappin
| |

RAD

Once mapping is completed, you will need to select a flexfield structure for a key

flexfield.
Descriptive Flexfield Mapping for PL/SQL APIs

For descriptive flexfields, an additional mapping is required for the context column. All
the flexfield table columns including the context column should be mapped to the scalar
parameters within one record type or parent type. Once mapping is completed, select at
least one context value for the selected context column for a descriptive flexfield.

For example, Chile uses 'Region' and 'Comuna’ in addition to 'State' and 'County' to
represent subdivision or relatively small location geographically. Similarly, Ecuador
uses 'Zona' and 'Parroquia’ in geography to describe different boundaries. This is a

perfect example using a descriptive flexfield to customize the application to meet your
business needs. Chile and Ecuador are the context values when defining the descriptive
flexfield 'TCA Location Information'. Parameterl (or Parameter?2) is mapped to
ATTRIBUTEIL (or ATTRIBUTE2) whose value depends on the selected context value

(either 'Chile’ or 'Ecuador’).

Note: For descriptive flexfields, context value should be available to the

runtime through an API parameter.
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Basic Descriptive Flexfield Mapping Concepts for PL/SQL APIs

API Parameters Table Column Context Values
3 1
P |
Attribute_Category | : » Chile :
Il
Parameter 1 | [MapPPing| | Auc bute 1 11> Region |
i ™ Comuna |
| (| |
Mapping . | [ |
Parameter 2 - Attnub.ute 2 [ ] Ld [s Ecuador |
: | L——dll Zona i
i '—————H»Parroquia
Parameter n Mapping » Attribute n : :
| * |
DataType | Flexfield 1 :

Descriptive Flexfield Mapping for Open Interface Tables

Similar to PL/SQL APIs, an additional mapping is also required for the context column
in defining descriptive flexfield mapping for Open Interface Tables. All the flexfield
table columns including the context column should be mapped to the open interface
table columns. Once mapping is completed, select at least one context value for the
selected context column for a descriptive flexfield.

Basic Descriptive Flexfield Mapping Concepts for Open Interface Tables

Open Interface Flexfield Table
Table Columns Column - _c_oilt_eict_\ia_lu_e_s -
Attribute_Category [ IN :
______ || |
Column 1 [ [Mapping | | ae b to 1 f[™Address_Line1 | |
“=== o ™Address_Line2 |||
o |
i |
Column2 [[MaPPING LI Avriubute 2 — LUETp !
1 I

: I L _{l|»Postal_Code i

; —————LimProvince
Column n Mapping » Aftribute n : :
. |
L_Flexfield1 |1

In this diagram, for example, 'Address_Linel' and 'Address_Line2' are selected for 'IN'
(India) to describe the address information, while the same attributes (ATTRIBUTE1
and ATTRIBUTEZ2) are mapped to Postal_Code' and 'Province' for 'JP' (Japan).

Oracle E-Business Suite Adapter uses the flexfield mapping defined from the Oracle
E-Business Suite Module Browser to generate the enhanced XSD. This XSD will contain
flexfield segment names based on the mapping chosen at design time. Oracle
E-Business Suite Adapter will then work in conjunction with Oracle Database Adapter
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to handle the enhanced schema file for runtime processing.
Guidelines for Defining Flexfield Structure and Context Values

You will not be able to select a context value for a descriptive flexfield or a structure for
a key flexfield if one of the following conditions are met:

* A context/structure has no segments or segment mappings.
Only context/structure values that have at least one segment can be selected.

e A context/structure has segments, but none of them matches with at least one of the
table columns mapped in the mapping page.

* A context/structure has all the segments disabled in Oracle E-Business Suite.

e A context/structure itself is disabled in Oracle E-Business Suite.

Only context/structure that is enabled will be shown in the Flexfield Subflow
wizard in step 6 (Flexfield Subflow - Configure Flexfields).

Flexfield mapping will be used to generate an enhanced schema or XSD file.

Flexfield Mapping Configuration Guidelines and Constraints

* Duplicate flexfields are not allowed. A flexfield can be mapped only once.
¢ Range key flexfields are not supported.
* Valuesets and qualifiers are not supported.

¢ For PL/SQL APIs, flexfield mapping for all the flexfield segments in one flexfield
should happen either at the parent level or within one record type.

e For PL/SQL APIs, the mapping for the context column should correspond to
parameters at the level at which the segments are mapped. In other words, if the
descriptive flexfield segments are mapped to a selected data type (either record
type or parent type) for PL/SQL APIs, the context column mapping should also
happen with the same selected data type.

Accessing Flexfield Mapping User Interface

While creating a partner link at design time, if a selected interface is configured with
flexfields, Oracle E-Business Suite Module Browser will display flexfield information in
the right pane of the browser window.

For example, a PL/SQL API SYNC_ACCT_ORDER can be retrieved from a search or
selected from HZ_AIA_CUSTOM_PKG listed under the Other Interfaces > Custom
Objects > PLSQL APIs node. The flexfield data if configured in this APl is displayed in
the Oracle E-Business Suite Module Browser.
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API with Flexfield Mapping Information

-
@) Oracle Applications Module Browser I@
Object Name: El [JTables []Views APIs  [|CP [ ]¥MLGateway [ |EDI [ ]BusinessEvents Search Browse
B2 HZ_AIA_CUSTOM_PKG Parameters with Corresponding Flexfield Mappings

[2++( Other Interfaces

5 Path Type Infout Segment Flexfield... Context Flexfield ...
(=2 Custom Objects .
& PLSQL JAPIs ; B sTatus VARCHARZ ~ IN
. CATEGORY_CODE VARCHARZ IN
& 0 HZ_AIA_CUSTOM_PKG (HZ_AIA_CL 4 =
B GET_ACCT MERGE_OBJ (GET A Bl sALUTATION VARCHARZ ~ IN
5 T T SR 5l ATTRIBUTE_CATEGORY VARCHARZ — IN Descriptive [Fauador > |HZ_LOCATL..
N T e (] [l ATTRIBUTEL VARCHARZ N Zona Descriptive HZ_LOCATL...
'" GI:T—RELATE_D DRG_CUFF o83 [l ATTRIBUTE2 VARCHAR2 N Parroguia Desdriptive HZ_LOCATI...
- s S El ATTRIBUTES VARCHARZ IN Descriptive HZ_LOCATL...
i'" ERCEAGEHIRE A SW m [E ATTRIBUTE4 VARCHARZ N Descriptive HZ_LOCATL...
e - El ATTRIBUTES VARCHARZ ~ IN Descriptive HZ_LOCATL...
[l ATTRIBUTES VARCHARZ ~ IN Descriptive HZ_LOCATL...
[El ATTRIBUTE? VARCHARZ N Descriptive HZ_LOCATL...
El ATTRIBUTES VARCHARZ IN Descriptive HZ_LOCATL...
El ATTRIBUTES VARCHARZ IN
[El ATTRIBUTE1D VARCHARZ ~ IN
[El ATTRIBUTE11 VARCHARZ ~ IN
[El ATTRIBUTEL2 VARCHARZ N
[l ATTRIBUTEL3 VARCHARZ IN
El ATTRIBUTE14 VARCHARZ IN
El aTTnIe mEls nouana T
Configure Flexfields
f Flexfield Definitions
Type Application Name Datatype Structure or Context
Descriptive Flexfield AR HZ_LOCATIONS HZ_ORGANIZATION_BC  [Ecuador -

Flexfield Metadata

HZ_ATA_CUSTOM_PKG_SYNC_ACCT_ORDER_SyncOrder_mapping. xml Import from File Add Mapping

ok Cancel

Note: If a selected API or an interface table has pre-configured flexfield
mappings available, a pop-up window appears allowing you to decide
if you want to use these pre-configured mappings. Click Yes to display
these mappings as part of the flexfield definitions in the Configure
Flexfields region. You can modify them later if needed.

Click No to indicate that you will not use these mappings and the
pop-up window disappears.

Understanding Flexfield Mapping Data in Oracle E-Business Suite Module Browser

The flexfield information associated with the selected interface can be populated and
configured in the following regions of the Oracle E-Business Suite Module Browser:

Note: Alternatively, you can bypass the flexfield mapping
configuration or modification for your selected interface by simply
clicking OK in the browser to proceed with the partner link creation.

e Parameters (or Interface Table Columns) with Corresponding Flexfield
Mappings Region

This region displays the parameters or interface table columns of the selected
interface along with the corresponding flexfield mapping information.
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For PL/SQL APIs, record type parameters are displayed as a tree structure within
the table, allowing you to expand or collapse the tree nodes to locate your desired
parameters. For Open Interface Tables, interface table column names are simply
listed in the table.

* Configure Flexfields Region
This region allows you to perform the following tasks:
*  Modifying Flexfield Mapping Definitions

No matter if the selected interface is a custom or seeded one, once the flexfield
mapping information is populated in the browser, you can modify context
values for a descriptive flexfield and structure for a key flexfield.

Oracle E-Business Suite Adapter will then use the flexfield definitions from the
Module Browser to generate the enhanced XSD. This XSD will contain the
flexfield segment names chosen at design time based on the mapping
information along with the parameter or table column names.

For more information on how to modify your flexfield mappings, see
Modifying Flexfield Mapping Definitions, page 4-119.

®  Creating a New Mapping

You can create a new mapping for a selected interface by clicking Add
Mapping in the Flexfield Metadata section. A new flexfield mapping wizard
appears guiding you through each configuration page where you can add key
and descriptive flexfields, as well as configure flexfield mapping between the
selected interface and any flexfields defined in the Oracle E-Business Suite
instance.

See: Adding or Configuring a New Custom Mapping, page 4-37.

e Importing an Existing Mapping

Instead of creating a new mapping, you can use an existing mapping that has
been created earlier by clicking Import from File in the Flexfield Metadata
section. This lets you select a desired flexfield mapping for your selected
interface.

Once a desired mapping is imported, you can modify the context values for a
descriptive flexfield and structure for a key flexfield if needed to meet your
needs.

See: Importing an Existing Flexfield Mapping, page 4-115.

Reviewing Flexfield Mapping Configuration Files

Once a partner link is created, an enhanced XSD file along with flexfield configuration
and mapping files are generated. You can review these files for flexfield details. See:
Reviewing Flexfield Mapping Configurations, page 4-122.
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Adding or Configuring a New Mapping

After performing a search or browsing through the list of interfaces available in Oracle
E-Business Suite Module Browser, if a selected PL/SQL interface or an open interface
table is configured with flexfields, then flexfield information in the API or the table will
be displayed in the right pane of the window.

To add or configure a new mapping for the selected API or open interface table, click
Add Mapping in the Configure Flexfields region. A series of flexfield selection pages in

the wizard appear guiding you to configure a new mapping for your selected API or
interface table.

Flexfield Subflow - Welcome

| 4| Flexfield SubFlow - Step 1 of 6 [
Welcome
This wizard will guide you to Add Descriptive/Key flexfield
This wizard helps you to add a flexfield to the APL.
You need to configure the Descriptive /Key flexfield and choose the
structure,
[ 5kip This Page Mext Time
| Help | | MNext = | | Cancel |

After clicking Next in the Welcome page, the Select Flexfield Type page appears where

you can choose either a key or descriptive flexfield to be configured or added for your
flexfield.
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Flexfield Subflow - Select Flexfield Type
| | Flexfield SubFlow - Step 2 of 6 )

Select Flexfield Type

Select the flexfield type and dick next to createfedit and configure the flexfield

Type of Flexfield (™) Key Flexfield
(") Descriptive Flexfield

| Help | | < Back | | Cancel |

Select either the Key Flexfield or Descriptive Flexfield radio button for your flexfield
configuration.

Please note that you can configure more than one key or descriptive flexfield for the
selected API or open interface table to meet your business needs.

See:

¢ Configuring Key Flexfield Mappings for a PL/SQL API, page 4-38
¢ Configuring Descriptive Flexfield Mappings for a PL/SQL API, page 4-59
* Configuring Key Flexfield Mappings for an Open Interface Table, page 4-79

* Configuring Descriptive Flexfield Mappings for an Open Interface Table, page 4-85

Configuring Key Flexfield Mappings for a PL/SQL API

Sample Business Scenario

Take the INV_EBI ITEM PUB.PROCESS ITEM LIST API as an example to explain
the inbound web service creation with flexfield data.

When a request is placed for processing inventory item list from a third party
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application, the key flexfield data as part of the input payload is routed and the PL/SQL
API INV_EBI ITEM PUB.PROCESS ITEM LIST isinvoked to update the item list in
Oracle E-Business Suite. The updated data will be passed to the client as the response
message.

The following diagram illustrates the service invocation process flow:

Input Payload

& Flexfield Data
[ 'II- Process Item List
Request L
——
+ _______
rd Response
3 !:'arlfy Oracle E-Business
Application Oracle SOA Suite Suite Database

After deploying the service, you can validate the process by querying inventory item
list directly from Oracle E-Business Suite application. The retrieved item data should be
the same as input from the payload.

Configuring a Key Flexfield Mapping As Part of the Partner Link Creation

To configure a key flexfield mapping for the selected API

INV_EBI_ ITEM PUB.PROCESS ITEM LIST, click Add Mapping in the Configure
Flexfields region. A series of flexfield selection pages in the wizard appear guiding you
to configure a new mapping for your selected API.

Click Next in the Welcome page. The Select Flexfield Type page is displayed.
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Flexfield Subflow - Select Flexfield Type
[ () Flexfield SubFlow - Step 2 of 6 S5

Select Flexfield Type

Select the flexfield type and dick next to create/edit and configure the flexfield

Type of Flexfield (%) key Flexfield
(") Descriptive Flexfield

| Help | | < Back || Mext = J Cancel

Perform the following steps to configure a key flexfield:

1. Select the Key Flexfield radio button in the Select Flexfield Type page. Click Next.
The Select Flexfield Application page appears.

2. Tolocate your desired application name, enter keyword search (such as '‘%App%')
and click Query to execute the search. All the entries that match your search criteria
will be displayed. For example, select the Inventory radio button as the application
name to which the flexfield belongs.
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Flexfield Subflow - Select Flexfield Application

p

| £ Flexfield SubFlow - Step 3 of 6

Select Flexfield Application

Select the application to which the fliexfield belongs and dick next

Application: |% || Query |

) Application Object Library
Asia/Pacific Localizations

() Capital Resource Logistics - Assets
() Common Modules-AK
() Complex Maintenance Repair and Overhaul

L~

E-Business Tax

(" JEnterprise Performance Foundation
Financial Inteligence

" )General Ledger

JHuman Resources

#) Inventory
Learning Management

{_)Public Sector Budgeting
Receivables

) Service

| bep |

| < Back || Eext>J| Einish || Cancel |

Alternatively, click Query directly to execute the blank search without keyword
search. This displays all flexfield application names for your selection.

Click Next.

In the Select Flexfield page, enter keyword search if desired and click Query to
execute the search. All the matched key flexfields are displayed for your selection.
Select your desired key flexfield radio button.
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Flexfield Subflow - Select Flexfield
%] Flexfield SubFlow - Step 4 of 6 (X

Select Flexfield

Select the flexfield and dick next

Application: Inventory

Flexfield: |% || Query |

JAccount Aliases
Item Catalogs
() Item Categories

W

(")ORACLE_SERVICE_ITEM_FLEXFIELD
(1Sales Orders
() 5tock Locators

() 5ystem Items

Help < Back ” Mext = J Cancel

Click Next to continue.
The Select Datatype and Configure Mapping page appears where you can choose

desired mapping for your key flexfield. Notice that your selected key flexfield name
is automatically populated as the Flexfield name.
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Flexfield Subflow - Select Datatype and Configure Mapping

|4 Flexfield SubFlow - Step 5 of 6 [

Select Datatype and Configure Mapping

Application: Inventory Flexfield: System Items
Select the Datatype | INV_EBI_ITEM_PUB:INV_EBI_ITEM_MAIN... ¥ | Paths for the datatype
P_ITEM/P_ITEMSINV_EBI_ITEM_OBJ_TBL/MAIN_C)
I
Use parameter prefix to auto map parameter to table column | | | Auto Map | | Clear Mapping |
Parameter Table Column
SEGMENT 12 | SEGMENT 12 b
SEGMEMT11 [SEGMENT 11 b
SEGMENT 10 [SEGMENT 10 hd|
SEGMENTS | SEGMENTS -]
SEGMENTS | SEGMENTS il
SEGMENT7 | SEGMENT7 b
SEGMENTS [SEGMENTE b
SEGMENTS [SEGMENTS b
SEGMENT4 | SEGMENT4 -]
SEGMENT3 | SEGMENT2 il
SEGMENT2 | SEGMENTZ hd|

Help | | Mext = J | Cancel |

To configure flexfield mapping, select the <Parent_type> from the Select the
Datatype drop-down list if it's a simple API which does not have record types. This
retrieves all needed flexfield metadata from Oracle E-Business Suite database and
populates parameters at the parent level for your mapping.

Note: Parent_type is a pseudo type to allow all the scalar
parameters at the procedure level to participate in the mapping.

You can also select record type if it's for a complex API. When a
record type occurs multiple times in the AP]I, the list of paths is
displayed for reference. If the parameters from a record type are
mapped to the flexfield table columns, then the same mapping
would be applicable to all the paths it occurs.

In this mapping page, you have the option to do the mapping manually or use
automapping feature.

Automapping feature maps all the segments to the parameters, which have the
column name as part of the parameter name. For example, table column
SEGMENT1 would be mapped to parameter SEGMENTTL. If there are multiple
sets of parameters and the table column names, then the prefix can be specified.
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For example, enter 'P_' as the prefix to retrieve all parameters starting with 'P_',
such as P_SEGMENT1, P. SEGMENT2, P_SEGMENTS3, to P SEGMENTnN where
n is a number. If you click Auto Map, all the parameters with prefix 'P_' are
automatically displayed along with the automapped table column names.

Note: Flexfield values are stored in the application database
tables. In general, key flexfields store their data in columns
called SEGMENTnN and descriptive flexfields store their data in
columns called ATTRIBUTEn, where n is a number.

* Manual mapping lets you select a desired table column for a corresponding
parameter.

Note: If a parameter has already mapped to a table column, you
cannot remap the parameter to other column. In this situation,
'Mapped to other Flexfield' appears instead for the mapped
parameter.

Click Clear Mapping to clear current mapping you have. All previously mapped
columns marked with 'Mapped to other Flexfield' will not be removed from the
system.

Click Next to continue.
5. The configuration of the flexfield will not be complete without a structure for a key
flexfield and at least one context value for a descriptive flexfield.

In the Configure Flexfields page, enter keyword search if desired in the Structure
field or simply click Query to execute a blank search. All the matched structures for
the selected key flexfield are displayed.

Select only one structure (such as SYSTEM_ITEMS).

Please note that there are certain criteria need to be met in order to have your
desired structures displayed in the wizard for selection. See: Guidelines for
Defining Flexfield Structure and Context Values, page 4-34.
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Flexfield Subflow - Configure Flexfields
(@] Flexfield SubFlow - Step 6 of 6 )

Configure Flexfields

Select the Structure or Context and dick next
Application: Inventory

Flexfield Name: System Items

Structure :

%o | [ Query
{2 5YSTEM_ITEMS

|_Emsh | [ cancel |

Note: Only one structure for a key flexfield can participate in
flexfield mapping. In the case of a descriptive flexfield, multiple
context values can participate in the mapping.

Click Finish.

The Oracle E-Business Suite Module Browser window appears. The newly added
key flexfield structure and mapped parameters are displayed in the Parameters
with Corresponding Flexfield Mappings region.

The key flexfield information is also displayed in the Flexfield Definitions section.
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1.

Displaying Selected Key Flexfield Information

@) Oracle Applications Module Browser

=

B 1
Object Name: [14v_EBI_ITEM_PUB | [ITebles [ views aPls  [JcB  []XM.Gateway [|EDI [ |BusmessEvents | search | [ growse |
= INV_EBI_ITEM_PUB Parameters with Corresponding Flexfield Mappings
OGS Path Type InjOut  Segment Flexfiel... Context Flexfield Name
(= (& Custom Objects
Bl [l ONT_PRICING_QTY_SOURCVARCHAR2 ™
= &3 INv_EBI_ITEM_PUB (INV_EBI_[TEM_PUE) I E sscomﬁ.:g; EFAULUND:iE:ﬁ; i:
¢~ GET_ITEM_ATTRIBUTES (GET_ITEM 5 SEGMENTL VARCHAR2 m™ Ite Ke System Iter
-, GET_ITEM_BALANCE (GET_ITEM_BAL [ SEGMENTZ VARCHARZ ™ " Kﬁy SYS‘EM llEms
£, PROCESS_ITEM (PROCESS_ITEM) o e
- [ SEGMENT3 VARCHAR2 b Key System Items
g LT T [l SEGMENT4 VARCHARZ ™ Ke System Ite
*. B, VALIDATE_ITEM (VALIDATE_ITEM) o e
Bl SEGMENTS VARCHAR2 b Key System Items
-l SEGMENTS VARCHARZ b Key System Items
-l SEGMENT? VARCHARZ b Key System Items
- El SEGMENTS VARCHARZ b Key System Items
-l SEGMENTS VARCHARZ b Key System Items
- [E SEGMENT10 VARCHARZ b Key System Items
-l SEGMENTL1 VARCHARZ b Key System Items
[ SEGMENT12 VARCHARZ ™ Key System Items
-l SEGMENT13 VARCHARZ ™ Key System Items
- [El SEGMENT14 VARCHARZ ™ Key System Items N
-l SEGMENTLS VARCHARZ ™ Key System Items
Configure Flexfields
Flexfield Definitions
Type Appiication Name Datatype Structure or Context
ey Flexdfield NV System Items INV_EBL_ITEM_MAIN_GB]  SYSTEM_ITEMS
rFlexfield Metad,
|| tmportfromFile || Add Mapping
ok | [ cancel

Click OK.

The Application Interface page appears with the selected APL
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r N
ﬂ Adapter Configuration Wizard - Step 5 of 6 gj

Application Interface L
" _’f
¥ou are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tablesfviews or you can add a single APT/Concurrent ProgramXML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors,
rOperation Objects
= | @ Delete |
Mame Type
PROCESS_ITEM_LIST API
A wrapper API will be created in a package, enter a package name.
XX_BPEL_Processltem |
[ ] Overwrite specified wrapper package, if it exists
| Help | < Back || Mext = Cancel |

Click Next and then click Finish.

The wizard generates the WSDL file corresponding to the partner link. An
enhanced XSD file, for example ProcessItem KFF flex.xsd, is also created.
This XSD file contains the schema describing the procedure arguments with the
elements representing the parameters that have been replaced with flexfield
segment names.

Click Apply and then OK.
8. Additionally, configuration file and flexfield mapping file are created. For more

information on these files, see Reviewing Flexfield Mapping Configurations, page
4-122.

To add descriptive flexfield mappings for the selected API, see Configuring Descriptive
Flexfield Mappings for a PL/SQL API, page 4-59.

Displaying Mapped Key Flexfields at Design Time

The key flexfield mapping data configured earlier during the partner link creation can
be shown at design time.

A Composite Example with Key Flexfield Mappings
Here is an example describing the key flexfield mapping in the BPEL process of a SOA
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composite:
* Create anew SOA composite application with BPEL process
* Add a partner link service called ProcesItem KFF with key flexfield mapping

that we configured earlier for the INV. EBI ITEM PUB.PROCESS ITEM LIST
API

For information on how to configure key flexfield mappings, see Configuring Key
Flexfield Mappings for a PL/SQL API, page 4-38.
¢ Add a partner link for File Adapter to read input payload that contains flexfield
data for service invocation
® In the File Directories dialog, enter the physical directory (such as /usr/tmp)
where the input payload xml file (such as input payload.xml) resides.
* In the Messages dialog, select the 'browse for schema file' icon next to the URL

field to open the Type Chooser.

Click Type Explorer and select Project Schema Files > ProcessItem_KFF_sp.xsd
> ProcessItem_KFF_flex.xsd > InputParameters.

4-48 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



@ FILE Adapter Configuration Wizard - Step 7 of 8

Messages

-
& Type Chooser

Define the message for the
Schema Element that defines
definition. If you chedk 'Sche

Message Schema

[] Mative format translatio
URL
Schema Element

Ck Tvpe Explorer

=-[53 Project Schema Files

: g3 BPELProcessl.xsd

&=, ProcessItem_KFF_Flex.xsd

o, Processltem_KFF_sp.xsd

-2 Pracessitem_KFF_flex.xsd

)
Lo4% OutputParameters

{22 Praject W3DL Files

Type: |{htt|:|:ﬂmlns.orade.comfpd:pelfadapter,.fdbfspfProcessItem_lG:F}Inpuﬂ’aramehers |
[] Show Detailed Node Information

’ 0K ” Cancel ]

Click OK. The selected schema information will be automatically populated in
the URL and Schema Element fields.
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) FILE Adapter Configuration Wizard - Step 7 of 8 @

Messages

Define the message for the Synchronous Read File operation. Specify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you chedk 'Schema is Opague’, then you do not need to spedfy a Schema.

Message Schema

[] Mative format translation is not required (Schema is Opaque)

URL |xsdIProcessItem_KFF_5|:| xsd| | Q. 5]

Schema Element | tnputParameters -

Help <Back || Next> | Cancel

* Configure two Invoke activities

* Associate the first Invoke activity with the File Adapter partner link to
synchronously read input payload data

¢ Associate the second Invoke activity with the partner link ProcessItem KFF
that contains flexfield mapping to invoke the service

* Add an Assign activity to pass input payload received from the File Adapter to the
second Invoke activity for service invocation

Mapped key flexfield column names corresponding to the flexfield matching
segments defined in the Oracle E-Business Suite are displayed in the Assign
activity. See: Assigning Parameters with Key Flexfields in the Assign Activity, page
4-54.
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Constructing BPEL Process in SOA Composite

Partner Links Partner Linlks
- ®),

@

receiveInput

Invake

& (| -

. -l
bpelprocessl _client Assigni

i B

Invokel ProcessItem_KFF

&

replyCutput

o

For more information on how to create design time tasks, see Design-Time Tasks for
PL/SQL APIs, page 9-2.

Flexfield Validation in Oracle E-Business Suite

When defining key flexfield segments for a key flexfield 'System Items' in Oracle
Inventory application (Application Developer responsibility), only SEGMENTT1 is
specified as 'Item' in the Segments Summary - System Items window.
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Key Flexfield Segments Summary for System Items

O] —alx
Application  Inventory Flaxfield Title System ltemns
Structures
Code Title Description Wiew Name
l SYSTEM_ITEMS System ftems System iterns flexfield =

© Segments Summa 1 Iterm ystem ltems

MNumber Enahled
Marme Window Prompt Caolurmn “Walue Set Displayed
. M tem ltem SEGMEMT1 ltem haster v oW

WFreeze F
[ Crogs-v4

Walue Set Flexfield Cualifiers )] o= | Open l

The following table explains the relationship between the key flexfield mapping data
and the actual segments defined in Oracle E-Business Suite:

Segment Summary for Key Flexfield 'System Items’

Key Flexfield Segments Mapped During Key Flexfield Segments Defined in Oracle

Flexfield Configuration E-Business Suite
SEGMENT1 Item

SEGMENT?2 Not defined
SEGMENTn Not defined

Mapped segment column names for the key flexfield 'System Items' are displayed in the
Oracle E-Business Suite Module Browser once the mapping is complete. In this case,
only 'Ttem', the corresponding column name in SEGMENT], is shown here.
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Displaying Mapped Segment Column Name ‘Item’

{©) Oracle Applications Module Browser

Object Name: [INy_EBI_ITEM_PUB

[]Tables [ ]Views s [ce

[] XML Gateway

[Jent

[ ] Business Events

‘ Search | | Browse ‘

E= INv_EBI_ITEM_PUB
(5= Other Interfaces
= 2 Custom Objects
B[ PLSQL APIs
&+ INV_EBI_ITEM_PUB (INV_EBI_ITEM_PUE)
&, GET_ITEM_ATTRIBUTES (GET_ITEM_/
------ &, GET_ITEM_BALANCE (GET_ITEM_BAL
------ &, PROCESS_ITEM (PROCESS_ITEM)
B Nvoces: o i (rocess_e|

------ &, VALIDATE_ITEM (VALIDATE_ITEM)

Parameters with Corresponding Flexfield Mappings

path Type Infout  Segment Flexfiel... Context Flexfield Name
{...[El ONT_PRICING_QTY_SOURCVARCHARZ ]
i [l SECONDARY_DEFAULT_INDVARCHAR2 N
- B ITEM_NUMBER VARCHAR2 N
[} SEGMENTL VARCHAR2 N Item Key System Items
- [E SEGMENT2 VARCHAR2 N Key System Items
[l SEGMENT3 VARCHAR2 N Key System Items
[l SEGMENT4 VARCHAR2 N Key System Items
[l SEGMENTS VARCHAR2 N Key System Items
[l SEGMENTS VARCHAR2 N Key System Items
[l SEGMENT? VARCHAR2 N Key System Items
[l SEGMENTS VARCHAR2 N Key System Items
[E] SEGMENT9 VARCHAR2 N Key System Items
[l SEGMENT 10 VARCHAR2 N Key System Items
[l SEGMENT11 VARCHAR2 N Key System Items
[l SEGMENT12 VARCHAR2 N Key System Items
[l SEGMENT13 VARCHAR2 N Key System Items
[l SEGMENT14 VARCHAR2 N Key System Items
[l SEGMENT15 VARCHAR2 N Key System Items
Configure Flexfields
Flexfield Definitions
| Type Application Mame: Datatype Structure or Context
IKey Flexfield Y System Items INV_EBI_ITEM_MAIN_OB] SYSTEM_ITEMS
Flexfield Metadat:
| import fromFile || Add Mapping
[ ok | [ concel

For information on how to define key flexfields and key flexfield segments, refer to the
Planning and Defining Key Flexfields chapter, Oracle E-Business Suite Flexfields Guide.

Flexfield Validation in the Schema File

Select the enhanced XSD file (for example ProcessItem KFF flex.xsd)in Oracle
JDeveloper and notice that the mapped key flexfield column (Item) is displayed with
type 'flex' under the flexfield name System_Items.
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<Zschemas

I

targetflamespace | http:ifkmins.oracle.comfpcbpelfadapter/db/spiProcessitem_KFFflex

System_ltems

System_ltems = [tem
type flex:System_ltems type flex:stringd0

System_ltems o) m - string40

maxLength | 40

Assigning Parameters with Key Flexfields in the Assign Activity

In the Assign activity of the BPEL process diagram within the SOA composite
application, the mapped key flexfield can be displayed and used to pass an input
variable from payload to the second Invoke activity for service invocation.
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Displaying Mapped Key Flexfields in the Assign Activity
@ Edit Assign =

General  CopyRules  Annotations  Documentation  Targets  Sources  Skip Condition

|Insert New Rule After '|

ns2i INVENTORY _ITEM_ID
ns2:TTEM_NAME
ns2:MASTER_ORGANIZATION_ID
ns2;MASTER _ORGANIZATION_CODE
ns2:PRIMARY_UNIT_OF_MEASURE
ns2:CROS5_REFERENCE_TYPE
ns2;REVISION_REASCN
ns2iSTART_DATE_ACTIYE_STR
ns2:END_DATE_ACTIVE_STR.
ns2; CREATION_DATE_STR.
» ns2iLAST_UPDATE_DATE_STR
% ns2:PROGRAM_UPDATE_DATE_STR
ns2:EFFECTIVITY_DATE_STR

ns2:Systemn_lkems
-[as] ns2:EFFECTIVITY_DATE_STR i

¥ [@] - ! ns3:Ikem skring40 [@&]--
3] nsz:oystem_[tems AL_OB]_TYPE
f-[es] ns3:Item string40 BT

*_OBI_TYPE

fe-fas] nsz:REV_CURRENT_PHASE_NAME
[-Jas] nsz:APPLY_TEMPLATE

[#-fas] ns2:INVENTORY_ITEM_ID

F-as] nsz:ITEM_MAME

[ -fas] ns2:MASTER _ORGANIZATION_ID
-fas] ns2:MASTER_ORGANIZATION_CODE
[-[as] nsz:PRIMARY_UNIT_OF_MEASURE
f-fas] nsz:CROSS_REFERENCE_TYPE
£
[E
£
£
[
e
£

£ -[as] ns2:REVISION_REASCN

t-fas] ns2:START_DATE_ACTIVE_STR
#-[as] ns2:END_DATE_ACTIVE_STR
i-Jas] ns2:CREATION_DATE_STR

#-[as] nsZ:LAST_LIPDATE_DATE_STR
-[as] nsz:PROGRAM_UPDATE_DATE_STR

N

&R R R &'Z‘@ & EEE R R

2.5,
-6

B

EE-E

fea}
fea}
O i) o

nsz: :

-fas)] nsz:PURCHASING_OB]_TYPE LI fea]-@

el nsPiRFCEIVING OR1 TYPF LSELIRIE [‘*3’1"

| Copy '| From XPath: |,l’nsZ:InputParameters;’nsZ:PfITEM;’nsZ |Io XPath: |,|’ns2:InputParameters,l’nsZ:PfITEM,l’nsZ ‘ 4‘ Xad
From To

. Invoke 1_ProcessItem_KFF_InputVariable/InputParametersf/ns2:InputPar. ..

Help Apply || OK. || Cancel

Use Assign activity to provide input payload information to the Item object of the
target parameter.

Note: The target parameter ns2 : SEGMENT1 mapped to the column
name SEGMENT1 during the key flexfield configuration earlier is now
translated into ns3:Item (under ns2:System Items)and displayed
in the Assign activity.

¢ In the From navigation tree, navigate to Variables > Process > Variables >
Invoke_SynchRead_OutputVariable > body > ns2:InputParameters > ns2:P_ITEM
>ns2:P_ITEM_ITEM > ns2:MAIN_OB]_TYPE (datatype
INV_EBI_ITEM_MAIN_OB]J) > ns2: System_Items and select ns3: Item.

¢ Inthe To navigation tree, navigate to Variables > Process > Variables >
Invokel_Processltem_KFF_InputVariable > InputParameters >
ns2:InputParameters > ns2:P_ITEM > ns2:P_ITEM_ITEM > ns2:2MAIN_OBJ_TYPE
(datatype INV_EBI_ITEM_MAIN_OB]J) > ns2: System_Items and select ns3: Item.

Drag the source node (ns3: Item) to connect to the target node (ns3: Item) that you just
specified. This creates a line that connects the source and target nodes. The copy rule is
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displayed in the From and To sections at the bottom of the Edit Assign dialog box.

Click Apply and OK to complete the Assign activity.
Note: Alternatively, since 'ns2:InputParameters' variables contained in
the Source and Target are identical, you can simply drag the source

node (ns2:InputParameters) to connect to the target node
(ns2:InputParameters) and complete the Assign activity.

Assigning Input Variables to the Invoke Activity

& Edit Assign @
General | CopyRules  Annotations | Documentation | Targets | Sources | Skip Condition
|mnsert New Rule After Bk O =

% EBPELProcessl.bpel

BPELPracess1.
-2 Partner Links

Partrer Links

=22 variables variables
B g Process Process g
23 variables Variables (231
(x) input¥ariable n | inputvariable x)
-fx) output¥ariabls autpUtYarisble )
(x) Invokel_Pracessltem_KFF_Inputwariable 2 Inwokel_ProcessItem_KFF_Inputvariable (x)

-(x) Invaokel_Pracessltem_kFF_OutputVariable

-(x) Invoke_SynchRead_Inputvariable

=) Invoke_SynchRead_Outputiariable
=[] body

€% ns2:InputParameters <anonymouss

» InputParameters [F1-F
- ns2:InputParameters <anonymouss €3-#
: Invokel_ProcessItem_KFF_Outputyariable
Irvvoke_SynchRead_Inputiarisble
Invoke_SynchRead_Outputyariable

| cony ¥ Erom XPath: |jnsz:InputParameters To XPath: [[ns2:InputParameters |+ % @

From To

nvoke_SynchRead_Outputvariable/body/fns2: InputParameters [4¢] Invoke 1_Processltem_KFF_Input¥ariable/InputParameters/fns2:InputPar. .

| telp | | apoly || ok || cancel |

Please note that the datatype INV_EBI_ITEM_MAIN_OB] shown here is exact the same
datatype (INV_EBI_ITEM_PUB:INV_EBI_ITEM_MAIN_OB]J) specified earlier from the
drop-down list in the Select Datatype and Configure Mapping page. P_ITEM is listed as
the paths for the selected datatype.
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-
4| Flexfield SubFlow - Step 5 of B
p

Select Datatype and Configure Mapping

Application:  Inventory Flexfield: System Items

Select the Datatype [INV_EEI_]'I'EM_PUE:INV_EEI_ITEI'U'I_MAIN. .. || Paths for the datatype

P_ITEM/P_ITEMSINY_EBI_ITEM_OBI_TEL/MAIN_O)

< >
Use parameter prefix to auto map parameter to table column | | [ Auto Map ] [ Clear Mapping ]
Farameter Tahle Column
SEGMENT 12 [SEGMENT12 ¥~
SEGMENT11 [SEGMENT 1L i
SEGMENT 10 [SEGMENT 10 -]
SEGMENTS [SEGMENTS v
SEGMENTS [SEGMENTS -]
SEGMENTZ [SEGMENTZ -]
SEGMENTS [SEGMENTS v
SEGMENTS [SEGMENTS -]
SEGMENT4 [sEGMENT4 A
SEGMENT3 [SEGMENT3 -]
SEGMENTZ2 SEGMENTZ bl [

Displaying Mapped Key Flexfields at Run Time

After deploying the BPEL process contained in a SOA Composite application (
FlexfieldKFF) to the Oracle WebLogic managed server (for example 'soa-serverl’),
the key flexfields we configured earlier are displayed in the soa-serverl server (
http://<servername>:<portnumber>/soa-infra) allowing you to specify
payload data and test the service invocation.

Note: Please note that you can also test and manage the process from
the Oracle Enterprise Manager Fusion Middleware Control Console. In
this example, the mapped key flexfield used as part of the input
payload happens to be located or nested within multiple sub-levels
down from the top. This means that we need to drill down to the
mapped key flexfield Item by expanding the parameter nodes multiple
times from the top level (Payload > P_ITEM > P_ITEM_ITEM >
MAIN_OBJ_TYPE > System_Items > Item). However, Oracle Enterprise
Manager Fusion Middleware Control Console has certain limitations on
displaying payload parameters if they are nested too deeply.
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Request Response

> | Security

> Quality of Service
»|HTTP Transport Options
»| Additional Test Options
~|Input Arguments

Tree View E|
Name Type Value
W *payload payload
P_COMMIT string
P_OPERATION string
W P_ITEM APPS.INV_EBI_ITEM_OBIJ_TEL
P_ITEM_ITEM APPS.INV_EBI_ITEM_OBJArray Siz...

Therefore, in this case we access the mapped key flexfield directly from
the soa-infra in the soa-serverl server.

For information on how to test the service invocation from the Oracle
Enterprise Manager Fusion Middleware Control Console, see Test the
deployed SOA Composite application with BPEL process, page 9-42.

In the Welcome to the Oracle SOA/BPM Platform on WebLogic page, click the deployed

key flexfield project.

The Web Services Test Client page is displayed with your selected project. Click Test.
The key flexfield configured earlier will be displayed as part of the input payload in the
Parameters region of the Web Services Test Client page.
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E Web Services Test Clent
| Choose Anather WSDL WSDL | Imported WSDL and Scherma
Operations bpelprocess2_dlient_ep > BPELProcess2_pt > process
[ Stpelprocess2_dient_ep Parameters
[EBPELProcess2_pt
Elprocess
% payload ot
5 P_coMMIT StringValue o
5 P_OPERATION StringValue =]
i P_ITEM o
B P_ITEM_ITEM o
2 MAIN_OBI_TYPE [=}
5 APLVERSION 1023
= IT MSG 1TST StrinaValie
Settings
Basic Settings | Addressing  Reliable Messaging ~ Atomic Transaction = MTOM  Fast Infoset
Endpoint URL: m:8001/s0a-infra, Jdefault/F

User Name (for Basic Authentication):

Password (for Basic Authentication):

HTTP Headers:

Specify each header on a separate line
as a key:value pair, separated by a
colon (3

Raw Message

Make Connection = DWSM

[nvoke |

In the Parameters region, expand the Payload > P_ITEM > P_ITEM_ITEM >
MAIN_OBJ_TYPE > System_Items. Mapped key flexfield 'Item' is displayed as part of

the payload.

bpelprocess2_client_ep > BPELProcess2_pt > process

Parameters

[ LAST_UPDATE_DATE_STR StringValue
[} PROGRAM_UPDATE_DATE_STR StringValue
[5 EFFECTIVITY_DATE_STR StringValue
T System_Items

Raw Message

Mapped Key Flexfield ——| [ Item StringValue

T PHYSICAL_OB]_TYPE

[ WEIGHT_UOM_CODE StringValue

Enter appropriate data as payload and then click Invoke to invoke the service.

Configuring Descriptive Flexfield Mappings for a PL/SQL API

Sample Business Scenario

Take the HZ AIA CUSTOM PKG.SYNC ACCT ORDER API as an example to explain the

inbound web service creation with flexfield data.

When a request is placed for synchronizing customer information from a third party
application, the descriptive flexfield data as part of the payload is routed and the
PL/SQL API HZ AIA CUSTOM PKG.SYNC ACCT ORDER isinvoked to update the

Oracle E-Business Suite Adapter Concepts 4-59



organization and customer accounts in Oracle E-Business Suite. The synchronized
customer data will be passed to the client as the response message.

The following diagram illustrates the service invocation process flow:

Invoking an Inbound Service with Flexfield Data

Input Payload

& Flexfield Data
o Synchronize =
p Request L Oracle . g g
- ¥ | EBS > %
- Adapter """ T T T T~
31 Party Response .
Applicati ' ) Oracle E-Business
pplication Oracle SOA Suite Suite Database

After deploying the service, you can validate the process by querying customer data
directly from Oracle Customer Online application. The retrieved customer data should
be the same as input from the payload.

Configuring a Descriptive Flexfield Mapping As Part of the Partner Link Creation

To configure a descriptive flexfield mapping for the selected API

HZ AIA CUSTOM PKG.SYNC_ACCT ORDER, click Add Mapping in the Configure
Flexfields region. A series of flexfield selection pages in the wizard appear guiding you
to configure a new mapping for your selected APL

Click Next in the Welcome page. The Select Flexfield Type page is displayed.
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Flexfield Subflow - Select Flexfield Type

[£] Flexfield SubFlow - Step 2 of 6 C

Select Flexfield Type

Select the flexfield type and dick next to createfedit and configure the flexfield

Type of Flexfield  (7) Key Flexfield
() Descriptive Flexfield

| Help | | < Back || Next = | Cancel

Perform the following steps to configure a descriptive flexfield:

1.

Select the Descriptive Flexfield radio button in the Select Flexfield Type page, and
then use the similar approach as described earlier for key flexfields in the flexfield
mapping wizard.

Click Next in the Select Flexfield Type page. The Select Flexfield Application page is
displayed.

To locate your desired application, enter keyword search (such as '%App%'") or
simply click Query to execute the search. All the matched applications for
descriptive flexfield are displayed. For example, select the Receivables radio button
as the application name to which the descriptive flexfield belongs.
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Flexfield Subflow - Select Flexfield Application
" [&] Flexfield SubFlow - Step 3 of 6 (T

Select Flexfield Application

Select the application to which the flexfield belongs and dick next

Application: |'5-’n || Query |

" )Public Sector Payroll

[~

Purchasing

[~

TJPurchasing Inteligence

Quality
(s)Receivables

" )Regional Localizations
Release Management
Release Management Integration Kit (Cbsolete) N
Report Manager

Risk Management

Sales Inteligence
Sales Offline
()Sales Online

Help < Back || Next = i Cancel

Click Next.

4. In the Select Flexfield page, enter keyword search (such as 'HZ%'") if desired and
click Query to execute the search. All the matched descriptive flexfields are
displayed for your selection.

Select your desired descriptive flexfield (such as HZ_LOCATIONS) and click Next.
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Flexfield Subflow - Select Flexfield
' (&) Flexfield SubFlow - Step 4 of 6 =

Select Flexfield

Select the flexfield and didk next
Application: Receivables

Flexfield: |HZ% |[ Query

{_JHZ_CREDIT_PROFILE_AMTS fad
| JHZ_CREDIT_RATINGS_GROUP
{_JHZ_CREDIT_USAGES
\_JHZ_CREDIT_USAGE_RULES
\_JHZ_FIN_NUMBERS_GROUP
{JHZ_FIN_REPCRTS_GROUP
(2)HZ_LOCATIONS
| )HZ_LOCATIONS_GROUP
{)HZ_ORGANIZATION_PROFILES
| _)HZ_ORG_CONTACTS
(_JHZ_ORG_PROFILES_GROUP
(_JHZ_ORIG_SYS_MAPPING
| JHZ_ORIG_SYS_REFEREMCES
\_JHZ_PARTIES
{_JHZ_PARTY_SITES

H7 PARTY STTES GROLIE

d

The Select Datatype and Configure Mapping page appears where you can choose
desired mapping for your descriptive flexfield.

Notice that your selected descriptive flexfield name HZ_LOCATIONS is
automatically populated as the Flexfield name.
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Flexfield Subflow - Select Path and Configure Mapping
[ (@) Flexfield SubFlow - Step 5 of 6 =

Select Datatype and Configure Mapping

Application: Receivables Flexfield: HZ_LOCATIONS
Select the Datatype | Hz_AIA_CUSTOM_PKG:HZ_LOCATION_OB) w | Paths for the datatype
P_ORG_CUST_OB1/ORGANIZATION_OBJ/CONT
P_ORG_CUST_OB1/ORGANIZATION_OBJ/PART!
X_RETURN_OB1/ORGANIZATION_OB/CONTAC
Vv ACTLINA SO/ NCARTTATTAM ADTHARTY ©
Map Context Column ATTRIBUTE_CATEGORY |ATTRIBUTE_CATEGORY 'l
Use parameter prefix to auto map parameter to table column | | | Auto Map | | Clear Mapping |
Parameter Table Column
ATTRIBUTES |ATTRIBUTES |
ATTRIBUTES |ATTRIBUTES -]
ATTRIBUTE? |ATTRIBUTEZ |
ATTRIBUTES | ATTRIBUTES b
ATTRIBUTES [ATTRIBUTES b
ATTRIBUTE4 [ATTRIBUTE4 |
ATTRIBUTE3 |ATTRIBUTE3 -]
ATTRIBUTEZ |ATTRIBUTE2 -]
ATTRIBUITEL |ATTRIBUTEL bl
Help Next = | Cancel |

To configure flexfield mapping, select a desired data type from the Datatype
drop-down list. This retrieves all needed flexfield metadata from Oracle E-Business
Suite database and populates parameters at the parent level for your mapping.

e Parent type: Parent type is a pseudo type to allow all the scalar parameters at
the procedure level to participate in the mapping. It can be used for simple
APIs that just have scalar parameters.

* Record type: Record type can be selected if it's a complex API that has record
types in addition to scalar types.

Selecting Context Column for Descriptive Flexfield Mapping

For descriptive flexfields, you need to perform an additional mapping for the
context column. This is because flexfield mapping cannot span across record types.
All the table columns including the context column should be mapped to the scalar
parameters within one record type or parent type.

In the Map Context Column ATTRIBUTE_CATEGORY field, select a desired
category name that you want to view the mapping information from the
drop-down list. For example, select ATTRIBUTE_CATEGORY from the drop-down
list.
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Note: If a parameter has already mapped to a table column, you
cannot remap the parameter to other column. In this situation,
'Mapped to other Flexfield' appears instead for the mapped
parameter.

Similar to key flexfields, the mapping can be performed manually or assisted with
the automapping feature by clicking Auto Map.

Automapping feature maps all the table columns to the parameters, which have the
column name as part of the parameter name. For example, table column names
from ATTRIBUTEL1 to ATTRIBUTE20 are automatically displayed and mapped to
parameters from ATTRIBUTE1 to ATTRIBUTE20 respectively through
automapping.

If there are multiple sets of parameters and the table column names, then the prefix
needs to be specified for automapping. This would map the potential parameters
which need to be considered for the mapping. Enter parameter prefix (such as
'INDUSTRY_') to first locate your desired parameters that you want the
automapping to be performed. Next, click Auto Map. All the parameters with
prefix INDUSTRY_' are automatically displayed along with the automapped table
column names. Parameter INDUSTRY_ATTRIBUTE1" is mapped to column
ATTRIBUTE], and parameter INDUSTRY_ATTRIBUTEN' is mapped to column
ATTRIBUTEn.

Instead of using automapping feature, you can manually select a desired table
column name from the drop-down list for a corresponding parameter for your
flexfield mapping.

Click Clear Mapping to clear current mapping you have in the table column only.
All previously mapped columns marked with 'Mapped to other Flexfield' will not
be removed from the system.

Click Next to proceed to the next page.
In the Configure Flexfields page, select at least one context value for the selected

descriptive flexfield. For example, select desired context values (such as Chile and
Ecuador).

You can either enter keyword search in the Context field or simply click Query to
execute the search before selection.

For descriptive flexfields, context value should be available to the runtime through
an API parameter.

Please note that there are certain criteria need to be met in order to have your
desired context values displayed in the wizard for selection. See: Guidelines for
Defining Flexfield Structure and Context Values, page 4-34.

Oracle E-Business Suite Adapter Concepts 4-65



Flexfield Subflow - Configure Flexfields

| £ Flexfield SubFlow - Step 6 of 6

Configure Flexfields

Select the Structure or Context and dick next
Application: Receivables
Flexfield Mame: HZ_LOCATIONS

Context : |°}’n || Query |

[w]|Chile

[v|Ecuador
Global Data Elements

Einish _J| Cancel

| teb |

Click Finish to complete the flexfield configuration.

7. The Oracle E-Business Suite Module Browser window appears. The newly added
descriptive flexfield information including the segment values for the selected
context value is displayed in the right pane of the window.
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8.

Displaying Selected Descriptive Flexfield Information

© Oracle Applications Module Browser

[+ Custom Objects
& PLSQL APTs
&, HZ_AA_CUSTOM_PKG (HZ_ATA_CU
-, GET_ACCT_MERGE_OB (GET_A
£, GET_MERGE_ORG_CUSTS (GET |
B, GET_PARTY_MERGE_OBJS (GET.
&, GET_RELATED_GRG_CUST_OB:

C_ACCT -
B, SYNC_ACCT_UPDATE (SYNC_AC

) FA_LOCATION_{NUMBER
NUMBER.

& TIMEZONE_ID

Object Name: [Hz_AIA_CUSTOM_PKG [tables [ views apls  []cP  []¥M Gateway [JEDI [ ]BusinessEvents search | | Browse
5 (5 HZ_AIA_CUSTOM_PKG Parameters with Corresponding Flexfield Mappings
55 Other Interfaces Path Type Infout Segment Flexfield Type Context Flexfield Name

Desaiptive

R4 HZ_LOCATIONS

[l ATTRIBUTEL  VARCHAR2 m Region Desaiptive L2 rocamions
[ ATTRIBUTE2  VARCHAR2 m Comuna Descriptive JHz_LocaTIoNs
[ ATTRIBUTES  VARCHAR2 m Descriptive HZ_LOCATIONS
(£ ATTRIBUTE#  VARCHAR2 bl Descriptive HZ_LOCATIONS
(5 ATTRIBUTES ~ VARCHAR2 m Descriptive HZ_LOCATIONS
(5] ATTRIBUTES  VARCHAR2 m Descriptive HZ_LOCATIONS
[El ATTRIEUTE7  VARCHAR2 m Desaptive HZ_LOCATIONS
[l ATTRIEUTES  VARCHAR2 m Desaptive HZ_LOCATIONS
[ ATTRIBUTES  VARCHAR2 m Descriptive HZ_LOCATIONS
(£ ATTRIBUTET0  VARCHAR2 bl Descriptive HZ_LOCATIONS
{5 ATTRIBUTE1 VARCHAR2 bl Descriptive HZ_LOCATIONS
(5] ATTRIBUTEL? VARCHAR2 m Descriptive HZ_LOCATIONS
(5] ATTRIBUTE3 VARCHAR2 m Descriptive HZ_LOCATIONS
[El ATTRIEUTEI4  VARCHAR2 m Desaptive HZ_LOCATIONS
[ ATTRIUTELS VARCHAR2 m Desaptive HZ_LOCATIONS
[ ATTRIBUTETS VARCHAR2 m Descriptive HZ_LOCATIONS
[ ATTRIBUTE7 VARCHAR2 bl Descriptive HZ_LOCATIONS
(5 ATTRIBUTETS  VARCHAR2 bl Descriptive HZ_LOCATIONS
(5] ATTRIBUTELS VARCHAR2 m Descriptive HZ_LOCATIONS
(5] ATTRIBUTEZ0  VARCHAR2 m Descriptive HZ_LOCATIONS
[El PROGRAM_UPDIDATE ul

Configure Flexfields

Flexfield Definitions

[Type Appiication Name Datatype Structure or Context

[Descriptive Flexfield AR HZ_LOCATIONS HZ_LOCATION_OB] [Chite:

Flexfield o

|| import from Fie || Add Mapping
[ | [ cancel

Click OK.

The Application Interface page appears with the selected APL
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ﬂ Cracle Applications Adapter Configuration Wizard - Step 4 of 5 ﬁ

Application Interface L
il P g : _.:'/
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views or you can add a single APT/Concurrent Program %ML Gateway Map/EDI Concurrent
Program,Business Event for a service, If no objects are selected, it is assumed that you want to use previously
created descriptors.
r Operation Objects
% Delete
Marme Type
SYMC_ACCT_ORDER APT
A wrapper API will be created in a package, enter a package name.
XX_BPEL_SyncOrder|
[] Overwrite specified wrapper package, if it exists
Help < Back Next = Cancel

Click Next and then click Finish.

The wizard generates the WSDL file corresponding to the partner link. An
enhanced XSD file, for example SynAccOrder flex.xsd, is also created. This
XSD file contains the schema describing the procedure arguments with the elements
representing the parameters that have been replaced with flexfield segment names.

Click Apply and then OK.

9. Additionally, configuration file and flexfield mapping file are created. For more
information on these files, see Reviewing Flexfield Mapping Configurations, page
4-122.

Once a new flexfield mapping has been configured or added, if modification is needed,
you can make updates by first selecting desired flexfield type that you want to modify
and then make needed changes. For more information on how to modify the selected
mapping details, see Modifying Flexfield Mapping Definitions, page 4-119.

Displaying Mapped Descriptive Flexfields at Design Time

Similar to key flexfield mappings, the descriptive flexfield mapping data configured
earlier during the partner link creation can be shown at design time along with the
following activities orchestrated in the BPEL process within in a SOA composite:
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A Composite Example with Descriptive Flexfield Mappings

Here is an example describing the descriptive flexfield mappings in the BPEL process of
a SOA composite:

® Create anew SOA composite application with BPEL process
¢ Add a partner link service called SynAccOrder with descriptive flexfield

mappings that we configured earlier for the
HZ ATA CUSTOM PKG.SYNC ACCT ORDER API

For information on how to configure descriptive flexfield mappings, see

Configuring Descriptive Flexfield Mappings for a PL/SQL API, page 4-59.

¢ Add a partner link for File Adapter to read input payload that contains flexfield
data for service invocation

® In the File Directories dialog, enter the physical directory (such as /usr/tmp)
where the input payload xml file (such as input payload.xml) resides.
* In the Messages dialog, select the 'browse for schema file' icon next to the URL

field to open the Type Chooser.

Click Type Explorer and select Project Schema Files > SynAccOrder_sp.xsd >
SynAccOrder_flex.xsd > InputParameters.
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= E

Ck Type Explorer

=5 Project Schema Files

-2 BPELProcess1.xsd

-2 SynaccOrder_Fles,xsd

=27 SynaccOrder_sp.xsd
o SyndccOrder_Fles,xsd
2= 1] InputParameters
t..4® OutputParameters

B+ Project WSCL Files

Type: |{htt|:|:Hmlns.nrade.mmIpcbpelfadapterfdbfsp!SynAcd]rder}InmﬂJarameters |
[ ] Show Detailed Mode Information

|

Ok ” Cancel ]

Click OK. The selected schema information will be automatically populated in
the URL and Schema Element fields.
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L ki
) FILE Adapter Configuration Wizard - Step 7 of 8 @

Messages

Define the message for the Synchronous Read File operation. Spedfy the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you chedk 'Schema is Opague', then you do not need to specify a Schema.

Message Schema

[ ] Mative format translation is not required {Schema is Opaque)

URL |xsd}5ynAocDrder_sp.xsd| | Q, &

Schema Element [InputParameters v]

Configure two Invoke activities

* Associate the first Invoke activity with the File Adapter partner link to
synchronously read input payload data

* Associate the second Invoke activity with the partner link SynAccOrder that
contains flexfield mapping to invoke the service.

Add an Assign activity to pass input payload received from the File Adapter to the
second Invoke activity for service invocation

Mapped descriptive flexfield column names corresponding to the flexfield
matching segments defined in the Oracle E-Business Suite are displayed in the

Assign activity. See: Assigning Parameters with Descriptive Flexfields in the Assign
Activity, page 4-74.
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Constructing BPEL Process in SOA Composite

Partner Links

Partner Links

@

receivelnput

(®

Tnvoks SyncRead_DFF

‘ﬁ N

—
bpelprocess1_client Assigni

SynAccOrder

replyCutput

o

For more information on how to create design time tasks, see Design-Time Tasks for
PL/SQL APIs, page 9-2.

Flexfield Validation in Oracle E-Business Suite

When defining descriptive flexfield attributes for TCA Location Information'
(HZ_LOCATIONS) in Oracle Receivables application (Application Developer
responsibility), the following attributes are specified based on context values:

Descriptive Flexfield Segment Summary for TCA Location Information

Context Value ATTRIBUTE1 ATTRIBUTE2
Chile Region Comuna
Ecuador Zona Parroquia
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Descriptive Flexfield Segments Summary for System Items

= _lolx
Application  Receivables Title TCA Location Infarmation
Wl Freeze Flexfield Definition Segment Separator  Period [ ] -
Context Field
Prompt  Context Yalue [ Required
“alue Set ™ Displayed
Default Yalue O Synchronize with Reference Field

Reference Field

Context Field Values

Code MName Description Enabled

Global Data Elerments Global Data Elerments Global Data Elerment Context =
lChiIe Chile Chilean Localization

Ecuadaor Ecuadar Ecuadarian Localization

O

© Segrments Summary (TCA Location Information) - Chile

Enabled

Murnber
Mame Window Prompt Column Yalue Set Displayed
.ﬂ Region Region ATTRIEUTE1 [T Il
2 Comuna Cornuna ATTRIEUTEZ W v

= Murnber Enabled
MName Window Prampt Calumn “alue Set Displayed
Pl s Zona ATTRIBUTET T
2 Parroguia Farroguia ATTRIBUTE2 W v

pen

Flexfield Validation in the Schema File

Select the enhanced XSD file (such as SynAccOrder flex.xsd)in Oracle JDeveloper
and notice that the mapped descriptive flexfields are displayed with type 'flex' under
the HZ_LOCATIONS flexfield as part of the schema.

Additionally, the mapped table column names (Region, Comuna, Zona, and
Parroquia) are grouped by context value (Chile and Ecuador) listed in a tree
structure. Context value nodes are connected with the <choice> icon in between
indicating that only either one of the context values and its associated table columns can

be selected.
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=
=schema=

targethlamespace | hitpxmins.aracle.comipcbpelladapter/dbis plSynAccOrderiflex

HZ_LOCATIONS

ATTRIBUTE_CATEGORY
type flexstring30

Reqgion
type flexstring150

HZ_LOCATIONS
type flexHZ_LOCATIONS

Comuna
type flexstring150

Zona
type flexstring150

Parroquia
type flexstring150

_[ HZ_LOCATIONS

maxLength | 30

maxLength | 150

Assigning Parameters with Descriptive Flexfields in the Assign Activity

In the Assign activity of the BPEL process diagram within the SOA composite
application, the mapped descriptive flexfields can be displayed and used to pass an
input variable received from payload to the Invoke activity for SynAccOrder service
invocation.
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Mapped Descriptive Flexfields Displayed in the Assign Activity

-
O Edit Assign

General ~ Copy Rules Annotations Documentation ~ Targets

|InsertNew Rule After '|

@3] ns2:GEOMETRY

[e3] nsz:0RIG_SYs_0BIS

[e3] ns2:EXT_ATTRIBIUTES_OBIS

Sources

Skip Condition

nsZiGEOMETRY
ns2:ORIG_SYS_OBIS
KT_ATTRIBUTES_OBJS

[-fes] ns3:Parroquia

&-Je] ns2:Hz_LOCATIONS ns2HZ_LOCATIONS
---[@3] ns3ATTRIBUTE_CATEGORY ns3ATTRIBUTE_CATEGORY
=-(§] « = <

- < > 3
i 3] ns3:Region ns3:Reqgion
~[as] ms3uComuna string150 ns3:Comuna string150 [e
[ = <
---[@3] ns3:Zona ns3:Zona

ns3:Parroguia

(x) Invoke_SynchRead_OutputVariable fbody//ns2: InputParameters/ns

E}--[‘@&] ns2:PARTY_SITE_USE_OBIS Z:PARTY_SITE_USE_OBIS

f-[es] ns2:PHONE_OBIS nsz:PHOME_OB1S

[-[es] ns2:TELEX_OBIS ns2: TELEX_OBJS

f-as] ms2:EMAIL_0BIS nsZ:EMAIL_OB1S

i Fes] cemoucn spac R AMER TR

s
| Copy '| From XPath: |,|’n52:InputParameters,l’ns2 |Io !Pam:|,l’ns2:In|3utParameters,|’n52 | 4‘ XD
From To

Invoke_SynchRead_QOutputVariable body fjns2: InputParameters ns. ..

... (%) Invoke_SynAccOrder_InputVariable /InputParameters//ns2:InputPar...

nvoke_SynAccOrder_InputVariable InputParametersfjns 2:InputPar. ..

Help

[ Apply oK

_J | Cancel

Use Assign activity to provide input payload information to the TCA Location object of
the target parameter.

The target parameters ns2 : ATTRIBUTE1 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

e Region (under context value <sequence (Chile)>)

Zona (under context value <sequence (Ecuador) >)

The target parameters ns2 : ATTRIBUTE2 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

e Comuna (under context value <sequence (Chile)>)

e Parroquia (under context value <sequence (Ecuador) >)

These descriptive flexfield columns grouped by context value are displayed in the
Assign activity.

¢ In the From navigation tree, navigate to Variables > Process > Variables >

Invoke_SynchRead_OutputVariable > body > ns2:InputParameters >
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ns2:P_ORG_CUST_OB]J > ns2:0RGANIZATION_OB] > ns2:PARTY_SITE_OB]JS>
ns2:PARTY_SITE_OBJS_ITEM > ns2:LOCATION_OB]J >ns2:HZ_LOCATIONS
>ns3:ATTRIBUTE_CATEGORY and expand the <choice> icon to locate the
mapped descriptive flexfield columns ns3:Region and ns3:Comuna for the
selected context value ns3:Chile (or select ns3:Zona and ns3:Parroquia for
the selected context value ns3:Ecuador instead).

¢ In the To navigation tree, navigate to Invoke_SyncOrder_InputVariable >
InputParameters > ns2:InputParameters > ns2:P_ORG_CUST_OB]J >
ns2:ORGANIZATION_OB]J > ns2:PARTY_SITE_OBJS>
ns2:PARTY_SITE_OBJS_ITEM > ns2:LOCATION_OB]J >ns2:HZ_LOCATIONS
>ns3:ATTRIBUTE_CATEGORY and expand the <choice> icon to locate the
mapped descriptive flexfield columns ns3:Region and ns3:Comuna for the
selected context value ns3:Chile (or select ns3:Zona and ns3:Parroquia for
the selected context value ns3:Ecuador instead).

To assign the parameters with descriptive flexfields in the Assign activity, drag the
source node (ns3:Region) to connect to the first target node (ns3:Region) that you just
specified. This creates a line that connects the source and target nodes. The copy rule is
displayed in the From and To sections at the bottom of the Edit Assign dialog box.

Repeat the procedure to assign the second parameter by dragging the same source node
(ns3:Comuna) to connect to the second target node (ns3:Comuna). The second copy rule
is displayed in the From and To sections at the bottom of the Edit Assign dialog box.

Click Apply and OK to complete the Assign activity.

Note: Alternatively, since 'ns2:InputParameters' variables contained in
the Source and Target are identical, you can simply drag the source
node (ns2:InputParameters) to connect to the target node
(ns2:InputParameters) and complete the Assign activity.
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&) Edit Assign

[

General Copy Rules Annotations Documentation Targets

‘Insert New Rule After *

o BPELProcess1.bpel
&[] Partrer Links
-5 variables
= ﬁga Process
12 variables
(x) inputvariable
[#-(x) outputvariable
{x) Irwvoke_Synaccorder_Inputvariable
+ ) Invoke_SynaccOrder _Oukputyariable
-(,t} Irvoke_SynchRead_Inputiariable
=-(x) Inwoke_SynchRead_Outputvarisble
=[] body
E €% nsz:InputParameters <anaonymass
G-[es] ns2:P_VALIDATE_BO_FLAG
#-fas] ns2:P_ORG_CUST_0B]
-[es] ns2:P_CREATED BY_MODIULE
#-[e3] ns2:P_0OBJ_SOURCE

Sources  Skip Condition

B & Qb=

EPELProcess1.b

Partner Links

Vatiables

Process ﬁaa

Variables (532
inputiariahle (x)
outputyariable x)-=
Invoke_SynAccOrder_Input¥ariable x) E|

InputParameters [F-E1
ns2:InputParameters <anonymouss &3 = ]
ns2:P_YALIDATE_BO_FLAG [ez]
+f - ns2:P_ORG_CUST_0B)

ns2:P_CREATED_BY_MODULE
nsZ;P_0B]_SCOURCE
Invake_SynaccOrder_Outputhariable
Invoke_SynchRead_InputVariable x)-
Invoke_SynchRead_OutputVariable x)- :

=] copy

| From XPath: |,insZ:InputParameters

To ¥Path: ‘p’nsz:lnputParameters

From
;"’;f Invoke_SynchRead_OutputVariable body//ns2:InputParameters

To

Help

[ aoty J[__ox

j | Cancel

Displaying Mapped Descriptive Flexfields at Run Time

After deploying the BPEL process contained in a SOA Composite application to the

Oracle WebLogic managed server (such as 'soa-serverl'), the descriptive flexfields we

configured earlier are displayed in the soa-

server] server (

http://<servername>:<portnumber>/soa-infra) allowing you to specify
payload data and test the service invocation. Please note that you also test and manage
the process from the Oracle Enterprise Manager Fusion Middleware Control Console.

Note: Please note that you can also test and manage the process from
the Oracle Enterprise Manager Fusion Middleware Control Console. In
this example, the mapped descriptive flexfields used as part of the
input payload happen to be located or nested within multiple
sub-levels down from the top. This means that we need to drill down to
the mapped descriptive flexfields (Region and Comuna) by expanding
the parameter nodes multiple times from the top level (Payload >
P_ORG_CUST_OB] > ORGANIZATION_OB]J > PARTY_SITE_OBJS >
PARTY_SITE_OBJS_ITEM > LOCATION_OB] > HZ_LOCATIONS >
ATTRIBUTE_CATEGORY > HZ_LOCATIONS_1 to view descriptive
flexfields). However, Oracle Enterprise Manager Fusion Middleware
Control Console has certain limitations on displaying payload
parameters if they are nested too deeply.
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{3 DescFlex [2.0]® Logged in as weblogic|Host 2012013.us.0
ofd 50A Composite + Page Refreshed Feb 5, 2013 4:40:01 P

»| Additional Test Options
~|Input Arguments

Tree View El
Name Type Value
CREATED_BY_NAME string -
CREATION_DATE dateTime
LAST_UPDATE_DATE dateTime

LAST_UPDATED_BY_NAME  string
DO_NOT_CONFUSE_WITH  string
ACTUAL_CONTENT_SOUR.... string
I+ ORIG_SYS_OBIS APPS.HZ_ORIG_SYS_REF_OBI_TBL

[~ EXT_ATTRIBUTES_OBJS  APPS.HZ_EXT_ATTRIBUTE_OBJ_TBL
£~ CONTACT_CBIS APPS.HZ_ORG_CONTACT_BO_TEL
7 PARTY_SITE_CBIS APPS.HZ_PARTY_SITE_BO_TBL
PARTY SITE 0875 rrem APPSHZ_PARTY SITE BOAray Siz
£ PREFERENCE_OBJS APPS.HZ_PARTY_PREF_OBJ_TBL El
&> PHONE_OBIS APPS.HZ_PHONE_CP_BO_TBL o

& TELEX_OB15 APPS.HZ_TELEX_CP_BO_TBL

1

Therefore, in this case we access the mapped descriptive flexfields
directly from the soa-infra in the soa-serverl server.

For information on how to test the service invocation from the Oracle
Enterprise Manager Fusion Middleware Control Console, see Test the
deployed SOA Composite application with BPEL process, page 9-42.

Similar to the key flexfield project described earlier, click the deployed descriptive
flexfield project in the Welcome to the Oracle SOA/BPM Platform on WebLogic page.

The Web Services Test Client page is displayed with your selected project. Click Test.
The descriptive flexfields configured earlier will be displayed as part of the input
payload in the Parameters region of the Web Services Test Client page.

In the Parameters region, expand the Payload > P_ORG_CUST_OB] node and navigate
to ORGANIZATION_OBJ > PARTY_SITE_OB]JS > PARTY_SITE_OBJS_ITEM >
LOCATION_OB]J > HZ_LOCATIONS > ATTRIBUTE_CATEGORY >
HZ_LOCATIONS 1.

Two sets of descriptive flexfields configured earlier at the design time are now
displayed at the runtime.

1. HZ_LOCATIONS_1_0 (This is the default selection we configured in the Assign
activity at the design time.)

* Region

e Comuna

2. HZ_LOCATIONS_1_1

e Zona
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e Parroquia

Enter appropriate data as payload and then click Invoke to invoke the service.

Configuring Key Flexfield Mappings for an Open Interface Table

Sample Business Scenario

Take an open interface table ONT . OE_ HEADERS_IFACE ALL as an example to explain
the inbound web service creation with flexfield data.

When a request of inserting order data for a specific account is received, order data
details can be customized based on the requestor's needs using both key flexfields and
descriptive flexfields. This data will then be passed as an input payload and inserted
into the open interface table. The inserted data can be selected and written as an output
file and returned back as a response message for client verification.

The following diagram illustrates the service invocation process flow:

Input Payload

& 3 Flexfield Data
[ 'II- Insert Order Data
Request L Oracle
L ol (i EBS -
_______ g ~ Adapter
34 Party Written Output -
Applicati Response ) Oracle E-Business
pplication Oracle SOA Suite Suite Database

After deploying the service, you can validate the process directly by viewing the output
XML file. This data should be the same as input from the payload.

Configuring a Key Flexfield Mapping As Part of the Partner Link Creation

In this example, use key flexfields for a specific order needs (such as a special account
number, its associated account name, and so on) for the selected open interface table
ONT.OE HEADERS TFACE ALL.

To configure a key flexfield mapping, click Add Mapping in the Configure Flexfields
region. A series of flexfield selection pages in the wizard appear guiding you to
configure a new mapping for your selected open interface table.

Click Next in the Welcome page. The Select Flexfield Type page is displayed.
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Flexfield Subflow - Select Flexfield Type
[ () Flexfield SubFlow - Step 2 of 6 S5

Select Flexfield Type

Select the flexfield type and dick next to create/edit and configure the flexfield

Type of Flexfield (%) key Flexfield
(") Descriptive Flexfield

| Help | | < Back || Mext = J Cancel

Perform the following steps to configure a key flexfield:

1. Select the Key Flexfield radio button in the Select Flexfield Type page. Click Next.
The Select Flexfield Application page appears.

2. Tolocate your desired application name, enter keyword search (such as '‘%App%')
and click Query to execute the search. All the entries that match your search criteria
will be displayed. For example, select the Application Object Library radio button
as the application name to which the flexfield belongs.
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Flexfield Subflow - Select Flexfield Application

| £ Flexfield SubFlow - Step 3of6 3

Select Flexfield Application

Select the application to which the flexfield belongs and dick next.

| | Query

Application:

(%) Application Object Library

sia /Pacific Localizations

1 Assets

apital Resource Logistics - Assets

1 Common Modules-AK

omplex Maintenance Repair and Overhaul
JE-Business Tax

(" |Enterprise Performance Foundation

-

(_Financial Inteligence
General Ledger

(_Human Resources

nventory

‘Learning Management
ayroll

“JPublic Sector Budgeting
Receivables

(IService

Help < Back Mext = Cancel

Alternatively, click Query directly to execute the blank search without keyword
search. This displays all flexfield application names for your selection.

Click Next.

In the Select Flexfield page, enter keyword search if desired and click Query to
execute the search. All the matched key flexfields are displayed for your selection.
Select your desired key flexfield radio button.
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Flexfield Subflow - Select Flexfield

| £ Flexfield SubFlaw - Step 4 of 6 =3

Select Flexfield

Select the flexfield and dick next.

Application: Application Object Library

Flexfield: |% | Query

) FND_SAMPLE_KFF
(=)Sample Adapter KFF
" )Sample Adapter KFF 1
(" )Sample Adapter KFF 2

Help < Back Next = Cancel

Click Next to continue.

4. The Configure Mapping page appears where you can choose desired mapping for
your key flexfield. Notice that your selected key flexfield name is automatically
populated as the Flexfield name.

In this mapping page, you have the option to do the mapping manually or use
automapping feature.

¢ Automapping feature maps all the flexfield segments to the Open linterface
Table columns, which have the column name as part of the parameter name.
For example, flexfield table column SEGMENT1 would be mapped to interface
table column TP_SEGMENTT1. If there are multiple sets of interface table
columns and the flexfield table column names, then the prefix can be specified.

For example, enter "TP_' as the prefix to retrieve all interface table columns
starting with "TP_', such as TP_SEGMENT1, TP_SEGMENT2, TP_SEGMENTS3,
to TP_SEGMENTnN where n is a number. If you click Auto Map, all the interface
table columns with prefix "TP_' are automatically displayed along with the
automapped flexfield table column names.

Note: Flexfield values are stored in the application database
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tables. In general, key flexfields store their data in columns
called SEGMENTnN and descriptive flexfields store their data in
columns called ATTRIBUTEn, where n is a number.

* Manual mapping lets you select a desired flexfield table column for a
corresponding interface table column.

Note: If an interface table column has already mapped to a flexfield
table column, you cannot remap that column to other flexfield table
column. In this situation, 'Mapped to other Flexfield' appears
instead for that mapped interface table column.

Click Clear Mapping to clear current mapping you have. All previously mapped
columns marked with 'Mapped to other Flexfield' will not be removed from the
system.

Click Next to continue.
The configuration of the flexfield will not be complete without a structure for a key
flexfield and at least one context value for a descriptive flexfield.

In the Configure Flexfields page, enter keyword search if desired in the Structure
field or simply click Query to execute a blank search. All the matched structures for
the selected key flexfield are displayed.

Select only one structure (such as AU_BANK_DETAILS).

Please note that there are certain criteria need to be met in order to have your
desired structures displayed in the wizard for selection. See: Guidelines for
Defining Flexfield Structure and Context Values, page 4-34.
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Flexfield Subflow - Configure Flexfields
" [&] Flexfield SubFlow - Step 6 of 6 S5

Configure Flexfields

Select the Structure or Context(s) and dick Finish.
Application: Application Object Library

Flexfield Mame: Sample Adapter KFF

Structure : |% | Query

) AL_BANK_DETAILS
SAMPLE_ADAFTER_KFF

Help Einish Cancel

Note: Only one structure for a key flexfield can participate in
flexfield mapping. In the case of a descriptive flexfield, multiple
context values can participate in the mapping.

Click Finish.

6. The Oracle E-Business Suite Module Browser window appears. The newly added
key flexfield structure and mapped interface table columns are displayed in the
Interface Table Columns with Corresponding Flexfield Mappings region.

The key flexfield information is also displayed in the Flexfield Definitions section.
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Displaying Selected Key Flexfield Information

© Oradle Applications Madule Browser ==

P g e—

ObjectMame: || [Jiabes [Juews [Jais [Jp []xMGateway [EDI [ ]BusinessEvents Browse
65 Productanilies Interface Table Columns with Corresponding Flexfield Mappings
&3 Advanced Pianning (SCP_PF) Column Type Segment Flexfield Type  Context. Flexfield Name
€3 Applications Technelogy (ATG_PF) orEra U _Luue VARUIMRL
(53 Contracts Suite (OK_PF) ERROR_FLAG VARCHAR2
(53 Discrete Manufacturing (DMF_PF) READY_FLAG VARCHAR2
53 Finandal Globalizations Suite (FINGB_PF) ISTATUS_FLAG VARCHAR2
(53 Finandial Payables Suite (FINAP_PF) [FORCE_APPLY_FLAG VARCHAR2
(53 Finandial Receivables Suite (FINAR_PF) INTERFACE_STATUS VARCHAR2
(5 Finandal Services Applications (SEM_PF) CHANGE _REASON VARCHAR2
5 Finandials (FIN_PF) (CHANGE_COMMENTS VARCHAR2
(5 Human Resources Suite (HR_PF) EEUREE ETEE
S mescvmcons 17 o0 o o o ez
3 Merketing Suite (MKT_PF) REJECTED_FLAG VARCHAR2
3 Marketing and Sales Suite (MAS_PF) e conrext e
G Order Management Suite (OM_PF) TP _ATTRIBUTE L VARCHAR2 BSE number Key Sample Adapter KFF
G Transportation Execution (FTE) ITP_ATTRIBUTE2 VARCHAR2 Account Number Key Sample Adapter KFF
- G Order Management (ONT) TP_ATTRIBUITES VARCHAR2 Account Name Key Sample Adapter KFF
5 Sales Agreement (ONT_SALES_AGREEMEN | |Tp_ATTRIBUTE4 VARCHAR2 Key Sample Adapter KFF
=58 Sales Order (ONT_SALES_ORDER) TP_ATTRIBUTES VARCHAR2
(5 XM.Gateway TP_ATTRIBUTES VARCHAR2
G en ITP_ATIRIBUTE7 VARCHAR2
[mrLsoL TP_ATTRIBUTEB VARCHAR2
[ Openinterfaces TP_ATTRIBUTES VARCHAR2
(% Order Management Sales Orders ¢ | [TP_ATTRIBUTE10 VARCHAR2
(58 Order Management Sales Orders ¢ | |TP_ATTRIBUTELL VARCHAR2
(58 Order Management Admonledgme | |P-ATTRIBUTEL2 AR R
(5 Order Management Admonledgme | |7 -ATTRIBUTELS TS
° g OETET;HES O € [ Confgure Pesfods
‘- [ OE_LOTSERIALS_IFACE / | | Flexfield Definitions
-~ B OF _PRICE_ADIS IFACE_, | |ype Appiication Name Structure or Context
i g gg_:.?s;iﬁ;ﬁf:; ey Flexfield FD Sample Adapter KFF AU_BANK_DETAILLS
- [ OE_CUSTOMER _INFO_IF/
[ OE_PAYMENTS_IFACE_AL
i F OE_ACTIONS [FAcE_aut | |[Flexfickd Metadat:
g OE_CREDITS_IFACE_ALL Import from File Add Mapping
FFH OE_LINES_IFACE_ALL (Of
-3 Views oK Cancel

Click OK if you complete your flexfield configuration. The Application Interface
page appears with the selected open interface table.

In this example, we will cerate a descriptive flexfield mapping to this selected open
interface table by clicking Add Mapping. See: Configuring Descriptive Flexfield
Mappings for an Open Interface Table, page 4-85.

Configuring Descriptive Flexfield Mappings for an Open Interface Table
Based on the same business scenario described earlier, a special order applying for
customers both in India and Japan needs to be inserted to
ONT.OE HEADERS IFACE ALL open interface table. After the special order data is
inserted, a written output file containing those data is requested as part of a response
message for the requestor.

Configuring a Descriptive Flexfield Mapping As Part of the Partner Link Creation

In this example, descriptive flexfields are used to represent address requirements for
customers located in different countries.

To configure a descriptive flexfield mapping for the selected open interface table
ONT.OE HEADERS IFACE ALL, click Add Mapping in the Configure Flexfields
region. A series of flexfield selection pages in the wizard appear guiding you to
configure a new mapping for your selected APL

Click Next in the Welcome page. The Select Flexfield Type page is displayed.
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Flexfield Subflow - Select Flexfield Type
[£] Flexfield SubFlow - Step 2 of 6 C

Select Flexfield Type

Select the flexfield type and dick next to createfedit and configure the flexfield

Type of Flexfield  (7) Key Flexfield
() Descriptive Flexfield

| Help | | < Back || Next = | Cancel

Perform the following steps to configure a descriptive flexfield:

1. Select the Descriptive Flexfield radio button in the Select Flexfield Type page, and
then use the similar approach as described earlier for key flexfields in the flexfield
mapping wizard.

2. Click Next in the Select Flexfield Type page. The Select Flexfield Application page is
displayed.

3. To locate your desired application, enter keyword search (such as '%App%') or
simply click Query to execute the search. All the matched applications for
descriptive flexfield are displayed. For example, select the Oracle Application
Library radio button as the application name to which the descriptive flexfield
belongs.
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Flexfield Subflow - Select
|£| Flexfield SubFlow - Step 3 of 6

Flexfield Application

Select Flexfield Application

Select the application to which the flexfield belongs and dick next.

Application: |°}'n

| Query

()ADS Development

dvanced Benefits

dvanced Outbound Telephony
dvanced Pricng

) Advanced Product Catalog
dvanced Supply Chain Planning

pplication Implementation
Japplication Object Library
pplication Report Generator
) Applications BIS

pplications DBA

sia/Pacific Localizations
) Asset Tracking
() Assets

ctivity Based Management (Obsolete)

1 Applications Demonstration Services

Help

< Back Mext = Cancel

Click Next.

In the Select Flexfield page, enter keyword search (such as 'FND%') if desired and

click Query to execute the

search. All the matched descriptive flexfields are

displayed for your selection.

Select your desired descriptive flexfield (such as FND_FLEX_TEST) and click Next.
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Flexfield Subflow - Select Flexfield
|4 Flexfield SubFlaw - Step 4 of & (X

Select Flexfield

Select the flexfield and dick next.

Application: Application Object Library

Flexfield: | | Query

ATCHMT_COMTEXT_FLEX
ATCHMT_DESC_FLEX
ATCHMT_DOCUMENT _FLEX
Document Flexfield
FMD_COMMOMN_LOOKUPS
FMD_COMCURRENT _PROGRAMS
FMD_COMCURRENT_QUELES
FMD_CURREMNCIES
FMD_DOCUMEMT _SEQUEMCES
FMD_DOC_SEQUENCE_ASSIGMMENTS
FND_EMABLED _ACTIVATION
FMD_FLEX_TEST
FND_FLEX_VALUES
FMD_PRIMTER._DRIVERS
FMD_REQUEST_SETS

TENDL SAMPIE DEE

Help < Back Mext = Cancel

5. The Configure Mapping page appears where you can choose desired mapping for
your descriptive flexfield.

Notice that your selected descriptive flexfield name FND_FLEX_TEST is
automatically populated as the Flexfield name.
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Flexfield Subflow - Configure Mapping

[ N
[£] Flexfield SubFlow - Step 5 of 6 S5
Configure Mapping

Application: Application Object Library Flexfield: FND_FLEX_TEST

Map Context Column ATTRIBUTE_CATEGORY |CDNTEXT o

Use Open interface table column prefix to auto map Auto Map Clear Mapping

Open Interface Table Column Flexfield Table Column

AGREEMENT_ID [ -|
TP_ATTRIBUTEL | ATTRIBUTEL -|
TP_ATTRIBUTEZ2 | ATTRIBLTE2 -
TP_ATTRIBUTE3 | ATTRIBUTES -|
TP_ATTRIBUTE4 [ATTRIBUTES -|
TP_ATTRIBUTES | ATTRIBUTES -|
TP_ATTRIBUTES | ATTRIBLITES -
TP _ATTRIBUTET | ATTRIBUTE7 -|
TP_ATTRIBUTES [ATTRIBUTES -|
TP_ATTRIBUTES | ATTRIBLITES -|
[TP_ATTRIBUTE10 | ATTRIBUTELD -
TP_ATTRIBUTE 11 [ATTRIBUTE 11 =
TP_ATTRIBUTE12 [ATTRIBUTE12 =
TP_ATTRIBUTEL3 [ATTRIBUTE13 |
[TP_ATTRIELUTE 14 | ATTRIRIME14 |

Help Mext = Cancel

Selecting Context Column for Descriptive Flexfield Mapping

For descriptive flexfields, you need to perform an additional mapping for the

context column. This is because flexfield mapping cannot span across open interface

tables. All the flexfield table columns including the context column should be
mapped to the open interface table columns in the OIT table.

In the Map Context Column ATTRIBUTE_CATEGORY field, select a desired
category name that you want to view the mapping information from the
drop-down list. For example, select CONTEXT from the drop-down list.

Note: If an open interface table column has already mapped to a
flexfield table column, you cannot remap that column to other
flexfield table column. In this situation, 'Mapped to other Flexfield'
appears instead for that mapped open interface table column.
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)] Flexfield SubFlow - Step 5 of 6 (5

Configure Mapping

Application: Application Object Library Flexfield: FMD_FLEX_TEST

Map Context Column ATTRIBUTE_CATEGORY | -
Use Open interface table column prefix to auto map l:l Auto Map Clear Mapping
Open Interface Table Column Flexfield Table Column

TAA_CACIVIF | _INUIMIDER |

[TAX_EXEMPT_REASON [

[TAX_EXEMPT_REASON_CODE [ -
|
[

=

-]

TAX_POINT
[TAY_POINT_CODE

=

[TP_ATTRIBUTEL Mapped to other Flexfield
[TP_ATTRIBUTE2 Mapped to other Flexfield
[TP_ATTRIBUTE3 Mapped to other Flexfield
[TP_ATTRIBUTE4 Mapped to other Flexfield
[TP_ATTRIBUTES Mapped to other Flexfield
[TP_ATTRIBUTES [
[TP_ATTRIBUTE? [
[TP_ATTRIBUTES [ -|
[TP_ATTRIBUTES |
[TP_ATTRIBUTE10 |

=

=

-]

=

Help Next = Cancel

Similar to key flexfields, the mapping can be performed manually or assisted with
the automapping feature by clicking Auto Map.

Automapping feature maps all the flexfield table columns to the open interface
table columns, which have the column name as part of the interface table column
name. For example, flexfield table column names from ATTRIBUTE1 to
ATTRIBUTE20 are automatically displayed and mapped to the open interface table
columns from ATTRIBUTE] to ATTRIBUTE20 respectively through automapping.

If there are multiple sets of open interface table columns and the flexfield table
column names, then the prefix needs to be specified for automapping. This would
map the potential open interface table columns which need to be considered for the
mapping. Enter table column prefix (such as "TP') to first locate your desired
interface table columns that you want the automapping to be performed. Next, click
Auto Map. All the interface table columns with prefix 'TP' are automatically
displayed along with the automapped table column names. Interface table column
'TP_ATTRIBUTE1' is mapped to column ATTRIBUTEI, and interface table column
'TP_ATTRIBUTER' is mapped to column ATTRIBUTEn.

Instead of using automapping feature, you can manually select a desired flexfield
table column name from the drop-down list for a corresponding interface table
column for your flexfield mapping.

Click Clear Mapping to clear current mapping you have in the flexfield table
column only. All previously mapped columns marked with 'Mapped to other
Flexfield' will not be removed from the system.

Click Next to proceed to the next page.
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In the Configure Flexfields page, select at least one context value for the selected
descriptive flexfield. For example, select desired context values (such as 'IN' and
l]’Pl)'

You can either enter keyword search in the Context field or simply click Query to
execute the search before selection.

For descriptive flexfields, context value should be available to the run time through
an open interface table column.

Please note that there are certain criteria need to be met in order to have your
desired context values displayed in the wizard for selection. See: Guidelines for
Defining Flexfield Structure and Context Values, page 4-34.

Flexfield Subflow - Configure Flexfields
" (@) Flexfield SubFlow - Step 6 of 6 (3 |

Configure Flexfields

Select the Structure or Context(s) and dlick Finish.
Application: Application Object Library
Flexfield Name: FND_FLEX_TEST

Context : |'5-’n | Query

Global Data Elements
[w]IN
[w] P
| Jus

Help Einish Cancel

Click Finish to complete the flexfield configuration.

The Oracle E-Business Suite Module Browser window appears. The newly added
descriptive flexfield information including the segment values for the selected
context value is displayed in the right pane of the window.

Oracle E-Business Suite Adapter Concepts 4-91



Displaying Selected Descriptive Flexfield Information

O Oracle Applications Module Browser ==
- EN - e - -
ObjectNames| | [Isbes [Juews []aPs []c2 [ |xM.Gateway [ |EDI [ |BusinessEvents Browse
€8 ProductFamilies Interface Table Columns with Corresponding Flexfield Mappings
s RO Column Type Segment Flexfield Type | Context Flesfeld Name
g Applications Technology (ATG_PF)
3 Coniracta S (061 INVOICE_TO_CONTACT_LAST_NAME VARCHARZ
(ORDERED_BY_CONTACT_FIRST_NAME VARCHAR2
PR T ) (ORDERED_BY_CONTACT_LAST_NAME VARCHARZ
G Financial Globalizations Suite (FINGB_PF) IDROP_SHIP_FLAG VARCHAR?
- (% Fnancil Payables Suite (FINAP_PF) sooen LA e
E Financial Receivables Stite (FINAR_PF) ICLOSED_FLAG VARCHAR2
(& Finandial Services Applications (SEM_PF) ICANCELLED_FLAG CHAR!
G Financials (FIN_PF) [VARCHAR2 sariplive
G Human Resources Suite (HR_PF) IATTRIBUTEL VARCHAR2Z Address Line1 Desriptive
- (% Interaction Center (CC_PF) ATTRIBUTEZ VARCHARZ Address Line2 Descriptive
(5 Marketing Suite (MKT_PF) ATTRIBUTES VARCHAR2 Address Line3 Descriptive
- (% Marketing and Sales Suite (MAS_PF) ATTRIBUTES VARCHAR2 Town/Gity Descriptive
G Order Management Suite (OM_PF) RIECVIES UL s T=mEE
33 Transportation Execution (FTE) ATTRIBUTES VARCHARZ Pin Code Descriptive
3 Order Management (ONT) ATTRIBUTE? VARCHAR2 Descriptive
(53 Seles Agreement (ONT_SALES_AGREEMEN | | [FTTRIEUTES ARG BT
=% Sales Order (ONT_SALES_ORDER) ATTRIZUTES VARCHARZ WSS
L Gateway ATTRIEUTELD VARCHAR? Desarptive
ATTRIBUTELL VARCHARZ Descriptive
reb ATTRIBUTEL VARCHAR2 Descriptive
[mrsa ATTRIBUTE13 VARCHAR2 Descriptive
[ [ Opentnterfaces ATTRIBUTE 14 VARCHAR2 Desarptive
G Order Management Sales Orders C || lxrrreTers VARCHARZ Descriptive FND_FLEX_TEST
©3 Order Management Sales Orders C | | |HEADER_PO_CONTEXT VARCHAR2
53 Order Management Acknowledgme | | [po_aTTRIBUTE_1 VARCHAR2
3 Order Management Acknawledame | | [PO_ATTRIBUTE 2 VARCHAR2
= ? g:ﬁ‘bles s
[ OF_LOTSERIALS TFACE s | |Flexfield Definitions
-~ oe PRICE aD3S FPACE L | frpe Appleation Name Structure or Context
B OE_PRICE_ATTS IFACE: | Lo, Flexfeld FND Sample Adapter KFF AU_BANK_DETAILS
B OF_RESERVINS_IFACEA | Inescriptive Fexfield FID FND_FLEX_TEST [Global Data Elements -
[ OE_CUSTOMER INFO_IF/
- OF_PAYMENTS_IFACE_AL
B OE_ACTIONS IFace_aLL | [[iexfield Metad
- [EEH OF_CREDITS_IFACE_ALL Import from File Add Mapping
[B==1or reao Al
- FE3 O LINES_IFACE_ALL (OF
views ok Cancel

Click OK.

The Application Interface page appears with the selected open interface table.
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' R
iﬂ Cracle Applications Adapter Configuration Wizard - Step 4 of 5 u
Application Interface
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tablesfviews or you can add a single API/Concurrent Program XML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.,
r Operation Objects
Get Object (3% Delete
Mame Type
OMT.OE_HEADERS_IFACE_ALL Table view -
Help <Back  MNext> | Cancel
Click Next.

9. The Operation Type page is displayed.
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Adapter Configuration Wizard - Operation Type Page

@) Oracle Applications Adapter Configuration Wizard - Step 5 of 6

Operation Type

Select the Operation Type and dick Mext to continue defining the operation.

Operation Type:  (#) Perform an Operation on a Table
Insert
Select
[ ] select By Primary Key
() Poll for New or Changed Records in a Table

Cache Usage: |none (default) «

Help < Back Next =

Cancel

Select the Perform an Operation on a Table radio button and then choose the

Select and Insert check boxes.

10. Click Next. The Select Table page appears which displays the tables that have been

previously imported in this JDeveloper project. Select the
OE_HEADER_IFACE_ALL table.
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Adapter Configuration Wizard - Select Table Page

L A
ﬂ Cracle Applications Adapter Configuration Wizard - Step 6 of 12 @

Select Table

Please select the root database table for this service's guery.

Help < Back Mext = Cancel

11. Click Next. The Relationships page is displayed.

12. Click Next. The Attribute Filtering page appears.
Click Deselect All and select the orderSourceld check box only.

The mapped flexfield table column names we defined earlier for both key and
descriptive flexfields are already selected in this page. However, they appear as
grayed-out attributes indicating that you cannot deselect them.
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Adapter Configuration Wizard - Attribute Filtering Page with Mapped Flexfield Column
Names

-
'o Oracle Applications Adapter Configuration Wizard - Step 8 of 12 u

Attribute Filtering

Uncheck any attributes that you would like to exdude from the database queries for this service. Primary key
attributes cannot be exduded.

cancelledFlag

o
%t

-
O
|

RN A AR A

-] attribute11
[ | attribute 12
| attribute 13
-] attribute14

Select All Deselect All

Help < Back Mext = Finish Cancel

13. Click Next. The Define Selection Criteria page is displayed with SQL statements
populated.
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Adapter Configuration Wizard - Define Selection Criteria Page

- -
@) Cracle Applications Adapter Configuration Wizard - Step 9 of 12 [ﬁ

Define Selection Criteria

Define the selection criteria for the SELECT guery of this service. To use the graphical Expression Builder to create
the expression, dick the 'Edit..." button. To define your own custom Select SQL, modify the pre-generated SQL
string. MOTE: The SQL for SelectByPrimarykey (fixed) and QueryByExample (dynamic) operations are not shown at

design time.
Parameters: Add...
SCN SELECT ORDER_SOURCE_ID, CONTEXT, ATTRIEUTE1, ATTRIBUTEZ, ATTRIBUTES, Edit...
ATTRIEUTE4, ATTRIBUTES, ATTRIBUTES, ATTRIEUTES, ATTRIBUTES,
ATTRIBUTE10, CREATED_BY, CREATION_DATE, LAST_UPDATED_BY,
LAST_UPDATE_DATE, TP_ATTRIBUTEL, TP_ATTRIBUTEZ, TP_ATTRIBUTES,
ROWID FROM ONT.OE_HEADERS_IFACE_ALL

[ Use Outer Joins to return a Single Result Set for both Master and Detail Tables

Help < Back Mext = Cancel

14. Click Next. The Advanced Options page is displayed.
15. Click Next. The JCA Endpoint Properties page is displayed.

16. Click Next and then click Finish.

The wizard generates the WSDL file corresponding to the partner link. An
enhanced XSD file, for example AppsReference flex.xsd, is also created. This

XSD file contains the schema describing the procedure arguments with the elements

representing the interface table columns that have been replaced with flexfield
segment names.

Click Apply and then OK.

17. Additionally, configuration file and flexfield mapping file are created. For more
information on these files, see Reviewing Flexfield Configurations, page 4-122.

Once a new flexfield mapping has been configured or added, if modification is needed,
you can make updates by first selecting desired flexfield type that you want to modify
and then make needed changes. For more information on how to modify the selected
mapping details, see Modifying Flexfield Mapping Definitions, page 4-119.
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Displaying Mapped Key and Descriptive Flexfields at Design Time

Both key and descriptive flexfield mapping data configured earlier during the partner
link creation can be shown at design time along with the following activities
orchestrated in the BPEL process within in a SOA composite:

A Composite Example with Key and Descriptive Flexfield Mappings

Here is an example describing both key and descriptive flexfield mappings in the BPEL
process of a SOA composite:

¢ C(Create anew SOA composite application with BPEL process
¢ Add a partner link service called AppsReference with the key and descriptive

flexfield mappings that we configured earlier for the
ONT.OE HEADERS IFACE_ALL open interface table.

* Add a partner link for File Adapter WriteSelectOutput to write the inserted
order data as an output file in XML format.
® In the File Directories dialog, enter the physical directory (such as /usr/tmp)
where the output xml file (such as output payload.xml) resides.
* In the Messages dialog, select the 'browse for schema file' icon next to the URL
field to open the Type Chooser.

Click Type Explorer and select Project Schema Files >
AppsReference_table.xsd > AppsReference_flex.xsd >
OeHeaderIFaceAllCollection.
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@) FILE Adapter Configuration Wizard - Step 7 of 8 [ %

@ Type Chooser

Schema Element
definition. If you

Message Schen
[ Mative forma

URL

Schema Elemer|

Q% Type Explorer

=] Project Schema Files
% AppsReference_flex,xsd

o= AppsReference_table.xsd

% AppsReference_Flex, xsd

4% AppsReferenceSelectInputParameters

&2 BPELProcessl.xsd
-] Project WSDL Files

DeHeadersIfaceAllCollection OeHeadersIFaceAllCollection

Type: |n|ns.orade.com,.’pcbpeIfadapter,.‘dbftopIAppsReFerence}DeHeadersIfaceAJICoIIecﬁon

Help

[ "] show Detailed Node Information

oK Cancel

Click OK. The selected schema information will be automatically populated in
the URL and Schema Element fields.
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@) FILE Adapter Configuration Wizard - Step 7 of 8 u

Messages

Define the message for the Synchronous Read File operation. Specify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you check 'Schema is Opaque’, then you do not need to specify a Schema.

Message Schema

[ Wative format translation is not required (Schema is Opaque)

URL | .Jschemas/AppsReference _table. xsd| | Q, o

Schema Element [DeHeadersIfaoeAlICollecﬁon v]

Help < Back | Mext = Cancel

¢ Configure three Invoke activities

® Associate the first Invoke activity with the partner link AppsReference to

insert data to the ONT.OE HEADERS IFACE ALL open interface table columns.
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© Edit Invoke [

Documentation ~ Targets  Sources  Skip Condition  Headers

General Correlations Properties Assertions Annotations

Mame: |Ir1'u'nke |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type: |f.,.§ Partner Link =

Partner Link: |AppsF‘.eFerence | &,
Port Type: |i§}" AppsReference_ptt "'|
Operation: | g insert '|
Input
() Arguments Mapping () Input Variable =)
Input: [Invoke_insert_InputVariable |lii Ck
Help Apply 0K Cancel

* Associate the second Invoke activity with the partner link AppsReference
that contains flexfield mapping to invoke the service with selected order data.
Ensure to click the Output tab to specify the output variable.
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*ﬂl Edit Invoke

)

Documentation  Targets  Sources  Skip Condition
General Correlations Properties

Headers
Assertions

Annotations

Mame: |Ir1'u'nke

Conversation ID: |

[ ] Invoke as Detail

Interaction Type: |r._,§ Partner Link *

Partner Link: |Ap1:lsF‘.EFerence

Port Type: |$° AppsReference_ptt

Cperation: | 0y AppsReferenceSelect

Input  Output

() Arguments Mapping| () Input Variable

Input: |IrwckE_.ﬁ.ppsF‘.EFeren::eSeIect_Input’u'ariable

. ok | Cancel

® Associate the third Invoke activity with the File Adapter partner link

WriteSelectOutput to write the output file.
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) Edit Invoke

28]

General Correlations Properties

Documentation = Targets  Sources  Skip Condition  Headers

Assertions

Annotations

Mame: |Irwnke

Conversation ID: |

[ ] Invoke as Detail

Interaction Type: |r._,;s Partner Link "’|

Partner Link: |WriteSelectOutput

Port Type: |$° Write_ptt

Operation: | Ty Write

Input

I

(") Arguments Mapping (%) Input Variable

Input: |Invoke_Write_InputVariable

Help

Apply

0K

Cancel

e Add two Assign activities:

1.

To pass order data containing both key and descriptive flexfields defined earlier
as part of the input payload to the first Invoke activity to invoke the service

AppsReference.

Mapped key and descriptive flexfield column names corresponding to the
flexfield matching segments defined in the Oracle E-Business Suite are

displayed in the Assign activity. See: Assigning Parameters with Key and
Descriptive Flexfields in the Assign Activity, page 4-107.

To pass the output details from the service invocation as input data to the File

Adapter.
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Constructing BPEL Process in SOA Composite

@

receivelnput

Input

Invoke
[y
[{+7

4
by

AppsReference

YY

-5

bpelprocess _clisnt
pep = Invake

Output

Invoke WriteSelectOutput

callbackClient

For more information on how to create design time tasks, see Design-Time Tasks for
Open Interface Tables, page 8-3.

Flexfield Validation in the Schema File

Select the enhanced XSD file (such as AppsReference flex.xsd)in Oracle
JDeveloper and notice that the mapped key flexfields are displayed with type 'flex'
under the Sample_Adapter_KFF, and the mapped descriptive flexfields are displayed
with type 'flex' under the FND_FLEX_TEST flexfield as part of the schema.

For key flexfields, the following table explains the relationship between the key flexfield
mapping data and the actual segments defined in Oracle E-Business Suite:
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Segment Summary for Key Flexfield 'Sample_Adapter KFF'

Key Flexfield Segments Mapped During Key Flexfield Segments Defined in Oracle

Flexfield Configuration E-Business Suite
SEGMENT1 BSB_Number
SEGMENT2 Account_Number
SEGMENTS3 Account_Name

Mapped segment column names for the key flexfield 'BSB_Number', 'Account_Number'
and 'Account_Name' are displayed in the Oracle E-Business Suite Module Browser once
the mapping is complete.
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Mapped Key Flexfield Segments Displayed in the Schema File

L
<schema=

targettlamespace | hitp:lixmins. oracle. comipcbpelfadapter/dbitoplAppsReferenceiflex

Sample_Adapter_KFF

BSB_number
type string240

Sample_Adapter_KFF
type Sample_Adapter KFF

Account_Number

5 type string240

Imm == e ey
1

Account_Name
type string240

BSB_number
type string240

Account_Number
type string240

f
|
0

Account_Name
type string240

FND_FLEX_TEST
type FMD_FLEX_TES

_[ FND_FLEX_TEST

maxLength | 30

maxLength | 240

For descriptive flexfields, the mapped table column names Address Linel,
Address Line2, Address Line3, Town/City, State,and Pin Code are
grouped by context value IN, and Postal Code, Province, City,

Address Linel, Address Line2, and Address_ Line3 are grouped by context
value JP listed in a tree structure. Context value nodes are connected with the <choice>
icon in between indicating that only either one of the context values and its associated
table columns can be selected.
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Mapped Descriptive Flexfield Segments Displayed in the Schema File

Flexfield_Insert .
~| Projects E‘Eﬁ'?'ﬂ:}'
AppsReference-or-ma
AppsReference-prope
[¢2] ONT_OE_HEADERS_IF
=2 BPEL
" g BPELProcess1.bpel
-7 Events
=27 Schemas

[N psReference_flex. )
-3 AppsReference_table
-4 BPELProcess1.xsd

G- testsuites

-7 Transformations

=30 wsDLs

' ------ AppsReference. wsdl
i el onet feacnnn 4 wandl

| Application Resources
-2 Build Files
-7 Connections

{2} Database
+| Data Controls

+| Recent Files

BV E-

5

AppsReference_flex xsd - Struct. ..

12 @
= g%, schema
@5 element - Sample_Adapter_KFF
complexType - Sample_Adapter_Kl
& element - FND_FLEX_TEST
complexType - FND_FLEX_TEST
[*] simpleType - string30
- [2] simpleType - string240

FND_FLEX_TEST

type FND_FLEX_TEST'

FND_FLEX_TEST
ATTRIBUTE_CATEGORY
Address_Line1
type string240

Address_Line2
type string240

Address_Line3
type string240

Address_Line1
type string240

Address_Line2
type ng240

Address_Line3
type string240

k GLOBAL_CTX1

type string240

GLOBAL_CTX2
type string240

k GLOBAL_CTX3

type string240

Assigning Parameters with Key and Descriptive Flexfields in the Assign Activity

In the Assign activity of the BPEL process diagram within the SOA composite
application, the mapped key and descriptive flexfields can be displayed and used to
pass an input variable received from a payload to the Invoke activity for
AppsReference service invocation.
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Displaying Mapped Key and Descriptive Flexfields in the Assign Activity

Q) Edit Assign. s = e g S s &J
General  CopyRules  Annotations ~ Documentation  Targets | Sources  Skip Condition
[tnsert New Rule After | Bk O &= =
_Process1.bpel Invoke insert_Inputyariable (x)EJ
Partner Links OeHeaderslfaceAllCollection [ 2
Variables nis4: OeHeadersIfaceAlCollection @-a
& Process ns+: OeHeadersIfacedll 5=
=13 variables nsé:orderSaurceld [es]-1
(0 nputiariable ns4icreatedey ez}
G- ¥) outputvariabs ns4icreationDate [
() Invoke_insert_Inputiariable ns4:lastlpdatedsy ez}
=[] OeHeadersIfacealCallection ns4ilastUpdateDate [es)
€% nsti0eHeaderslFaceAlCollection nsS:FND_FLEX_TEST [E
B[] ns4:0eHeadersIFaceal nsSATTRIEUTE _CATEGORY fes}- @
e8] nsaordersourceld | <choice > [E]R=]
-[az] nsecreatedey & =)
[es] nss:creationDate nsS:Address_Linet fsl-@
-faz] ns#:lastUpdatedsy nsSraddress_Line2 fes) L
- fea] nstilastlpdatebate ;: % nsSiAddress_Lined [slw - Mapped Descriptive
[ @ [es] ns5:FuD_FLER_TEST nsSiTown-2FCity [} Flexfelds
[ =] resrsample_Adapter KFF ns5:State ez}
(%) Invoke_AppsReferenceselect_Inputvariable ns5:Fin_Code fesl@m |
(x) Invoke_AppsReferenceSelect_Outputvariable < ]
() Invoke \Write_Inputyariabls ns5iPostal_Code
ns3Province
nsSiCity
nsS:address_Linel
nsS:Address_Linez
nsSiaddress_Lined
TisBGLOBAL_CTR DR
nsSHGLOBAL CTXZ ez}
nsGiGLOBAL_CTXG [as}-m
ns5:5ample_Adapter_KFF DN
nsS:BSE_number s} Mapped Key
ns5:Account_Mumbesr ez} Flexfields
nsS:Account_Mame: fs}-m |
Irvoke_appsReferenceSelect_Inputariable (‘,l,‘]
v
+ X @
From To
[ Soutputvariable.payload Bl $Invoke_insert_InputVariable. OeHeadersIfaceAllCollection
Help Apply oK Cancel

In the Assign activity, the mapped key flexfields are displayed under Variables >
Process > Variables > Invoke_Insert_InputVariable > OeHeadersIfaceAllCollection >
ns4:0eHeadersIfaceAllCollection > ns4:OeHeadersIfaceAll >
ns5:Sample_Adapter_KFF.

The mapped descriptive flexfieldd are displayed under Variables > Process >
Variables > Invoke_Insert_InputVariable > OeHeadersIfaceAllCollection >
ns4:0eHeaderslIfaceAllCollection > ns4:0eHeadersIfaceAll > ns5:FND_FLEX_TEST.
Expand the <choice> node to locate the segment values based on selected context value,
either IN or JP.

The target parameters ns5: ATTRIBUTE1 was mapped to the following descriptive
flexfield columns during the descriptive flexfield configuration earlier:

® Address_Linel (under context value <sequence (IN) >)
e Postal Code (under context value <sequence (JP) >)

The target parameters ns5: ATTRIBUTE2 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:
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® Address_ Line2 (under context value <sequence (IN) >)
e Province (under context value <sequence (JP) >)

The target parameters ns5: ATTRIBUTE3 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

® Address_Line3 (under context value <sequence (IN) >)
e City (under context value <sequence (JP) >)

The target parameters ns5: ATTRIBUTE4 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

e Town/City (under context value <sequence (IN) >)
® Address_ Linel (under context value <sequence (JP) >)

The target parameters ns5: ATTRIBUTES was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

e State (under context value <sequence (IN) >)
® Address_Line2 (under context value <sequence (JP) >)

The target parameters ns5: ATTRIBUTE6 was mapped to the following descriptive
flexfield columns during the flexfield configuration earlier:

® Pin Code (under context value <sequence (IN) >)
e Address Line3 (under context value <sequence (JP) >)

Assigning Variables

For the first Assign activity, use the following steps to assign the variables:
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p
O Edit Assign ===

General  CopyRules  Annotations =~ Documentation  Targets  Sources  Skip Condition

[Insert New Rule After + Bk @ &
% BPELProcessl.bpel Varie
[ Partrer Links Process
B3 Variables Wariables B

B Process inputvariable

=[5 Variables outputariable

= §X) inputvariable Invoke_insert_Inputyariable

payload
(%) outputvarisble ) . ns4i0eHeadersTfacasliCallaction

) Irvoke_insert_InputVariable ns4:OeHeadersIFacenl
(%) Invoke_AppsReferencesdlert_InputWariable 'q ; ns+iorderSourceld
#-(x) Irvoke_AppsReferenceSelact_Outputvarisble 1 : ns#icreatedsy
() Invoke Wrike_Inputvariable 2 g nsecreationDate
: i ns+ilastUpdatedBy
ns4ilastUpdateDate
TS5 IFMD_FLEX_TEST Tea]
ns5:Sample_adapter_KFF [es}-
Invoke_appsReferenceSelect_InputVarisble
Invoke_AppsReferenceSelect_Outputiariable
Invaoke_Write_Inputvariable
i + X a3
From To
Help Apply OK Cancel

¢ In the From navigation tree, navigate to Variables > Process > Variables >
inputVariable and select body.

¢ In the To navigation tree, navigate to Variables > Process > Variables >
Invoke_Insert_InputVariable and select OeHeadersIface AllCollection

Drag the source node (body) to connect to the target node
(OeHeaderslfaceAllCollection) that you just specified. This creates a line that connects
the source and target nodes. The copy rule is displayed in the From and To sections at
the bottom of the Edit Assign dialog box.

For the second Assign activity, use the following steps to assign the variables:
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0 Edit Assign * [ LR

= > ®

- )

General Copy Rules Annotations Documentation Targets

|Insert New Rule After ~

£ BPELPracess1.bpel
D Partner Links
=[5 variables
E}ﬁ% Process

-5 Variables
(X)) inputvariable
() outputvarisble
0,‘] Invoke_insert_Inputtariable
- l;)j Inwvoke_AppsReferenceSelect_Inputyarisble
= 0,‘] Invoke_AppsReferenceSelect Oukputyariable
=+-[F] OeHeadersIFacealCallection

E--€¥ ns+OeHeadersIfaceAlCallection

= (3 ns4:0eHeadersFaceal
[ez] ns4:ordersourceld
[es] ns4:creatediy
[ez] ns4:creationDate
«s] ns4:lastUpdatedBy
[es] ns4:lastUpdateDate
[es] nsS:FND_FLEX_TEST
[ez] nss:sample_pdapter_KFF
() Irvoke_wirite_InputVariable

Sources  Skip Condition

B & Q= cf

BPELProces

Partner Li

Variak

Process

Variables (25

inpukYariable @)=
outputYariable @)

Invoke_insert_Inputyariable

OeHeadersTFaceAlCollection [F]-
i Invoke_AppsReferenceSelect_InputVariable 0,‘]
5 Invoke_AppsReferenceSelect_Oukputyariable l;)j
-2

Irwvoke_Write_InputYariable

=]

body [F]-

ns4:0eHeadsrsIfacealCollection
ns4:OeHeadersIFaceAll
nsdorderSourceld
ns4:createdBy
nsicreationDate
ns4:lastlpdatedBy
ns:lastUpdateDate
nsS:FMD_FLEX_TEST
ns5:5ample_Adapter_KFF

From

Help

=B, sinvoke_AppsReferenceSelect_OutputVariable. OeHeadersIfaceAllCollection

B, $invoke Wirite_InputVariable body

Apply OK

Cancel

Since the OeHeaderslfaceAllCollection node variables contained in the Source and
Target are identical, instead of specifying each flexfield, we can simply drag the source
node (OeHeaderslfaceAllCollection) to connect to the target node
(OeHeaderslfaceAllCollection) to complete the second Assign activity.

¢ In the From navigation tree, navigate to Variables > Process > Variables >
Invoke_AppsReferenceSelect_OutputVariable and select

OeHeadersIfaceAllCollection.

¢ In the To navigation tree, navigate to Variables > Process > Variables >

Invoke_Write_InputVariable and select body.

Drag the source node (OeHeaderslface AllCollection) to connect to the target node
(body) that you just specified. This creates a line that connects the source and target

nodes. The copy rule is displayed in the From and To sections at the bottom of the Edit
Assign dialog box.

Click Apply and OK to complete the Assign activity.

Displaying Mapped Key and Descriptive Flexfields at Run Time

After deploying the BPEL process contained in a SOA Composite application to the
Oracle WebLogic managed server (such as 'soa-serverl'), the key and descriptive
flexfields we configured earlier are displayed in the Oracle Enterprise Manager Fusion
Middleware Control Console (http://<servername>:<portnumber>/em).

From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa-serverl) >
default to navigate through the SOA Infrastructure home page and menu to access your
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deployed SOA composite applications (such as 'Insert [1.0]').

Select 'Insert [1.0]' and click Test at the top of the page. The Test Web Service page for
initiating an instance appears.

You can specify the XML payload data to use in the Input Arguments section.

Supplying XML Payload Data
~|Input Arguments

XML View El Enable Yalidation

<spap:Envelope xmins:soap="http://schemas. xmlsoap.org/soap/envelope/ = -
<spap:Body =
<ns1:0eHeadersIfaceAlCollection

wmins:ns1="http: //xmins.orade. com pcbpel fadapter /dbftop /AppsReference™=

<ns1:0eHeadersIfacedll xmins:ns2="http: {fxmins.orade. com pcbpel fadapter /db/top /AppsReferencefflex”=
«<ns1:orderSourceld=10. 23 </ns 1:orderSourceld =

<nsl:createdBy = 10.23</ns l:createdBy =
<ns1:creationDate »2013-03-25T10:08: 10, 325-07:00< /n= 1: creationDate = i
«<ns1:lastpdatedBy > 10. 23« /ns1:lastpdatedBy =
«<ns1:lastpdateDate »2013-03-25T 10:08: 10.325-07:00</ns 1:lastUpdateDate =
=ns2:FND_FLEX_TEST>
<ns 2 ATTRIBUTE _CATEGORY =StringValue < /ns2: ATTRIBUTE_CATEGORY >
«<ns2:Address_Line1=5tringValue </ns2: Address_Linel>
<ns2:Address_Line2=StringValue</ns2: Address_Line2»
<ns2:Address_Line3=StringValue</ns2: Address_Line 3>
<ns2:Postal_Code =StringValue < /ns2:Postal_Code =
<ns2:Province =5tringValue </ns2:Province =
<ns2:City =5tringValue < s 2: City >

<ns2:GLOBAL _CTX 1=5tringValue < /ns2:GLOBAL_CTX 1>
<ns2:GLOBAL _CTX 2=5tringValue < /ns2:GLOBAL_CTX2> -

m

Both key and descriptive flexfield mappings defined earlier are displayed as part of the
input payload fields.
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Mapped Flexfields are Displayed as Part of the Input Payload

ORACLE Enterprise Manager Fusion Middleware Control 12c

Help =

Logout O

Target Navigation
View +
&> £ Application Deployments
7 [ 504
7 T soa-infra
7 &2 soa-nfia (coa_server1)
7 (@) defauit
off§ dff flex_insert [1.0]
rseDetsils [1.0]
off
olff SimpleApproval [1.0]
offf SimpleRest [1.0]
of§ Tesisimplerest [1.0]
V [ webLogic Domain
7 i soainfra
& Adminserver
5l soa_server1
I> [ Metadata Repositories
> [ User Messaging Service

& Insert[1.0] @
off§ SO0A Compasite +

Operation |process =]

Endpoint URL

Request Response

> Security

>/ Quality of Service
>|HTTP Header

> Additional Test Options
~/Input Arguments

Tree View[=]  Enable Validaton

Logged in as weblogic| [5] 2606:b400:2010:4047:216:3eff:fe52:51ee

Page Refreshed Mar 25, 2013 10:53:27 AM PDT

Edit Endpoint URL [

SOAP Body
Name [Type [value
7 = payload OeHeadersifaceAlColection

V DeHeaderslfaceal
7 *Oetieadersifaceall

orderSourceld

eatedsy
Mapped reationDate
Descriptive lastUpdatedBy

Flexfield \ lastlpdateDate
[> FND_FLEX_TEST

OeHeaderslfaceAllaray Size - [ 3

Mon Mar 25 10:08: 10 PDT 2013

Mon Mar 25 10:08: 10 PDT 2013

V S le_Adapter KFF
Mapped ampe ﬂl; T
Ke BSB_number
Flexfield Account_Number
Account_Name

OeHeaderslfaceAll

decimal 10.23
decmal 10.23
datsTime

decmal 10.23
dat=Time

FND_FLEX_TEST

Sample_Adapter_KFF

string StringValue
string StringValue
siring StringValue

4

Displaying Mapped Descriptive Flexfields As Part of the Payload

In the SOAP Body section, expand the Payload > OeHeadersIfaceAll >

OeHeaderslIfaceAll > FND_FLEX_TEST.

4 mnsert[1.0] @
afd SOA Composite ~

>|HTTP Header

»| Additional Test Options

~|Input Arguments

Tree VIE'NE' Enable validation

Logged in as weblogic| E 2606:b400: 2010: 4047: 216: 3eff:fe52:

SOAFP Body
Mame |Type Value
createdBy decimal 10.23
creationDate dateTime Mon Mar 25 10:08:10 PDT 2013
lastUpdatedBy dedimal 10.23
lastUpdateDate dateTime Mon Mar 25 10:08:10 POT 2013
% FND_FLEX_TEST FND_FLEX_TEST

City

Address_Linel

Address_Line2

Address_Line3
Postal_Code
Province

ATTRIBUTE_CATEGORY  siring

string

string

string
string
string
string

StringValue
StringValue
Indude data in request
StringValue
Indude data in request
StringValue
StringValue
StringValue
StringValue

One set of descriptive flexfield configured earlier at the design time are passed as part

of the payload input and displayed at the run time.

FND_FLEX_TEST (context value 'IN")

Mapped
Descriptive
Flexfield

m

Page Refreshed Mar 25, 2013 10:53:27 AM PDT
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e Address_Linel
e Address_Line2
e Address_Line3
e Town/City

e State

e Pin_Code

Displaying Mapped Key Flexfields As Part of the Payload

In the SOAP Body section, expand the Payload > OeHeaderslfaceAll >
OeHeaderslfaceAll > Sample_Adapter_KFF.

Mapped key flexfield (Sample_Adapter_KFF) with the following mapped segments are
displayed as part of the input payload fields:

e BSB_Number

e Account_Number

e Account_Name

Mapped Key Flexfields are Shown as Part of the Input Payload

~|Input Arguments
Tree View [=] Enable Validation

SOAP Body
Name |Type |\u'a\ue
W * payload OeHeadersIfaceAllCollection -
V OeHeadersIfaceal OeHeadersIfaceAllArray Size - | 2
W * OeHeadersIfaceall OeHeadersIfaceAl
orderSourceld decimal 10.23
createdBy decimal 10.23
creationDate dateTime Mon Mar 25 10:08: 10 POT 2013 |
lastlpdatedBy dedimal 10,23 3
lastlpdateDate dateTime Mon Mar 25 10:08: 10 PDT 2013
> FND_FLEX_TEST FND_FLEX_TEST
Mapped W Sample_Adapter_KFF Sample_AdapEr_lfF :
Key BSB_number string StringValue
Flexfields Account_Number string StringValue
Account_Name string StringValue -

4 I b

Enter appropriate data as input payload. Click Invoke to invoke the service

In the Instance ID column, click a specific instance ID to show the message flow through
the various service components and binding components. The Flow Trace page is
displayed.

Click the Insert BPEL Component link to open the instance details.

In the Audit Trail tab, click the <payload> link under the first Invoke activity. The
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payload details is displayed.

Go to the directory (such as \user\tmp) where you specified for the write operation
when defining the File Adapter. Open the output XML file. The data should be the same
as the input details shown in the payload from the first Invoke activity.

The output content is part of a response message for the requestor.

File Edit Wiew Search Terminal Taps Help
sbheemir@slcdlfbe:tmp ¥ | sbheemin@slcolfbe:tmp 3

i} encoding="UTF-8" ?-<OeHeadersIfaceAllCollection =mlns:xsis"http: /v, w3 . org/ 2001 MHL chema- instan|~

ttp://xalng. oracle. comfpcbpelsadaptersdo/top/ InvokeAPI 111>

rsIfaceAlls

sourceld=1162</ordersourcelds
EI

| th:]JtLJE B--.fla U:-datcus-)u:-
<lastlpdatebate~2812-85-10T18:85:30.980-07 :88</lastUpdatebate-
<FHND FL tx TEST xml ns=* htta S i il orgfzaalfx Lschema/flex">

<Pin f.JuL 5531&3 fPin_Code=
</FND_FLEX_TEST= 1
<Sample_Adapter KFF xmlns="http: Nw-uw w3.org/2081/2MLSchema/ Flex">
-cI-hH number>122121</858
= '. _Number=53433<

E I\ﬂIL"'ﬂ.EK" fAccoun

=/Sanple Adapter_KFF=
=/OeHeadersIfacesll>

=/0eHeadersIfaceAllCollection=

“TestFlexInsert caselll.log” [neceol] 23L, 1133C 1,1 Al

Importing an Existing Flexfield Mapping

Instead of configuring a new mapping, you can simply import an existing mapping for
your selected interface. By using a previously configured mapping, you can quickly
establish the flexfield mapping for your interface or use it as a base with proper
modification if needed.

To import an existing mapping, click Import from File in the Configure Flexfields
region. The Open window appears where you can select a desired flexfield mapping.
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Selecting a desired flexfield mapping

ﬂ Cpen lﬂr

O—
O—

Location: |E| F... "| £ {ar CH

oo
==

23 .designer

[C3 dasses

[C3 sCA-INF

£ testsuites

C3 xsd

3 xsl

B HZ_AIA_CUSTOM_PKG_SYMC_ACCT_ORDER_SyncOrder_mapping.xml

|5_"| INV_EBI_ITEM_PUB_PROCESS_ITEM_LIST Process_Item_List_mapping. xml

File Mame; |HZ_AIA_CUSTDM_PKG_SYNC_ACCT_DF‘.DEF‘._Synd]rder_mapping.x|

File Type: | Flexfield Mapping File g

Open Cancel

After selecting the desired mapping to be imported, click Open. The selected mapping
file is automatically displayed in the Import Flexfield Data into the project field.

For example, select
'HZ_AIA_CUSTOM_PKG_SYNC_ACCT_ORDER_SyncOrder_mapping.xml' file and
the imported mapping for the selected API is automatically displayed in the Parameters
with Corresponding Flexfield Mappings region along with the selected mapping file
name.
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Displaying Imported Flexfield Mapping File

- o .
© Oracle Applications Module Browser [E=x
Object Name: [|Tables [ ]views APIs [ JCP [ |XMLGateway [ |EDI [ ]BusinessEvents Search Browse
B[S HZ_AIA_CUSTOM_PKG Parameters with Corresponding Flexfield Mappings
Other Interfa
5[5 Other Interfaces Path Type InfOut Segment Fl... Context Flexfield Name
5[ Custom Objects
ey ~~[E) SALUTATION VARCHAR2  IN
-] ATTRIBUTE_CATEGORY VARCHARZ 1IN De... Hz_LOCATL...
- 82 He_ALA_CUSTOM_PKG (HZ_p0A_ g ATTRIBUTEL VARCHAR2 TN D: ‘ leZ_LDCATI
. GET_ACCT eRGe_08) (65T A B ATTRIBUTE2 VARCHAR2 TN De... HZ_LOCATL...
| . GETMERGE ORG_CLTS (GET | [E ATTRIBUTES VARCHAR2 TN DEM HZ_LOCATL...
I ARYREREE B T [El ATTRIBUTE4 WARCHARZ N DEM HZ_LDCATIM
s SR AEDRORCEUS e [} ATTRIBUTES VARCHAR2 TN De.‘. HZ_LOCATL..
R\ ACCT_ORDER (ST A [ ATTRIBUTES VARCHAR2 TN D:m HZ_ LOCATL...
- B, SYNC_ACCT_UPDATE (SYNC_AC] =
[ ATTRIBUTE? VARCHAR2  IN De... Hz_LOCATL..
[ ATTRIBUTES VARCHAR2 TN De... Hz_LOCATL..
- ATTRIBUTES VARCHAR2 TN
--[E] ATTRIBUTE10 VARCHAR2  IN
~-[E] ATTRIBUTE11 VARCHAR2 TN
[ ATTRIBUTE12 VARCHAR2 TN
- ATTRIBUTE13 VARCHAR2 TN
[} ATTRIBUTE14 VARCHAR2 TN
-] ATTRIBUTE1S VARCHAR2  IN
-] ATTRIBUTE16 VARCHAR2 TN
El aTmne e OrUAR T TR 4
Configure Flexfields
| Flexfield Definitions Edit Delete
Type Application Name Datatype Structure or Context
cripti R |HZ_LOCATIONS HZ_ORGANIZATION BO || -
Flexfield Metadata
HZ_AlA_CUSTOM_PKG_SYNC_ACCT_ORDER_SyncOrder_mapping Import from File Add Mapping
oK Cancel

When a desired mapping is imported for the selected interface, you will need to select
the structure for a key flexfield and context values for a descriptive flexfields.

First, select the key or descriptive flexfield in the Flexfield Definitions section that

requires modification, and then click Edit

. The Flexfield Subflow - Welcome page is

displayed. Click Next to select the desired flexfield context values if it's for a descriptive

flexfield.
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Selecting the Context Values for Imported Mapping
[Z] Flexfield SubFlow - Step 6 of 6 =S

Configure Flexfields

Select the Structure or Context{s) and dick Finish,
Application: Receivables

Flexfield Name: HZ_LOCATIONS

Context : |“}‘u | Query

| ]chile
i [#|Ecuador
Global Data Elements

Help Finish Cancel

Click Finish to complete the descriptive flexfield mapping information. The updated
descriptive flexfield context value (Ecuador) is now added both in the Parameters with
Corresponding Flexfield Mappings region and Flexfield Definitions section.
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@) Oracle Applications Module Browser I@

Object [Name: El [JTables []Views APIs  [JCP [ ]¥MLGateway [ |EDI [ ]BusinessEvents Search Browse

([ HZ_AIA_CUSTOM_PKG

Parameters with Corresponding Flexfield Mappings
- [& Other Interfaces

(& Custom Gbjects Path Type InfOut Segment Flexfield... Context Flexfield N...
&[5 PLSQL APIs i -8l STATUS VARCHARZ ~ IN
= HZ_ATA_CUSTOM_PKG (HZ_ATA_CLY [l CATEGORY_CODE VARCHARZ N
B GET ACCT MERGE OBI (GET A El SALUTATION VARCHARZ IN
"B GET MERGE ORG. CUSTS (GET [El ATTRIBUTE_CATEGORY VARCHARZ  IN Descriptive [Ecuador = |HZ_LOCATL...
b e e s e [l ATTRIBUTEL VARCHARZ ~ IN Zone Descriptive HZ_LOCATL..
Yy [El ATTRIBUTEZ VARCHARZ ~ IN Parroquia Descriptive HZ_LOCATL...
5 T e El ATTRIBUTEZ VARCHARZ N Descriptive HZ_LOCATL...
i“‘ ECTACETTTATE (SIICTAL El ATTRIBUTE4 VARCHARZ IN Descriptive HZ_LOCATL...
. i - [E ATTRIBUTES VARCHARZ N Descriptive HZ_LOCATL...
[l ATTRIBUTES VARCHARZ ~ IN Descriptive HZ_LOCATL...
[El ATTRIBUTE? VARCHARZ ~ IN Descriptive HZ_LOCATL...
El ATTRIBUTES VARCHARZ N Descriptive HZ_LOCATL...
[El ATTRIBUTES VARCHARZ IN
[El ATTRIBUTE10 VARCHARZ ~ IN
[E ATTRIBUTE11 VARCHARZ ~ IN
[l ATTRIBUTE12 VARCHARZ ~ IN
Bl ATTRIBUTEL3 VARCHARZ ~ IN
[l ATTRIBUTE14 VARCHARZ N
i [El ATTRIONTEAC nruAnn ThL
Configure Flexfields
i Flexfield Definitions
Type Application Name Datatype Structure or Context
Descriptive Flexfield AR HZ_LOCATIONS HZ_ORGAMNIZATION BO  [Ecuador  =|
Flexfield Metadata
HZ_AIA_CUSTOM_PKG_SYNC_ACCT_ORDER_SyncOrder_mapping. xml Import from File Add Mapping
oK Cancel

Use the same approach to update the key flexfield that requires structure information
before clicking OK.

For more information on how to modify the selected mapping details, see Modifying
Flexfield Mapping Definitions, page 4-119.

Modifying Flexfield Mapping Definitions
Oracle E-Business Suite Adapter allows you to modify flexfield mapping definitions for
both key and descriptive flexfields as often as needed. However, modification is only
limited to context values for a descriptive flexfield or flexfield structure for a key
flexfield. If further update is needed in addition to modifying structure or context
values, you should delete the flexfield mapping first and configure a new one.

Modifying Flexfield Mapping Data

To modify flexfield mapping data, select either the Key Flexfield or Descriptive
Flexfield in the Flexfield Definitions section that you want to modify and then click Edit
. Appropriate flexfield pages corresponding to your selected flexfield type appear
where you can modify the flexfield mapping details.
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Modifying Flexfield Mapping Data

@ Oracle Applications Module Browser [E
Object Name: [HZ_AIA_CUSTOM_PKG | [Izables [ ]vews apls  [JcB [|xMcateway []EDI [ ]BusinessEvents search | [ Browse
B HZ_ATA_CLISTOM_PKG Parameters with Corresponding Flexfield Mappings
5 Other Interfaces path Type Injout Segment Flexfield Type Context Flexfield Name
=-(& Custom Objects S
i) FA_LOCATION_NUMBER N
EHPEENE 5] TIVEZONE_ID  NUMBER N
-7 HZ_ALA_CUSTOM_PKG (HZ_ALA_CL - = —
- B GeT_AceT peRGE_08) (TN B ATRIBUTEL  vARCHARZ Region Desu CATIONS
B cem_ence oR.cusTs (GeT| [E ATTIRIBUTEZ  VARCHAR2 n C ; D: pu CATIONS
- B ceT_paRTy MeRGe oe%s (T [E] ATTRIBUTES  VARCHAR2 N o DesmpnvE CATIONS
i &, GET_RELATED_ORG_CUST_OBX: e =
H T = [E] ATTRIBUTES  VARCHAR2 N Descriptive HZ_LOCATIONS
LA e [E] ATTRIBUTES  VARCHAR2 N Desariptive HZ_LOCATIONS
(] ATTRIBUTEG  VARCHAR2 N Descriptive HZ_LOCATIONS
(] ATTRIBUTE7  VARCHAR2 N Descriptive HZ_LOCATIONS
--E ATTRIBUTES  VARCHAR N Descriptive HZ_LOCATIONS
--[E] ATTRIBUTES  VARCHARZ N Descriptive HZ_LOCATIONS
[E] ATTRIBUTE1D  VARCHAR2 N Descriptive HZ_LOCATIONS
[E] ATTRIBUTE1L VARCHAR2 N Desariptive HZ_LOCATIONS
(] ATTRIBUTE12 VARCHAR2 N Descriptive HZ_LOCATIONS
(] ATTRIBUTE13  VARCHAR2 N Descriptive HZ_LOCATIONS
- ATTRIBUTE4  VARCHARZ N Descriptive HZ_LOCATIONS
--[E] ATTRIBUTELS  YARCHARZ N Descriptive HZ_LOCATIONS
[E] ATTRIBUTESS  VARCHAR2 N Descriptive HZ_LOCATIONS
[E] ATTRIBUTE1? VARCHAR2 N Descriptive HZ_LOCATIONS
(] ATTRIBUTEIS  VARCHAR2 N Descriptive HZ_LOCATIONS
[ ATTRIBUTE1S  VARCHAR2 N Descriptive HZ_LOCATIONS
-+E ATTRIBUTEZ0  VARCHARZ N Descriptive HZ_LOCATIONS
++[E] PROGRAM_UPDIDATE N
Configure Flexfields
Fiexfield Definitons
Type Application Name Datatype Structure or Context
IDescriptive Flexfield AR HZ_LOCATIONS HZ_LOCATION_CB] [chie
Fiexfield Metad:
|| tmport fromFie || Add Mapping
[ ok | | concel

For example, modify the structure of the descriptive flexfield (HZ_LOCATIONS). The
Configure Flexfields window appears after you click Next in the Flexfield Subflow
Welcome wizard.
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Flexfield Subflow - Configure Flexfields

| £| Flexfield SubFlow - Step 6 of 6

Configure Flexfields

Select the Structure or Context{s) and dick Finish.
Application: Receivables

Flexfield Mame: HZ_LOCATIONS

Context : |% || Query |

[ ]chile
[+|Ecuader
Global Data Elements I

| Help | | Einish ” Cancel |

Click Query and select the 'Ecuador’ check box only as the context value. Click Finish to
complete the modification. The updated flexfield information should be reflected in the

Flexfield Definitions section.

Validating Modified Flexfield Mapping Data

Configure Flexfizlds

Flexfield Definitions | Edit || Delete |

Type Application MNarme Datatype Structure or Context

Descriptive Flexfield HZ_LOCATIONS HZ_ORGANIZATION_BO  [[Eo¥ENIN M
[Ecuador

You can also validate the changes in the flexfield configuration xml file (
<projectname> flex-config.xml).See: Reviewing Flexfield Mapping

Configurations, page 4-122.
For more information on how to configure or add each Flexfield Subflow window, see
Adding or Configuring a New Flexfield Mapping, page 4-37.

Deleting Flexfield Mapping Data

To delete flexfield mapping data, select either the Key Flexfield or Descriptive Flexfield
that you want to delete and then click Delete. This removes the selected flexfield

Oracle E-Business Suite Adapter Concepts 4-121



mapping data and the associated structure or values from the database.

Alternatively, use [Control] and [Shift] keys to select multiple flexfield mappings before
the deletion.

Reviewing Flexfield Mapping Configurations

After creating a partner link with flexfield mapping information, from Oracle
JDeveloper, expand the SOA > Schemas folder and select the enhanced XSD file, for
example ProcessItem KFF flex.xsd, to validate the flexfield mapping information
you configured or updated earlier.

The enhanced schema information is displayed with flexfield segment names based on
the mapping chosen at the design time.

Viewing an Enhanced XSD File

L
=5chemas

targetflamespace | http:icmins.oracle.comfpcbpelfadapterdbispiProcessitem_KFFflex

System_ltems

ltem
type flex:stringd0

System_ltems =
type flex:System_Items

type flexstring40

maxLength |40

Additionally, two xml files are created along with the XSD file. Expand the SOA >
Adapters folder to view the file details:

¢ Mapping XML: The mapping xml file (for example
INV_EBI ITEM PUB PROCESS ITEM LIST ProcessItem KFF mapping.xm

1) would hold the mapping information captured in the mapping wizard panel.
This information can be reused for the same API and can be imported from another
Partner Link.
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Viewing Key Flexfield Mapping Details
ist1_flex.xsd X | [¢2]ProcessLineListl_flex-config.oml x |EDN_EB]_HIM_PUB_PRD(ES_HEM_LISI_PW,NDW"H x| [&lsyncorder Overview x |ofScomg (][]

=] <keyFlexfields>

=]

=] mappings>

=]
< /MApping
< /mapping>

| < /mapping:
< /mappings
</keyFlexfield>
< /keyFlexfields>
< /flexfieldMapping:

$G)
<7xml wersion = '1.0' encoding = 'IUTF-3' 2%
= <flexfieldMapping packageName="INVY_EEI_ITEM PUB" procedureName="PROCESS_ITEM LIST" owmer="APPS" overload="-1"x

<keyFlexfield name="3ystem Itemz" flexfieldTableName="NTL_3¥3TEM ITEM3 B applicationflame="INV" dataType="INV_EEI ITEM_ PUE

<mapping nappingld="SEGMENTS!E#SEGMENT3! @#INV_EBI_ITEM PUB:INY EEI_ITEM MAIN OBJ">
<FlexFieldTableColunn colunnName="SEGMENT3" columnId="3384458" columnKey="SEGMENTS!@#338448" f£flsageCode="K"/>
<parameter arquuentNames="SEGMENTI" position="26" sglType="VARCHARZ" dataType="IN¥_EBI_ITEM PUE:INV_EEI_ITEM MAIN

= <mapping mappingld="SEGMENTZ ! B#SEGMENTZ! B#INV_EBT_TTEM PUB:INV_EET ITEM MATH OBJ">
<FlexFieldTableColumn columnfame="SEGMENTZ” columnId="338§447" colunnKey="SEGMENTZ!@#335447" ffUsageCode="K"/>
<parameter arquuentName="JEGMENTZ" position="25" sglType="VARCHARZ" dataType="IN¥_EBI_ITEM PUE:INV_EBI_ITEM MAIN

=] <mapping neppingld="SECMENTL!B#SECMENTL!@4INV_EBI_ITEM PUE:INV_EBI_ITEM MAIN 0BT
<FlexFieldTableColumn colunnName="SEGMENT1” columnId="338446" columnKey="SEGMENTL!H#336446" ffUsageCode="K"/>
<parameter arguuentName="SEGIMENT1” position="Z4" sqlType="VARCHARZ" dataType="IN¥ EBI_ITEM PUB:INV_EBEI_ITEM MATN

Another mapping example (ONT OE HEADERS IFACE All mapping.xml)is for
the open interface table we defined earlier. This example contains the mappings for
both key and descriptive flexfields:

Viewing Key and Descriptive Flexfield Mapping Details

Applications
Flexfield_Insert - |
=I Projects & @ 7-E-
=23 Adapters
i [e3] Appsheference_apps.jca
- [oo] AppsReference_flex-config.xml
+-l[2) Appsheference-or-mappings. xml
- [e2] AppsReference properties.xml
-[¢9] fileReference_file jca
[e2] ONT_OE_HEADERS IFACE_ALL_ma
- fea] writeselectoutput_file jea
- BPEL
i~ Events

=) Application Resources

[ Build Files

[ Connections

@[ 7] Descriptors

[ Libraries

{3 service Bus System Resources

| Data Controls
I Recent Files

Q- [ Find

..FF g BPELProcesslbpel &% AppsReference_tablessd &% AppsReference_flex.xsd | [2] ONT_OF_HEADERS_IFACE _ALL_mapping.xm (%)
TR

'UTF-8"2>
"OF_HEADERS_IFACE ALL" OITableOwner="ONT™>

2xml version = '1.0" encoding

E <flexfieldiapping OITableNam
E  <descriptiveFlexfields>

& «descriptiveFlexfield na
«mappings> <mapping

<contextColumn columnla
</descriptiveFlexfield>

</descriptiveFlexfields>

FND_FLEX_TEST"
mapping> </mappings>
TTRIBUTE_CATEGORY" columnId="339742" columnKey="RTTRIBUTE CATEGORY!@#339742

ieldTableName="FND_FLEX_TEST" applicationMame="FND" f

B  <keyFlexfields>
a <keyFlexfield name="Sample Adapter KFF" flexfieldTableName="FND FLEX TEST DEFINITIONS" applicationName="FN
g <mappings>
a <mapping mappingld="SEGMENT2!@4TE_ATTRIBUTI

<FlexFieldTableColumn columnName="SEGHE]

<0ITableColumn columnName="TE ATTRIBUTE.

</mapping>

<mapping mappingId=" ... '8#208"/> </mapping>
<mapping map) 184211"/> </mapping>
<mapping mappingTd . 184210"/> </mapping>
a <mapping mappingld="SEGMENTS'@4TPE_ATTRIBUTES">

<FlexFieldTableColunn colurnName="SEGMENTS" columnId="976241" columnl EGMENTS!B4976841" £fll=a
<0ITableColumn columnName="TP_ATTRIBUTES" columnld="212" datalype="VARCHAR2" columnKey="TP_ATTRIB
</mapping>
</mappings>
</keyFlexfield>
</keyFlexfields>
</ flexfielddapping>

For information on how to import the flexfield mapping for a selected API or open
interface table, see Importing an Existing Flexfield Mapping, page 4-115.

Config XML: The config xml (for example

OE_ORDER PUB PROCESS LINE GL Flexfield flex-config.xml)has the
flexfield information including both key and descriptive flexfield mappings if
configured. This is not reusable.

Please note that config xml is internal to the partner link, it should neither be edited

nor reused.
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Viewing Flexfield Configuration Details

wfield.xsd IEIOE_ORDER_PUB_PR(N:ES_LI!E_GL_H&:M_WDM x | [?]Processltem_flex-config.sml % | &) wv_g (40

L@h- P |
<zxml wersion = 'l.0' encoding = 'UTF-§':>»

= «<flexfieldMapping packageNauwe="0E_0RDER_PUE" procedureName="PROCESS_LINE™ owmer="APPS™ owerl
= <descriptiveFlexfields>

= <descriptiveFlexfield name="FND_FLEX VALUES" flexfieldTableName="FND_ FLEX WALUES™ appl
CRAPPINGE> <RAPPIRY ... RAPPING> </ WEAPPINGS>
<ocontextColumn colunnfane="VALUE CATEGORY" columnId="£02" columnFey="VALUE CATEGORY
</descriptiveFlexfield:
< /descriptiveFlexfields:
= <keyFlexfields>:
= <keyFlexfield name="CGL Ledger Flexfield" flexfieldTableName="GL_CODE_COMEINATIONS™ app
CHAPPINGSF <RAPPLIRY ... RAPPINGs </ WEPPINGS>
< /keyFlexiield-
< /keyFlexfields:>
</ flexfieldMapping:-

Logging
Oracle E-Business Suite Adapter implements the Oracle SOA Suite's logging framework
to write the diagnostic log files in text format. Therefore, whenever the Oracle
E-Business Suite services are invoked using Oracle E-Business Suite Adapter, the log
messages are recorded which can be accessed by system administrator. This enriches
the problem identification mechanism to track any issues during service invocations at
run time for Oracle E-Business Suite Adapter.

Oracle E-Business Suite Adapter and technology adapters implement the LogManager
interface of JCA Binding Component, which redirects the log files for both inbound and
outbound interactions to the soa-diagnostic. log file in the Oracle Diagnostic
Logging (ODL) format. These log files record all types of events including startup and
shutdown information, errors and warning messages, access information on HTTP
requests, and additional information. It provides a quick, inside-out view about the
invocation process which greatly helps administrators identify and resolve potential
issues efficiently. With proper log-level configuration in Oracle Enterprise Manager
Fusion Middleware Control Console, you can view ODL level log files written to a
single file at run time for Oracle E-Business Suite Adapter as well as technology
adapters.

To better understand how the logging mechanism work, the following topics are
discussed in this chapter:

¢ Enabling Logging for Adapters, page 4-125
¢ Searching and Viewing Adapter Logs, page 4-129

For more information about SOA Suite, see Oracle Fusion Middleware Administrator’s
Guide for Oracle SOA Suite.
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Enabling Logging for Adapters

All logs of Oracle E-Business Suite Adapter and technology adapters are redirected to
the soa-diagnostic. log file in the Oracle Diagnostic Logging (ODL) format. To be
able to view logs for Oracle E-Business Suite Adapter, you need to set or enable an
appropriate message type and its associated log level for the logger
oracle.soa.adapter using the Oracle Enterprise Manager Fusion Middleware
Control Console. This enables the log settings at the Oracle SOA Suite level.

Note: The logger configuration is under
SFMWHOME /user projects/domains/soainfra/config/fmwco

nfig/servers/soa serverl/logging.xml and the
corresponding logger name for all Oracle JCA Adapters is called
oracle.soa.adapter.

The following table lists the diagnostic message types and log levels:

Note: For each message type, possible values for message level are from
1 (highest severity) through 32 (lowest severity). Some components
support only some of the levels for each message type. Generally, you
need to specify only the type; you do not need to specify the level.

The default message type for each logger is set to NOTIFICATION,

level 1.
Message Type Level Description
INCIDENT_ERROR 1 A serious problem that may

be caused by a bug in the
product and that should be
reported to Oracle Support.

Examples are errors from
which you cannot recover or
serious problems.
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Message Type Level Description

ERROR 1 A serious problem that
requires immediate attention
from the administrator and is
not caused by a bug in the
product.

An example is if Oracle
Fusion Middleware cannot
process a log file, but you can
correct the problem by fixing
the permissions on the

document.

WARNING 1 A potential problem that
should be reviewed by the
administrator.

NOTIFICATION 1 A major lifecycle event such

as the activation or
deactivation of a primary
subcomponent or feature.

NOTIFICATION 16 A finer level of granularity for
reporting normal events.

TRACE 1 Trace or debug information
for events that are meaningful
to administrators, such as
public API entry or exit
points.

TRACE 16 Detailed trace or debug
information that can help
Oracle Support diagnose
problems with a particular
subsystem.

TRACE 32 Very detailed trace or debug
information that can help
Oracle Support diagnose
problems with a particular
subsystem.

To set the diagnostic message type and log level for Oracle E-Business Suite Adapter
in Oracle SOA Suite:
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Use the following procedures to set the message type and its associated log level:

1. Navigate to http://<servername>:<portnumber>/em.
The Oracle Enterprise Manager Fusion Middleware Control Console home page is
displayed.

2. Enter username and password to log on to the console.

3. Right-click soa-infra from the SOA Folder in the Navigator tree.

4. Select Logs > Log Configuration from the pop-up menu.

Note: You can also access the Log Configuration page by clicking
the SOA Infrastructure Menu and selecting Logs > Log
Configuration from the drop-down menu.

This opens the Log Configuration page where you can view a list of loggers
(persistent or active run time) and configure the Oracle Diagnostic Logging (ODL)
level for setting the amount and type of information to write to a log file and the log
level state.

5. Select the Log Levels tab.

6. Select one of the following values from the View drop-down list:

¢ Runtime Loggers (default): Runtime loggers are automatically created during
run time and become active when services are getting executed. For example,
oracle.soa.b2bor oracle.soa.bpel are runtime loggers. Log levels for
runtime loggers are not persistent across component restarts.

¢ Loggers with Persistent Log Level State: Persistent loggers are loggers that are
saved in a configuration file and become active when the component is started.
The log levels for these loggers are persistent across component restarts.

Note: By default, the log level is set for Runtime Loggers. Runtime
loggers do not persistent across when a component restarts. To
ensure that log levels persist across component when it restarts,
select Loggers With Persistent Log Level State from the View list.

7. Expand the oracle.soanode to locate oracle.soa.adapter runtime logger in
the Logger Name list. Select the logging level from the Oracle Diagnostic Log Level
drop-down list. For example, select TRACE:32 (FINEST)'.

8. Click Apply.

Creating and Editing Log File in the Log Files Tab
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You can edit a specific log file by clicking the log handler link displayed in the Log File
column. This opens the Log Files tab where you can configure the basic and advanced
log configuration settings. These settings include handler's name, the log file in which
the log messages are logged, the format of the log messages, the rotation policies used,
and other parameters based on the log file configuration class.

For example, select the log handler from the table and click Edit Configuration. The
Edit Log File dialog box is displayed.

* To change log file location, enter a new path in the Log Path field.

* To configure message levels, select the logging level from the Log Level drop-down
list. For example, select TRACE:32 (FINEST)'.

¢ To configure log file rotation, in the Rotation Policy section, select either Size Based
or Time Based log file with appropriate information.

Fore more information on how to configure log file, see the Managing Log Files and
Diagnostic Data Chapter, Oracle Fusion Middleware Administrator’s Guide.

For more information about SOA Suite, see Oracle Fusion Middleware Administrator’s
Guide for Oracle SOA Suite.

Automatic FND Logging for PL/SQL APIs and Concurrent Programs Using oracle.soa.adapter Runtime
Logger

Based on the log level set for oracle. soa.adapter runtime logger in Oracle SOA
Suite, logging can be automatically controlled or enabled for PL/SQL APIs and
Concurrent Programs while these interfaces are invoked during run-time execution.
There is no need to enable the FND logging framework on the Oracle E-Business Suite
side separately.

Note: This automatic FND logging would be available in Oracle
E-Business Suite Release 12.1.3 and above only.

The following table lists the log level mapping between oracle.soa.adapter
runtime logger and the corresponding Oracle E-Business Suite:

Runtime Logger oracle.soa.adapter Log Oracle E-Business Suite Log Level
Level

INCIDENT_ERROR LEVEL_UNEXPECTED

ERROR LEVEL_ERROR

WARNING LEVEL_EXCEPTION
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Runtime Logger oracle.soa.adapter Log Oracle E-Business Suite Log Level

Level

NOTIFICATION 1, 16, 32 LEVEL_EVENT
TRACE 1 LEVEL_PROCEDURE
TRACE 16, 32 LEVEL_STATEMENT

Searching and Viewing Adapter Logs

Oracle E-Business Suite Adapter and technology adapters implement the LogManager
interface of JCA Binding Component, which redirects the log files written to a single file
at run time in the Oracle Diagnostic Logging (ODL) format.

For both outbound and inbound interactions, the log files are redirected to the single
file sca-diagnostic.log.

The log files for Oracle SOA Suite that is deployed to the server-soa managed server

are located in
MW HOME/user projects/domains/<domain name>/servers/server-soa/l

ogs/soa-diagnostic.log.

To search and view Oracle E-Business Suite Adapter log files, you can use Oracle
Enterprise Manager Fusion Middleware Control Console, the WLST displayLogs
command-line tool, or you can download log files to your local client and view them
using another tool (for example a text editor, or another file viewing utility). For
information on how to use WLST command-line tool to search and view log files, see
the Managing Log Files and Diagnostic Data Chapter, Oracle Fusion Middleware
Administrator’s Guide.

Steps to Search and View Adapter Logs Using Oracle Enterprise Manager Fusion Middleware Control
Console

Use the following steps to search Adapter Logs through the Oracle Enterprise Manager
Fusion Middleware Control Console:

1. Navigate to http://<servername>:<portnumber>/em.

The Oracle Enterprise Manager Fusion Middleware Control Console home page is
displayed.

2. Enter username and password to log on to the console.

3. There are two ways to access the Log Messages page from the Navigator tree in the
left pane:
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e From the SOA folder, right-click soa-infra.
e From the WebLogic Domain folder, right-click soainfra.

Select Logs and then View Log Messages from the pop-up menu. The Log
Messages page is displayed with the Search section and a table that shows a
summary of the messages with default search criteria.

4. Enter the following search criteria for searching the log messages for Oracle
E-Business Suite Adapter:

¢ Date Range: Select your value from the drop-down list and enter an
appropriate number. For example, 'Most Recent' 6 hours.

If 'Time Interval' is selected from the drop-down list, select the calendar icon for
Start Date and then select the date and time. Similarly, select the calendar icon
for End Date and then select the date and time.

* Message Types: Select one or more of the message types. For example, select
the Trace check box if it is the message type configured earlier for Oracle
E-Business Suite Adapter.

* Message: Select 'Contains' from the list of values and then enter 'Oracle
E-Business Suite Adapter' in the text box.

® Specify more search criteria if needed in the Search section.

You can optionally add more search criteria by clicking Add Fields. This action
allows you to add more criteria, such as Host, which lets you narrow the search
to particular hosts. Then click Add.

5. Execute the search by clicking Search. All messages that match your search criteria
will be retrieved and displayed in the table. These messages can be displayed as
messages, or can be grouped by message type or message ID depending on the
selected value in the Show field.

6. Click one of the log messages from the table. The selected message details, such as
message level, component, ECID (Execution Context ID), Relationship ID, actual
message, are displayed below the table of messages.

Clicking the ECID link retrieves related messages with the same ECID in the
Related Messages by ECID page. For more information on related messages, see
Correlating Messages Across Log Files and Components, page 4-131.

7. Select an appropriate output option from the Export Messages to File drop-down
list if you want to export log messages as a Oracle Diagnostic Log Text file (.txt)

XML file (.xml), or Comma-Separated List (.csv) file.

8. Click Target Log Files to open the Log Files page where you can view a list of log
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files related to the managed server (server-soa).

1. Select a file and click View Log File. The View Log File page is displayed for
the selected log file where you can view a list of messages contained in this log.

2. To view the details of a message, select the message. The message details, such
as message level, component, ECID, Relationship ID, actual message, are
displayed below the table of messages.

3. To view messages that are related by time or ECID, click View Related
Messages and select 'by Time' or by 'ECID (Execution Context ID)'.

Alternatively, clicking the ECID link directly from the message details also
retrieves related messages with the same ECID in the Related Messages by
ECID page.

Correlating Messages Across Log Files and Components

Oracle Fusion Middleware components provide message correlation information for
diagnostic messages. Message correlation information helps those viewing diagnostic
messages to determine relationships between messages across components. Each
diagnostic message contains an Execution Context ID (ECID) and a Relationship ID.

An ECID is a globally unique identifier associated with the execution of a particular
request. An ECID is generated when the request is first processed. A Relationship ID
distinguishes the work done in one thread on one process from the work done by any
other threads on this and other processes on behalf of the same request.

While viewing log messages in the Oracle Enterprise Manager Fusion Middleware
Control Console, you can view correlated messages by selecting a log message first, and
then selecting one of the following values from the View Related Messages drop-down
list:

Note: The View Related Messages selection is available only when
‘Messages' is chosen in the Show field when displaying all matching
messages based on search criteria. If 'Group by Message Type' or
'‘Group by Message ID' is selected in the Show field, then all matching
messages are displayed by groups based on message type or message
ID. In this situation, the View Related Messages field is not available.

* by Time: This displays the Related Messages by Time page where all messages with
the same timestamp as the selected message are displayed in this page.

e by ECID (Execution Context ID): This displays the Related Messages by ECID page
where all messages with the same ECID as the selected message are displayed in
this page.

By searching for related messages using the message correlation information, multiple
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messages can be examined and the component that first generates a problem can be
identified. Message correlation data can help establish a clear path for diagnosing errors
generated in the API being invoked.

Enhanced Error and Exception Handling

In order to identify the root cause of an issue or error which might occur during
invocation of an Oracle E-Business Suite interface, Oracle E-Business Suite Adapter
provides user-friendly, descriptive exceptions and error messages. Especially, these
would be available during invocation of any PL/SQL APlIs.

Apart from handling errors during adapter preprocessing and the run-time execution
by Database Adapter and AQ Adapter, it also provides a way to retrieve the functional
errors raised by PL/SQL APIs at run time, without the need for an extra call to retrieve
them. These messages would guide you to pinpoint the cause of failures at run time.

Additionally, based on the common logging framework used by other JCA Adapters,

all errors and exceptions pertaining to Oracle E-Business Suite Adapter and debug
information will be logged. This allows administrators or developers to better
understand what happened during the execution and take necessary actions to solve the
issue.

Handling Functional Errors

During the invocation of an integrated interface supported by Oracle E-Business Suite
Adapter, in case of issues or errors occurred (such as the entered order number does not
exist while invoking OE ORDER_PUB.CHANGE ORDER API), an exception (
ORA-20100: Order number does not exist)would be thrown and such
exception consists of functional errors. This type of exception is used extensively to
report functional problems while executing the API.

For most PL/SQL APIs, functional errors can be thrown as SQLException caught by
Adapter runtime engine along with code and message or as part of API output
parameters. However, certain PL/SQL APIs do not throw functional errors during
execution, but they keep on accumulating them in the memory stack. The responsibility
of fetching the errors is deferred to the caller of the APIs.

For example, HRMS APIs put functional errors in FND_MESSAGE stack using
FND MSG_ PUB.put package. Upon completion of the API call, the caller must
explicitly fetch the errors from this stack using FND MSG PUB.GET () methods.

Note: Error messages can only be retrieved from the stack
FND MSG _PUB in this release.

For such APIs that require explicit handling, a new JCA property called
APIErrorHandler is introduced to fetch functional errors from the FND_MESSAGE
memory stack.
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At run time, if the JCA property is set, the error handler will be invoked right after the
execution of the PL/SQL API. If this returns one or more errors, then Oracle E-Business
Suite Adapter will throw runtime exception. The exception handler, such as catchAll
fault handler, can be used to process the messages coming out of this function.

Please note that the following functional error handling parameter needs to be added to
the WSDL file (XX _apps . jca) for fetching the functional errors for such APIs:

<property name="APIErrorHandler"
value="FND MSG PUB.GET DETAIL" />

Example of Error Handling Using APIErrorHandler JCA Property
SOA Composite Application with BPEL Process Scenario

This example uses a PL/SQL API called Create Project (

PA PROJECT PUB.CREATE PROJECT) to explain how to use the APIErrorHandler
JCA property along with the catchall fault handler to catch any faults which might
occur during the service invocation.

At run time, if the service invocation is executed successfully, a project should be
created in Oracle Projects by using an existing project. If any error occurs, the
catchAll fault handler will catch the error messages. These messages will be written
in an xml file.

Functional Requirement

To successfully create a project in Oracle Project using the PL/SQL API (
PA PROJECT PUB.CREATE PROJECT), the following functional requirement must be
in place:

* An existing project is associated with a template in Oracle Project.
¢ Avalid Oracle E-Business Suite user who has the responsibility to create a project in
Oracle Project, and that user must have the privilege to execute this

PA_PROJECT PUB.CREATE PROJECT APL

This example includes the following design-time activities:
1. Create a main process to invoke the Create Project service through a partner link

¢ Create a partner link for the Create Project API
* Add an Invoke activity to invoke the API
* Add an Assign activity to assign the input for the service invocation

e Add another Assign activity to assign the output for the service invocation

2. Add a CatchAll process on the main process you just created to catch faults if occur
during the service invocation
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* Create a file adapter with "Write File" as the operation type
* Add an Assign activity to pass the faults from the catchall fault handler

¢ Add an Invoke activity to invoke the file adapter partner link to write the error
messages in an xml file

SOA Composite Application with BPEL Process Creation Flow

Based on the process scenario, the following design-time tasks are explained in this
section:

1. Create a new SOA Composite application with BPEL process, page 4-134
2. Create a Partner Link, page 4-136

3. Create a Partner Link for File Adapter, page 4-137

4. Add a CatchAll Activity on the Main Scope, page 4-139

5. Create Invoke Activities, page 4-140

6. Create Assign Activities, page 4-143

Deploying and Testing the Composite Application

Once you complete the design-time activities, deploy the composite application and test
it to see if the output file generated by the file adapter contains the faults.

See Validating and Testing SOA Composite Application with BPEL Process, page 4-149.

For the payload information on creating a project, see Sample Payload for Creating a
Project, page 4-153.

Creating a New SOA Composite Application

Use this step to create a new SOA composite application that will contain various BPEL
process activities.

To create a new SOA composite application with BPEL process:

1. Open Oracle JDeveloper.

2. Click New Application in the Application Navigator.
The "Create SOA Application - Name your application” page is displayed.

3. Enter an appropriate name for the application in the Application Name field and
select SOA Application from the Application Template list.

Click Next. The "Create SOA Application - Name your project” page is displayed.
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Enter an appropriate name for the project in the Project Name field, for example,
TestProjectCreation.

In the Project Technologies tab, select 'Web Services' and ensure that SOA is
selected from the Available technology list to the Selected technology list.
Click Next. The "Create SOA Application - Configure SOA settings" page is
displayed.

Select Composite With BPEL from the Composite Template list, and then click
Finish. You have created a new application, and a SOA project. This automatically
creates a SOA composite.

The Create BPEL Process page appears.

Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

F |
@) Create BPEL Process @

BPEL Process |_:|

A BPEL process is a service orchestration, based an the BPEL specification, used to describefexecute a ﬁ
business process (or large grained service), which is implemented as a stateful service.

—

() BPEL 2.0 Specification |

L

1 BPEL 1.1 Specification

Mame: |TE5tProjech:reaﬁon |

Mamespace: |htt|:u:,|’fxmlns.orade.cc:-m;’APIErrorHandIer,fte5tpru::-jecbﬂ'eaﬁonﬁestPrnjecb:reaﬁnn |

Directory: |C:UDevelo|:|Er‘n,rn\,rwork‘n,.B.PIErrorHandler‘n,tesiq:rojechu’eaﬁon‘n,SDA‘n,BPEL | Q&

Template: |§ Synchronous BPEL Process "| g

Service Mame: |be5u:urojectcreaﬁon_dient |

Expose as a SOAP service

Transaction: |required "| g

Input: |ﬂxmlns.orade.::cmfnPIErrorHandlerftesu:lrojectcreah’onfTestProjectCreaﬁon}process| Q&

Output: |'ade.com,.’.ﬁ.PIErrorHandIer,.’tesu:lrojectcreaﬁonﬂ'estProjectﬂreaﬁon}processResponse| Q&-

Help oK Cancel

Enter an appropriate name for the BPEL process in the Name field. Select
Synchronous BPEL Process in the Template field. Select 'required’ from the
Transaction drop-down list and click OK. A synchronous BPEL process is created
with the Receive and Reply activities. The required source files including bpel and
wsdl, using the name you specified and the associated composite are also
generated.
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. % @
testprojectcreation_...

Operations:
process

Creating a Partner Link

Use this step to create a partner link called CreateProjectpi for the PL/SQL API
that will be invoked later.

To create a partner link:

1.

Drag and drop Oracle Applications from the BPEL Services list into the right
Partner Link swim lane of the process diagram. The Adapter Configuration Wizard
Welcome page appears. Click Next.

The Adapter Configuration Wizard Welcome page appears.

Enter a service name in the Service Name field. For example, CreateProjectApi.
Click Next. The Service Connection dialog appears.

Specify your database connection and proceed to the Oracle Applications Module
Browser.

Locate the PL/SQL API in the Oracle Applications Module Browser by navigating to
Projects Suite (P]_PF) > Projects (PA) > Project (PA_PROJECT) > PLSQL > Project
Definition (PA_PROJECT_PUB) to select Create Project

(PA_PROJECT_ PUB.CREATE PROJECT).

For information about Oracle Applications Module Browser, see Understanding the
Oracle Applications Module Browser, page 4-14.
In the Application Interface page, click Next.

In the Finish page, click Finish to complete the process of configuring Oracle
E-Business Suite Adapter.

The wizard generates the CreateProjectApi.wsdl file corresponding to the
CreateProjectApi sp.xsd schema. This WSDL file is now available for the
partner link.

Select the Partner Link Type and Partner Role fields from the drop-down lists. Click
Apply and then OK to complete the partner link configuration.

To fetch the functional errors for the API you just created as a partner link:

Navigate to SOA > Adapters folder and double click the
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CreateProjectApi apps.jca. Add the following functional error handling
parameter to the CreateProjectApi apps. jca file and save the changes:

<property name="APIErrorHandler"
value="FND MSG PUB.GET DETAIL"/>

Applications  Appiication Servers | ...sdl | (@] TestProjectcraation.wsd writeError.wedl | % CreateProjectapi_sp.xsd CreateProjectApi_apps.ica 7
= = =

5] APIErrartindier ~ = || Q- Find AR E .
=I Projects Bl - T-E- & kadapter-config name="CreateProjectApi” adapter="apps" wsdllocation="../WSDLs/CreateProjectipi.vsdl” xmlns="http:

{5] AP1ErrorHandier

&5 restrroectcreaton <comection-factory ULConnectio eis/apps/EBS11i" UIConcurrentPgulame="" UlOra

50504 B  <endpoint-interaction p teProjectApi prt” reateProjectipi”>
&[] Adapters 5 ey G e T e e e e
i-.-[3] CreateProjectApi_apps.ica ;Dh:ma[l;me )
WriteError_fle jca ackageName

Procedurelane
IRepInternalll
Username” ve

_PROJECT"/>

i--[B] XX_BPEL_CREATEPROJECTAPI_drop.sd UB: CREATE_FROJECT"/>

[B] xx_BPEL_CREATEPROJECTAPLsql

D@ea Responsibility rojects, Visien Services (USA)"/>
(] Events RPTErrorHandler” value="FND_MSG_PUB.GET_DETATL"/> |

{3 schemas <7interaction-specs

[ 7) testsuites </endpoint-interaction>

i [ Transformations

3 wsoLs </adapter-config>

i+l measurements.xml
off§ TestProjectCreation

Source | History il

Creating a Partner Link for File Adapter
Use this step to configure a BPEL process by writing the output to a text file.

1. In Oracle JDeveloper, drag and drop the File Adapter service from the BPEL
Services list into the right Partner Link swim lane of the process diagram. The
Adapter Configuration wizard welcome page appears.

2. Click Next. The Service Name dialog box appears.
3. Enter a name for the file adapter service, for example WriteError.
4. Click Next. The Adapter Interface dialog box appears.

5. Select the Define from operation and schema (specified later) radio button and
click Next. The Operation dialog box appears.

6. Specify the operation type, for example Write File.
This automatically populates the Operation Name field.
Click Next to access the File Directories dialog box.

7. For the Directory specified as field, select Physical Path. Enter directory path, such

as /usr/tmp/, in the Directory for Outgoing Files field. Specify a naming
convention for the output file, such as pa_%SEQ%_%yyMMddHHmmss%.xml.

Oracle E-Business Suite Adapter Concepts 4-137



L Y
@ FILE Adapter Configuration Wizard - Step 5 of 7 M

File Configuration

Spedfy the parameters for the Write File operation.

Directory specified as () Physical Path () Logical Name
Directary for Outgoing Files (physical path):
|,.fusr,.ft11|:| Browse

File Maming Convention (po_%SEQ %6, bet): ||:la_%SEQ%_%wMMddHHmmss%.xml

[ Append to existing file
Write to output file when any of these conditions are met
Mumber of Messages Equals: |1 =
|
Help < Back MNext = Cancel

Click Next. The Messages dialog box appears.

Select Browse for schema file in front of the URL field. The Type Chooser window
is displayed.

1.

Click the Import Schema Files button on the top right corner of the Type
Chooser window.

Click the Browse Resources button in the Import Schema File window to add
the Error.xsd file to the schema. Select the Copy to Project check box. Click OK.
Select the Maintain original directory structure for imported files Copy

Options check box and click OK.

The selected Error.xsd is displayed as URL and the Exception element is
selected as Schema Element.
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L Al
@) FILE Adapter Configuration Wizard - Step 6 of 7 M

Messages
Define the message for the Write File operation. Specify the Schema File Location and select the Schema Element
that defines the messages in the outgoing files. Use the Browse button to find an existing schema definition. If you
check 'Schema is Opaque’, then you do not need to specfy a Schema.
Message Schema
[] Mative format translation is not required (Schema is Opague)
URL | .[Schemas Error.xsd | Q i
Schema Element [Exception v]
Help < Back Mext = Cancel
. Fl

9. Click Next and then Finish. The wizard generates the WSDL file corresponding to
the partner link. The main Create Partner Link dialog box appears, specifying the
new WSDL file WriteError.wsdl.

Click Apply and then OK to complete the configuration and create the partner link
with the required WSDL settings for the File Adapter Service.

The WriteError Partner Link appears in the BPEL process diagram.

Adding a CatchAll Activity on the Main Scope

This step adds a CatchAll activity to catch any faults if occur during the invocation
process.

1. In the expanded Scope activity of the Oracle JDeveloper, click the Add CatchAll
icon.
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b @

Add CatchAll L ciyetrput

2. You can find that a CatchAll activity is created in the right side of the main scope
activity.

= O &

P_ Catchall

receivelnput

replyCutput

O

Creating Invoke Activities
This step is to configure two Invoke activities in order to:

* Invoke the CreateProjectApi partner link service.

* Invoke the WriteError file adapter partner link that in turn writes the error
messages in a output file.

To add an Invoke activity for CreateProjectApi Partner Link:

1. In Oracle JDeveloper, expand the BPEL Constructs from the Component Palette.
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Drag and drop the Invoke activity from the Component Palette into the center
swim lane of the process diagram, between the receiveInput and replyOutput
activities.

Link the Invoke activity to the CreateProjectApi service. The Edit Invoke dialog
box appears.

Enter a name for the Invoke activity, such as InvokeCreateProjectAPL

In the Input tab, click the Create icon next to the Input Variable field to create a
new variable. The Create Variable dialog box appears.

Enter a name for the variable. You can also accept the default name. Ensure the
Global Variable radio button is selected and click OK.

Oracle E-Business Suite Adapter Concepts 4-141



© Edit Invoke eS|

Documentation  Targets  Sources  Skip Conditon  Headers
General Correlations Properties Assertions Annotations

Mame: |InvukECreatePrujectAPI |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type: |f.,,§3_$ Partner Link "|

Partmer Link: |CreateProjectApi | Ck
Port Type: |$° CreateProjectApi_ptt "|
Operation: | Gy CreateProjectApi -
Input  Quiput
() Arguments Mapping (=) Input Variable 71}
Input: |CreatePrujectApi_Input‘u'ariable | Ei Ck
i Help Apply oK Cancel

5. Select the Output tab. Use the same method mentioned in step 4 to create an output
variable.

6. Click Apply in the Edit Invoke dialog box.
Click OK in the Edit Invoke dialog box to finish configuring the Invoke activity.

The Invoke activity appears in the process diagram.

To add the second Invoke activity for WriteError File Adapter Partner Link:

1. In Oracle JDeveloper, expand the BPEL Constructs from the Component Palette.
Drag and drop the second Invoke activity from the Component Palette into the
center swim lane of the CatchAll process diagram.

4-142 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



2. Link the Invoke activity to the WriteError service. The Edit Invoke dialog box
appears.

3. Follow the instructions described in step 4 of the first Invoke activity to create the
input variable for this Invoke activity.

© Edit Invoke eS|

Documentation  Targets  Sources  Skip Condition  Headers
General Correlations Properties Assertions Annotations
Mame: |In'u'oke'|.’l.|'riteEx|:Epﬁon |
Conversation ID: | |
[ ] Invoke as Detail
Interaction Type: |5,,ﬁ_% Partrer Link *
Partmer Link: |'|.I'l.|'riteErmr | Q
Port Type: |"df|'° Write_ptt v|
Operation: | Gy Wirite =
Input
i1 Arguments Mapping (=) Input Variable &)
Input: [Invoke _Write_Exception_InputVariable | 4 Q%
R Help Apply OK Cancel

Click Apply and then OK in the Edit Invoke dialog box to finish configuring the
Invoke activity.

The second Invoke activity appears in the process diagram.

Creating Assign Activities
This step is to configure three Assign activities:

1. To pass the input information to the CreateProjectApi service through the
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Invoke activity.

2. To pass the output information from the CreateProjectApi service through the
Invoke activity.

3. To pass the faults caught through the CatchAll activity as the input to the
WriteError file adapter.
To add the first Assign activity in the main scope:

1. In Oracle JDeveloper, expand the BPEL Constructs from the Component Palette.
Drag and drop the Assign activity into the center swim lane of the process diagram,
between the receiveInput and Invoke activities.

2.  Double-click the Assign activity to access the Edit Assign dialog box.

3. Click the General tab to enter the name for the Assign activity, such as
'‘Assignlnput'.

4. Select the Copy Rules tab and expand the source and target trees:
¢ In the From navigation tree, navigate to Variables > Process > Variables >

inputVariable and select payload.

¢ In the To navigation tree, navigate to Variables > Process > Variables >
CreateProjectApi_InputVariable and select InputParameters.

Drag the source node (payload) to connect to the target node (InputParameters) that
you just identified. This creates a line that connects the source and target nodes. The
copy rule is displayed in the From and To sections at the bottom of the Edit Assign
dialog box.
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5.

i @ Edit Assign [

General = CopyRules | Annotations =~ Documentation — Targets = Sources  Skip Condition

|Insert New Rule After = E w Q = 3
i TestProjectCreation bpel TestProjectCreation.bpel gk
D Partner Links Partnet Links D
=3 Variables Yarisbles [5-=
E}ﬁga Process Process ﬁaaE\
=53 variables L ” variables (51

%) inputvariable inputyariable )-®

-[] payload tputyarisble )=

(X) outputvariable CreateProjectapi_InputVariable )=
m CreateProjectApi_Inputvariable b S InputParameters D
G-4X) CreateProjectApi_Outputyariable K i CreatePrajectipl_Outputyariable )=
(,\j Invoke_Write_Exception_InputVariable Invoke_‘Write_Exception_InputYariable (x)

+ X & 3

From

[} $inputvariable payload [, $CreateProjectApi_Inputvariable. InputParameters

Help Apply Ok Cancel

The Edit Assign dialog box appears.
Click Apply and then OK to complete the configuration of the Assign activity.

To add the second Assign activity:

1.

Add the second Assign activity by dragging and dropping the Assign activity from
the BPEL Constracts section of the Component Palette into the center swim lane of
the process diagram, between the Invoke and replyOutput activities.

Repeat Step 2 to Step 3 described in creating the first Assign activity to add the
second Assign activity called 'AssignOuput'.

Select the Copy Rules tab and expand the source and target trees:
¢ In the From navigation tree, navigate to Variables > Process > Variables >

CreateProjectApi_OutputVariable and select OutputParameters.

* In the To navigation tree, navigate to Variables > Process > Variables >
outputVariable and select payload.

Drag the source node (OutputParameters) to connect to the target node (payload)
that you just identified. This creates a line that connects the source and target nodes.
The copy rule is displayed in the From and To sections at the bottom of the Edit
Assign dialog box.
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- 5
@ Edit Assign s

General  CopyRules  Annotations =~ Documentation =~ Targets = Sources  Skip Condition

|InsertNew Rule After v Ef“! O &= =
535 TestProjectCreation. bpel TestProjectCreation.bpel ﬁg.
- [ Partner Links Partner Links [_-&
-5 Variables variables [23-2
& da Process Process ga-&
-3 varizbles variables (232
h‘) inputy ariable i 5 inputYariable m

(%) outputvariable : : oukputyariable @)=
().‘) CreateProjectapi_Inputyariable ’ payload D
/ CreateProjectapi_InputVariable
- : CreateProjectapi_OutputYariable

h‘) Invvoke_‘Write_Exception_Inputtariable . . Invoke Write_Exception_Inputariable

B

+ R4 3
From To
ﬁ, SCreateProjectApi_OutputVariable. OutputParameters E] Soutputvarizble.payload
Help Apply OK Cancel

4. Click Apply and then OK to complete the configuration of the Assign activity.

To add the third Assign activity in the CatchAll activity:

1. Add the third Assign activity by dragging and dropping the Assign activity from
the BPEL Constracts section of the Component Palette into the CatchAll process
diagram, before the Invoke activity.

2. Repeat Step 2 to Step 3 described in creating the first Assign activity to add the
second Assign activity.

3. Inthe Edit Assign dialog, enter the first parameter:

® (lick the Expression icon to invoke the Expression Builder dialog.
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© Expression Builder

e

editors below the Expression field.

Expression:

Build an expression by typing directly into the Expression field, using Ctrl+Space for XPath assistance, and/for insert fragments from the fragment

/0

substring-before(substring-after {ora: getFaultAsString (), Following error occurred while executing the APL), "API returned an error™)

BPEL Variables

# Insert Into Expression

W A

Functions

|5 wariables
E}ﬁ?‘a Process
-3 variables
{x) inputvariable
() outputvariable
ﬁ,’) CreateProjectapi_Inputyariable
ﬁ,’) CreakeProjectApi_Oukpubyariable
ﬁ,’} Invake_Write_Exception_InputYariable

|Shing Functions

ﬂ compare-ignore-case
] concat

OJ contains

h create-delimited-string
mR| ends-with

Content Preview:

| format-strinn

|xp20:compare0

I Description:

Help

Returns the lexicographical difference between inputString and compareString comparing the unicode value of each character of
both the strings. Returns -1 if inputString lexicographically precedes the compareString, Returns 0 if both inputString and
comparestring are equal. Returns 1 if inputString lexicographically follows the compareString. Usage: xp20:comparefinputstring as

OK

Cancel

Enter

substring-before (substring-after (ora:getFaultAsString(),"F
ollowing error occurred while executing the API"),"API

returned an error") in the Expression box. Click OK.

The Expression icon with the expression value appears in the center of the Edit

Assign dialog, between the From and To navigation tree nodes.

* Inthe To navigation tree, navigate to Variables > Process > Variables >
Invoke_Write_Exception_InputVariable > body > ns4:Exception and select

ns4: message string.

Drag the Expression icon to connect to the target node (ns4: message string) that
you just identified. This creates a line that connects the source and target nodes. The
copy rule is displayed in the From and To sections at the bottom of the Edit Assign

dialog box.
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O Edit Assign

==

General  CopyRules  Annotations = Documentation =~ Targets  Sources  Skip Condition

|Insert Mew Rule After +

& TestProjectCreation.bpel
-3 Partner Links

=3 variables
=g Process
B2 variables
(t) inputvariable inputvariable
(t) outputyariable outputyariable

AT

& Q =
TestProjectCreation.bpel &
Partner Links [
Variables [£3-2
Process g izl
variables (532
@)

Help

(t) CreateProjectApi_InputYariable CreateProjectApi_Inputyariable
ﬂ!’) CreateProjectApi_Outputy ariable CreateProjectApi_Outputtariable
m Invoke_Write_Exception_InputWariable Invoke_Write_Exception_InputVarisble
ns4:Exception
ns4: ge string @3-
....... i
+ R @ 3
From To
ﬂ. substring-before(substring-after{ora:getFaultAsString(, Following error ocou, .. E{. &Invoke_Write_Exception_InputVariable. body/ns4:message
Apply ‘ oK Cancel

4. Click Apply and then OK to complete the configuration of the Assign activity.
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Complete BPEL Process Flow

Partrer Links Partner Links

= «

o \ 4
> Catchall

receivelnput

Assignl
..

AssignInput :
o B

WriteError

{a: ] TnwokeWriteFxran. .. "{a
e ! >

testprojectereation_clisnt CreatePraiectisi
prel — InvokeCreatePrai. ., reateProjectApi

AssignOutput

replyOutput

O

Click the TestProjectCreation to display the Oracle JDeveloper composite

diagram:
-3
CreateProjectApi
Operations:
CreateProjectApi
testprojectcreation_...
Operations:
D o
process O {%
WriteError
Operations:
Write

Validating and Testing SOA Composite Application with BPEL Process
Deploying the SOA Composite Application with BPEL Process
After creating the BPEL process contained in the SOA Composite application at the
design time, you need to deploy the SOA Composite with BPEL process first and then

manually test the process in the Oracle Enterprise Manager Fusion Middleware Control
Console (http://<servername>:<portnumber>/em).
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Important: Before deploying the SOA Composite with BPEL process
using Oracle JDeveloper, you must have established the connectivity
between the design-time environment and the runtime server. Ensure
that you have configured Oracle E-Business Adapter on your Oracle
SOA Suite server to handle the service invocation. For configuration
details, see:

¢ Configuring the Data Source in Oracle WebLogic Server, page 11-
1

® Creating Connection Factory for Oracle E-Business Suite Adapter,
page 11-7

¢ Creating the Application Server Connection, page 11-10

1. To deploy the SOA Composite application, in Oracle JDeveloper select the SOA
Composite project in the Applications window. Right-click the project name, such
as TestProjectCreation, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

Applications - | Application Servers | bs O} TestrojectCreation | gk TestProjectCreation.bpe! | (@] CreateProjectApiwsdl  [@] TestProjectCreationwsdl...
[ ArmErrontiander T 7| [famanprocess v|# G (02 IE-@- - S-@ P W > oo E@a‘
Sfrmiects S R Partner Links = Partner Links
[ APrErrorHandler O &
- [3] TestProjectcreal
ERmES Mew D o

[ Adapters|  Edlit Project Source Paths..

o [Oeeee |3 Delete Project ‘c

e Testy Catchal

»
i [ events 204 D =
=1 Schemas @8 Find Broject Files receivelnput
[ o i Y N [ I A R -} s, S
o Errar, AR

Show Classpath (
B Tesy  Show Overview i
i

i

{3 testsuite: b ‘ \AEA
{7 Transfor b - R A (R B e B

[ wsbls | Make TestProjectCreation.jpr igninput [ {g-
- \all measuren) §5 Rebuild TestProjectCreation.jpr e
ool Teseron e
> Run .. -
W Debug - - TnunketWriteFyren o
Compare With » E=E InvokeCreateProj. .. CreateProjectApi
Replace With »

Restore from Local History i

[; Check Code Compliance ‘i‘
[ Build Files AssignOutput
[ Comnectans | (&I Project Properties..
[ Descriptors
[ Libraries
[ service Bus System Resources

replyOutput

= Application Resources

Create SOA Template

| Data Contrels
+| Recent Files

For example, you can select Deploy > TestProjectCreation > soa-serverl if you have
the server connection set up properly.

2. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.

3. Inthe SOA Servers page, accept the default target SOA Server ('soa-serverl’)
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selection.

Click Next and Finish to start the deployment process.

You can check for successful compilation in the SOA - Log window, and verify that the
deployment is successful in the Deployment - Log window.

Validating and Testing the Deployed SOA Composite

In the Oracle Enterprise Manager Fusion Middleware Control Console, from the Farm
base domain, expand the SOA >soa-infra to navigate through the SOA Infrastructure

home page and menu to access your deployed SOA composite applications running in
the SOA Infrastructure for that managed server. Click the SOA Composite application
that you want to initiate from the SOA Infrastructure. Click Test at the top of the page.

In the Test Web Service page, specify the XML payload data to use in the Input
Arguments section. Enter the input string required by the process and click Test Web
Service to initiate the process.

The test results appear in the Response tab upon completion.

In the Response tab, click the Launch Message Flow Trace link to view the result
details. The Flow Trace page appears.

Flow Trace @ @
This page shows the flow of the message through various composite and component instances. Flow ID 180002
Started Mar 17, 2015 9:38:06 AM

Faults Composite Sensor Values =~ Composites

View v Flow Instance 180002
Error Message Fault Owner Fault Time Recovery
@ BINDING.JCA-12563 Exception occurred when binding was invoked. Exception occurred during invocatio ,553 TestProjectCreat Mar 17, 2015 9:38... C’ Recovered
@ request-response conversation has timed out for component = default/TestProjectCreation!1.0%soa_961 "i'zﬁ testprojectcreati Mar 17, 20155:38.. @ Nonrecoverable

Columns Hidden 8

Trace
Actions » View = Show Instance IDs

Instance Type Usage State Time Composite

@ Service 9{’8 Service €3 Failed Mar 17, 2015 9:38:06 AM TestProjectCreation [1.0]
ﬁxd TestProjectCreation BPEL &) Failed Mar 17, 2015 9:38:06 AM TestProjectCreation [1.0]
= Reference o] Reference & Failed Mar 17, 2015 9:38:06 AM TestProjectCreation [1.0]

-1 Reference ] Reference «# Completed Mar 17, 2015 9:38:08 AM TestProjectCreation [1.0]

If any error occurred during the test, you should find it in the Faults tab.

Click the TestProjectCreation link in the Trace region to view the invocation details in
the Audit Trail tab.
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. - P (2
ﬁga Instance of TestProjectCreation @ @
This page shows BPEL process instance details. Instance I 180005

Started Mar 17, 2015 9:38:06 AM

Audit Trail Flow Sensors

Actions = View = Highlight Faults [

4 receiveInput

Received "process” call from partner "testprojectcreation_client”
View Payload
B AssignInput
Updated variable "CreateProjectfpi_InputVariable"
pleted assign

(¥
| [T} InvokeCreateProjectAP1 (fmm:T

Started invocation of operation "CreateProjectapi” on partner "CreateProjectapi”.
Faulted while invoking operation "CreateProjectApi” on provider “CreateProjectApi”,

View Payload

%] Assign1
Updated variable "Invoke_Write_Exception_InputVariable"
Completed assign

4% InvokeWriteException
Started invocation of operation "Write" on partner "WriteError”.
Invoked 1-way operation "Write" on partner "WriteError".

View Payload

BPEL process instance “1B80005" completed

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

For example, click the "InvokeCreateProjectAPI (faulted)" to view the faults.

BINDING.JCA-12563

Exception occurred when binding was invoked.

Exception occurred during invocation of JCA binding: "JCA Binding
execute of Reference operation 'CreateProjectApi' failed due to: API
Execution Error.

Following error occurred while executing the API

"PA PROJECT PUB.CREATE PROJECT": "1.
PAPA FUNCTION SECURITY ENFORCEDNEND ERROR LOCATION FIELDNFND MESSAGE TYP
EE

"

API returned an error.
Correct the inputs for the API call. Contact oracle support if error is

not fixable.
"

The invoked JCA adapter raised a resource exception.
Please examine the above error message carefully to determine a
resolution.

Additionally, verify the faults collected through the file adapter partner link during the
service invocation. For example, go to the outputDir (/usr/tmp/) you specified for the
write operation during the file adapter partner link creation. Open the output file (such
as pa_%SEQ%_%yyMMddHHmmss%.xml) which contains the following faults:
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<part name="detail">

<detail>API Execution Error.

Following error occurred while executing the API
"PA PROJECT PUB.CREATE PROJECT": "

1. PA PA FUNCTION SECURITY ENFORCED N

FND ERROR LOCATION FIELD

FND MESSAGE TYPE E".

API returned an error.

Correct the inputs for the API call. Contact oracle support if error is
not fixable.

</detail>

</part>

<part name="code">

<code>EBzA-201</code>

</part>

Sample Payload for Creating a Project

The following information shows the sample payload in creating a project in Oracle
E-Business Suite:
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<soap:Envelope xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/">
<soap:Body>
<nsl:InputParameters
xmlns:nsl="http://xmlns.oracle.com/pcbpel/adapter/db/sp/EBSReference">
<nsl:P_API_VERSION_NUMBER>1.0</nsl:P_API_VERSION_ NUMBER>
<nSl:P_COMMIT>F</nSl:P_COMMIT>
<nsl:P_INIT MSG _LIST>T</nsl:P_INIT MSG LIST>
<ns1:P_PM PRODUCT CODE>MSPROJECT</nsl1:P_PM PRODUCT CODE>
<nsl:P_PROJECT IN>
<nsl:PM PROJECT REFERENCE>AGL-AMG Project
6</nsl:PM_PROJECT REFERENCE>
<nsl:PROJECT NAME>AGL-AMG Project 6</nSl:PROJECT_NAME>
<nsl:PAﬁPROJECTiNUMBER>SAGIR—P6</ns1:PAﬁPROJECTiNUMBER>
<nsl:CREATED_FROM_PROJECT_ID>lOO5</nsl:CREATED_FROM_PROJECT_ID>

<nsl:CARRYING_OUT_ORGANIZATION_ID>478</nSl:CARRYING_OUT_ORGANIZATION_ID>
<nsl:PROJECT STATUS CODE>ACTIVE</nsl:PROJECT STATUS CODE>
<nsl:DESCRIPTION>TaskDesc</nsl:DESCRIPTION>
<nsl:STARTiDATE>2014—Ol—OlTOO:OO:OO</nSl:START7DATE>
<nsl:COMPLETION_DATE>2018—12—31TOO:OO:OO</nSl:COMPLETION_DATE>

<nsl:PROJECT_RELATIONSHIP_CODE>Primary</nS1:PROJECT_RELATIONSHIP_CODE>
</nsl:P_PROJECT IN>
<nsl:P KEY MEMBERS>
<nsl:P_KEY MEMBERS ITEM>
<nsl:PERSON_ID>2960</nsl:PERSON ID>
<nsl:PROJECT ROLE TYPE>PROJECT MANAGER</nSl:PROJECT_ROLE_TYPE>
</nsl:P _KEY MEMBERS ITEM>
</nsl:P_KEY MEMBERS>
<nsl:P_CLASS_CATEGORIES>
<nsl:P_CLASS CATEGORIES ITEM>
<ns1:CLASS CATEGORY>Construction</nsl:CLASS CATEGORY>
<nsl:CLASS CODE>New Building</nsl:CLASS_CODE>
</nsl:P_CLASS CATEGORIES ITEM>
<nsl:P CLASS CATEGORIES>
<nsl:P_TASKS IN>
<nsl:P_TASKS IN ITEM>
<nsl:PMﬁTASKiREFERENCE>l</nsl:PMﬁTASKﬁREFERENCE>
<ns1:PA_TASK NUMBER>1</nsl:PA TASK NUMBER>
<nsl:TASKﬁDESCRIPTION>Plant function</nsl:TASKiDESCRIPTION>
<nsl:PM_PARENT_TASK_REFERENCE></nSl:PM_PARENT_TASK_REFERENCE>
</nsl:P_TASKS IN ITEM>
<nsl:P_TASKS IN ITEM>
<nsl:PMﬁTASKiREFERENCE>l.l</nsl:PMﬁTASKiREFERENCE>
<nsl:PA_TASK NUMBER>1.1</nsl:PA TASK_NUMBER>
<nsl:TASK DESCRIPTION>Plant function</nsl:TASKiDESCRIPTION>
<nsl:PM_PARENT_TASK_REFERENCE>1</ns1:PM_PARENT_TASK_REFERENCE>
</nsl:P_TASKS IN ITEM>
</nsl:P_TASKS IN>
<nsl:P_ORG ROLES/>
<nsl:P_STRUCTURE_IN/>
<nsl:P_EXT ATTR TBL IN/>
</nsl:InputParameters>
</soap:Body>
</soap:Envelope>
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Secured Connection Between Oracle E-Business Suite and Oracle Fusion
Middleware SOA Suite Using J2EE Data Source Implementation

By implementing the J2EE Data Source for secured connection between Oracle
E-Business Suite and Oracle SOA Suite, two distinct advantages can be leveraged.
Firstly, to get the secured connection to the Oracle E-Business Suite's application
database, you do not require Apps/Apps-equivalent schema's username and password,
just EFND username and password (concept of Oracle E-Business Suite username and
password) is sufficient. Secondly, since the password is not stored in the middleware,
not only this eliminates the security risk, but also does away the need to keep the
password in-sync between Oracle E-Business Suite and SOA Suite.

Oracle E-Business Suite Adapter authenticates users at run time and gets the connection
to Oracle E-Business Suite databases through the use of J2EE data sources. This
approach is native to Oracle E-Business Suite in defining the connection pool to access
the application database.

Account details information including application login user name and password that
was required as part of the configuration for database connection is added together
with the dbc file location as input parameters during the J2EE data source creation.

To accomplish this process, the following steps are used to define J2EE data source
connection to the Oracle E-Business Suite database:

1. Register your Service-Oriented Architecture (SOA) suite middle tier node on the
Oracle E-Business Suite environment and generate the dbc file used by the data
source implementation to instantiate the connections.

2. Copy the dbc file to the middle tier server where your SOA suite server runs, and
place it on a location in the file system to which the SOA suite owner has access.

3. Create a connection pool where you need to enter the application login user name,
password, and dbc file location as the connection factory properties.

4. Create an application data source. This is the step that you associate the application
data source with the Java Naming and Directory Interface (JNDI) name for the
application database connection for Oracle E-Business Suite Adapter.

To enable the native Oracle E-Business Suite connectivity using J2EE data sources
feature,

Note: To have this feature available, the minimum requirement for
Oracle E-Business Suite Release 11i is 11i. ATG_PF.H.Delta.6 (RUP6)
and for Oracle E-Business Suite Release 12 is 12.0.4 release.

Additionally, you must apply necessary patches to enable the
connectivity between Oracle E-Business Suite and an external
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application server. See My Oracle Support Knowledge Document
787637.1 for details.
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5

Using XML Gateway

This chapter covers the following topics:

Overview of XML Gateway

Design-Time Tasks for XML Gateway Inbound Messaging
Creating a New SOA Composite Application with BPEL Process
Creating a Partner Link

Adding a Partner Link for the File Adapter

Configuring the Invoke Activities

Configuring the Assign Activity

Run-Time Tasks for XML Gateway Inbound Messaging
Deploying the SOA Composite Application with BPEL Process
Testing the SOA Composite with BPEL Process

Verifying Records in Oracle E-Business Suite

Design-Time Task for XML Gateway Outbound Messaging
Creating a SOA Composite Application with BPEL Process
Adding a Partner Link

Adding a Receive Activity

Adding a Partner Link for File Adapter

Adding an Invoke Activity

Adding an Assign Activity

Run-Time Task for XML Gateway Outbound Messaging
Deploying the SOA Composite Application with BPEL Process
Testing the SOA Composite Application with BPEL Process

Troubleshooting
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Overview of XML Gateway

Oracle E-Business Suite Adapter provides a bridge between Oracle E-Business Suite and
third party applications. Inbound and outbound XML data is exchanged between
Oracle E-Business Suite and third party applications through the XML Gateway.

Oracle XML Gateway provides a common, standards-based approach for XML
integration between Oracle E-Business Suite and third party applications, both inside
and outside your enterprise. XML is key to an integration solution, as it standardizes
the way in which data is searched, exchanged, and presented thereby enabling
interoperability throughout the supply chain.

Oracle XML Gateway is an XML messaging based integration infrastructure essentially
for business partner integration which includes a set of services that allows easy
integration between Oracle E-Business Suite and third party applications. Oracle
E-Business Suite utilize the Oracle Workflow Business Event System to support
event-based XML message creation and consumption.

Oracle E-Business Suite Adapter can be configured to use XML Gateway to interact
with third party applications. The tight integration provided by open interface tables is
not suitable for those scenarios where trading partners change frequently. XML
Gateway is an ideal solution when you need to interact with third party applications
that use open standards. Moreover, it is also suitable for scenarios where trading
partners change frequently.

Standards-Based Messaging

As a provider of broad based business application solutions to support all industries,
Oracle XML Gateway supports all Document Type Definition (DTD) based XML
standards. The majority of the Oracle prebuilt messages delivered with Oracle
E-Business Suite are premapped using the Open Application Group (OAG) standard.
Any Oracle prebuilt message map may be remapped to your standard of choice using
the XML Gateway Message Designer.

Integration Architecture

XML Gateway provides an application integration infrastructure that is flexible enough
to accommodate the integration requirements of any application that needs to integrate
with Oracle E-Business Suite. XML Gateway enables you to create an efficient and
responsive supply chain that links all customers, factories, warehouses, distributors,
carriers, and other trading partners. All these entities can seamlessly operate as a single
enterprise.

Oracle XML Gateway supports both Business-to-Business (B2B) and
Application-to-Application (A2A) initiatives. B2B initiatives include communicating
business documents and participating in industry exchanges. An example of an A2A
initiative is data integration with legacy and disparate systems.
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XML Gateway enables bidirectional integration with Oracle E-Business Suite by
allowing you to insert and retrieve data from Oracle E-Business Suite. Oracle E-Business
Suite Adapter for XML Gateway supports inbound and outbound XML Gateway
message processing. For XML Gateway inbound message processing, the inbound
message will be placed in the ECX_INBOUND queue. Agent Listeners running on
ECX_INBOUND would enable further processing by the Execution Engine. Oracle XML
Gateway picks this XML message, does trading partner validation, and inserts data into
Oracle E-Business Suite. For XML Gateway outbound message processing, the
outbound message will be first enqueued to the ECX_OUTBOUND queue. Oracle BPEL
PM listens to ECX_OUTBOUND queue for the message with the same correlation Id
BPEL. The message will then be dequeued to retrieve outbound data from Oracle
E-Business Suite. The retrieved data can be passed to trading partners or consumers
who subscribed to the message.

XML Gateway Integration Architecture

Common Integration
Framework

Oracle Applications
= Caplure Business Events
= Apply Business Rules

i F 3
XML Gateway
= Apply Mapping Rules

*  Apply Transformations )
o racle Fusion
* Apply Validation Rules - Dl'-u“li q dle:;a:e - BPEL
. Fﬂn'nat_ Transactions > Adapter > Process
=  Subscribe XML on
Queue

* Publish XML on Queue

Message Queues

The XML Gateway uses queues specifically at two points in the process as well as
employing a general error queue. The first point is at the transport agent level between
the transport agent module and the XML Gateway. The second point is at the
transaction level between base Oracle E-Business Suite application products and the
XML Gateway.
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Inbound Queues

Inbound message queues are used for XML messages inbound into Oracle E-Business
Suite. Inbound message queues are positioned between the Transport Agent and the
Oracle Workflow Business Event System.

The messages must be formatted according to the XML Gateway envelope message
format. The envelope message format is discussed under XML Gateway Envelope, page
5-4. Oracle Workflow Business Event System copies the inbound messages to the
proper inbound Transaction Queue.

Outbound Queues

Outbound message queues are used for XML messages outbound from Oracle
E-Business Suite. The outbound Message Queue is positioned between the XML
Gateway and the Transport Agent.

The XML Gateway creates XML messages, then enqueues them on this queue. The
Transport Agent dequeues the message and delivers it to the Trading Partner.

XML Gateway Envelope

In addition to the business document such as a purchase order or invoice in the XML
Payload, a set of message attributes are also transmitted. Collectively, these attributes
are called the XML Gateway envelope. The following table describes some of these

attributes.

Envelope Attributes

Attribute Description

MESSAGE_TYPE Payload message format. This defaults to XML.
Oracle XML Gateway currently supports only XML.

MESSAGE_STANDARD Message format standard as displayed in the Define
Transactions form and entered in the Define XML
Standards form. This defaults to OAG. The message
standard entered for an inbound XML document
must be the same as the message standard in the
trading partner setup.

TRANSACTION_TYPE External Transaction Type for the business

document from the Trading Partner table. The
transaction type for an inbound XML document
must be the same as the transaction type defined in
the Trading Partner form.
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Attribute Description

TRANSACTION_SUBTYPE External Transaction Subtype for the business
document from the Trading Partner table. The
transaction subtype for an inbound XML document
must be the same as the transaction subtype defined
in the Trading Partner form.

DOCUMENT_NUMBER The document identifier used to identify the
transaction, such as a purchase order or invoice
number. This field is not used by the XML Gateway,
but it may be passed on inbound messages.

PROTOCOL_TYPE Transmission Protocol as defined in the Trading
Partner table.

PROTOCOL_ADDRESS Transmission address as defined in the Trading
Partner table.

USERNAME USERNAME as defined in the Trading Partner table.

PASSWORD The password associated with the USERNAME
defined in the Trading Partner table.

PARTY_SITE_ID The party site identifier for an inbound XML
document must be the same as the Source Trading
Partner location defined in the Trading Partner form.

ATTRIBUTE3 For outbound messages, this field has the value from
the Destination Trading Partner Location Code in
the Trading Partner table. For inbound messages, the
presence of this value generates another XML
message that is sent to the trading partner identified
in the Destination Trading Partner Location Code in
the Trading Partner table. This value must be
recognized by the hub to forward the XML message
to the final recipient of the XML Message.

Note: For more information, see Destination
Trading Partner Location Code in the Oracle XML
Gateway User’s Guide. This guide is part of the
Oracle E-Business Suite Documentation Library
which can be accessed on the Oracle Technology
Network (OTN).
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Attribute Description

PAYLOAD The XML message.

Parameters defined by the Application

The following parameters may be defined by the base application:

e ATTRIBUTEL
e ATTRIBUTEZ2
e ATTRIBUTEA4

e ATTRIBUTES

Parameters Not Used

The following parameters are not used:

e PARTYID

¢ PARTYTYPE

Note: See Oracle XML Gateway User’s Guide for details on the XML
Gateway Execution Engine, Trading Partner validation, and other XML
Gateway information. This guide is part of the Oracle E-Business Suite
Documentation Library which can be accessed on the Oracle
Technology Network (OTN).

Design-Time Tasks for XML Gateway Inbound Messaging

This section describes configuring Oracle E-Business Suite Adapter to use XML
Gateway. It describes the tasks required to configure Oracle E-Business Suite Adapter
using the Adapter Configuration Wizard in Oracle JDeveloper.

SOA Composite Application with BPEL Process Scenario

Take the XML Gateway Inbound Process PO XML Transaction as an example to explain
the BPEL process creation. In this example, the XML Gateway inbound message map is
exposed as a Web service through PROCESS PO 007 inbound map. It allows sales
order data including header and line items to be inserted into Order Management
system while an associated purchase order is created.

When a purchase order is sent by a trading partner, the purchase order data is used as
input to the BPEL process along with ECX Header properties such as
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jca.apps.ecx.TransactionType. The BPEL process then pushes this purchase
order in ECX_INBOUND queue. Agent Listeners running on ECX_INBOUND would
enable further processing by the Execution Engine. Oracle XML Gateway picks this
XML message, does trading partner validation, and inserts order data to Order
Management application.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you should get the same order information inserted into the
Order Management table once a purchase order is created.

Prerequisites to Configure XML Gateway Inbound
Setting XML Gateway Header Properties

You need to populate certain variables in the BPEL process in order to provide context
information for Oracle E-Business Suite applications. This is accomplished by setting
individual fields as header properties from the SYSTEM. ECXMSG object used in earlier
releases.

The header properties can include, for example, jca.apps.ecx.TransactionType,
jca.apps.ecx.TransactionSubtype, jca.apps.ecx.PartySiteld,
jca.apps.ecx.MessageType, jca.apps.ecx.MessageStandard,
jca.apps.ecx.DocumentNumber that you need to populate for the XML transaction
to complete successfully.

These header property values can be defined through the Properties tab of an Invoke
activity. See Configure the Invoke activity, page 5-24 for more information.

Setting Up XML Gateway Trading Partner

You need to ensure that you have defined a valid inbound XML Gateway trading
partner in the Trading Partner Setup form through XML Gateway responsibility.

For example, a Trading Partner (such as '‘Business World' with Site information 2391 L
Street San Jose CA 95106’ and partner type 'Customer') has the following details for an
inbound transaction:

¢ Transaction type: ONT

e Transaction sub type: POI

¢ Standard Code: OAG

¢ External transaction type: PO

¢ External transaction subtype: PROCESS
¢ Direction: IN

¢ Map: ONT_3A4R_OAG72_IN

e Source Trading partner location code: BWSANJOSE
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Ensuring Agent Listeners Are All Up and Running

You also need to configure and schedule two listeners on the Oracle E-Business Suite
application side. These are the ECX Inbound Agent Listener and the ECX Transaction
Agent Listener. Use the following steps to configure these listeners in Oracle E-Business
Suite:

1.

Log in to Oracle E-Business Suite with the responsibility of Workflow
Administrator.

Select the Workflow Administrator Web Applications link from the Navigator.
Click the Workflow Manager link under Oracle Applications Manager.

Click the status icon next to Agent Listeners.

Configure and schedule the ECX Inbound Agent Listener, ECX Transaction Agent

Listener, and the Workflow Deferred Agent Listener. Select the listener, and select
Start from the Actions box. Click Go.

Based on the XML Gateway Inbound Process PO XML Transaction business scenario,
the following design-time tasks are discussed in this chapter:

1.

Create a new SOA Composite application with BPEL process, page 5-8.
Create a partner link, page 5-13.

Add partner links for file adapter, page 5-18.

Configure Invoke activities, page 5-24.

Configure an Assign activity, page 5-31.

Creating a New SOA Composite Application with BPEL Process

5-8

To create a new SOA Composite application with BPEL process:

1.

2.

Launch Oracle JDeveloper.

Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.
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The New Gallery Page

= nplications

----- Connections
----- Deployment Descriptors
----- Deployment Profiles

----- Projects
----- Service Constructor

[=+-Business Tier

----- ADF Business Components

----- Business Rules

----- Contexts and Dependency Injecti

O New Gallery I.g
Q
Categories: Items: ["] Show All Descriptions

ADF Java Desktop Application
[ﬂ Application from EAR File

?‘ Application Template

Custom Application

Database Application
Extension Application

Java EE Web Application

QEP Application

Service Bus Application

..... Data Controls Service Bus Application With Service Bus Project
----- EIB =
S0A Applicatiol
----- Enterprise Scheduler Metadata ppiication
_____ Security Creates a SOA (service-oriented architecture} application. The application
) conzistz of one SOA project for the SOA composite, components, and adapters.
----- TopLink/JPA
o me—ee— UML Application

Help oK Cancel
L
Click OK.

3. The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page

@) Create SOA Application - Step 1 of 3

Name your application
- — Application Name:
T Application Name |PCInbound!CMLGateway—ap1:| |
Project Mame

’Tl‘ Directory:
|C:‘l,JDeveloper\mywork\lZc\PCInboundKMLGateway—app Browse...
Application Package Prefix:

Help MNext = Finish Cancel

4. Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.
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The Create SOA Application - Name your project Page

-
ﬁ Create SOA Application - Step 2 of 3

Name your project

Project Name: |PCJIr1b::ur'|d)(I'\J'ILGEn:ewa}‘uI |

_—
¥ Application Mame

Directory: |'k‘l.lZc‘lPCInbour'|dXMLGateway—app\POInboundXMLGabeway | Browse...

L =
e Project Name

|
w Project SOA Settings Project Features:

S0A Suite
S0A Suite is a suite of tools to model SOA(Service Oriented Architecture) applications.

Enter an appropriate name for the project in the Project Name field. For example,
POInboundXMLGateway.

Notice that SOA Suite is shown in the Project Features section.

Click Next. The Create SOA Application - Configure SOA settings page is
displayed.
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The Create SOA Application - Configure SOA settings Page
i @) Create SOA Application - Step 3 of 3

Configure SOA settings

Composite Mame:

_—
EE S |PDII"IbOL.Ir1dKMLGatEWB}' |

/T\ Project Mame

Start from:  (3) Standard Composite] () SOA Template
D Empty Composite
<& Composite With Mediator
& Composite With Human Task
21, Composite With Spring Context
- Composite With BPEL Process

! Project 50A Settings

ﬁ?’d Composite With Subprocess
Q Composite With Business Rule

[] Customizable

Help < Back Finish Cancel

7. Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
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The Create BPEL Process Page

ﬂ Create BPEL Process ﬁ

BPEL Process L;|

A BPEL process is a service orchestration, based on the BPEL specification, used to describejexecute a ﬁ
business process {or large grained service), which is implemented as a stateful service,

(%) BPEL 2.0 Specification () BPEL 1.1 Spedcification

Mame: |PDInbound!{MLGateway| |

Mamespace: |htt|:u:ﬁxmlns.orade.cnmfﬂpplication1,|'POInbu::-und!(MLGabewaw'POInbnundXMLGabeu\'a\; |

Directory: |C:‘\JDEvelo|:|er‘lm\,rwork‘PDInbound:!{MLGateway—ﬁ\|:||:|1IPDInboundXMLGateway‘\,SDMBPEL | Q@

Template: |f-! asynchronous BPEL Process "| 9

Service Mame: ||3oinboundxmlgateway'_dient |

Expose as a SOAP service

Delivery: |async.persist '| 9

Input: |ns.orade.comprplimﬁon1,|’PDInboundxMLGateway;’PDInboundXMLGateway}pmcess | Q@

Output: | com/Application 1/POInboundXMLGateway [POINboundXMLGatewaykprocessR esponse | Q,

Help Ok Cancel

8. Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
POInboundXMLGateway.

Select Asynchronous BPEL Process in the Template field. Click OK.

An asynchronous BPEL process is created with the Receive and Reply activities.
The required source files including bpel and wsdl, using the name you specified
(for example, POInboundxXMLGateway.bpel and POInboundXMLGateway.wsdl
) and POInboundXMLGateway (composite.xml) are also generated.

Creating a Partner Link

The next task is to add a partner link to the BPEL process. A partner link defines the
link name, type, and the role of the BPEL process that interacts with the partner service.

To add a partner link:
1. Click BPEL Services in the Component palette.
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5-14

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a reference name in the Name field. For example,
XMLGatewayOrderInbound.

2. Click Next. The Service Connection dialog appears.

Specifying a Database Service Connection

ﬂ Cracle Applications Adapter Configuration Wizard - Step 2 of 3 ﬁ

Service Connection

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

Connection:  |Adapter 'l l* / &,
User Mame: apps
Diriver: orade. jdbc. Oradelriver

Connect String:  jdbciorade: thin: @localhost: 1521:sid01

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

IMDI Name: |eiszppszda|:|ter | Q

Help < Back Mext = Cancel

3. You can either create a new database connection or use an existing connection.

Note: You need to connect to the database where Oracle
E-Business Suite is running,.

¢ Creating a New Database Connection:
Complete the following steps to create a new database connection:

1. From the Service Connection page, click the Create a New Database
Connection icon.
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The Create Database Connection page appears.

Enter the following information:

1.

In the Connection Name field, specify a unique name for the database
connection.

From the Connection Type list, select the type of connection for your
database (such as Oracle (JDBC)).

In the UserName field, specify a unique name for the database
connection.

In the Password field, specify a password for the database connection.
In the Oracle (JDBC) Settings, from the Driver list, select Thin.

In the Host Name field, specify the host name for the database
connection.

In the JDBC Port field, specify the port number for the database
connection.

In the SID field, specify the unique SID value for the database
connection.

Click Test Connection to determine whether the specified information
establishes a connection with the database.

The status message "Success!" indicates a valid connection.

Click OK.

The Service Connection dialog box appears, providing a summary of your
database connection.

Selecting an Existing Database Connection:

Instead of creating a new database connection, you can use an existing database
connection that you have configured.

1.

From the Service Connection page, select an appropriate connection from
the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI
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name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your
service is deployed to the BPEL server. This enables you to use different
databases for development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware User’s Guide for Technology
Adapters.

4.  Once you have completed a new connection or selected an existing connection, you
can add an XML Gateway inbound map by browsing through the list of APIs
available in Oracle E-Business Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
* C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.

¢ Click No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle
E-Business Suite Module Browser.

5. The Oracle E-Business Suite Module Browser combines interface data from Oracle
Integration Repository with information about the additional interfaces supported
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6.

by Oracle E-Business Suite Adapter, organized in a tree hierarchy.

Specify an Inbound XML Gateway Message Map from the Module Browser

© Oracle Applications Module Browser

Objectliame: [|  [|Tables  [Jiews [ ]4Pls

[]Jce [ ¥MLGateway [ |EDI [ |BusinessEvents Browse

8 ProductFamilies

(58 Advanced Planning (SCP_PF)
- (53 Applications Technology (ATG_PF)
- (5% Contracts Suite (OK_PF)

(58 Discrete Manufacturing (DMF_PF)

(8 Financial Globalizations Suite (FINGE_PF)
-3 Financial Payables Suite (FINAP_PF)
- (5% Financial Receivables Suite (FINAR_PF)
- (5% Financial Services Applications (SEM_PF)

(E8 Financials (FIN_PF)

(©8 Human Resources Suite {HR_PF)
- (53 Interaction Center (CC_PF)
- (5 Marketing Suite (MKT_PF)

(E8 Marketing and Sales Suite (MAS_PF)
= - (58 Order Management Suite (OM_PF)
(53 Transportation Execution (FTE)
(53 Order Management {OMNT)
(53 Sales Agreement (ONT_SALES_AGREEMEN
(= (53 Sales Order (ONT_SALES_ORDER)

- [ xMLGateway

Shipping Request XML Message (C
Shipping Order Confirmation XML I
INBOUND: Change Purchase Orde
Purchase Order Cancellation Confi
FrE0UD: Proces Purchise O
INBOUND: Cancel Purchase Order
Purchase Order Cancellation Requ
Shipping Order Confirmation XML b
Purchase Order Confirmation XML
Purchase Order Update Notificatio
Show Shipment Inbound (WSH_ST

- [ EDI
[ PLsqL

P AemcsciTastom Ence

Value
PROCESS_PO_007

Type
Root Element

File Name 003_process_po_007.dtd
Version ont/xmlfoag72

Direction Inbound

ayload

<|ENTITY % RESOURCES SYSTEM file: /nfs/bld/d 14/VISXBORI /apps/apps_st/appl/ont/12.0.0/xml|/oag72/oagis_resources.dtd™>
<IENTITY % SEGMENTS SYSTEM “fle: fnfs/bld/d 14/VISXBSR1/apps/apps_st/zpplfont/12.0.0/xmljoag72/oagis_segments, dtd™>
<IENTITY % ENTITY_EXTENSIONS SYSTEM “file: /nfs/bld/d14/VISXBORI/apps/apps_st/appl/ont/12.0.0/xmljoag72/oagis_entity_exter
<IENTITY % SEG_AMOUMT_QUALTFIERS_EXTEMNSION "OTHER™>

<IENTITY % SEG_AMOUNT_TYPES_EXTENSION "OTHER™>

<IENTITY % SEG_DATETIME_QUALIFIERS_EXTENSION "OTHER | EXCHRATEDATE >

<IENTITY % SEG_DATETIME_TYPES_EXTENSION "OTHER™>

<IENTITY % SEG_OPERAMT_QUALIFIERS_EXTENSION "OTHER™>

<IENTITY % SEG_OPERAMT _TYPES_EXTENSION "OTHER ">

<IENTITY % SEG_QUANTITY_QUALIFIERS_EXTENSION "OTHER™>

<IENTITY % SEG_TEMPRATURE_QUALIFIERS_EXTENSION "OTHER">

<IENTITY % SEG_TEMPRATURE_TYPES_EXTENSION "OTHER™>

<IENTITY % DATETIME.EXCHRATEDATE "DATETIME >

<IENTITY % FIELDS SYSTEM "fle: /nfs/bld/d14/VISXBORI fapps/apps_st/appljont/12.0.0/xm|/oag72foagis_fields.dtd™>
<IENTITY % DOMAINS SYSTEM “file: /nfs/bld/d 14/VISXBIRI/apps/apps_st/appl/ont/12.0.0/xml/oag72/oagis_domains. did”>
<IENTITY % STRDOM “(#PCDATA)">

<IELEMENT ABSENCETYP (#PCDATA) >

<ELEMENT ACCTPERIOD (#PCDATA) >

<IELEMENT ACCTTYPE (#PCDATA)>

<IELEMENT ACCTYEAR {#PCDATA)>

<IELEMENT ACKCODE (#PCDATA)>

<IELEMENT ACKMODE (#PCDATA)>

<IELEMENT ACKREQUEST (2PCDATA) >

<IELEMENT ACTIONCODE (#PCDATA)>

<IELEMENT ACTIVE (#PCDATA)>

<IELEMENT ACTTYPE (#PCDATA)>

<IELEMENT ADDRLINE (#PCDATA) >

<IATTLIST ADDRLINE index CDATA #REQUIRED =

<IELEMENT ADDRTYPE (#PCDATA)>

<IELEMENT ALLOWTYPE (#PCDATA) >

Pr—— e

oK Cancel

Note: The Oracle E-Business Suite Module Browser includes the
various product families that are available in Oracle E-Business
Suite. Each product family contains the individual products. Each
product contains the business entities associated with the product.

Business entities contain the various application modules that are
exposed for integration. These modules are grouped according to

the interface they

provide.

Navigate to Order Management Suite > Order Management >Sales Order > XML
Gateway to select Inbound: Process Purchase Order XML Transaction

(ONT 3A4R _OAGT2_IN)

Click OK.

Using XML Gateway

5-17



Adapter Configuration Wizard - Application Interface Page

|- -
ﬁ Oracle Applications Adapter Cenfiguration Wizard - Step 4 of 5 Iﬁ
Application Interface
i _."/
You are connected to a post 11,5, 10 instance, Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent Program/XML Gateway Map/EDI Concurrent
ProgramBusiness Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.,
- Operation Objects
@ Delete
Mame Type
PROCESS_PO_007 SCHEMA
Help < Back Next > Cancel
Click Next.

7. Click Finish to complete the process of configuring Oracle E-Business Suite
Adapter. The partner link is created with the required WSDL settings. The wizard
also generates the WSDL file corresponding to the XML schema. This WSDL file is
now available for the partner link.

Double click the newly generated Partner Link (XMLGatewayOrderInbound) icon
to view the partner link details.

Adding a Partner Link for the File Adapter

If you are configuring an inbound message, then you would need to add another
partner link for the file adapter. This allows the inbound message to pick up an XML
file received from the third party application. The data is inserted into Oracle
E-Business Suite through the partner link that was configured earlier.

To add a partner link for the file adapter to get the XML Message:
1. In]JDeveloper BPEL Designer, click BPEL Services in the Component palette.
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Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane of the process diagram. The File Adapter Reference page appears.

The File Adapter Reference Page
r hl
ﬂ FILE Adapter Cenfiguration Wizard - Step 1 of 4 u

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

This wizard helps you create a File Adapter. You will be asked to specify configuration parameters and define an
operation for the adapter.

Enter a Reference Mame.

MName: |getOrderxML

Help Mext = Cancel

Enter a name for the file adapter service, for example, getOrderXML.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface

r B
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 @

Adapter Interface

The adapter interface is defined by a wsdl that is generated using the operation name and schema(s) specified later

in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: (5] Define from operation and schema (specified later)

() Impart an existing WSDL
#]
Help < Back MNext = Cancel
[

Select the Define from operation and schema (specified later) radio button and
click Next.

3. The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.

Click Next
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r
@) FILE Adapter Configuration Wizard - Step 3 of 4 g

File Server Connection

Specify the JNDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter

must associate this JNDI name with a set of configuration properties needed by the File Adapter to access the File

Server at runtime,

File Server JMDI Mame |EiSfFi|eAda|:lter| | q
Help < Back | Next = Finish Cancel

In the Operation page, specify the operation type. For example, select the

Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation
-
ﬁ FILE Adapter Configuration Wizard - Step 4 of 8 ﬁ

Operation

g

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in spedfied locations, and & Chunked Read operation that
synchronously reads file data in chunks and can be used OMNLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: (7) Read File
() Write File
(2) Synchronous Read File
() List Files

() Chunked Read

Operation Name: |SynchRead

[ | Read File As Attachment

Help < Back | MNext = . Cancel

Click Next to access the File Directories page.

5. Select the Physical Name radio button and specify directory for incoming files, such
as /usr/tmp.

Ensure the Delete files after successful retrieval check box is not selected.
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Configuring the Input File
ﬂ- FILE Adapter Configuration Wizard - Step 5 of 8 ﬂ

File Directories

Enter directory information for the incoming file of the Synchronous Read File operation.

Directory names are specified as: (3) Physical Path () Logical Name

Directory for Incoming Files {physical path): |Jru5rl,rh-n|;.

Browse

[ ] Archive processed files
Archive Directory for Processed Files (physical path):

Help <« Back Mext = Cancel

Click Next to open the File Name page.

Enter the name of the file for the synchronous read file operation. For example,
enter order data xmlg.xml.

Click Next. The Messages page appears.

Select the 'browse for schema file' icon to open the Type Chooser window.

Expand the node by clicking Project Schema Files > PROCESS_PO_007.xsd >
PROCESS_PO_007.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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Specifying Message Schema

@ FILE Adapter Configuration Wizard - Step 7 of 8 M

Messages

AR

Define the message for the Synchronous Read File operation. Spedify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you check 'Schema is Opaque’, then you do not need to specify a Schema.

Message Schema

[ Mative format translation is not required (Schema is Opague)

LRL |../Schemas/ PROCESS_PO_007.xsd| | Q @

Schema Element | PROCESS PO 007 '|

Help < Back Mext > Cancel

8. Click Next and then Finish. This completes the configuration and creates the
partner link with the required WSDL settings for the File Adapter service. The
wizard also generates the getOrderXML.wsdl WSDL file corresponding to the
partner link.

The getOrderXxML Partner Link appears in the BPEL process diagram. Double click
the Partner Link service icon to open the Edit Partner Link dialog and view the
details.

Configuring the Invoke Activities

After adding and configuring the partner link, the next task is to configure the BPEL
process. You can start by configuring the Invoke process activity to enqueue the XML
Gateway inbound messages and set XML Gateway header properties.

Based on the scenario described earlier, you need to configure the following two Invoke

activities:

1. To get the XML message details from the input XML file through synchronous read
operation by invoking the getOrderXML partner link.
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2. To enqueue the purchase order information to the ECX_INBOUND queue by
invoking XMLGatewayOrderInbound partner link in an XML file.

The ECX Header properties for the XML Gateway inbound service can also be set
through the Invoke activity.

To configure the first Invoke activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the first Invoke activity into the center swim
lane of the process diagram, between the receivelnput and callbackClient
activities.

2. Link the Invoke activity to the getOrderXML partner link service.

Creating an Invoke Activity

1M

recefvelnput
\ Inwoke 1
3 X B
poinboundxmlgate. . . q { G rdersML

eza]

' h | MLGatewayOrde. .

3. In the Edit Invoke dialog, enter a name for the Invoke activity in the General tab.

The value of the Operation field is automatically selected based on the associated
partner link. For example, this Invoke activity is to invoke a File Adapter service to
synchronize read an input XML file; thus, the SynchRead is automatically
populated in the Operation field.

4. Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

Select Global Variable and enter a name for the variable. You can also accept the
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default name. Click OK.

5. In the Output tab, ensure the Output Variable radio button is selected. Click the
Create icon next to the Output Variable field to create a new variable. The Create
Variable dialog box appears.

Select Global Variable and enter a name for the variable. You can also accept the
default name. Click OK to return to the Edit Invoke dialog.
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6.

The Edit Invoke Dialog

) Edit Invoke

2=

Documentation  Targets  Sources  Skip Condition = Headers

General Correlations Properties

Assertions Annotations

Mame: |II'|'u'l]kE

Conversation ID: |

[ ] Invoke as Detail

Interaction Type: |r.,@_!. Partner Link *

Pariner Link: |getl:lrder)€h‘l.

Port Type: |n|!fbm5ynd'1F'.eadJ:Itt

Operation: | 0y SynchRead

Input Cutput

() Arguments Mapping (=) Output Variable

Output: |In'uuke_5ynd1Read_Dut|:lut'l.|'ariabIe

Help

Apply QK Cancel

Click Apply and then OK.

To configure the second Invoke activity:

1.

2.

In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the second Invoke activity into the center swim
lane of the process diagram, between the first Invoke activity and callbackClient

activity.

Using XML Gateway

Link the Invoke activity to the XMLGatewayOrderInbound partner link service.
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3. In the Edit Invoke dialog, enter a name for the Invoke activity in the General tab.

The value of the Operation field is automatically selected based on the associated
partner link. Since this Invoke activity is associated with an inbound message map
partner link, the Enqueue operation is selected.

4. In the Input tab, ensure the Input Variable radio button is selected. Click the Create
icon next to the Input Variable field to create a new variable. The Create Variable
dialog box appears.

Select Global Variable and enter a name for the variable. You can also accept the
default name. Click OK.

Click Apply.

5. Setting ECX Header Message Properties

You need to enter appropriate XML Gateway header property values in order to
pass individual message properties required for XML transaction to complete
successfully.

Use the following steps to set ECX header message properties:

1. Click the Properties tab in the Invoke dialog box. You will find all predefined
normalized message properties.

2. Click the Create icon. The To Property dialog appears.

3. Select the jca.apps.ecx.TransactionType property from the Name
drop-down list.
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Entering a Selected Property Value
© Edit Invoke |

Documentation  Targets  Sources — Skip Condition = Headers
General Correlations Properties Assertions Annotations

To

From  Properties: 4 / ®

MName Value

O To Property

Mame: -

@ cha.apps.en:s(.Promcnl.ﬁ.ddress

lica.apps. ecx.ProtocolType
jca.apps.eck, TransactionSubtype

jca.apps.eck. TransactonType

lica.apps.ecx.Username
lica.aq. Attempts
jca.ag.Correlation
jca.aq.Delay

Help

Help Apply | QK . Cancel

Select the 'Expression’ button as the message type.

Enter a property value for the selected property. For example, enter ' PO ' for
the property jca.apps.ecx.TransactionType.
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D) To Property

===

Name:

(3

hca.apps.echTansacﬁunType

Variable  (2) Expression

‘PO’

Help Ok Cal

nicel

Click OK.

5. Repeat Step 2 to Step 4 to set the following property values:

jca

jca.

jca.

jca.

jca.

jca

.apps.ecx.MessageType: 'XML'
apps.ecx.TransactionSubType: ' PROCESS'
apps.ecx.PartySiteId: '"BWSANJOSE'
apps.ecx.MessageType: 'XML'
apps.ecx.MessageStandard: 'OAG'

.apps.ecx.DocumentNumber: 'order xml 01'

Note: In earlier releases, XML Gateway header variables
including MESSAGE _TYPE, MESSAGE_STANDARD,
TRANSACTION TYPE, TRANSACTION SUBTYPE,

DOUCMENT NUMBER, and PARTY SITE_ ID are contained in
the SYSTEM. ECXMSG object. Oracle E-Business Suite Adapter
normalizes the SYSTEM . ECXMSG object to create and set each
individual message property through the Properties tab of the
Invoke activity. These header properties are required for the
XML transaction to complete successfully.

6. In the Invoke dialog box, click Apply and then OK.

Note: If you have configured a partner link for outbound messages,
then you need to configure a Receive activity in place of the Invoke
activity. The Receive activity is used to dequeue the XML Gateway
outbound messages.
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Configuring the Assign Activity

Use the Assign activity to pass the output of getOrderXML service as an input to the
XMLGatewayOrderInbound service.

To add an Assign activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Assign activity from the Basic Activities
section into the center swim lane of the process diagram between the two Invoke
activities you just created earlier.

2. Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
SetOrderXML.
3. Select the Copy Rules tab and expand the target trees:
¢ In the From navigation tree, navigate to Variable > Process > Variables >
Invoke_SynchRead_OutputVariable and select body.
¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_Enqueue_InputVariable and select PROCESS_PO_007.

Drag the source node (body) to connect to the target node (PROCESS_PO_007)
that you just specified. This creates a line that connects the source and target
nodes. The copy rule is displayed in the From and To sections at the bottom of
the Edit Assign dialog box.
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4.

Assigning Parameters

r
@ Edit Assign

===

General | CopyRules  Annotations | Documentation

Insert New Rule After +

nboundXMLGateway . bpel

Partner Links

Variables

ﬁ?a Process

B2 variables

(x) input¥ariable

(x) outputvariable

{x) Invoke_Engqueue_Input¥ariable

Targets | Sources | Skip Condition

B & Q=

POInbound®MLGateway bpel ﬁ?a
Partner Links (-5
warishles (2521

Process =

Wariables (521
inputvariable
aukputYariable

Invoke_Engueue_InputYariable

(%) Invoke_SynchRead_Inputvariable &
=H-{x) Invoke_SynchRead_Outputariable / :
=8 body
f-4¥ ns3PROCESS_PO_007

< ] >

3 copy -

Invoke_SynchRead_Inputyariable
Inwoke_SynchRead_Outputyariable

+ R4

From
Invoke_SynchRead_OutputVariablefbody/

To

nvoke_Enqueue_InputVariable/PROCESS_PD_007/

[ Apply ” oK ” Cancel

Click Apply and OK to complete the configuration of the Assign activity.

The following diagram illustrates the complete BPEL process:
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BPEL Process Diagram

Partner Links

poinboundsmlgate. .. @

SehOrdersiML

calbackZbent

O

Partner Links

@

getOrdersiL

KMLGatewayOrde..,

Click the POInboundXMLGateway (composite.xml) to display the Oracle

JDeveloper composite diagram:
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Oracle JDeveloper composite Diagram

Exposed Services Components External References
XMLGatewayOrderl...
Opemations:
Engueue
poinboundxmigatew ...
Operations:
process ® = {:ﬁl
process Response getOrderXML
Operations:

SynchRead

Run-Time Tasks for XML Gateway Inbound Messaging

After designing the SOA Composite with BPEL process, the next step is to deploy, run
and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 5-34
2. Test the SOA Composite application with BPEL process, page 5-37

3. Verify records in Oracle E-Business Suite, page 5-39

Deploying the SOA Composite Application with BPEL Process

To invoke the XML Gateway inbound service from the BPEL client contained in the
SOA composite, the SOA composite needs to be deployed to the Oracle WebLogic
managed server. This can be achieved using Oracle JDeveloper. Once the composite is
deployed, it can be tested from the Oracle Enterprise Manager Fusion Middleware
Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 11-1 and Creating an Application Server Connection, page 11-
10.

Note: If a local instance of the WebLogic Server is used, start the
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WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name. Select Deploy > [project name] > [serverConnection]
from the menu that appears.

For example, you can select Deploy > POInboundXMLGateway > soa-serverl to
deploy the process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

¢ New Revision ID: 1.0
*  Mark composite revision as default: Select this check box.

* Overwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from

JDeveloper are covered in Creating an Application Server
Connection, page 11-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.
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Select Server

ieployment

/"\_u_

ELiwESL Application Servers: ﬁ %
A Deploy Configuration IntegratedeblogicServer (domain unconfigured)

i _
Sel Select Server

).I.\ SOA Servers

IS

Qwerwrite modules of the same name

[ < Back ]L Next = ][ Finish H Cancel ]

4. In the SOA Servers page, accept the default target SOA Server ('soa-serverl’)

selection.
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SOA Servers
Choose the target S0A server(s) and correspanding partitions to which you want to deploy
/I\ this archive.
AT SOA Server: Partition: Status: Server URL:
g, Select Server S03_Server efaul hd thost0l exam..
Select 5 = 1 |default RUNNING http:/} hostol
I
el SO0A Servers
|
@ Summary
|
| Help | < Back || Next = | | Finish | | Cancel |
Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

5. Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window.

Verity that the deployment is successful in the Deployment - Log window.

Testing the SOA Composite with BPEL Process

Once the BPEL process contained in the SOA Composite application is deployed, you
can manage and monitor the process from the Oracle Enterprise Manager Fusion
Middleware Control Console. You can also test the process and the integration interface
by manually initiating the process.

To test the deployed SOA Composite with BPEL process:

1. Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
http://<servername>:<portnumber>/em). The composite you deployed is
displayed in the Applications Navigation tree.
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ORACLE’ Enterprise Manager Fusion Middleware Control 12¢ e

Login
Farm Farm_soainfra
* User Name [weblogic

=Passnord [es

Logn

Enterprise Manager Key Features New in this Release

Vs v Test your applications using real world workdoad using the:
i tion Replay functionality

» Automate Routine Tasks

» Stay ahead of the curve with My Oracle Support Integration

» Manage Many-as-One with Groups

» Complete, Integrated, Application-to-Disk IT Management ney
cover IT assets using dramatically improved Target Auto-

» Complete, Unified and Business-Driven Enterprise Cloud

Management
> SOA Management with improved dehydration diagnostics

2. Enter username (such as weblogic) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

3. From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_serverl)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA Composite application that you want to initiate (such as
"POInboundXMLGateway') from the SOA Infrastructure.

Click Test at the top of the page.
4. The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate
the process.
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Testing Web Service
Input Arguments

Tree View »
ame Type e
= * payload paylad
*input string kest

Request | Responss

Task Web Servce

The test results appear in the Response tab upon completion. Click Launch Flow
Trace in the Test Web Service page. The Flow Trace page is displayed.

5. In the Trace section, you should find the sequence of the message flow for the
service binding component (poinboundxmlgateway client ep), BPEL
component (POInboundXMLGateway), and reference binding components (
getOrderXML and XMLGatewayOrderInbound). All involved components have
successfully received and processed messages.

If any error occurred during the test, you should find it in the Faults section.

6. Click your BPEL service component instance link (such as
POInboundXMLGateway) to display the Instances page where you can view
execution details for the BPEL activities in the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

Verifying Records in Oracle E-Business Suite

Once the BPEL process contained in the SOA Composite application is successfully
initiated and completed, you can validate it through the relevant module in Oracle
E-Business Suite applications.

For example, you can validate it using Oracle Transaction Monitor to ensure the process
is successfully completed, and then import the order to Order Management application.
You can then verify it in Oracle Order Management to ensure the order does exist.
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To validate it Using Oracle Transaction Monitor

Additionally, you can also validate it from the Transaction Monitor. The Transaction
Monitor is a tool for monitoring the status of inbound and outbound transactions
originating from and going into Oracle E-Business Suite applications that have been
processed by the XML Gateway and delivered or received by the Oracle Transport
Agent. It shows a complete history and audit trail of these documents.

You can navigate to the Transaction Monitor page using the Workflow Administrator
Web responsibility. The Transaction Monitor provides the following:

* Flexible search criteria to support access to a specific document or group of
documents

e Search results at the document header level with drill down by document ID
* Resend capability for outbound messages

¢ Viewing capability of the XML message content

Note: For details on using the Transaction Monitor, see Oracle XML
Gateway User's Guide. This guide is part of the Oracle E-Business
Suite Documentation Library which can be accessed on the Oracle
Technology Network (OTN).

Use the following steps to validate in Oracle Transaction Monitor:

1. Log on to Oracle E-Business Suite with the Workflow Administrator Web
Applications responsibility. Select Transaction Monitor to open the search window
to search for the order.

2. Select the Inbound Messages radio button.
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Searching from the Transaction Monitor

ORACL_E& Transaction Monitor

Trangaction Moniter :Seaich

Search Criteria

Select search criteria and press Go to view the report,

() Inbound Messages
Processing Status | Al |
Crouthound Messages
Generation Status | al b
Delivery Status |l 3
Retry Status | All “
Transaction Type | | @& Trarsaction Subtype |

Source TP Location Code I: G, Trading Partner Name
Documant 1D |order_xmi_01 | Site Mame ]
Party Type | Customer v
Fombate [ | @

To Cate | |

£ PP

Enter the following information in the search window:
e Party Type: Customer

* Document ID: Enter the document ID you defined for the header message
property. For example, enter oder xml 01.

Click Go to retrieve all XML inbound messages listed in the Inbound Search Results
region.

Confirm that transaction for 'order_xml_01" has the 'Success' status.

To import the order to Oracle Order Management:

1.

Log on to the Forms-based Oracle E-Business Suite with the Order Management
Super User, Vision Operations (USA) responsibility.

Select Orders, Returns : Import Orders > Order Import Request. The Order Import
Request window is displayed along with the Parameters dialog.
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Order Import Request
= x

Run this Request. ..

Copy...

Mame Order Import
Oiperating Unit
Pararmeters

Language American Enclak
auag O Parameters

Operating Linit |
At these Times ..

| Order Source
Run the Job  As Soon as F'_

Order Reference
“alidate Only? No
Upon Complation... Ihstances 4
¥ Save all Qut
| Change Sequence
Layout | Trimn Trailing Blanks [No
Mitify

Print ta  noprint

Help () i ok | Cancel | Clear | Help |

I

| Walidate Descriptive Flexfield Yes

3. Click OK in the parameters dialog. The Order Import request name is populated
automatically in the Import Request window.

4. Click Submit to submit the request. This displays a concurrent request number.
Record the request number, but click No in the Decision dialog that you will not
submit another request.

5.  From the application menu, select View >Requests to open the Find Requests
window.

6. Enter the request number you recorded earlier and click Find.
This would show the status of Order Import request. It should be success and the
order should be created in Order Management application.

To validate it in Oracle Order Management:

1. Log on to the Forms-based Oracle E-Business Suite with the Order Management,
Super User responsibility.

2. Select Order Returns > Sales Order. Sales Order Forms would open up.

3. Search for an order by entering the order number (order xml 01)in the
Customer PO field. This would bring up the details of a newly created order using
XML Gateway inbound map.
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Sales Orders

O 5ales Ordars Mislon Operations) - b4683, Business Word

| Order Information | Line hems
& Defaut

| [LETH] ] Others

Order Murnber  B4ES3
Order Type | Mixed

Custorner

Customar Mumbear

Customer PO |order_zml 01 Date Ordered  |16-MAR-2009 23:33-11
Custarner Contact Price List | Corporate
Operating Unit | Vision Operations Salesperson | Sprague, Wi Howard
Ship To Location [San Jose (OPE) Status  Entersd
2391 L Street Curency |USD
San Jose, CA, 95106, LIS Subtatal 2.359.00
Bill Ta Location |San Joge [DFS) Tax 21591
2391 L Street Charges 71.97
Total 2 FE6 88

San Jose, CA, 25106, LIS

Actions | Related lLems Cogfigurator [ awajlabiliy | | Bookower |

You can also select the Items tab for item details.

Design-Time Task for XML Gateway Outbound Messaging

For an outbound XML Gateway Map interface, since an outbound message is first
enqueued to the ECX_OUTBOUND queue, Oracle BPEL PM listens to
ECX_OUTBOUND queue for the message with the same correlation Id. The message
will then be dequeued to retrieve outbound data from Oracle E-Business Suite. The
retrieved data can be passed to trading partners or consumers who subscribed to the
message.

SOA Composite Application with BPEL Process Scenario

Take XML Gateway outbound interface PO acknowledgement XML Transaction as an
example. The XML Gateway outbound interface is exposed as a Web service through
ECX CBODO OAG72 OUT CONFIRM outbound map.

When a purchase order is created and approved, on approval of the purchase order, a
workflow will be triggered which creates the Purchase Order Acknowledgement flow
and sends out the PO Acknowledgement as an XML file. The workflow delivers the
Confirm BOD as the PO Acknowledgement to ECX_OUTBOUND queue for delivery to
the other system.

The correlation Id for this message is set to "BPEL" and the Oracle BPEL PM listens to
ECX_OUTBOUND queue for the message with the correlation Id "BPEL". Confirm BOD
as the PO Acknowledgement is written as an output XML file using File Adapter.
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Prerequisites to Configure XML Gateway Outbound
Setting Up Correlation Identifier

For invoking an outbound message map, you need to set up the correlation identifier in
Oracle E-Business Suite. The correlation identifier enables you to label messages meant
for a specific agent, in case there are multiple agents listening on the outbound queue.
The agent listening for a particular correlation picks up the messages that match the
correlation identifier for the agent.

To set up the correlation identifier:
1. Log in to Oracle E-Business Suite with the XML Gateway responsibility. The
Navigator page appears.

2. Click the XML Gateway link.

3. Click the Define Lookup Values link under XML Gateway to open the XML
Gateway Lookups form.

XML Gateway Lookups

= Oracla Applications

File Edit “iew Foldsr Tools Yiindow Help
B I SGP AN DHEg L0855 7
O ML ps
Type |COMM_METHOD ﬁ“;:::’ el
Meaning | COMW_METHOD _ )
‘ Extensible
Application XML Gateway
- System
Desl::npilun Communications Method
Effective Dates Enabled
Code Ieaning Description Tag From Ta 11
[HTTPS-0xTA Attachment Enabled C/Attachment Enabled 0| [=-ocTa02 12DEcn: O [ =
[HTTPS-Wi  [Webhethods using HIHTTPS with WebhMethor| A-SEP2000 | [
 |E=0 BPEL Used for Apps Adapter | mo-MARZIE | -
|I.'|1.S Oracle Integration Sen Oracle Integration Serve 07-FEB-2002 |
[lTGI:IE [Eracle iProcurement € Cracle iProcurement lﬁu._' [o7-FEE-2002 [ C |
e S M5 _ [8-JUL-2002 | v
[MENE Mo Elactronic Dalivery |No Electronic Deliery BSER200 | -,,
[CTAHATCH |Attachment Enabled Clattachment Enablad Ot inDEC2IE | w
[OTAHS—ATCH Attachment Enable Orlttachment Enable Gran;_' [12-0EC-2002 [ = |
ENE Ernail (SMTP) Ermail Delivery _ #-SEP20 | E[]=

4. Search for COMM METHOD in the Type field to see if it exists in the system.

5. Add anew record to the COMM METHOD type by entering BPEL for the Code field
and Meaning field. Enter description information and save the record.

Oracle XML Gateway puts the correlation of BPEL when enqueueing the message
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on the ECX_OUTBOUND queue.

Setting Up XML Gateway Trading Partner

Once you have the correlation identifier set up correctly, you also need to ensure a valid
outbound XML Gateway trading partner in the Trading Partner Setup form through

XML Gateway responsibility. You want to have the Protocol Type field set to BPEL.

For example, a Trading Partner (such as '‘Business World' with Site information 2391 L
Street San Jose CA 95106’ and partner type 'Customer') has the following details for an
outbound transaction:

Transaction type: ECX

Transaction sub type: CBODO

Standard Code: OAG

External transaction type: BOD

External transaction subtype: CONFIRM
Direction: OUT

Map: ECX_CBODO_OAG72_OUT_CONFIRM
Connection/Hub: DIRECT

Protocol Type: BPEL

Source Trading partner location code: BWSANJOSE
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Trading Partner Setup

O Trading Parser Sallp
Oiperating Unit |'~.-1$i|:|n Project Manufact

Trading Fartnar Type |Cus1umer
Trading Partner Mama |Eiu$inaas World

Trading Partner Site |2591 L Gireet San Jose CAS5106
Corpany Admin Ennail |DracletrwantI@y5hnn com

LIser Setup | Code Conversion |

Trading Partner Details

Extemnal External

Transaction Transaction Standard  Transactien Transaction Connection/ Protocal
Type SubType Code Type SubType Directian Map Hub Type
AR COMFIRM_E OAG EQD CORFIR I 002 _confirm_k

ECx CEODD  |OAG Bom [COMFIRM [N EC¥_CBODL (| _

J [Ecx CBODD  [0AG  BOD conFrM  jouT SN - [DIRECT e
AR PROCESS_ | 0AG IMVOICE  PROCESS  |OUT  [171_process_ DIRECT [HrTe
0zF POS 0AG  POS PPROCESS  |IN 0ZF_PROCEE| '
ozF FOSI DAG POS PROCESS I 07F_PROCES| _

O7F Troso [oas POS |PrRocESS |out  [0zF_PROCESDIRECT |hrR

1]

SOA Composite Application with BPEL Process Creation Flow

Based on the PO acknowledgement XML Transaction scenario, the following
design-time tasks are discussed in this chapter:

1.

Create a new SOA Composite application with BPEL process, page 5-46
Create a Partner Link, page 5-52

Add a Receive activity, page 5-57

Add a Partner Link for File Adapter, page 5-59

Add an Invoke activity, page 5-64

Add an Assign activity, page 5-65

Creating a SOA Composite Application with BPEL Process

To create a SOA Composite application with BPEL process:

1.

Launch Oracle JDeveloper.
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2. Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.

The New Gallery Page
) New Gallery (2o
Q
Categories: Items: [ 5how All Descriptions
----- applications = -
_____ Connections ADF Java Desktop Application
""" Deployment Descriptors [ﬂ Application from EAR. File
----- Deployment Profiles
..... Diagrams F‘ Application Template
""" Java Custom Application
----- Maven
----- Projects Database Application
----- Service Constructor —
Extension Application
..... UML
""" XML Java EE Web Application
[=}-Business Tier - o
----- ADF Business Components OEP Application
""" Business Rules Service Bus Application
----- Contexts and Dependency Inject —
----- Data Controls Service Bus Application With Service Bus Project
..... EIB —
----- Enterprise Scheduler Metadata Sepscation
_____ Security Creates a SOA (service-oriented architecture} application. The application
) consists of one 50A proiect for the SOA composite, components, and adapters.
----- TopLink/JPA
e UML Application
Help oK Cancel
Click OK.

3. The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page

r
@) Create SOA Application - Step 1 of 3

Name your application

\; Application Name
/+\ Project Mame
'« Project SOA Settings

Application Mame:
[XMLGatewayOutbound-App |
Directory:
|C:‘!.JDeveloper\nywork\lZc\KMLGabewayDuﬂJound—App Browse. ..
Application Package Prefix:

Next> | Cancel

4. Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.

5-48 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



The Create SOA Application - Name your project Page
@) Create SOA Application - Step 2 of 3

Name your project

Project Name: |XMLGatewayouHJound |

i Application Mame

i
oy Project Name

|
s Project SOA Settings Project Features:

Dirgctory: |.lork‘l.lZc‘l,XMLGabewayDutbound—App‘l,XMLGatewayOuﬂJound | Browse. ..

SOA Suite

S0A Suite is a suite of tools to model S0A(Service Oriented Architecture) applications.

Help <Back | MNext> | Finish Cancel

Enter an appropriate name for the project in the Project Name field. For example,
XMLGatewayOutbound.

Notice that SOA Suite is shown in the Project Features section.

Click Next. The Create SOA Application - Configure SOA settings page is
displayed.
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The Create SOA Application - Configure SOA settings Page
r*ﬂ Create SOA Application - Step 3 of 3

Configure SOA settings

Compaosite Name:

-
Application Name |XMLGabewalfDu1i:ound |

Project Mame
A Start from: (@) Standard Composite () SOA Template

I:l Empty Composite

& Composite With Mediator

&5 Composite With Human Task
"ﬂﬂ Composite With Spring Context
.+ Composite With BPEL Process
,53,3, Composite With Subprocess
0 Composite With Business Rule

I
i Project SOA Settings

[ Customizable

Help < Back Finish Cancel

7. Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.

8. Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
XMLGatewayOutbound.

Select Define Service Later in the Template field. Click OK.
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Create BPEL Process

. .
@ Create BPEL Process ﬁ

BPEL Process |_:|

A BPEL process is a service orchestration, based on the BPEL spedification, used to describe/execute a ﬁ
business process (or large grained service), which is implemented as a stateful service.

(#) BPEL 2.0 Specification () BPEL 1.1 Spedcification

Mame: |XMLGatewayOuﬂJound |

Mamespace: |http:melns.orade.mmfxMLGatewayDuHJound_A|:||:|fxMLGabewavOuﬂ:nundeMLGatewayDuﬂ:ound |

Directory: |C:UDevelo|:|er'\nwwork.‘!,xMLGatewayDuﬂ:ound—A|:||:|‘lxMLGatewayDuﬂJound\SDMBPEL | Q@,
Template: | Define Service Later '| @
Help 0K Cancel

An empty BPEL process is created. The required source files including bpel and
wsdl, using the name you specified (for example, XMLGatewayOutbound.bpel
and XMLGatewayOutbound.wsdl) and XMLGatewayOutbound (composite.xml)
are also generated.
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An Empty BPEL Process

0 Oracle Developer 12c Development Build - XMLGatewayQutbound-App.jws : XMLGatewayOutbound.jpr : C\JDeveloperimywork\XMLGatewayQutbound-... [ "= 5 |

File Edit View Application Refactor Search Mavigate Build Run Team Tools Window Help
bHa @45 %@ Q O- @S > % BEA Q- search
Applications wnd| £ XMLGatewayOutbound.bpel L0 ko Components
XML GatewayOutbound-App = = 1| [a MeinProcess -| @ fu- 02 - &l - Q-
|| pratects a@-v-E- W-E5-P2PR >0 BPEL 2.0 -
=[] xM.Gatenayoutbound - )
-2 Resources BP @ % ad| @ | +6PE Constucs
- {3l pom.smi partoll| SUoTEE
=-£3 508 =] O | Orade Extensions
-7 BeEL +| SOA Components
. XMLGatewayOutbound.bpel 5 _ | =BPEL Services
#1771 Fuente _ HTTP Binding 1DE World mMs
—| Application Resources Fi Adapter
-7 Build Files A & ) &
[ Connections G — Mo
Descriptors
7] Libraries O _+| Custom Activity Templates
-] service Bus System Resources P— =
roperties
+| Data Controls ’
+ Recent Files Q Find @
XMLGatewayOutbound.bpel ... Thumbnail @
Q
° )
Zoom:| 100 |§ T & a «

Adding a Partner Link

This section describes how to create an Oracle E-Business Suite Adapter for the
application service by adding a partner link to your BPEL process. A BPEL partner link
defines the link name, type, and the role of the BPEL process that interacts with the
partner service.

You need to add a partner link for the outbound XML message in order for the Receive
activity to dequeue it later.

To add a partner link:
1. Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a reference name in the Name field. For example,
XMLGatewayPOAckOutbound.

Click Next.

2. The Service Connection dialog appears.
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Specifying a Database Service Connection

@) Oracle Applications Adapter Cenfiguration Wizard - Step 2 of 3 ﬁ

Service Connection

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

Connection:  |Adapter "| EF / %,
User Mame: apps
Driver: orade. jdbc. Oradelriver

Connect 5tring:  jdbciorade: thin: @ocalhost: 1521:sid0 1

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

IMDI Mame: |eis,|'Ap1:|s,|'Ada|:|ter | Q

Help < Back Next = Cancel

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle
E-Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 5-14.

* You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.
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Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware User's Guide for Technology Adapters.

4.  Once you have completed creating a new connection for the service, you can add an
outbound message map by browsing through the list of APIs available in Oracle
E-Business Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
* C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.

5-54 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



Using the Local Integration Repository Data File
ﬁ Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R12 (or later) apps instance.

From R 12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDeveloper\mywork\Application 1\AppsAdapter_IrepData

IRep Data file
|ve|o|:|er‘lmywork‘lﬁ.|:||:|limﬁon 1\AppsAdapter_IrepDatalrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

* C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click Next in the Operation page to open the Oracle E-Business
Suite Module Browser.

The Oracle E-Business Suite Module Browser combines interface data from Oracle

Integration Repository with information about the additional interfaces supported
by Oracle E-Business Suite Adapter, organized in a tree hierarchy.
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Specify an API from the Module Browser

© Oracle Applications Module Browser

et

(53 Healthcare Suits (HC_PF)
(58 Human Resources Suits (HR_PF)
(58 Inkeraction Center (CC_PF)
(5% Marketing Suite (MKT_PF)
% Marketing and Sales Suite (MAS_PF)
€ Order Management Suite (OM_PF)
(58 Process Manufacturing {OPM_PF)
(3 Procurement (PRC_PF)
(58 Product Lifecycle Management (PLM_PF)
(58 Projects Suite (P1_PF)
(5% Public Sector {PS_PF)
% sales Suite (SLS_PF)
% Service Suite (SRY_PF)
(58 Supply Chain Management (SCM_PF)
(3 Other Interfaces
(53 Business Evants
= (53 Custom Objacts
[ (58 PLSQL APIs
- G XMLGateway Maps

& Inbound

- 15 Cutbound
1] Change PG 006 (CHANGE PG 008)

(-G () - B G- G G ) B B -

OKE_DD250_DLF10_OUT (COKE_DD250_DLF10_OUT)
PROCESS_PO_007 (PROCESS_PO_007)
3] cXML_OrderRequest (CXML_ORDERREQUEST)

Object Mame: | |:| Tables [¥ews [JaPls [JCB [ |#MLGateway [ JEDI [ ] Business Events | Brawse \
@ Confracts Sulte (OF_FF)
(58 Discreke Manufacturing (DMF_PF) Type Yalue
(58 Exchange Suite (EXCHG_PF) Root Element CONFIRM_EOD_004
(53 Financial Globalizations Suite (FINGE_PF) File Name 002_corfirm_bod_004.dvd
€ Financial Payables Suite (FINAP_PF) ersion ecxfoag?z
(%5 Financial Receivables Suite (FINAR_PF) Direction Qutbound
(58 Financials (FIN_PF) Payload

<IEMTITY % RESOURCES SYSTEM “file:fappltopj115fecxi11.5.0f=mlfoaa? Zfoagis_resources.dtd">
ZIEMTITY % SEGMENTS SYSTEM “file:jappltop/1 15jecx/11.5.0fxml{oag72joagis_segments.did">
<IEMTITY % ENTITY_EXTENSIONS SVSTEM “file: fappltapi115/ecx/11.5.0/xmljoag7 2 oagis_entiy_e
<IEMTITY % SEG_AMOUNT_QUALIFIERS_EXTEMSIGN "OTHER" >

<IEMTITY % SEG_AMOUNT_TVPES_ERTENSION "OTHER" >

<IEMTITY % SEG_DATETIME_QUALIFIERS_EXTENSION "OTHER">

<IEMTITY % SEG_DATETIME _TY¥PES_EXTEMSION "OTHER">

<IEMTITY % SEG_OPERAMT_QUALIFIERS_EXTENSION "OTHER":>

<IEMTITY % SEG_OPERAMT_T¥PES_EXTEMSION "OTHER">

IEMTITY % SEG_QUANTITY_QUALIFIERS_EXTENSION "OTHER">

<IEMTITY % SEG_TEMPRATURE_QUALIFIERS_EXTENSION "OTHER" >

<IEMTITY % SEG_TEMPRATURE _TVPES_EXTEWSION "OTHER">

<IEMTITY % FIELDS SYSTEM "File: lappltopf1 15/ecx/11.5.0/xmljoag72{oagis_Fields.dtd" =
<IEMTITY % DOMAINS SYSTEM “File:japplton/115/ecx/11,5.0/xm/aag72 /oagis_domains.dtd" >
<IEMTITY % STRDOM "(#PCDATA)" >

<IELEMENT ABSENCETYP (#PCDATAY >

<ELEMENT ACCTPERIOD (#PCDATAR >

<IELEMENT ACCTTYPE (#PCDATA >

<IELEMENT ACCTYEAR (#PCDATAY* >

<ELEMENT ACKCODE (#PCDATA)* >

<IELEMEMT ACKMODE (#PCDATAY >

<IELEMENT ACKREQUEST (#PCDATAY* >

<IELEMENT ACTIONCODE (#PCDATAY >

<ELEMENT ACTIVE (#PCDATAR* >

<IELEMENT ACTTVPE (#PCDATAY

<IELEMENT ADDRLINE (#PCDATA

<IATTLIST ADDRLINE index CDATA #REQUIRED >

«|ELEMEMT ADDRTYPE (#PCDATA} =

| ok | | cance

Note: The Oracle E-Business Suite Module Browser includes the
various product families that are available in Oracle E-Business
Suite. Each product family contains the individual products. Each
product contains the business entities associated with the product.
Business entities contain the various application modules that are

exposed for integration. These
the interface they provide.

modules are grouped according to

Navigate to Other Interfaces > Custom Objects >XML Gateway Maps> Outbound to
select an outbound map ECX CBODO OAG72 OUT CONFIRM.

Click OK.
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Adapter Configuration Wizard - Application Interface Page

|- -
ﬁ Oracle Applications Adapter Cenfiguration Wizard - Step 4 of 5 @
Application Interface "
i PO ? . _.:'/
You are connected to a post 11.5. 10 instance, Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent Program/XML Gateway Map/EDI Concurrent
ProgramBusiness Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.,
- Operation Objects
@ Delete
Mame Type
CONFIRM_BOD_004 SCHEMA
Help < Back Next > Cancel
Click Next.

Click Finish to complete the process. The partner link is created with the required
WSDL settings. The wizard also generates the WSDL file corresponding to the XML
schema. This WSDL file is now available for the partner link.

Adding a Receive Activity

When configuring the Oracle E-Business Suite Adapter to use an outbound XML
Gateway map, you need to configure the Receive activity for the associated partner link.
The Receive activity dequeues the outbound XML messages.

To configure the Receive activity:

1.

In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Receive activity from the Web Service
section into the center swim lane of the process diagram.

Link the Receive activity to the partner link XMLGatewayPOAckOutbound you
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created earlier.

The Receive dialog appears.

3. Enter an appropriate name for the Receive activity.
The Dequeue Operation is automatically selected since the partner link has been

configured with an outbound XML Gateway map.

4. Specify a Variable to receive the message data from the partner link by clicking the
Create icon to the right of the Variable field.

The Create Variable dialog box appears.
Click OK to accept the default name.

5. Select the Create Instance check box.

Configuring the Receive Activity

ﬂ Edit Receive ﬁ

Sources  Headers — Skip Condition  Timeout

Annotations Assertions Documentation Targets
General Correlations Properties

Name: |F'.ECEi'u'E| |

Conversation ID: | |

Create [nstance

Interaction Type: | ¢} Partner Link ¥

Partner Link: |}{MLGatewayPDAd<Duﬁmund | Ck
Port Type: |$° Degqueue_ptt "|
Operation: | Gy Dequeue v|
() Arguments Mapping (=) Variable &)
Variable: |F‘.E:Eive_Dequeue_Input\.|'ariable |-:F Ck

| |

|

|
Help Apply oK Cancel
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6. Click Apply in the Receive dialog, then click OK.

Adding a Partner Link for File Adapter

Use this step to write PO acknowledgement details in an XML file as an output file.
To add a Partner Link for File Adapter:
1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component

palette. Drag and drop File Adapter from the BPEL Services list into the right

Partner Link swim lane of the process diagram. The File Adapter Reference page
appears.

The File Adapter Reference Page

r hl
@) FILE Adapter Configuration Wizard - Step 1 of 4 @

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

This wizard helps you create a File Adapter. You will be asked to spedfy configuration parameters and define an
operation for the adapter.

Enter a Reference Name.

Name: |WriteAck]

Help Mext = Cancel

Enter a name for the file adapter service, for example, WriteAck.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
L B
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 @

Adapter Interface

P

The adapter interface is defined by a wsdl that is generated using the operation name and schema(s) specified later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: @ Define from operation and schema (spedfied later)

() Impart an existing WSDL

[Ef

Help < Back MNext = Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.

Click Next
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r
@) FILE Adapter Configuration Wizard - Step 3 of 4 g

File Server Connection

Specify the JNDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter

must associate this JNDI name with a set of configuration properties needed by the File Adapter to access the File
Server at runtime,

File Server JNDI Name |Eisa'Fi|eAda|:lter|

|

Help < Back | Next =

I
%1

Cancel

3. In the Operation page, specify the operation type. For example, select the Write File

radio button. This automatically populates the Operation Name field.
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Specifying the Operation

F Bl
ﬂ FILE Adapter Configuration Wizard - Step 4 of 7 M

Operation

The File Adapter supports five operations, There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in spedified locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used OMLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: () Read File
() \irite File
() Synchronous Read File
() List Files
() Chunked Read

Operation Name: |Write

[ Add Output Header

! Help <gBack | Mext> | e Cancel

Click Next to access the File Configuration page.
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Adapter Configuration Wizard - File Configuration Page

-
ﬂ FILE Adapter Configuration Wizard - Step 5 of 7

File Configuration

Specify the parameters for the Write File operation.

Directory specified as () Physical Path (=) Logical Name
Directory for Qutgoing Files (ogical name):
outputDir|

File Maming Convention {po_%SEQ%s. bt): |PDAd<%wMMddHHmmss%.xml

[ ] Append to existing file
Write to output file when any of these conditions are met
MNumber of Messages Equals: |1 =
| | I
Help < Back Mext > Cancel

For the Directory specified as field, select Logical Name. Enter directory name in
the Directory for Outgoing Files (logical name) field, for example, outputDir.

Specify a naming convention for the output file, for example,
POAckSyyMMddJJmmss$ . xml.

Select the Number of Messages Equals check box and set it to '1'.

Click Next to open the Messages page.

Select the 'browse for file schema' icon next to the URL field to locate the schema
location and schema element.

The Type Chooser dialog box appears. Expand the node by clicking Project Schema
Files > CONFIRM_BOD 004.xsd. Select CONFIRM_BOD_004 and click OK.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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Adapter Configuration Wizard - Messages Page
0 FILE Adapter Configuration Wizard - Step 6 of 7 ﬁ

Messages 103 1
Define the message for the Write File operation. Spedfy the Schema File Location and select the Schema Element

that defines the messages in the outgoing files. Use the Browse button to find an existing schema definition. If you
chedk 'Schema is Opaque’, then you do not need to specify a Schema.

Message Schema

[] Mative format translation is not required (Schema is Opague)

URL .. /Schemas/CONFIRM_BOD_004.xsd | Q

Schema Element ICDNFIRM_EDD_UU4 vl

Help < Back Mext = Cancel

6. Click Next and then Finish. This completes the configuration and creates the
partner link with the required WSDL settings for the File Adapter service.

The wizard also generates the WriteAck.wsdl WSDL file corresponding to the
partner link.

The WriteAck Partner Link appears in the BPEL process diagram. Double click the
Partner Link service icon to open the Edit Partner Link dialog and view the details.

Adding an Invoke Activity

This step is to configure an Invoke activity to write PO acknowledgement information
to an XML file through invoking the partner link for File Adapter.

To add an Invoke activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Invoke activity from the Web Service
section into the center swim lane of the process diagram after the Receive activity.
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2. Link the Invoke activity to the WriteAck service.
The Edit Invoke dialog appears.
3. Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable

radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

4. Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.

Click Apply and then click OK in the Edit Invoke dialog to finish configuring the
Invoke activity.

The Invoke activity appears in the process diagram.

Adding an Assign Activity

Use the Assign activity to take the output from the Receive activity and to provide
input to the Invoke activity.

To add an Assign activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Assign activity from the Basic Activities
section into the center swim lane of the process diagram, between the Receive and
Invoke activities that you just created earlier.

2.  Double-click the Assign activity to access the Edit Assign dialog.

Click the General tab to enter a name for the Assign activity.

3. Select the Copy Rules tab and expand the target trees:

¢ In the From navigation tree, navigate to Variable > Process > Variables >
Receive_ DEQUEUE_InputVariable and select CONFIRM_BOD_004.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_Write_InputVariable and select body.

Drag the source node (CONFIRM_BOD_004) to connect to the target node
(body) that you just identified. This creates a line that connects the source and
target nodes. The copy rule is displayed in the From and To sections at the
bottom of the Edit Assign dialog box.
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Assigning Parameters

=)

ﬂ Edit Assign
General = CopyRules | Annotations  Skip Conditon ~ Sources  Targets
|tnsertnew Rule after = Bk Q@ B =
. POAckOUtbouNdXMLGateway, bpel POAckOUtboundXMLGateway bpe
[ Partner Links Partner Links [
) Variables Yariables (=5
E‘Egi Process Process 59;{3
=23 variables varizbles [53-=)
E} (X) Receive_Dequeus_Inputvariabls Receive_Dequeus_Inputtariable [+ 8
CONFIRM_BOD_DD‘I—\\ Invoke _Writs_Inputyariatle =
X)) Invoke_iwrite_Inputiariable ? - body [E]-#
(x) ReadPayload_Inputyariable i ReadPayload_Inputvariable b?}
e - +X & 3
From To
Invoke_tirite_InputVariablebhody/
Help Apply Ok Cancel

4. Click Apply and then click OK to complete the configuration of the Assign activity.

The following diagram illustrates the complete BPEL process diagram:
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Partrer Links

Partner Links
- @)

uew M

Receive

WriteAckToFile

Note: Click the Source tab of XMLGatewayOutbound (composite.xml)
to enter a value for the physical directory outputDir for the reference
WriteEventData (such as /usr/tmp).

<property name="outputDir" type="xs:string"
many="false" override="may">/usr/tmp</property>

Click XMLGatewayOutbound (composite.xml) to display the Oracle JDeveloper
composite diagram:

Oracle JDeveloper Composite Diagram

=]

XMLGatewayPOAck... WriteAckToFile

[ Operations: | | Cperations:

|Dequeue | [ write |

Run-Time Task for XML Gateway Outbound Messaging

After designing the SOA Composite application with BPEL process, you can compile,
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deploy and test it.
1. Deploy the SOA Composite application with BPEL process, page 5-68

2. Test the SOA Composite with BPEL process, page 5-71

Deploying the SOA Composite Application with BPEL Process

After creating a SOA composite application with BPEL process for XML Gateway
outbound message map, you need to deploy it to the Oracle WebLogic managed server.
This can be achieved using Oracle JDeveloper. Once the composite is deployed, it can be
tested from the Oracle Enterprise Manager Fusion Middleware Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 11-1 and Creating an Application Server Connection, page 11-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name. Select Deploy > [project name] > [serverConnection]
from the menu that appears.

For example, you can select Deploy > XMLGatewayOutbound > soa-serverl to
deploy the process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.
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Deployment Action

-);.\- Deployment Action | Select a deployment action from the list below.

| .
/T'\ Deploy Confiquration Deploy to Application Server

Deploy to SAR
/I\

/l\

Deploy this archive to SOA configured Application server(s)

Help Mext = || Einish || Cancel

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

¢ New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

¢ Opverwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from

JDeveloper are covered inCreating an Application Server
Connection, page 11-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.
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Select Server

ieployment

/"\_u_

ELiwESL Application Servers: ﬁ %
A Deploy Configuration IntegratedeblogicServer (domain unconfigured)

i _
Sel Select Server

).I.\ SOA Servers

IS

Qwerwrite modules of the same name

[ < Back ]L Next = ][ Finish H Cancel ]

4. In the SOA Servers page, accept the default target SOA Server ('soa-serverl’)

selection.
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SOA Servers
Choose the target S0A server(s) and correspanding partitions to which you want to deploy
/I\ this archive.
AT SOA Server: Partition: Status: Server URL:
g, Select Server S03_Server efaul hd thost0l exam..
Select 5 = 1 |default RUNNING http:/} hostol
I
el SO0A Servers
|
@ Summary
|
| Help | < Back || Next = | | Finish | | Cancel |
Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

5. Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window.

Verity that the deployment is successful in the Deployment - Log window.

Testing the SOA Composite Application with BPEL Process

In Oracle E-Business Suite, you can check for outbound transactions that have been
processed by the XML Gateway and delivered to the Transaction Agent by using the
Transaction Monitor. You can also use the Transaction Monitor to resend an outbound
document if necessary.

Note: For details on using the Transaction Monitor, see Oracle XML
Gateway User's Guide. This guide is part of the Oracle E-Business Suite
Documentation Library which can be accessed on the Oracle
Technology Network (OTN).

If you have used a File Adapter to write outbound messages from Oracle E-Business
Suite to files, you can check the output directory location for the presence of these files
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after the BPEL process contained in a SOA Composite application has been executed.

To validate the design-time tasks created earlier, you can log in to Oracle E-Business
Suite to manually create and book the order as well as generate the order
acknowledgement by submitting a Workflow Background Process concurrent request.

To manually test the SOA Composite application with BPEL process:

1. Log in to Oracle E-Business Suite with the XML Gateway responsibility.

This is to ensure that the XML Gateway trading partner is set up correctly so that a
purchase order can have a valid customer that has been defined.

2. Select Define Trading Partner from the navigation menu to access the Trading
Partner Setup window.

3. Enter the header values on the Trading Partner Setup form as follows:

Trading Partner Type: Customer
Trading Partner Name: Business World

Trading Partner Site: Enter a trading partner site information, such as 2391 L
Street, San Jose, CA 95106.

Company Admin Email: Enter a valid e-mail address.

4. Enter the following trading partner details:

Transaction Type: ECX

Transaction SubType: CBODO

Standard Code: OAG

External Transaction Type: BOD

External Transaction SubType: CONFIRM
Direction: Out

Map: ECX_CBODO_OAG72_OUT_CONFIRM
Connection / Hub: DIRECT

Protocol Type: BPEL

Username: 'operation’

Password: Enter the associated password twice.
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5.

® Protocol Address: 'http://ebssoa.sample.com'

® Source Trading Partner Location Code: BWSANJOSE

Save your work.

To successfully generated PO Acknowledgement, you need to create an order and then
manually book the order through Order Management.

Use the following steps to create an order and then manually book the order:

1.

Switch to Order Management Super User, Vision Operations (USA) responsibility
and select Customer > Standard from the navigation menu to open the Enter
Customer form.

Search on the 'Business World' in the Name field and click Find.

Select the Business World with the following information from the search results.

¢ Account Name: Business World

® Registry ID: 2813

¢ Identifying check box: checked

e Address: 2391 L Street, San Jose, CA 95106
e Country: United States of America

Select row with the following entries:

e Account Number:1608

® Account Description: Business World

e Status: Active

Click Details to open the Customer Information page.

Click Details in the row with the Business World with Address '2391 L Street, San
Jose, CA 95106' and Country 'United States of America'. This opens the Customer
Account page.

Enter ' BWSAN]JOSE' in the EDI Location field.

In the Business Purposes tab, create a new row with the following values:

* Usage: Sold To
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e Check on the 'Primary' check box
Save your work.

Use the following steps to generate acknowledgement for already created order:

1. Log in to Oracle E-Business Suite with the Order Management Super User, Vision
Operations (USA) responsibility. Select Order Returns > Sales Order to open the
Sales Orders form.

2. Retrieve the order that you have created earlier by entering the order ID in the
Customer PO field. For example, enter order id 01.

3. Click Book Order to book the order.

Order Infarmation Lire harms

(2] Defaul

Waim | Others

Customar

| /o 5 Oirdler Murmber |5452*1
Custorner Number |15|:|E Order Type |Mi):Ed
Customer PO |order_id_01 Date Ordered |05-MAR-2003 042815
Customer Contact [ ' Price List [Cﬂrpﬂra'ie
Oiperating Uinit i'v’lsiun Operations ' Salesperson |Sprague,r-,1r Howard
Ship To Location |San Jose [OPS) Status |Bocked
[2301 L Street Curency |USD
[San Jose, CA, 95106, US Subtotal | 0,00

Bill To Location |San Jose [OPS) Tax 0.00
2291 L Street Chargas 0.00

| . Total | 0.0m
[San Jose, CA, 85106, US

( Astions Related Heme Configuralor Ayailability Book Order

4. Switch to the System Administrator responsibility and select Request > Run.
5. Select Single Request and click OK.

6. Enter the following information in the Submit Request form:
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Specifying Parameters

- Aum this Reguest. ..
Cogy...
Mame Workflow Backgiound Prodess

Fararmet ers
Language American English

ltem Type :ﬂl Hend Acknowdedgment

A these Times. ..
Run the Jab A8 Sec  Minimum Threshald |

Maximum Threshald

 Upon Completion.... Pmcass Deferad {Tm
Mg procpss Timeou lﬂu—
Layoun Process Sluck iNu
Madify

Prirt 1o Aaprin

QK Cancel | | Clear | Help )

Help [ ET CanCEl

¢ Name: Workflow Background Process

¢ Enter the following parameters:

¢ Item Type: OM Send Acknowledgement
e  Process Deferred: Y
e Process Timeout: N

e Process Stuck: N
e (Click OK.

7. Click Submit to submit 'send acknowledgement' request.
8. View your request by entering the request ID to ensure its status is 'Success'.

On approval of the order, Oracle E-Business Suite triggers the workflow that creates the
Purchase Order Acknowledgement flow and sends out the PO Acknowledgement as an
XML file. The workflow delivers the Confirm BOD as the PO Acknowledgement to the
ECX_OUTBOUND queue for delivery to the other system.

On the other hand, Oracle BPEL PM listens to the ECX_OUTBOUND queue for the
message with the correlation Id = "BPEL" which is the same id for this outbound
message. The Confirm BOD as the PO Acknowledgement is written as XML file using
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File Adapter.

Since the BPEL process contained in a SOA Composite application is deployed, the
process is continuously polling the ECX_OUTBOUND queue for PO acknowledgement.
It also writes PO Acknowledgement in the physical directory mentioned in
composite.xml after receiving from XML Gateway ECX_OUTBOUND queue.

You can open file in text editor and search for ORIGREF element. Its value should be
same as order id (order id 01 whose order was booked.

T

(o

CYERRF2002</YERR >
SHONTH10<HONTH:
<DEY 09 THY
<HOUR>1B</HOUR:-
SMINUTE>45</MINUTE:
<SECOMD:-47</SECOMD::
<SUBSECOND =356+ SUBSECOMI:
<TIMEZOME:-0BO0 /T IMEZOME:
</TATETIME>
</CNTROLARERA:
LSTATUSLYL=00<ASTATUSLYL =
<IESCRIFTH>Inbound Process PO Document< DESCRIFTH:
<ORIGREF »order_id_01</0RIGREF:
<USERAREA></USERARER>
<CONF IRMMSG:
<DE5EHIPTN><HDESEQ§PTN>
+REASOMCODE > AREASUNCODE:
BUSERARERA =< USERARER:
< /CONF IRMHSG::
</CONFIRM:
< /CONF IRM_BOD::
</IATAARERA:
</CONF IRM_BOD_004
"POACkOIOINEOZ0I5E , xm]1 " FIL, 2342C BE,16 Bot

Troubleshooting

If you experience problems with your Oracle XML Gateway integration, you can take
the following troubleshooting steps:

Confirm that you have the correct settings for the following elements of the trading
partner setup:

e Standard Code
¢ Transaction Type
¢ Transaction Subtype

® Source Trading Partner Location Code (Party Site ID)
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e Confirm that the correct transaction is enabled for the trading partner.

®  Check the status of the XML transaction in Transaction Monitor.

¢ Ensure that the document number is unique within this transaction type.
¢ For inbound transactions, confirm that ECX Listeners are running,.

¢ For outbound transactions, confirm that Background Engine is running.
¢ In the trading partner setup, ensure that the Protocol Type is set to BPEL.

® Specify the same correlation ID for Oracle E-Business Suite for the Adapter.

The Adapter Configuration wizard does not specify a correlation ID for XML
Gateway transactions for inbound or outbound interfaces. Instead, a default
correlation ID of BPEL is automatically set in the WSDL file. To make this
configuration work, you must configure Oracle E-Business Suite to set the same
correlation ID value of BPEL for the corresponding XML Gateway transactions.

If you want the Adapter to use a different correlation ID than the default, you need
to configure a correlation ID in Oracle E-Business Suite, then edit the
Correlation="BPEL" line contained in the <jca:operation> section of the
adapter service WSDL. Replace BPEL with the string value of the correlation ID you
specified in Oracle E-Business Suite.

Enable logging for adapter to see if the issue is on the middleware side. How to enable

logging for Oracle E-Business Suite Adapter, see Enabling Logging for Adapters, page
4-125.
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6

Using Business Events

This chapter covers the following topics:

* Overview of Business Events

¢ Design-Time Tasks for Outbound Business Events

* Creating a New SOA Composite Application with BPEL Process
® Creating a Partner Link

¢ Configuring the Receive Activity

¢ Adding a Partner Link for the File Adapter

* Configuring an Invoke Activity

¢ Configuring an Assign Activity

* Run-Time Tasks for Outbound Business Events

* Deploying the SOA Composite Application with BPEL Process
¢ Testing the SOA Composite Application with BPEL Process

* Troubleshooting

Overview of Business Events

The Oracle Workflow Business Event System (BES) is an application service that leverages
the Oracle Advanced Queuing (AQ) infrastructure to communicate business events
between systems. The Business Event System consists of the Event Manager and
workflow process event activities.

The Event Manager contains a registry of business events, systems, named
communication agents within those systems, and subscriptions indicating that an event
is significant to a particular system. Events can be raised locally or received from an
external system or the local system through AQ. When a local event occurs, the
subscribing code is executed in the same transaction as the code that raised the event,
unless the subscriptions are deferred.
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Subscriptions can include the following types of processing:

e Executing custom code on the event information
¢ Sending event information to a workflow process
¢ Sending event information to other queues or systems

Each business event represents a ready to use integration or extension point. Oracle
E-Business Suite currently ships preconfigured with over 900 business events.

The uses of the Business Event System include:

* System integration messaging hubs - Business Event System can serve as a
messaging hub for complex system integration scenarios. The Event Manager can
be used to "hard-wire" routing between systems based on event and originator.

e Distributed applications messaging - Applications can supply Generate and
Receive event message handlers for their business entities. For example, message
handlers can be used to implement Master/Copy replication for distributed
applications.

* Message-based system integration - You can set up subscriptions, which cause
messages to be sent from one system to another when business events occur. In this
way, you can use the Event Manager to implement point-to—point messaging
integration.

* Business—event based workflow processes - You can develop sophisticated
workflow processes that include advanced routing or processing based on the
content of business events.

¢ Non-invasive customization of packaged applications - Analysts can register
interesting business events for their Internet or intranet applications. Users of those
applications can register subscriptions to those events to trigger custom code or
workflow processes.

Business Events Concepts

Event

Event Key

A business event is an occurrence in an Internet or intranet application or program that
might be significant to other objects in a system or to external agents. For instance, the
creation of a purchase order is an example of a business event in a purchasing
application.

A string that uniquely identifies an instance of an event. Together, the event name,
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Event Message

event key, and event data fully communicate what occurred in the event.

A standard Workflow structure for communicating business events, defined by the
datatype WF_EVENT_T. The event message contains the event data as well as several
header properties, including the event name, event key, addressing attributes, and error
information.

Event Activity
A business event modeled as an activity so that it can be included in a workflow
process.

Event Data
A set of additional details describing an event. The event data can be structured as an
XML document. Together, the event name, event key, and event data fully
communicate what occurred in the event.

Event Subscription

A registration indicating that a particular event is significant to a system and specifying
the processing to perform when the triggering event occurs. Subscription processing
can include calling custom code, sending the event message to a workflow process, or
sending the event message to an agent.

Deferred Subscription Processing

Agent

If you do not want subscriptions for an event to be executed immediately when the
event occurs, you can defer the subscriptions. In this way you can return control more
quickly to the calling application and let the Event Manager execute any costly
subscription processing at a later time.

An agent is a named point of communication within a system. Communication within
and between systems is accomplished by sending a message from one agent to another.
A single system can have several different agents representing different communication
alternatives. For example, a system may have different agents to support inbound and
outbound communication, communication by different protocols, different propagation
frequencies, or other alternatives.

Business Event Groups

A business event group is a type of event that contains multiple individual business
events. Once an event group is defined, a subscription that is registered for an event
group will be executed when any of the individual events within it is triggered.
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With the support for business event groups, different business events belonging to an
even group can be handled through a single partner link. A service created for an event
group would be able to dequeue payloads corresponding to any of the events within
the group.

To support existing partner links for outbound business events which are part of an
event group, a workaround has to be followed. For detailed information, see Support
for Business Events through Existing Partner Links, page A-1.

Note: If individual events under a group are subscribed, then two
messages would be enqueued into the WF_BPEL_Q queue. Users
requiring only one message would need to disable the subscription for
the individual event which enqueues the messages into WF_BPEL_Q.

For information about creating a partner link with a business event group, see Creating
a Partner Link with a Business Event Group, page 6-14.

Design-Time Tasks for Outbound Business Events

This section describes the tasks required to configure Oracle E-Business Suite Adapter
using the Adapter Configuration Wizard in Oracle JDeveloper.

Creating Service Artifacts for Business Event Consumption

While creating a partner link for listening to a business event, the following tasks are
performed behind the scenes:

* Creation of WF_BPEL_Q queue
® Creation of an entry for WF_BPEL_Q in WF_AGENTS table
* Creation of a subscription for the event being listened to

To facilitate re-creating the above entries on a different Oracle E-Business Suite instance,
a script is generated in the project folder. In addition, a drop script is created which can
be run manually on the corresponding instance to clean up all the tasks performed
above. Running the drop script is optional, and is not recommended. The drop script
would delete the WF_BPEL_Q queue, which can impact other composites, listening to
events on the same Oracle E-Business Suite instance.

Multiple BPEL Processes Consuming the Same Business Event

Oracle E-Business Suite Adapter can handle multiple BPEL processes consuming the
same business event. Oracle E-Business Suite Adapter creates only single subscription
for a particular business event regardless of the number of BPEL process consuming it.
Internally, this subscription forwards business event message to a multi-consumer AQ.
Since each BPEL process is an unique consumer for the event, when the message is
placed in the queue, all BPEL processes are notified. Therefore, as a user you do not
need to create a separate subscription for each BPEL process. All you need to do is to
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create the service for the event, and Oracle E-Business Suite Adapter will take care of
message delivery to each BPEL process.

For example, if there are three BPEL processes (BPEL1, BPEL2, and BPEL3) that want to
consume the same business event (such as BE1 event). For each BPEL process, you
create a service for the BE1 event using Oracle E-Business Suite Adapter. Oracle
E-Business Suite Adapter in turn creates a single subscription for all the three BPEL
processes - BPEL1, BPEL2, and BPEL3. This subscription puts BE1 event message in
multi-consumer AQ.

At run time, when a BE1 event is raised, since the subscription is applicable to all the
three BPEL processes, all these three deployed BPEL processes will be activated and
would receive the same BE1 event message.

SOA Composite Application with BPEL Process Scenario
Take a PO XML Raise business event as an example.

When a purchase order is created and approved, a purchase order approved business
event oracle.apps.po.evnt.xmlpo is raised. The subscription to this event is
created in the background to listen to the business event and get event details. The
event data will be passed through BPEL process activities and then written in XML file
as an output file.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you should get the same purchase order information from
the output file once a purchase order is approved.

Prerequisites to Configure Outbound Business Events

® The WF_Deferred Agent Listener must be up and running on the target instance.

e The event should be enabled for BPEL to subscribe to it. The event should not be in
the disabled mode.

SOA Composite Application with BPEL Process Creation Flow

Based on the PO XML Raise business event scenario, the following design-time tasks
are discussed in this chapter:

1. Create a new SOA Composite application with BPEL process, page 6-6.
2. Create a partner link, page 6-10.

3. Configure a Receive activity, page 6-20.

4.  Add a partner link for the file adapter, page 6-22.

5. Configure an Invoke activity, page 6-29.

6. Configure an Assign activity, page 6-31.
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Creating a New SOA Composite Application with BPEL Process

To create a new SOA Composite application with BPEL process:
1. Launch Oracle JDeveloper.

2. Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.

The New Gallery Page
O New Gallery l&]
Q
Categories: Items: [ Show All Descriptions
----- _ —
_____ Comnections ADF Java Desktop Application
""" Deployment Descriptors [ﬂ Application from EAR. File
----- Deployment Profiles
..... Diagrams F Application Template
""" pev Custom Application
----- Maven
----- Projects Database Application
----- Service Constructor —
Extension Application
..... UML
""" XML Java EE Web Application
[=}-Business Tier - o
----- ADF Business Components OEP Application
""" Business Rules Service Bus Application
----- Contexts and Dependency Inject —
..... Data Controls Service Bus Application With Service Bus Project
..... EIE —
Enterprise Scheduler Metadata Appscation
_____ Security Creates a SOA (service-orisnted architecture} application. The application
) consists of one 50A proiect for the SOA composite, components, and adanters.
----- TopLink/IPA
Mok Somioos UML Application
Help oK Cancel
b
Click OK.

3. The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page
@) Create SOA Application - Step 1 of 3

Name your application
= . Application Name:
T’ e e |Geﬂ90Achu5'.inessEvent
Project Name

/T\ Directaory:
|C:UDEVeloper‘mywork‘l,lZc‘l,GetPDAchusinessEvent Browse...
Application Package Prefix:

Help Next = Finish Cancel

4. Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.
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The Create SOA Application - Name your project Page
rﬂ Create SOA Application - Step 2 of 3

Name your project

Project Name: |GetPD#\chusinessEvent |

+ Application Name

Directory: |fwork\,12c\,GetPO#\chusinessEvent\,GetPDAchusinessEvent| Browse...

i

Jel Project Name
|

w Project SOA Setfings Project Feafures:

S0A Suite
304 Suite is a suite of tools to model SOA(Service Oriented Architecture) applications.

Help < Back Next = Finish Cancel

5. Enter an appropriate name for the project in the Project Name field. For example,
GetPOAckBusinessEvent.

Notice that SOA Suite is shown in the Project Features section.

6. Click Next. The Create SOA Application - Configure SOA settings page is
displayed.
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The Create SOA Application - Configure SOA settings Page
r@ Create SOA Application - Step 3 of 3

Configure SOA settings

Compaosite Name:

R |Geﬂ90Ad<Bu51nessEvent |

.. Project Name
B

Start from: (@) Standard Composite () SOA Template
[_| Empty Compasite
<& Composite With Mediator
5 Composite With Human Task
2y Composite With Spring Context
*. Composite With BPEL Process

1
i Project SOA Settings

,533, Compaosite With Subprocess
«Jp Composite With Business Rule

[ ] [] Customizable

Help < Back Mext = Finish Cancel

Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
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The Create BPEL Process Page

r hl
ﬂ Create BPEL Process ﬁ

BPEL Process L']

A BPEL process is a service orchestration, based on the BPEL specification, used to describe fexecute a ﬁ
business process {or large grained service), which is implemented as a stateful service,

(%) BPEL 2.0 Spedification () BPEL 1.1 Spedification

Mame: |Geﬂ30AchusinessEvent |

MNamespace: |hth3:ﬂxmlns.Urade.cDmJ"GetPOAckBusinessEvent,.‘GEtPOAn:kBusinEssEvent{GeﬂjOAchusinessEvent |

Directory: |C: \Developer ymywark\GetPOAdBusinessEvent\GetPOAckBusinessEvent\SOA\BPEL | Ck
Template: | Define Service Later 'l 2
Help 0K Cancel

8. Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
GetPOAckBusinessEvent.

Select Define Service Later from the Template field. Click OK.

An empty BPEL process is created. The required source files including bpel and
wsdl, using the name you specified (for example,
GetPOAckBusinessEvent.bpel and GetPOAckBusinessEvent.wsdl) and
GetPOAckBusinessEvent (composite.xml) are also generated.

Creating a Partner Link

Configuring an outbound business event requires creating a partner link to allow the
outbound event to be published.

This task adds a partner link to the BPEL process. A partner link defines the link name,
type, and the role of the BPEL process that interacts with the partner service.
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To add a partner link:
1. Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a reference name in the Name field. For example, Get POApprovalEvent.

2. Click Next. The Service Connection dialog appears.

Specifying a Database Service Connection

ﬂ Cracle Applications Adapter Configuration Wizard - Step 2 of 3 @

Service Connection

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a New Connection.

Connection:  |Adapter "| g F O
User Mame: apps
Diriver: orade. jdbc. OradeDriver

Connect String:  jdbczorade: thin: @localhost: 1521:s5id01

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

IMDI Mame: |eiszppszda|:|ber | Q

Help < Back MNext = Cancel

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle
E-Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.
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How to define a new database connection, see Create a New Database
Connection, page 5-14.

*  You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware User’s Guide for Technology Adapters.

4. Once you have completed creating a new connection for the service, you can add a
business event by browsing through the list available in Oracle E-Business Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
* C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.
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Using the Local Integration Repository Data File
ﬂ Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R12 (or later) apps instance.

From R 12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDeveloper\mywork\Application 1\AppsAdapter_IrepData

IRep Data file
|ve|o|:|er‘lmywork‘lﬁ.|:||:|limﬁon 1\AppsAdapter_IrepDatalrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

* C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle
E-Business Suite Module Browser.

The Oracle E-Business Suite Module Browser combines interface data from Oracle
Integration Repository with information about the additional interfaces supported
by Oracle E-Business Suite Adapter, organized in a tree hierarchy.

To select a business event, expand the navigation tree to Product Families > Other
Interfaces > Business Events > Outbound. The direction outbound is from the
Oracle E-Business Suite perspective, in this case listening to business events from
Oracle E-Business Suite. Select the appropriate business event, for example,
oracle.apps.po.event.xmlpo, and click OK. The Application Interface page is
displayed with selected business event.
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Selecting a Business Event from the Module Browser

© Oracle Applications Module Browser

ObjectName: || [ |Tables [ |Views [ |APIs [ ]CP [ |XM Gateway [ JEDI [ |BusinessEvents Browse

T PR
7] oradle.apps.ozf.request. SpedalPrice.z

oracle.apps.ozf.sd.batch lifecyde T Orade Purchasing
Java Generate Function

Generate Function

Type Value

orade.apps.ozf.sd.batch, outbound
0 oradle. apps. ozf.sd.request. outbound
7] oracle.apps.ozf.sd.request. statuschar
oracle.apps.ozf. target. TargetApprova
£7] oracle.apps.pay.core.autoretro.retroc
7] oracle.apps.pay. core.autoretro. retrop
7] oracle.apps.pay.event.processflow.pe
7] oracle.apps.pay.event.processflow.pr
oracle.apps. per.api.vacancy. create_v
3] oracle.apps.per.hrhdrir. xml.out

7] oracle.apps.per.irc.api.offer_status_h
7] oracle.apps.per.irc.common. notificatio
oracle.apps.per.ki.radingpartner.coni
5] oracle.apps.per.ki.tradingpartner. initiz
7] oracle.apps.per.ki. radingpartner.rece
orade.apps.per.perreq.inbound
oracle.apps.po.asl.create

7] oracle.apps.po.asl.update

7] oracle.apps.po.buyersignature
orade.apps.po.event.ackpo
oracle.apps.po.event.create_asl
orade.apps.po.event.document_actio
orade.apps.po.event.orderstatus
orade.apps.po.event.requester_chan
oradle.apps.po.event, sebal

5] oracle.apps.po.event.suppchnresp
0 oradle.apps.po.event.supplier_change
77 oradh po.event.update_as|

orade.apps.po.event.xmipogen
2] oradle.apps.po.event.xmlposent. oK Cancel

Note: Creating a Partner Link with a Business Event Group

Business event groups appear under the Other Interfaces >
Business Events > Outbound > Groups node from the Oracle
E-Business Suite Module Browser.

If a business event group (such as oracle.apps.fem.event.group.all)
is selected from the Groups node, detailed event group information
including the event group owner name, generate function
information if any, and each individual event contained in the
selected event group is listed in the right pane of the Oracle
E-Business Suite Module Browser window.
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Selecting a Business Event Group from the Oracle E-Business Suite
Module Browser

© Cradle Applications Module Browser ==
ObjectMame:[] [JTsbles [Jvews []aPls []CR []xMi Gatewsy [JEDI  []BusinessEvents Browse
T MR T S SO MRS T = o
[~ (53 Order Management Suite (OM_FF)
Owner Name Strategic Enterprise Managemen

(54 Process Manufacturing (OPM_PF)

G Procurement (PRC_PF)

3 Product Lifecycle Management (PLM_PF)
(S Projects Suite (PJ_PF)

(53 Public Sector (PS_PF) orade.apps. fem.impexp.event.migratelm. ..
(- (53 Sales Suite (5L5_PF) orade.apps. fem.brbase.event.approval
(€3 service Suite (SRV_PF) orade.apps. fem.impexp.event migrateEx. .

Java Generate Function
Generate Function

Business Events

(S Supply Chain Management (SCM_PF) orade.apps. fem.brbase.event.delete

G University (UNV_PF)

(=~ (5 Other Interfaces

- (53 Business Events
3 Inbound(Raise Business Events into Oracle
= €3 Qutbound(Listen to Business Events from ¢

€8 Groups

5 adap_group

7] adapter. test.group

i greup1

T group2

£ group3

orade.apps. cs.sr ServiceRequest.

e.apps. fem.event.group.al

) oracle.apps. fd.bes. control. group
£33 orade.apps.fd.cp.gsc.bes contre
£7] orade.apps. fnd. search. ChangeLo
3] orade.apps. fnd. system.event.grc
1] orade.apps. frd umf.reg

i) oradle.apps.ozf dam.group

i) oradle.apps. wf.bes. control. group
£1] orade.apps. wf.event.agent.invall
3] orade.apps. wf.event.group.all
i) orade.apps.nf.event.invaiidate.g 3 Cancel

Additionally, select 'Any Schema' in the WF Event Schema
Definition page later on for the business event payload. This allows
XML payload of any schema to be attached to event payload. You
can also verify the JCA Property "MessageSelectorRule" for the
selected event group (described in Step 10) once the partner link is
created.

This feature applies to Oracle E-Business Suite Release 12 and
Release 11.5.10. For more information about business event groups,
see Business Event Groups, page 6-3.

6. Click OK to display the Application Interface page.
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Adapter Configuration Wizard - Application Interface Page

ﬂ Cracle Applications Adapter Configuration Wizard - Step 4 of 5 ﬁ

Application Interface

. o

‘You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables fviews or you can add a single API/Concurrent Program XML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
r Operation Objects
@ Delete
Mame Type
oracle.apps.po.event. xmipo Business Event Cutbound
Help = Back Mext = Cancel

7. Click Next in the Application Interface page. The WF Event Schema Definition page

for business event payload appears.

8. Specifying Event Schema

You must specify one of the following options to be used for the business event
payload:

Note: When you select either the 'No Schema' or 'Any Schema'
option, there is no need to further specify the schema information
for your business event, and you will proceed to the next step.

No Schema

If you select the No Schema option, then the payload data would be available in
the form of string. This option also allows you to receive non-XML event
payload.

Any Schema
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If you select the Any Schema option, then XML payload of any schema could be
attached to event payload. You should select this option if you know the
payload is XML, but not sure of its schema.

Note: If a business event group is selected for the partner link
creation, select the 'Any Schema' option. This allows any
schema to be attached to a business event group.

Specify Schema

If you select the Specify Schema option, then the Schema Location and Schema
Element fields become visible. You must specify the location of schema file and
then select the schema element that defines the payload of outbound business
event.

Using Business Events  6-17



Selecting Business Event Payload Schema
i hl
-ﬂ Cracle Applications Adapter Configuration Wizard - Step 5 of 6 @

WFEvent Schema Definition

Specify the schema for Business Event payload.
If you choose ' Mo Schema' then the payload data would be available in the form of string. This option allows you to
receive non-xml event payload as well,
If you choose "Any Schema' then xml payload of any schema could be attached to event payload. Choose this if you
know payload is xml but not sure of it's schema.
If you choose "Specify Schema' then you would be prompted to specify the location of schema file and then select
the schema element that defines the payload of outbound Business Event.
Use 'Browse' button to search for an existing schema definition.

Choose Schema

(#) Mo Schema
() Any Schema
() Specify Schema

Help « Back Mext = Cancel

Select 'No Schema' and click Next.

9. The Finish page appears indicating that you have finished defining the business
event service.

10. The Set Transaction Properties of BPEL Service dialog appears. Ensure that 'sync' is
selected in the Delivery field and 'required' is selected in the Transaction field.
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Setting the Transaction Properties of BPEL Service
-

|£:| Set the Transaction Properties of BPEL Service @

Delivery: |S'5|'T'IC "'| =)

Transaction: |required '| 2
Help QK Cancel

Click OK to complete the partner link configuration.

The wizard generates the GetPOApprovalEvent WSDL file corresponding to the
oracle.apps.po.event.xmlpo business event service.

The partner link is created with the required WSDL settings, and is represented in
the BPEL project by a new icon in the border area of the process diagram.
. Verifying JCA Property "MessageSelectorRule" for an Event Group Partner Link

If a business event group is selected for the partner link creation, you can verify the
business event group Jca property by selecting the partner link service (such as
BE Group apps.jca from the SOA Content > Adapters folder.
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Applications
GetPOAdBusinessEvent v o

=| Projects SR AR
O] cetPoAckBusinessEvent

EID Resources

b |E| pom. xml

=-£3 soa

=[] Adapters

------
...... GetPOApprovalEvent_apps.jca
...... [@] %x_BPEL_WFEVENT_BE_Group_drop.sgl
...... [B] %x_BPEL_WFEVENT_BE_Group.sql
...... [B] xx_BPEL_WFEVENT_GetPOApprovalEvent_drop.sq
...... [B] xx_BPEL_WFEVENT_GetPOApprovalEvent. sl
-7 BPEL
----- 7] Events
=-{ 7] Schemas
b o APPS_WF_EVENT_T_BE_Group.xsd
- APPS_WF_EVENT_T_GetPOApprovalEvent.xsd
-] testsuites
&[] Transformations
- WsDLs
..... ] GetPOAdBusinessEvent
----- JE measurements. xml

Click the Source tab to display the .jca file. Notice that the JCA property
"MessageSelectorRule" contains the value of

value="tab.user data.getvalueforparameter ('GROUP') =
'oracle.apps.fem.event.group.all'".

el g PoAdOutboundXMLGateway.bpel (2] pomaml  offE Gerro) messEvent | ga GeiPol messEvent.hpel | (2] BE_Group_apps.jca Y
Fnd AR |

Bi<adapter-config name="BE_Group" adapter="Rpps" wsdlLocation="../WSDLs/BE_Group.wsdl" xmlns="http://platform.integraticn.pracle/blocks/a

<connection-factory UIConnectionName="Adapter" location="eis/Apps/Adapter” UIWLEventName="oracle.apps.fem.event.group.all™ UIOraclelp
B  <endpoint-activation portType="DEQUEUE_ptt" operation="DEQUEUE">
=] <activation-spec classNam oracle.tip.adapter.apps.AppsWEBesQueueDequeuehctivationSpec™>
<property name="(QueueName" value="WF_BPEL Q"/>
<property na "DatabaseSchema™ ="RPEF5"/>
44d9i 8cg] fhhk70skedhmEh™ />
e="tab.user_data.getvalueforparameter ('GROUF') = 'oracle.apps.fem.event.group.all’'"/>

MessageSelector]
"EppaEventichema”
<property name="OpagqueSchema" wvalue="f;
</activation-specs
</endpoint-activation>

<«/adapter-config>

Configuring the Receive Activity

The next task is to configure a Receive activity to receive event details from the partner
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link that you just configured for the adapter service as an input to the Assign activity.

To configure the Receive activity:

1. In]JDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette. Drag and drop Receive from the Web Service section into the center swim
lane of the process diagram.

2. Link the Receive activity to the partner link Get POApprovalEvent that you just
created earlier.

Associating the Receive Activity with the Partner Link

" O

Partner Links

uew @M

Receive_1

&

O | [> 'pprovalEy. ..

The Receive dialog appears.

3. Enter an appropriate name for the Receive activity.

The Dequeue Operation is automatically selected since the partner link has been
configured with an outbound business event.

4. Specify a Variable to receive the message data from the partner link by clicking the
Create icon to the right of the Variable field. The Create Variable dialog box
appears.

5. Click OK to accept the default name.
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Configuring the Receive Activity

© Edit Receive o

Sources  Headers  Skip Conditon  Timeout

Annotations Assertions Documentation Targets
General Correlations Properties

Mame: |F'.e::ei'u'e |

Conversation ID: | |

[ ] Create Instance

Interaction Type: | ¢4 Partner Link »

Partner Link: |GE1:F‘D.ﬁ.ppro1.-'alE1.rent | 'y
PortType: | DEQUELE pt v
Operation: | Oy DEQUELIE "|

() Arguments Mapping (@) Variable )
Variable: |F‘.e::eiue_DEQUEUE_Input'u'ariabIe | EF Ck
Help Apply Ok Cancel

6. Click Apply in the Receive dialog, then click OK.

Adding a Partner Link for the File Adapter

If you are configuring an outbound business event, you need to add another partner
link for the file adapter. This allows the outbound business event to write the data to the
XML file.

To add a partner link for the file adapter:

1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component
palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
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swim lane of the process diagram. The File Adapter Reference page appears.

The File Adapter Reference Page

- -
-ﬁ FILE Adapter Configuration Wizard - Step 1 of 4 M

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

This wizard helps you create a File Adapter. You wil be asked to specify configuration parameters and define an
operation for the adapter.

Enter a Reference Mame.

Mame: |WriteEventData

Help ack ' Mext = ' nizh Cancel

Enter a name for the file adapter service. For example, enter WriteEventData.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
L B
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 @

Adapter Interface

P

The adapter interface is defined by a wsdl that is generated using the operation name and schema(s) specified later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: @ Define from operation and schema (spedfied later)

() Impart an existing WSDL

[Ef

Help < Back MNext = Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.

Click Next
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r
@) FILE Adapter Configuration Wizard - Step 3 of 4 g

File Server Connection

Specify the JNDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter

must associate this JNDI name with a set of configuration properties needed by the File Adapter to access the File
Server at runtime,

File Server JNDI Name |Eisa'Fi|eAda|:lter|

|

Help < Back | Next =

I
%1

Cancel

3. In the Operation page, specify the operation type. For example, select the Write File

radio button. This automatically populates the Operation Name field.
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Specifying the Operation

p
@) FILE Adapter Configuration Wizard - Step 4 of 7 ﬁ

Operation

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
gystem, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in spedfied locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used ONLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: (7) Read File
(@) Mirite File
() Synchronous Read File
() List Files
(") Chunked Read

Operation Name: |Write

[ ] Add Output Header

Help < Back Mext = i Canicel

4. Click Next to access the File Configuration page.
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Configuring the Output File
ﬂ FILE Adapter Configuration Wizard - Step 5 of 7 M

File Configuration

Spedify the parameters for the Write File operation.

Directory specified as () Physical Path (=) Logical Name
Directory for Cutgoing Files (logical name):
outputDir

File Naming Convention (po_%eSEQ %, txt): |EventAdc%yyMMddHHmmss%.xml

[] Append to existing file

Write to output file when any of these conditions are met
Mumnber of Messages Equals: |1

v

Help <« Back Mext > Cancel

For the Directory specified as field, select the Logical Name radio button. Enter
outputDir as the Directory for Outgoing Files (logical name) and specify a
naming convention for the output file, such as EventAck%yyMMddHHmms s% . xm1.

Tip: When you type a percent sign (%), you can choose from a list of
date variables or a sequence number variable (SEQ) as part of the
filename.

Confirm the default write condition: Number of Messages Equals 1.

Click Next, and the Messages page appears. For the output file to be written, you
must provide a schema.

Click Browse to access the Type Chooser.
Expand the node by clicking Project Schema Files >

WF_EVENT_T_GetPOApprovalEvent.xsd. Select WE_EVENT_T as the element
and click OK.
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The selected schema information will be automatically populated in the URL and
Schema Element fields.

Populating the Selected Message Schema

ﬂ FILE Adapter Configuration Wizard - Step 6 of 7 @

Messages

Define the message for the Write File operation. Specify the Schema File Location and select the Schema Element
that defines the messages in the outgoing files, Use the Browse button to find an existing schema definition. If you
check 'Schema is Opague’, then you do not need to spedfy a Schema.

Message Schema

[] Mative format translation is not required (Schema is Opaque)

URL [../Schemas/APPS_WF_EVENT_T_GetPOApprovalEvent. xsd | Q o3

Schema Element |VWFE_EVENT T |

Help | < Back Mext = Cancel

9. Click Next and then Finish. This completes the configuration and creates the
partner link with the required WSDL settings for the File Adapter service. The
wizard also generates the WriteEventData.wsdl WSDL file corresponding to the
partner link.

The WriteEventData Partner Link appears in the BPEL process diagram. Double
click the Partner Link service icon to open the Edit Partner Link dialog and view the
details.
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Completing the Partner Link Configuration

© Edit Partner Link e

Gerneral | Image  Property  Documentation  Idempotence

MName: |'|.f'.|'riteE~.rentData |

Process: |GE1:F‘DP.ds:EiusinessEuent |

[ ] Initialize Partner Role
WSDL Settings

QAaz @

WSDOL URL: |.. /WSDLs WriteEventData.wsdl |
Partner Link Type: |ndfi'° Write_plt 'l
Partner Role: hB Write_raole "’l
My Role: 33, —— Not Specified — -
Help Apply Ok Cancel

Configuring an Invoke Activity

After adding the File Adapter partner link, you need to configure an Invoke activity to
associate it with the File Adapter link.

Through the Invoke activity, the business event information can be written to the XML
file you specified as the output directory.

To configure an Invoke activity:
1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the

Component Palette. Drag and drop an Invoke activity from the Web Service

section into the center swim lane of the process diagram after the Receive activity.
2. Link the Invoke activity to the WriteEventData File Adapter service.

The Invoke activity will send event data to the partner link. The Edit Invoke dialog

appears.

3. Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
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create a new variable. The Create Variable dialog box appears.

4. Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK to return to the Edit Invoke dialog.
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Editing the Invoke Activity

© Edit Invoke S

Documentation =~ Targets  Sources | Skip Condition = Headers

General Correlations Properties Assertions Annotations

Mame: |Irwnke |

Conversation ID: | | el

[ ] Invoke as Detail

Interaction Type: |r._,i3_!. Partrer Link *

Partner Link: |WriteEuer1tDa13 | &,

PortType: |3 " write_ptt -

Operation: | Gy Write =

Input

() Arguments Mapping (=) Input Variable )

Input: [Invoke_Write_InputVariable |I$ Ck

Help Apply 84 Cancel

Click Apply and then OK to finish configuring the Invoke activity.

Configuring an Assign Activity

Use the Assign activity to take the output from the Receive activity and to provide
input to the invoke activity.

To configure an Assign activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Assign activity from the Basic Activities
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section into the center swim lane of the process diagram, between the Receive
activity and the Invoke activity.

2. Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
setEventData.

3. Select the Copy Rules tab and expand the target trees:
¢ In the From navigation tree, navigate to Variable > Process > Variables >

Receive_ DEQUEUE_InputVariable and select WF_EVENT_T.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_Write_InputVariable > body > ns3:WF_EVENT_T.

Drag the source node (WF_EVENT _T) to connect to the target node (body) that you
just specified. This creates a line that connects the source and target nodes. The
copy rule is displayed in the From and To sections at the bottom of the Edit Assign
dialog box.

Assigning Parameters

@ Edit Assign [
General = CopyRules  Annotations  Documentation | Targets  Sources — Skip Condition
|Insert Mew Rule After ~ Ef“l E‘?ﬂ @ =y
& GetPOBckBusinessEvent.bpel GetPOAckBusinessEvent.bpel
- Partner Links Partner Links [
=[5 variables variables [5-5
= s Process Process g =
=13 variables variables [£5-=
E}m Receive_DEQUEUE_InputVariable B  Receive_DEQUEUE_Inputvariable (x‘)
-] wF_EVENT_T :::\g; Inwoke_Write_Inputyariable )=
Invoke_Write_Inputvariable .‘ ; body -2
B i nsSWE_EVENT_T -
e e
L
From To
% SReceive_DEQUEUE_InputVariable.WF_EVENT_T & SInvoke_Write_InputVariable.body
Help Apply OK Cancel

4. Click Apply and then OK in the Edit Assign dialog box to complete the
configuration of the Assign activity.

6-32 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



Completed Outbound Business Event BPEL Process Project
= Q
‘ e GetPOApprovalEy. ..

Feceive

im setEventDaka

l
11 WritEE{\%ntData J

Irwoke

®

Click the GetPOApprovalEvent (composite.xml) to display the Oracle JDeveloper
composite diagram:

Partner Links

uew | [

Note: Click the Source tab of GetPOApprovalEvent
(composite.xml) to enter a value for the physical directory
outputDir for the reference WriteEventData (such as /usr/tmp).

<property name="outputDir" type="xs:string"
many="false" override="may">/usr/tmp</property>
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Specifying the Physical Directory for the Property
el | [2] pomaaml | ol GetroAckBusi t
Q- Find

fa GetPOs i stbpel [ BE_Group_apps.jca (4]

R E

schemas. xmlscap. org/ws/2004/09/policy”
fschemas. oracle. com/ws/ 01/policy”

=l

importTypes="vsdl"/>
"GetPO ... property> </services
=="AppsR ... propertys </services
=="BE_Gr ... propertys </services

roductVersion” type="xs:string” m

HEEHBHBE®H

<property na

"false">12.1.1.0.0</property>

<property 32">7c346929-782b-45a8-8dac-0032be982877</property>
<compenen:
<reference n: ta” ui:wsdlLocation="WSDLs/WriteEventData.wsdl">
<interfa xmlns.cracle.com/pcbpel/adapter/£ile/GetPOAckBusinessEvent /GetPOACkBusinessi
<binding.j iteEventData file.jca”/>
|  <property name=" ype="x3:string” many="false" override="may">/usr/tmp</property>
</reference>
B <wire>

<source .uri>GetPOApprovalEvent</source.uri>
<target.uri>GecPOAckBusinessEvent/GetPORpprovalEvent</target. uri>
</wire>
B <wire>

Oracle JDeveloper Composite Diagram

&

= {% ® GatPOMI:BmII‘Ii._ @ = {%

GetPOApprovalEvent Write EventData
Operations: Operations:
DEQUELE Write

Run-Time Tasks for Outbound Business Events

After designing the SOA Composite with BPEL process, you can compile, deploy and
test it.

1. Deploy the SOA Composite application with BPEL process, page 6-34.

2. Test the SOA Composite application with BPEL process, page 6-38.

Deploying the SOA Composite Application with BPEL Process

To invoke the service (GetPOApprovalEvent) from the BPEL client contained in the
SOA composite, the SOA composite needs to be deployed to the Oracle WebLogic
managed server. This can be achieved using Oracle JDeveloper. Once the composite is
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deployed, it can be tested from the Oracle Enterprise Manager Fusion Middleware
Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 11-1 and Creating an Application Server Connection, page 11-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:

1. In the Applications Navigator of JDeveloper BPEL Designer, select your SOA
Composite project name (such as GetPOAckBusinessEvent).

2. Right-click the project name, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy > GetPOAckBusinessEvent > soa-serverl to
deploy the process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.
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Deployment Action

-);.\- Deployment Action | Select a deployment action from the list below.

| .
/T'\ Deploy Confiquration Deploy to Application Server

Deploy to SAR
/I\

/l\

Deploy this archive to SOA configured Application server(s)

Help Mext = || Einish || Cancel

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

¢ New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

¢ Opverwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from

JDeveloper are covered inCreating an Application Server
Connection, page 11-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.
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/l.\ D Actio Application Servers:
S Deploy Configuration

IntegratedeblogicServer (domain unconfigured)
T _
}?’{ Select Server

|
/T\ SOA Servers

EPHOYT

Qwerwrite modules of the same name

[ <Back | Mext: I[ Finish H Cancel ]

4. In the SOA Servers page, accept the default target SOA Server ('soa-serverl’)
selection.
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SOA Servers
Choose the target S0A server(s) and correspanding partitions to which you want to deploy
/I\ this archive.
AT SOA Server: Partition: Status: Server URL:
g, Select Server S03_Server efaul hd thost0l exam..
Select 5 = 1 |default RUNNING http:/} hostol
I
el SO0A Servers
|
@ Summary
|
| Help | < Back || Next = | | Finish | | Cancel |
Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

5. Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window as well as in the Deployment - Log
window.

Testing the SOA Composite Application with BPEL Process

Once the SOA Composite application with BPEL process is deployed, you can manage
and monitor the process from the Oracle Enterprise Manager Fusion Middleware
Control Console. You can also test the process by manually initiating it.

To test the SOA Composite application with BPEL process:

1. Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
http://<servername>:<portnumber>/em). The composite you deployed is
displayed in the Applications Navigation tree.
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ORACLE’ Enterprise Manager Fusion Middleware Control 12¢ e

Login
Farm Farm_soainfra
* User Name [weblogic

=Passnord [es

Logn

Enterprise Manager Key Features New in this Release
o ,

v Test your applications using real world workdoad using the:
Application Replay functionality

» Automate Routine Tasks
» Stay ahead of the curve with My Oracle Support Integration
» Manage Many-as-One with Groups
» Complete, Integrated, Application-to-Disk IT Management
cover IT assets using dram lly improved Target Auto-

» Complete, Unified and Business-Driven Enterprise Cloud
Management
» SOA Management with improved dehydration diagnostics

Enter username (such as weblogic) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple

target Oracle Enterprise Manager Fusion Middleware Control Console farms.

From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_serverl)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA Composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
When you expand the SOA folder in the navigator and click the
links displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Log on to Oracle E-Business Suite with the XML Gateway responsibility.

This is to ensure that the XML Gateway trading partner is set up correctly so that a
purchase order can have a valid supplier that has been defined.

Select Define Trading Partner from the navigation menu to access the Trading
Partner Setup window.

Enter the header values on the Trading Partner Setup form as follows:

e Trading Partner Type: Supplier

e Trading Partner Name: Advanced Network Devices
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Trading Partner Site: Enter a trading partner site information, such as 2000
Century Way, Santa Clara, CA 95613-4565.

Company Admin Email: Enter a valid e-mail address.

Enter the following trading partner details:

Transaction Type: PO

Transaction SubType: PRO

Standard Code: OAG

External Transaction Type: PO

External Transaction SubType: Process
Direction: Out

Map: itg_process_po_007_out

Connection / Hub: DIRECT

Protocol Type: HTTP

Username: 'operation’

Password: Enter the associated password twice.
Protocol Address: 'http://appsadapter.sample.com'

Source Trading partner location code: STPLC
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Trading Partner Setup Form

O Trading Fanrar Setup

(CETE RGN sion Cnerations
Trading Partner Type | Supplier
Trading Partner Mame | Advancad Metwork Devices
Trading Partner Ste |2000 Century Way Santa Clara CA 95613-4555

Company Admin Email  nobodyi@localhost

User Setup Code Comersion J
Trading Parner Details
Extemnal Extemal
Trangaction Transaction Standard  Transaction  Transaction Connaclion”  Protocal

Type SuhType Caode Type 5uhT3|pE Diraction Map Hub T]rpe =
l PO FRO DA |E’D [PROCESS OUT itg_process_p |DIRECT |HTTF

| |
| |
]
——
]
|
| |
| |

| b

Save the trading partner details.

8. Switch responsibility by selecting the Purchasing, Vision Operations (USA) and
select Purchase Order from the navigation menu.

The Purchase Order forms is displayed.

9. Create a purchase order with the header values reflecting the trading partner you
previously defined in the Purchase Order window:

* Supplier: Enter a supplier information, such as 'Advanced Network Devices'.
e Site: Select a site information, such as 'SANTA CLARA-ERS'.
10. On the Lines tab, enter a data row with the following values:
e Type: Goods
e Jtem: CM13139
* Quantity: 1

® Description: Hard Drive - 8GB
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* Promised: Enter any future date in the format of dd-mmm-yyyy (such as
23-JUN-2009).

11. Save your purchase order. The status of the purchase order is 'Incomplete'.

Setting Up a Purchase Order

PO, Rev [H43 Type |Standard Purchase Order Crested [19-JUL-2006 D2:25:53

Supplier Advanced Network Devices Sile [SANTA CLARA-ERS Conlacl
Ship-To [M1- Seatile ] BilkTe [W1- New York City ] Cumency [USD
Buyer |Stack, Ms. Pat Statue [Incomplete Total [150.39 tEh
Diescription
F-Card
Frice F Ref: (1] hore AGTERTENE
Murn  Type lern Rev  Category Description IO Cuantity Prrice Promizad
. 1 Soods CM13139 | PRODUCTN.DRI"Hard Drive - 8GEB IEach 1 [ﬁ.ﬁﬂ:ﬂ 20 JUL 2007 004 |Ll =)
i e [ [
! [ [ I
E 1 .l B
; [ [ L]
i [ [ g
| [ [ [
! [ [ [
i | [ | [ [ . (5
1l it R A | 3
ftem |[CHI13139 Hard Drive - 83GB
I: Catalog Currency... | | Terms | | Shipments I I Approve. .. )

12. Click Approve. The Approve Document form appears.

6-42 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



Approving the Purchase Order

B Oracle Applications - atgzdh2: Patch Test Enw
. SJUL-Z006 02:25:53
Tzl OTYE:
=11
Unreserve Date | 0.33 T
Accounting Date
Farerand From [
Appraval Path
Forward To Promised I
e 20.JUL-2007 B0:0 =
T ission Methods
- ML
F s Murnbar CEL
E-Mail Addrass
»
| 0l I | Cancel )I
Currency... Terins Shipraants Apprave,.
T

Click OK to confirm the approval.

Note: Because the trading partner is set up and valid, the
transmission method is automatically set to XML.

The status of the purchase order is now changed to 'Approved'. For future
reference, record the value of the PO, Rev field (for example, the PO number 4449 in
this case).

Once the purchase order is approved, the business event
oracle.apps.po.event.xmlpo is raised.

13. Use the following steps to ensure that the WF_Deferred Agent Listener is running
on the target database.
1. Log on to Oracle E-Business Suite with the System Administrator responsibility.

2. Select the Workflow Administrator Web Applications responsibility and choose
Oracle Applications Manager > Workflow Manager from the menu.
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soft Internet Ex

Edit View Favorites Todls Help

| a
Q= - O - ¢ (&) (3 P irenes @020 - B B 3 |
Address [£] hep://qapache s cracle. com 8482joa_ser BN
- |
ORACLE . _
Applications Manager o) @@ )
Spef Gt Selip bome Logut Hel
Applications Dashboard |

>
¥ Related Links

Workflow System: atgzdb2
Last Updated: 19.07-2006 028015 (2,
Matification Mailers &3 up. Background Engines 43 up
Agent Listeners &

Purge & up
Senice Components &y Control Cueue Cleanup &3 up

Submit Request For [Background Engines =] G )

Related Database Parameters

Last Updated: 2006 0250 16
Parameter Name Parameter Value Rocemmendod Value Description
Job_gusue_processes 2 104y number of job queue slave processes
ag_im_processes 1 =1 number of AG Time Managers to start
Workflow Metrics ® Retum ta Top
Work ltems Agern Aty
B Shaw B Show
Related Links ® Raturn 1o Tap
Confignation Thw auglurit
Senice Componants Work lems
s Propagation Aqen Activity
Hatrication Msilers
|_Add 10 Support Can
Supporl Cart | Setup | Home | Logout | Help
Cepyright 2001, 2005 Orescle Ceeporetin. & Rights Reserved

ei Ot Spiieshoris Meseper ersicn 291

L]

[T [ mrusted ses

On the Applications Manager page, click the Agent Listeners icon. The Service
Components page appears, containing a list of the installed agent listeners.
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Reviewing Agent Listener status
ORACLE Suppent €

tepications Dashoaard | Site Map
Applcefions Syslencalgiiicd = Workdow =
Servioe Conpoments: atgl Hdd

Add Lo Suppior
Lt Updsted | 26-Teb-2000 0520157

Fiter | Trpe dnterra) | [WE_sacEnT |[oe | wesify Al | ©

Select o Service Compunent and .| Edit | View Log | View Detalls || view Event History | Delete

Sedeck Hame & | Status [rype Skarbup Mode Container Type  [Conksiner Inctions
@ B irbound Bgent Lterar T | Rfrnsh
© et tean s - o Runring acrkflom Agent Listener otorak g;:l."t.ﬂ:ﬁ:.tn'\rs ';:.l-rlccx.ﬂncf: Lkt .Mh“ |
Ie}  Funning E‘!ﬂ:é'h:h Jurva Agent J— g;‘:!t-ﬂwimv-'\;: |
O ok Savvizes T aaert v Rupring  (Workfoe Jirea gent puten o S [Retrush
O workflow feferrod Ak Lbene o WIS o Agent Listerer dustoratic ;ﬁum‘:““ =
o] ﬂ%&w o RUTND i At Lt Aot g;‘:'e.n:d:xo-\;: Fafresh v
(8] tLEREE o R o gant Liteter Mistoniatic %‘:‘*nmk*v* it |Rafrash w
O workflaw o T dgert Listener o UG o Agent Liserer dustomatic ;':f“:ﬂ:'““ :::_.L::“Tﬂmw" |Rebresn
o b o Running ek At Lisirmr Al ai g;‘:ltﬂmru ! P [Rabresh =
O siorbfiow 2ava ufemed Aeck Listang v Rty CS‘:G:.“ fara Rt Autoratic &:\Mwb:wi gﬁ‘!xn E— |Refrnsh %
O T T TR T A o Rumring :\so-:r;:x T Agenit ek ;.::t.&npﬂ:.\tn-\-: f.-. .._“ AR L i _I'..efmn 3

Select a Service Component and .| Edil | View Liy || Wiews Details || View Event History | Delete

4. Confirm that the Workflow Deferred Agent Listener is in Running status.

14. At this time, your deployed BPEL process contained in a SOA Composite is
listening for oracle.apps.po.event.xmlpo business event. Please allow 2 to 3
minutes for the BPEL process to activate after the event is raised.

15. Go to the directory, for example outputDir (typically under c: \ temp) you specified
for the write operation. Open the output file (such as
EventAck%yyMMddHHmmss . xm1), and confirm that the order number is same as
that of the approved purchase order.
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Confirming the Output Order Number

\PO_1.xml| =lelx|
Document Froject Tooks Window  Halp =18 x|

JedRBay D s B X 2 =% 4% 6 4w

EF0EE0 e

Qe sy Frdw s @t=dEss=£2)FadBE
I 2 |

>2006-07-15T02 :36: 46.000+05: 30</ 25
D06-07-19T02:37:32. 000405: 304/ R
> ¢/CORRELATION 10>

OCUMENT_DIRECTION</HANES
T2/ VAL IES

o b

X DEBUG_LEVEL</NAME»
£x0</

BESRGZLRE

TTEM>
. PARAMETERZ </HANES

3161505761201/
4 </PARAMETER_LIST_ITEX>
LIST TTEM:
HECK_PARANETER4</HANE:
E>32522¢/VALUEY

& _TVYPE</HANE>
<VALUEMS</ VALUE>

1o

BEEp://Hmins. oracLe. com xds/ BPPS ">

il

1| otempict e hesder (o default groug s Degueverws| o freqist  |o GelPOAppray]» po 06071804 po 06071000 o po 06071902 opoxsd | eempasd | eNonamei |oevent datal] oPO_1iml

For Help, press F1

Troubleshooting

hia

col 21 132) 3¢

Fc Jrec s [REen

If you experience problems with your Business Event System integration, you can check

the following troubleshooting steps:

¢ Confirm that Workflow Deferred Agent Listener is up and running.

¢ Ensure that business events are raised after the Composite is deployed.

¢ If the partner link of Oracle E-Business Suite Adapter is created on one instance of
Oracle E-Business Suite and deployed on another, ensure the following on the

target database:
e  WF_BPEL_Q queue exists

* A custom subscription for the business event being raised is present

Note: The above two can be easily re-created by running the
XX BPEL WFEVENT <parnerlink name>.sql (located in the
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project folder) on the target Oracle E-Business Suite database.

¢ Enable logging for Adapter to see if the issue is on the middleware side. For
information on enabling logging for Oracle E-Business Suite Adapter, see Enabling
Logging for Adapters, page 4-125.
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7

Using Concurrent Programs

This chapter covers the following topics:

¢ Opverview of Concurrent Programs

¢ Design-Time Tasks for Concurrent Programs

* Creating a New SOA Composite Application with BPEL Project
e Adding Partner Links

* Adding Partner Links for File Adapter

¢ Configuring Invoke Activities

e Configuring Assign Activities

* Run-Time Tasks for Concurrent Programs

* Deploying the SOA Composite Application with BPEL Process
® Testing the Deployed SOA Composite Application with BPEL Process
¢ Verifying Records in Oracle E-Business Suite

* Troubleshooting

Overview of Concurrent Programs

A concurrent program is an instance of an execution file. Concurrent programs use a
concurrent program executable to locate the correct execution file. Several concurrent
programs may use the same execution file to perform their specific tasks, each having
different parameter defaults. Concurrent manager runs in the background waiting for a
concurrent program to be submitted. As soon as a concurrent program is submitted, it
is put into an execution queue by concurrent manager. Concurrent manager also
manages the concurrent execution of concurrent programs.

Concurrent programs associated with the Open Interface Table move the data from
interface table to base tables. While other concurrent programs execute the business
logic and application-level processing for Oracle E-Business Suite.
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Accessing Concurrent Programs

Use Oracle E-Business Suite Module Browser to access concurrent programs either by
browsing through product family or by performing a search to locate your desired
concurrent programs.

Custom Concurrent programs

For custom concurrent programs, they are displayed in the Oracle E-Business Suite
Module Browser under the Other Interfaces > Custom Objects > Concurrent Programs
node.

Browsing and Selecting a Custom Concurrent Program
© Oracle Applications Module Browser =

Object Name: | | [JTables [Jviews [J&Pls [JCB [J¥MLGateway []EDI []BusinessEvents Browse

=65 ProductFamilies
(&3 Advanced Planning (SCP_PF)
(3 Applications Technology (ATG_PF)
(58 Contracts Suite (OK_PF)
(53 Discrete Manufacturing (DMF_PF)
(&3 Financial Globalizations Suite (FINGB_PF)
(58 Financial Payables Suite (FINAP_PF)
(53 Financial Receivables Suite (FINAR,_PF)
(58 Financial Services Applications (SEM_PF)
(58 Financials (FIN_PF)
(58 Human Resources Suite (HR_PF)
(53 Interaction Center {CC_PF)
(58 Marketing Suite (MKT_PF)
(58 Marketing and Sales Suite (MAS_PF)
(53 Order Management Suite {OM_PF)
(58 Process Manufacturing {OPM_PF)
(S8 Procurement (PRC_PF)
(58 Product Lifecyde Management (PLM_PF)
(58 Projects Suite (PI_PF)
(S8 Public Sector (PS_PF)
(53 Sales Suite (SLS_PF)
(53 Service Suite (SRV_PF)
(58 Supply Chain Management (SCM_PF)
(58 University (UNV_PF)
(=) (5 Other Interfaces
[} (5@ Business Events
(53 Inbound(Raise Business Events into O1
(53 Outbound(Listen to Business Events fr
(= (% Custom Objects
(53 PLSQL APTs
3% XMLGateway Maps
= (3 Concurrent Programs ~———
.. ADS Archive Demand Plan (ADSAR
F., ADS Batch Import (ADSBATCHIMP)
i.: ADS Cross currency lockbox flat f
g; ADS Customer Listing - Detail (ADS

Cancel

Alternatively, you can perform a search to locate your desired custom concurrent
programs.
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Searching for a Custom Concurrent Program

© Oracle Applications Module Browser ===
Object Name: | ADs% ] []Tables [Views []APIs [|CP [ |¥MLGateway [ |EDI [ |BusinessEvents Browse
3 & ADS%

5 >

= = Custom Objects

&5 Concurrent Programs

ADS Archive Demand Plan (ADSA
ADS Batch Import (ADSBATCHIMF
ADS Cross currency lockbox flat
ADS Customer Listing - Detail (&
ADS Danish Postal Code Upload |
ADS Date Specific Purge ODP Fac
ADS Deductions Lockbox Flat Fils
ADS Delete Records in Self Servic
ADS Financials (ADSFINS)
ADS Invoice Print Selected Invoic
ADS Kill ODP Session (ADSKILLOI
ADS ODF OLAP Request (ADSODI
ADS Open Periods (Concurrent F
ADS Process To Discrete Transfe
ADS Purge Demand Plan (ADSPUF
ADS Purge Order Transactions ¢/
ADS Receive (ADSREC)
ADS Reset ODP Status (ADSODPS
ADS Restore Custom Demand Plz
ADS Restore Demand Plan (ADSR
ADS Russian Employee Name Chi
ADS Transaction Detail Report (A
2, ADS Transactions (ADSTRANS)
H, ADS UKHR OTL Create Timecard
F. ADS USD lockbox flat file creatior
5. ADS Update Invoice API (ADSINVC
., ADS Update Process to Discrete”
%, ADS - Create Hew Transactions
%, ADS Archive Demand Plan (ADS/
F. ADS Batch Import (ADSBATCHIM
&, ADS Cross currency lockbox fla
&, ADS Customer Listing - Detail (£

9,300 300303000090 300360 00 4030 00000308000 90 30 30 30

Cancel

Design-Time Tasks for Concurrent Programs

This section describes how to configure the Oracle E-Business Suite Adapter to use
concurrent programs.

SOA Composite Application with BPEL Process Scenario

Take Open Interface: Order Import concurrent program (OEOIMP) as an example. This
concurrent program allows you to run the Order Import process to retrieve order
details from the Order Management open interface tables to create sales orders.

When a request of creating an order is received, order details will be passed and
inserted into Open Interface tables (OE_ HEADER IFACE ALL and

OE_LINES_ IFACE ALL). Once the insertion is completed, the concurrent program is
invoked to import order data from Open Interface tables to Order Management base
tables.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you should find the order is created in Oracle E-Business
Suite. The purchase order ID should be the same as the payload input value.

Prerequisites to Configuring Concurrent Programs
Populating Applications Context Header Variables

You need to populate certain variables in the BPEL PM in order to provide context
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information for Oracle E-Business Suite. The context information is required for a
transaction in order for an Oracle E-Business Suite user that has sufficient privileges to
run the program.

The context is set taking into account the values passed for the header properties
including Username, Responsibility, Responsibility Application, Security Group, and NLS
Language. If the values for the new header properties Responsibility Application, Security
Group, and NLS Language are not passed, context information will be determined based
on Username and Responsibility.

The default Username is SYSADMIN, the default Responsibility is SYSTEM
ADMINISTRATOR, the default Security Group Key is Standard, and the default NLS
Language is US.

You can change the default values specified in the generated WSDL. This is a static way
of changing the context information. These values would apply to all invocations of the
deployed business process. However, if you need to provide different context
information for different invocations of the business process, then you can dynamically
populate the header values. The context information can be specified by configuring an
Invoke activity.

For more information about applications context, see Supporting for Normalized
Message Properties, page 4-7.

SOA Composite Application with BPEL Process Creation Flow

Based on the process scenario, the following design-time tasks are explained in this
chapter:

1. Create a new SOA Composite application with BPEL process, page 7-4
2. Add partner links, page 7-10

3. Add a partner link for File Adapter, page 7-27

4. Configure Invoke activities, page 7-39

5. Configure Assign activities, page 7-46

Creating a New SOA Composite Application with BPEL Project

To create a new SOA Composite application with BPEL project:
1. Open JDeveloper BPEL Designer.

2. Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.
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The New Gallery Page

= nplications

----- Connections
----- Deployment Descriptors
----- Deployment Profiles

----- Projects
----- Service Constructor

[=+-Business Tier

----- ADF Business Components

----- Business Rules

----- Contexts and Dependency Injecti

ADF Java Desktop Application
[ﬂ Application from EAR File

?‘ Application Template

Custom Application

Database Application
Extension Application

Java EE Web Application

QEP Application

Service Bus Application

O New Gallery I.g
Q
Categories: Items: ["] Show All Descriptions

..... Data Controls Service Bus Application With Service Bus Project
----- EIB =
S0A Applicatiol
----- Enterprise Scheduler Metadata ppiication
_____ Security Creates a SOA (service-oriented architecture} application. The application
) conzistz of one SOA project for the SOA composite, components, and adapters.
----- TopLink/JPA
o me—ee— UML Application

Help oK Cancel
L
Click OK.

3. The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page

-
ﬁ Create SOA Application - Step 1 of 3

Name your application
= e Application Mame:
il Application Name |DrderImporU:onmrrenﬂ?rogram
Project Mame
Directory:
ww Project SOA Setfings |C:\,JDeveloper\mywork‘l,lZc\,DrderImportConmrrenIProgram Browse...
Application Package Prefix:
Help Next = Finish Cancel

Enter an appropriate name for the application in the Application Name field.

4. Click Next. The Create SOA Application - Name your project page is displayed.

Enter an appropriate name for the project in the Project Name field. For example,

OrderImportConcurrentProgram.

Notice that SOA Suite is shown in the Project Features section.
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The Create SOA Application - Name your project Page

@) Create SOA Application - Step 2 of 3

Name your project

¥ Application Mame

I
e, Project Name

\.l; Project SOA Settings

Project Name: |OrderImporﬁ:onmrrenu?rogram| |

Directory: |:rIrnportConcurrentProgram‘I,DrderImporh:onmrrentProgram | Browse...

Project Features:

S0A Suite
S04 Suite is a suite of tocls to medel S0A(Service Oriented Architecture) applications.

< Back Mext = Finish Cancel

5. Click Next. The Create SOA Application - Configure SOA settings page is

displayed.
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The Create SOA Application - Configure SOA settings Page
r@ Create SOA Application - Step 3 of 3

Configure SOA settings

Compaosite Name:
Application Name

|DrderImporﬁ:oncurrenthgrarn |

Project Name
i

Start from: (2) Standard Composite () SOA Template
|:| Empty Composite

<& Composite With Mediator

{5 Composite With Human Task

&, Composite With Spring Context

.+ Composite With BPEL Process

I
iyl Project SOA Settings

,53,3, Compaosite With Subprocess
0 Composite With Business Rule

[ Customizable

Help < Back Finish Cancel

6. Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
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The Create BPEL Process Page

ﬂ Create BPEL Process ﬁ

BPEL Process |:|

A BPEL process is a service orchestration, based on the BPEL specification, used to describefexecute a ﬁ
business process {or large grained service), which is implemented as & stateful service,

() BPEL 2.0 Spedfication () BPEL 1.1 Specification

MName: |DrderIrnporIiIoncurrentProgram |

Mamespace: |htn:|:H}(mlns.orade.comIDrderImportConcurrentPrograrn-ﬁ|:||:|IOrderImporﬂ:onmrrentProgram!Order|

Directory: |]eveloper\mywork‘l'DrderIrn|:|ortCor1c|..|rrentProgram\DrderIm|:|orﬂ:onmrrenﬂjrogram‘!SDA\.BPEL| Q%

Template: |§! Asynchronous BPEL Process '| ]

Service Name: |orderimportconmrrenu:lrogram_dient |

Expose as a SOAP service

Delivery: |asw1c.persist v| 9

Input: |ogram—AppIDrderImportConcurrer1tProgramIDrderImport:onmrrenﬁ’rogram}pmoess| Q%

Output: |d;|,|f0rderImportConcurrentPr0gramICIrderImporU:nnmrrentProgram}prooessResponse| Ck

Help Ok Cancel

Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
OrderImportConcurrentProgram.

Select Asynchronous BPEL Process in the Template field. Click OK.

An asynchronous BPEL process is created with the Receive and Reply activities.
The required source files including bpel and wsdl, using the name you specified
(for example, OrderImportConcurrentProgram.bpel and
OrderImportConcurrentProgram.wsdl) and
OrderImportConcurrentProgram (composite.xml) are also generated.

Navigate to SOA folder and click OrderImportConcurrentProgram
(composite.xml) to view the composite diagram.
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i dgﬁ
orderimportconcurr... i<] ) D
Operations: kS ;

process
processResponse

Double click on the OrderImportConcurrentProgram component to open the
BPEL process.

Adding Partner Links

The next task is to add a partner link to the BPEL process. A partner link defines the
link name, type, and the role of the BPEL process that interacts with the partner service.

Based on the BPEL process scenario discussed earlier, the following two partner links
need to be configured:

¢ Add the first partner link InsertOrder to insert order details into selected Open

Interface tables

* Add the second partner link ImportOrderCP to import purchase order data from
the Open Interface tables to Order Management base tables

To add the first partner link:
1. Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a service name in the Name field. For example, InsertOrder.

2. Click Next. The Service Connection page appears.
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Specifying a Database Service Connection

@) Oracle Applications Adapter Cenfiguration Wizard - Step 2 of 3 ﬁ

Service Connection

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

Connection:  |Adapter "| EF / %,
User Mame: apps
Driver: orade. jdbc. Oradelriver

Connect 5tring:  jdbciorade: thin: @ocalhost: 1521:sid0 1

A Database Connection is required to configure this adapter. Select a database connection already defined in your
project or create a Mew Connection.

IMDI Mame: |eis,|'Ap1:|s,|'Ada|:|ter | Q

Help < Back Next = Cancel

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle
E-Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 5-14.

* You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.
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Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware User's Guide for Technology Adapters.

4. Click Next in the Service Connection dialog box. You can add a concurrent program
by browsing through the list of concurrent programs available in Oracle E-Business
Suite.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog box appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
e C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog box indicating where your local
copy exists with the creation date and time as part of the file name.
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Using the Local Integration Repository Data File
ﬂ Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R12 (or later) apps instance.

From R 12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDeveloper\mywork\Application 1\AppsAdapter_IrepData

IRep Data file
|ve|o|:|er‘lmywork‘lﬁ.|:||:|limﬁon 1\AppsAdapter_IrepDatalrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

* C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle
E-Business Suite Module Browser.

Oracle E-Business Suite Module Browser includes the various product families that
are available in Oracle E-Business Suite. Expand the tree nodes to locate your
desired interface. Concurrent programs can be found under the Open Interfaces
category.

Navigate to Order Management Suite (OM_PF) > Order Management (ONT) > Sales
Order (ONT_SALES_ORDER) > Openlinterfaces >Order Management Sales Orders Open
Interface (OEOIMP) > Tables to select OE_HEADERS IFACE ALL.
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Selecting a Concurrent Program from the Module Browser

© Cracle Applications Module Browser |
Object Name: | | [JTables [Iviews [Jap1s [Jc []¥M.Gateway [JEDI [ |BusinessEvents Browse
(33 Human Resources Suite (HR_PF) Interface Table Columns with Corresponding Flexfield Mappings
5 Interaction Center (CC_PF) Column Type Segment Flexfield... Context Flexfield Name
- (5% Marketing Suite (MKT_PF) (ORDER_SOURCE_ID NUMBER
53 Marketing and Sales Suite (MAS_PF) ORIG_SYS_DOCUMENT_REF VARCHARZ
(53 Order Management Suite (OM_PF) (CHANGE_SEQUENCE VARCHARZ
(53 Transportation Execution (FTE) ICHANGE_REQUEST_CODE VARCHARZ
=) (3 Order Management (ONT) ORDER _SOURCE VARCHARZ
(5% Sales Agreement (ONT_SALES_AGREEMEN | [ORG_ID NUMBER
= (53 Sales Order (ONT_SALES_ORDER) HEADER_ID NUMBER
i XMLGateway ORDER_NUMBER HUMBER
F 01 VERSION_NUMBER HUMBER
fRPLsQL ORDERED_DATE DATE
5 [ Openinterfaces ORDER _TYPE_ID NUMBER
ORDER _TYPE VARCHARZ
- (5% Order Management Sales Orders C PRICE (15T 1D e
- Tables PRICE_LTIST VARCHARZ
-~ EFH OE_LOTSERIALS IFACE | lconvErsIOn RATE NUMBER
- [l OF_PRICE_ADIS_IFACE_. | |-ONVERSION_RATE_DATE DATE
- [FFH| OE_PRICE_ATTS IFACE_. | |CONVERSION_TYPE_CODE VARCHAR2
— [ OE_RESERVINS IFACE_# | |cONVERSION_TYPE VARCHARZ
-~ [ OE_CUSTOMER INFO_IF+ | R ANSACTIONAl C1IRR CORE Driano
-~ B OF_PAYMENTS IFACE AL | [oore i re eoiae
- FFH OE_ACTIONS _IFACE_ALL
.. [ OF _CREDITS IFACE ALL | |Fiexfield Definitons
1] IType Application Mame Structure or Context
- FF OE_LINES_IFACE_ALL (O
-3 Views
i (3 ConcurrentPrograms Flexfield Metadata
3 Order Management Sales Orders Import from File Add Mapping
... (5 Order Management Acknowledgme
... (5 Order Management Acknowledgme
- (5 Order Management Sales Orders € oK Cancel

Note: If a selected interface table has pre-configured flexfield
mappings available, a pop-up window appears allowing you to
decide if you want to use these pre-configured mappings. Click Yes
to display these mappings as part of the flexfield definitions in the
Configure Flexfields region. You can modify them later if needed.

Click No to indicate that you will not use these mappings and the
pop-up window disappears.

Configuring Flexfield Mapping Data for the Selected Open Interface Table

Please note that an open interface table is selected in this example as part of the
partner link creation. Oracle E-Business Suite Adapter provides flexfield support
for open interface tables. Once the table is selected in the module browser, you can
either configure flexfield mappings for the table that has flexfields defined in Oracle
E-Business Suite or use current data without further flexfield mapping
configuration.

Perform either one of the following tasks in the Oracle E-Business Suite Module
Browser:

® Use the current data without further configuration by clicking OK to continue.

e Configure flexfield mapping data by either using an existing flexfield mapping
or creating a new mapping through a flexfield wizard if desired.

For more information on flexfield support for open interface tables and how to
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modify existing mapping configuration, see:

e Configuring Key Flexfield Mappings for an Open Interface Table, page 4-79

¢ Configuring Descriptive Flexfield Mappings for an Open Interface Table,
page 4-85

e Flexfield Support for PL/SQL APIs and Open Interface Tables, page 4-27.

In this example, click OK. The Application Interface page appears with the selected
open table.

Adapter Configuration Wizard - Application Interface Page

- B
-ﬂ Oracle Applications Adapter Configuration Wizard - Step 4 of 5 @
Application Interface
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables fviews or you can add a single API/Concurrent Program XML Gateway Map/EDI Concurrent
Program Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.,
rOperation Objects
Get Object (3% Delete
Mame Type
ONT.OE_HEADERS_IFACE_ALL Table view
Help < Back Mext = Cancel

Click Get Object to open the module browser again to select another open interface
table OE_LINES IFACE ALL using the same navigation path Order Management
Suite (OM_PF) > Order Management (ONT) > Sales Order (ONT_SALES_ORDER) >
Openlnterfaces >Order Management Sales Orders Open Interface (OEOIMP) > Tables to
select OE LINES IFACE ALL.

Click OK. The Application Interface page appears with the two selected tables.
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Adapter Configuration Wizard - Application Interface Page

r R
@) Oracle Applications Adapter Configuration Wizard - Step 4 of 5 M
Application Interface .
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent ProgramXML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
r Operation Objects
Get Object [k Delete
Marme Type
ONT.OE_HEADERS_IFACE_ALL Tableview =
ONT.OE_LINES_IFACE_ALL Tablefview
Il Help < Back | Mext = | Cancel
s E
Click OK.

8. Click Next. The Operation Type page is displayed.
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Adapter Configuration Wizard - Operation Type Page

i Rl
@) Oracle Applications Adapter Configuration Wizard - Step 5 of 11 ﬁ

Operation Type

Select the Operation Type and dick Next to continue defining the operation.

Operation Type:  (2) Perform an Operation on a Table
Insert
[ select

[ ] select By Primary Key

Cache Usage:  |none (default) =

Help

< Back Next =

| Cancel |

Select the Perform an Operation on a Table radio button and then choose the
Insert check box. Ensure that the Select check box is deselected.

9. Click Next. The Select Table page is displayed.
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Adapter Configuration Wizard - Select Table Page
fﬂl Oracle Applications Adapter Configuration Wizard - Step 6 of 11

Select Table

Flease select the root database table for this service's guery.

[ OE_LINES_IFACE_ALL
i OF HEADERS IFACE ALL

Help

< Back Mext = Cancel

Select OE_HEADERS_IFACE_ALL as the root database table for this service's
query.

10. Click Next. The Define Primary Keys page is displayed.
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11.

Adapter Configuration Wizard - Define Primary Keys Page for
OE_HEADERS_IFACE_ALL

ﬁ Adapter Configuration Wizard - Step 8 of 13 ﬁ

Define Primary Keys 0.

The [OE_HEADERS_IFACE_ALL] table does not have a primary key defined, but the Database Adapter must be able
to uniquely identify a given row. Please select the fields below that can be used as a virtual primary key (your
database table will not be altered). Once you pick a column, it is recommended to create an index on it or make sure
it has one. Otherwise every operation except insert could be signifantly slower.,

=-fE5 OE_HEADERS_IFACE_ALL ~

~#]E ORDER_SOURCE_ID
Srl=ERoRIG SYS DOCUMENT REF
~[]B CHANGE_SEQUENCE
~[]B CHANGE_REQUEST_CODE
~[1B ORDER_SOURCE

~[]8 ORG_ID

1B HEADER_ID

~[]E ORDER_MUMBER

~[]B VERSION_NUMBER

~["1E ORDERED_DATE

~[]E ORDER_TYPE_ID

~[|B ORDER_TYPE

~[18 PRICE_LIST_ID

~[ 18 PRICE_LIST

-8 CONVERSION_RATE

ol

| s |

Select the following primary keys for the OE_HEADERS_IFACE_ALL table:
e ORDER_SOURCE_ID

e ORIG_SYS_DOCUMENT_REF

Click Next.
Select the same primary keys for the OE_LINES_IFACE_ALL table.

Click Next. The Relationships page appears. Click Create to open the Create
Relationship dialog.
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Defining Relationships

@) Create Relationship lﬁ

Please specify the parent and child tables, relation type and relation name. You also must specify the
foreign key / primary key assodations in the table below.

Parent Table: | OE_HEADERS_IFACE_ALL >

Child Table: |OE_LINES_IFACE ALL >

(") OF_HEADERS_IFACE_ALL has a 1:1 Relationship with OF_LINES_IFACE_ALL
() OE_HEADERS_IFACE_ALL has a 1:1 Relationship with OE_LINES_IFACE_ALL {Foreign Key on Child...
(%) OF_HEADERS_IFACE_ALL has a 1:M Relationship with OF_LINES_IFACE_ALL

Private Owned

OF_HEADERS_IFACE_ALL OE_LINES_IFACE_ALL
OE_HEADERS_IFACE_ALL.ORDER_SOURCE_ID  [ORDER SOURCE ID -|
OE_HEADERS_IFACE_ALL.ORIG_SYS_DOCUMEN... [RreRS el e e = = -]

Relationship Name: |aeLinesIfaceAIICcllecﬁcn |

| Help | | oK _J | Cancel |

Enter the following information to define the relationship between the header and
the detail table:

* Select the OE_HEADERS_IFACE_ALL as the parent table and
OE_LINES_IFACE_ALL as the child table.

* Select the mapping type: OE_HEADERS_IFACE_ALL has a 1:M Relationship
with OE_LINES_IFACE_ALL

Note: If foreign key constraints between tables already exist in
the database, then two relationships are created automatically
while importing tables. One of the relationships is 1:M
relationship from the source table, which is the table containing
the foreign key constraints, to the target table. The other
relationship is a 1:1 back pointer from the target table to the
source table.
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e Select the Private Owned check box.

e Associate the foreign key fields with the primary key fields:
e OE_HEADERS_IFACE_ALL.ORDER_SOURCE_ID: ORDER_SOURCE_ID

e OE_HEADERS_IFACE_ALL.ORIG_SYS_DOCUMENT_REEF:
ORIG_SYS_DOCUMENT_REF

® The Relationship Name field is populated automatically by default. You can
optionally specify a new name for the relationship you are creating.

Click OK. The newly created relationship information appears in the Relationships
page.
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Adapter Configuration Wizard - Relationships Page
@) Adapter Configuration Wizard - Step 10 of 13

Relationships

Shown below are the relationships that are reachable from the root database table. You can define a new

relationship by dicking the 'Create..." button, or remove a relationship by dicking the ‘Remove’ button. To rename a
relationship, select it and dick the ‘Rename..." button,

‘1—'.§ OE_HEADERS_IFACE_ALL has a 1:M relationship with OE_LINES_IFACE_ALL {oelinesIfaceAllCollection)

| <Back | Mext> || Enish || cancel

12. Click Next. The Attribute Filtering page appears. Leave default selections
unchanged.
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13.

Adapter Configuration Wizard - Attribute Filtering Page
’0 Adapter Configuration Wizard - Step 11 of 13 @

Attribute Filtering

s

Unchedk any attributes that you would like to exdude from the database gueries for this service. Primary key
attributes cannot be exduded.

-] changeSequence
-] changeRequestCode
-] orderSource

] ergid

-] headerld

|| orderMumber

-] wersionMNumber

-w| erderedDate

-] orderTypeld

-] orderType

-] priceListld

|| priceList

[ -] conversionRate I

| Select All | | Deselect all

| Help | | < Back || Mext = || Finish || Cancel |

Click Next. The Advanced Options page appears.
Click Next.

Click Finish. The wizard generates the WSDL file corresponding to the selected
interface. This WSDL file is now available for the partner link.

To add the second partner link:

1.

Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a service name in the Name field. For example, ImportOrderCP.
Click Next. The Service Connection dialog appears.

You can perform either one of the following options for your database connection:
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Note: You need to connect to the database where Oracle
E-Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 5-14.

*  You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware User's Guide for Technology Adapters.

4.  Once you have completed creating a new connection for the service, you can add a
concurrent program by browsing through the list available in Oracle E-Business
Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
to Oracle E-Business Suite in your workspace. Absence of the data file would make
browsing or searching of Integration Repository tree considerably slow. You can
choose to extract the data file and create a local copy of the Integration Repository
data file. Once it is created successfully, Adapter will pick it up automatically next
time and retrieve data from your local Integration Repository.

You can select one of the following options:
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e C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.

Using the Local Integration Repository Data File
@ Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R 12 (or later) apps instance.

From R12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDeveloper\mywork\Application 1\AppsAdapter_IrepData

IRep Data file
|veloper\mw\'ork‘lﬁ.pplicaﬁon 1\AppsAdapter_IrepDatalrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

e C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click Next in the Operation page to open the Oracle E-Business
Suite Module Browser.

The Oracle E-Business Suite Module Browser combines interface data from Oracle
Integration Repository with information about the additional interfaces supported
by Oracle E-Business Suite Adapter, organized in a tree hierarchy.

Navigate to Order Management Suite (OM_PF) >Order Management (ONT) > Sales
Order (ONT_SALES_ORDER) > Openlnterfaces > Order Management Sales Orders Open
Interface > ConcurrentPrograms to select a concurrent program OEOIMP (OEOIMP).
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D Oracle Applications Madule Browser

ObjectMame:| | [ITsbes [Jvews [Japs [Jce []xMGateway []EDI []BusiessEvents Browse
75 ProductFaniles Name T Injout
53 Advanced Planning (SCP_PF) P_Operating_Unit VARCHAR2 In
(3 Applications Technology (ATG_PF) P_Order_Source: VARCHAR?Z In
5 Contracts Suite (OK_PF) P_Crig_Sys_Document Ref VARCHARZ In
(53 Discrete Manufacturing (DMF_PF) P_Operation_Code VARCHARZ In
G Finandal Globalizations Suite (FINGE_PF) P _Valdate_Only VARCHAR2 In
G Finandial Payables Suite (FINAP_PF) P_Debug_Level VARCHARZ In
(5 Finanaal Receivables Suite (FINAR_PF) P I TS Ui &
(%4 Finanial Services Applications (SEM_PF) g oTorolrd oeilta e
5 Financls (n_F) P_Sold_To_Org VARCHARZ In
3 Human Resources Suite (HR_PF) P_Change_Sequence VARCHARZ In
(53 Interaction Center (CC_PF) ;*:?;J;:‘: :xz:ﬁ: ;:
Marketing Stite (MKT_PF, —
e e s p s rdr i a3 T T
(5% Order Management Suite (OM_PF} p_validate_Desc_Flex VARCHARZ In
(B3 Transportation Execution (FTE)
G Order Management (ONT)
3 Sales Agresment (ONT_SALES_AGREEMEN
- (53 Sales Order (ONT_SALES_CRDER)
[ XMLGateway
-FRer
-[FrsqL
- [ Openlnterfaces
- (53 Order Management Sales Orders ¢
(3 Tables
(3 Views
& (& ConcurrentPrograms
&,
3 Order Management Sales Orders ¢
3 Order Management Acknowledgme
3 Order Management Acknowledgme
14 Order Management Sales Orders ¢
[ CONCURRENT_PROGRAMS
- [ INTERFACE_VIEWS
&3 Configurator (CZ)
(&3 Advanced Pridng (QP)
(58 Shipping Execution Common (WSH)
(¥ Release Management (RLM)
53 Process Manufacturing (OPM_PF)
3 Procurement (PRC_PF) oK Cancel

Click OK. The Application Interface page appears.
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Adapter Configuration Wizard - Application Interface Page
@ Adapter Configuration Wizard - Step 5 of 6 @

Application Interface

SR ~ _.-"."I
‘You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tablesfviews or you can add a single API/Concurrent Program /XML Gateway Map/EDI Concurrent
Program /Business Event for a service. If no objects are selected, itis assumed that you want to use previously
created descriptors,

rOperation Objects

m»
MName Type

OEQIMP COMCURRENT _PROGRAM ad

=

7. Click Next, then click Finish to complete the process. The partner link is created
with the required WSDL settings. The wizard also generates the WSDL file
corresponding to the XML schema. This WSDL file is now available for the partner
link.

Adding Partner Links for File Adapter

Use this step to configure a BPEL process by synchronously reading payload from an
input file to obtain the order details and concurrent program details.

Configure the following two partner links:

1. To obtain order details from an input file through Synchronous Read operation.

2. To obtain concurrent program details from an input file through Synchronous Read
operation.

To add the first Partner Link for File Adapter to read order details:

1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component
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palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane before the first partner link InsertOrder. The File Adapter Reference

page appears.

Specifying a File Reference Name

ﬂ) FILE Adapter Configuration Wizard - Step 1 of 4

File Adapter Reference

Welcome to the File Adapter Configuration Wizard
operation for the adapter.

Enter a Reference Name.

This wizard helps you create a File Adapter. You will be asked to specify configuration parameters and define an

Mame: |getOrderDetails|

Help Next =

Cancel

Enter a name for the File Adapter service, for example, getOrderDetails.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
L B
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 ﬂ

Adapter Interface

The adapter interface is defined by a wsdl that is generated using the operation name and schema(s) specified later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: @ Define from operation and schema (spedfied later)

() Impart an existing WSDL

[Ef

Help < Back MNext = Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.
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Specifying File Server JNDI Name

P
@) FILE Adapter Configuration Wizard - Step 3 of 4 g
File Server Connection
Specify the JNDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter
must assodate this INDI name with a set of configuration properties needed by the File Adapter to access the File
Server at runtime,
File Server JMDI Mame |Ei5,|'Fi|EAda|:ltEr| | Ck
Help < Back Next = Finish Cancel
Click Next

3. In the Operation page, specify the operation type. For example, select the

Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation

- -
ﬁ FILE Adapter Configuration Wizard - Step 4 of 8 ﬁ

Operation

..

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in spedfied locations, and & Chunked Read operation that
synchronously reads file data in chunks and can be used OMNLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: () Read File
() Wirite File
(2) Synchronous Read File
() List Files
() Chunked Read

Operation Name: |5ynchF‘.ead |

[ | Read File As Attachment

Cancel

Help < Back | MNext =

Click Next to access the File Directories page.

Select the Logical Name radio button and specify directory for incoming files, such
as inputDir.

Ensure the Delete files after successful retrieval check box is not selected.
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Configuring the Input File
FILE Adapter Configuration Wizard - Step 5 of 8 (o
p g P

File Directories

Enter directory information for the incoming file of the Synchronous Read File operation.

Directory names are specified as: () physical Path (3) Logical Name

Directory for Incoming Files (Jogical name): |ir1|:|utDir|

[] Archive processed files
Archive Directory for Processed Files (Jogical name):

Help < Back Mext = Cancel

Click Next to open the File Name page.

5. Enter the name of the file for the synchronous read file operation. For example,
enter order data.xml. Click Next. The Messages page appears.

6. Select the 'browse for schema file' icon next to the URL field to open the Type
Chooser.

Click Type Explorer and select Project Schema Files > InsertOrder_table.xsd >
OeHeaderslfaceAllCollection. Click OK.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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1.

Specifying Message Schema

-
ﬂ FILE Adapter Configuration Wizard - Step 7 of 8

Messages

Define the message for the Synchronous Read File operation. Specify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you chedk 'Schema is Opague’, then you do not need to spedfy a Schema.
Message Schema
[ ] Mative format translation is not required (Schema is Opague)
URL | .fschemasInsertOrder_table.xsd | Q 53
Schema Element [DeHeadersIfaoeAlICcllecﬁnn vl
Help < Back MNext = Cancel

Click Next and then Finish. This completes the configuration and create the partner
link with the required WSDL settings for the File Adapter service. The wizard also
generates the WSDL file corresponding to the partner link. The main Create Partner

Link dialog box appears, specifying the new WSDL

file getOrderDetails.wsdl.

The getOrderDetails Partner Link appears in the BPEL process diagram.

To add the second Partner Link for File Adapter to read concurrent program details:

1.

In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component

palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane after the first File Adapter partner link getOrderDetails. The File

Adapter Reference page appears.
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Specifying a File Adapter Reference Name
{) FILE Adapter Configuration Wizard - Step 1 of 4

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

operation for the adapter.

Enter a Reference MName.

This wizard helps you create a File Adapter. You will be asked to spedfy configuration parameters and define an

Mame: |getCPDetails

Help - Mext =

Cancel

Enter a name for the File Adapter service, such as getCPDetails.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
L B
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 ﬂ

Adapter Interface

The adapter interface is defined by a wsdl that is generated using the operation name and schema(s) specified later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: @ Define from operation and schema (spedfied later)

() Impart an existing WSDL

[Ef

Help < Back MNext = Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.

Click Next
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r
@) FILE Adapter Configuration Wizard - Step 3 of 4 g

File Server Connection

Specify the JNDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter

must associate this JNDI name with a set of configuration properties needed by the File Adapter to access the File

Server at runtime,

File Server JMDI Mame |EiSfFi|eAda|:lter| | q
Help < Back | Next = Finisk Cancel

3. In the Operation page, specify the operation type. For example, select the

Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation

- -
ﬁ FILE Adapter Configuration Wizard - Step 4 of 8 ﬁ

Operation

..

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in spedfied locations, and & Chunked Read operation that
synchronously reads file data in chunks and can be used OMNLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: () Read File
() Wirite File
(2) Synchronous Read File
() List Files
() Chunked Read

Operation Name: |5ynchF‘.ead |

[ | Read File As Attachment

Cancel

Help < Back | MNext =

Click Next to access the File Directories page.

Select the Logical Name radio button and specify directory for incoming files, such
as inputDir.

Ensure the Delete files after successful retrieval check box is not selected.
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Configuring the Input File
ﬁ FILE Adapter Configuration Wizard - Step 5 of 8 ﬁ

File Directories

Enter directory information for the incoming file of the Synchronous Read File operation.

Directory names are specified as: (3) Physical Path () Logical Name

Directory for Incoming Files {physical path): |Jru5rl,rh-n|;. Browse

[ ] Archive processed files
Archive Directory for Processed Files (physical path):

Help <« Back Mext = Cancel

Click Next to open the File Name page.

5. Enter the name of the file for the synchronous read file operation. For example,
enter cp_data.xml. Click Next to open the Messages page.

6. Select the 'browse for schema file' icon next to the URL field to open the Type
Chooser.

Click Type Explorer and select Project Schema Files > ImportOrderCP_sp.xsd >
InputParameters. Click OK.

The selected schema information will be automatically populated in the URL and
Schema Element fields.

7. Click Next and then Finish. his completes the configuration and create the partner
link with the required WSDL settings for the File Adapter service. The wizard also
generates the WSDL file corresponding to the partner link. The main Create Partner
Link dialog box appears, specifying the new WSDL file getCPDetails.wsdl.

The getCPDetails Partner Link appears in the BPEL process diagram. Double
click the Partner Link service icon to open the Edit Partner Link dialog and view the
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details.

Configuring Invoke Activities

After adding and configuring partner links, you need to configure the following four
Invoke activities:

1.

To get the order details by invoking the getOrderDetails partner link through
Synchronous Read operation to read the order from an input file.

To get the concurrent program details by invoking the getCPDetails partner link
through Synchronous Read operation to read the concurrent program information
from an input file.

To insert order data into Open Interface tables by invoking InsertOrder partner
link.

To import order data from Open Interface tables to Oracle E-Business Suite by
invoking ImportOrderCP concurrent program partner link.

To add the first Invoke activity for a partner link to get order details:

1.

In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the first Invoke activity from the Web Service
section into the center swim lane of the process diagram, between the receivelnput
and callbackClient activities.
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Adding an Invoke Activity

; O

2. Link the Invoke activity to the getOrderDetails service. The Edit Invoke dialog
appears.

3. Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

4. Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.

5. In the Output tab, ensure the Output Variable radio button is selected. Click the
Create icon next to the Output Variable field to create a new variable. The Create
Variable dialog box appears.

6. Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK to return to the Edit Invoke dialog box.
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_
© EditInvoke |

Documentation | Targets = Sources  Skip Condiion  Headers
General Correlations Properties Assertions Annotations

Mame: |Ir1'u'uke |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type: |43 Partner Link ~

Partner Link: |ge1ﬂrderDE1ﬁiIs | 4,

Paort Type: [3‘ SynchRead_ptt "]

Operation: [ G SynchRead v]

Input Qutput

() Arguments Mapping (=) Output Variable g

Cutput: |Inunke_5ynd’1Read_Du1:puth'ariabIe | I% Ck

Help Apply oK Cancel

Click Apply and then OK to finish configuring the Invoke activity.

The Invoke activity appears in the process diagram.

To add the second Invoke activity for a partner link to get concurrent program
details:

1.

In JDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette. Drag and drop the second Invoke activity from the Web Service section
into the center swim lane of the process diagram right after the first Invoke activity.

Link the Invoke activity to the getCPDetails service. The Edit Invoke dialog
appears.

Repeat Step 3 to Step 6 described in the first Invoke activity procedure.
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The input and output variables should be populated in the Edit Invoke dialog box.
O Edit Invoke [

Documentation  Targets  Sources  Skip Condition  Headers

General Correlations Properties Assertions Annotations

Mame: |Inmke |

Conversation ID: | | =]

[ ] Invaoke as Detail

Interaction Type: |r.,,“3_!. Partner Link *

Partrer Link: |getl:P‘DE13iIs | &,

Part Type: |"@'° SynchRead_ptt "'|

Operation: | 0@y SynchRead "|

Input  Output

() Arguments Mapping () Qutput Variable =]

Cutput: |Invuke_5md1Read_Dumut'u'ariabIE_:l | Ei \:k

Help Apply oK Cancel

To add the third Invoke activity for a partner link to insert order data into Open
Interface tables:

1. In]JDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette. Drag and drop the third Invoke activity from the Web Service section into
the center swim lane of the process diagram, between the second Invoke and
callbackClient activities.

2. Link the Invoke activity to the InsertOrder service. The Edit Invoke dialog box
appears.

3. Repeat Step 3 to Step 4 described in the first Invoke activity procedure. Click OK in
the Edit Invoke dialog box to finish configuring the second Invoke activity.
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@ Edit Invoke S

]

Documentation  Targets  Sources  Skip Conditon | Headers
General Correlations Properties Assertions Annotations

Mame; |Inunke |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type: |f.‘.‘3_!. Partrer Link *

Partner Link: |Inser1ﬂrder | Q
Port Type: |iﬁ° |InsertOrder_ptt 1Ir|
Operation: | Gy insert v|
Input
() Arguments Mapping () Input Variable =)
Input: [Invoke_insert_InputVariable |EF Ck
Help Apply OK Cancel

To add the fourth Invoke activity for a partner link to import the order information to
Oracle E-Business Suite:

1. InJDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette. Drag and drop the fourth Invoke activity from the Web Service section into
the center swim lane of the process diagram, between the third Invoke and
callbackClient activities.

2. Link the Invoke activity to the ImportOrderCP service. The Edit Invoke dialog box
appears.

3. Repeat Step 3 to Step 6 described in the first Invoke activity procedure.
The input and output variables should be populated in the Edit Invoke dialog box.
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4. Setting Header Properties for Applications Context

Use the following steps to set the header message properties required to pass
applications context required to complete the BPEL process:

1. Select the Properties tab in the Edit Invoke dialog box.
2. Click the Create icon. The To Property dialog appears.

3. Select the jca.apps.Username property from the Name drop-down list.
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-
© Edit Invoke %
Documentation = Targets | Sources | Skip Condition = Headers
General Correlations Properties Aszsertions Annotations
To
From  Properties: ':‘F / ®
Name Value
s
O ToProperty ===

Mame: |

@)

ot 3

Help

. [ica.apps.HeaderDocument
lica.apps.ML5Language
I:jca.apps.DRG_ID

lica.apps.RespApplication
lica.apps.Responsibility
lica.apps.SecurityGroup

ﬁ;ca.apps.eu..ﬁ.tﬁibutﬂ

1I

Help

Apply QK Cancel

4. Select the Expression radio button and enter ' OPERATIONS' as the property

value.

Click OK.

5. Repeat Step 2 to Step 4 to assign the following properties:

® 'Order Management Super User,

for jca.apps.Responsibility.

® 204 for jca.apps.ORG _ID

Vision Operations (USA)'

Click Apply and then OK to complete the Invoke activity.
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Configuring Assign Activities

Based on the BPEL process scenario, you need to configure the following two Assign
activities:

1. To pass the output of File Adapter's Synchronous Read (getOrderDetails)
service as an input to the Open InterfaceInsertOrder service.

2. To set the payload of the Concurrent Program (ImportOrderCP) service.

To add the first Assign activity:

1. In]JDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette.

Drag and drop the first Assign activity from the Basic Activities section into the
center swim lane of the process diagram, between the first and second Invoke
activities that you just created earlier.

2.  Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
SetOrderDetails.

3. Select the Copy Rules tab and expand the target trees:
¢ In the From navigation tree, navigate to Variable > Process > Variables >

Invoke_SynchRead_OutputVariable and select body.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_insert_InputVariable and select OeHeadersIfaceAllCollection.

Drag the source node (body) to connect to the target node
(OeHeaderslfaceAllCollection) that you just specified. This creates a line that
connects the source and target nodes. The copy rule is displayed in the From and To
sections at the bottom of the Edit Assign dialog box.
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4,

© Edit Assign

=)

General =~ CopyRules  Annotations ~ Skip Conditon  Sources  Targets

[Insert New Rule After ~

2 OrderImportConcurrentProgram, bpel
3 Partrer Links
B 123 Variables
- ga Process
B3 varisbles
) inputvariable
) outputvariable
B-@x) Irvoke_SynchRead_InputVariable
B--L\.‘] Inwoke_SynchRead_Outputvariable i
bod: N
E-(x) Invoke_SynchRead_Inputvariable_t
B-(x) Irvoke_SynchRead_Outputvariable_t

B Q@ @
OrderImportConcurrentProgram.bpel ¢
Partner Links 231
Wariables (3-1
Process gy =l
Varisbles (3=
inputtariable
outputYariable
Invoke_SynchRead_Inputyarisble
Inwake_SynchRead_OutputVariable
Invoke_SynchRead_InputVariable_1
Tnwoke_SynchRead_Outputyariable_1
Invoke_insert_Inputvariable

L\,‘] Irnvoke_insert_Inputvariable
) Invoke_ImportOrderCP_Inputiariable
E-(x) Invoke_ImportorderCP_Outputvariable

B copv M

OeHeadersIfacealCollection
Tnwoke_ImportOrdercP_Inputvariable
Invoke_ImportOrderCP_Output¥ariable

28=8ZEEEEE
- - B

BB

From
Invoke_SynchRead_OutputVariablefbodyf

Invoke_insert_InputVariable fOeHeadersIface Al Collection/

Apply OK. Cancel

Click Apply and then OK to complete the configuration of the Assign activity.

To add the second Assign activity:

1.

In JDeveloper BPEL Designer, expand the BPEL Constructs from the Component

Palette.

Drag and drop the second Assign activity from the Basic Activities section into the
center swim lane of the process diagram, between the third and fourth Invoke

activities that you just created earlier.

Double-click the Assign activity to access the Edit Assign dialog.

Click the General tab to enter a name for the Assign activity. For example,

SetCPDetails.

Select the Copy Rules tab and expand the target trees:

¢ In the From navigation tree, navigate to Variable > Process > Variables >
Invoke_SynchRead_OutputVariable_1 and select body.

* In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_ImportOrderCP_InputVariable and select InputParameters.

Drag the source node (body) to connect to the target node (InputParameters) that
you just specified. This creates a line that connects the source and target nodes. The
copy rule is displayed in the From and To sections at the bottom of the Edit Assign

dialog box.
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- A
) Edit Assign ol
General | Copy Rules | Annotations = Skip Conditon — Sources — Targets

B&Oma

A OrderImportConcurrentProgram. bpel OrderimportCancurrentProgre
&[] Partrer Links Partner Li
-2 variables Variak
-5 Process Process
=53 variables Variables [£3-

() inputvariable inputyariable &)

(x) outputvariable outputyariable &)
().') Invoke_SynchRead_InputYariable i : Invoke_SynchRead_InputYariable b,')
() Irvoke SynchRead Outputyariable Invoke_SynchRead_Output¥ariable &)
() Irvoke_SynchRead_Inputvariable_1 i Tnvoke_SynchRead_Tnputvarisble_1 &)
B-().’) Invoke_SynchRead_OutputYariable_1 :j Invoke_SynchRead_CutputYariable_1 b,')
-[2] bod: > Invoke_insert_InputVariable )
() Irvoke insert_Inputvariable Invoke_ImportOrderCP_Inputyariable @)

(%) Irvoke_ImportordercP_Inputtariable InputParameters [~
().') Invoke_ImportCrderCP_Cukputyariable Invoke_ImportOrderCP_CutputYariable b,')

e P
+ne D
From Ta

Invoke_SynchRead OutputVarizble_1/body/ Invoke_ImportOrderCP_InputVarizble/InputParameters,

Help Apply 0K Cancel

4. Click Apply and then OK to complete the configuration of the Assign activity.
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Completed Concurrent Program BPEL Process Project

-®
receivelnput
v
Er &
Invoke getOrderDetails

&

getCPetails

SetOrderDetails

&

arderimportconcuar. ..

a 8

InsertOrder

Invoke

¥
]

SetCPDetails

v
&
Invoke ImportOrderCP

Click the OrderImportConcurrentProgram (composite.xml) to display the Oracle
JDeveloper composite diagram:
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InsertOrder
Operations:
insert

getOrderDetails
Operations:
Synch Read

o ®

orderimportconcurr...

Operations:
process
processResponse ® — {[%
ImportOrderCP
Operations:
ImportOrderCP

@eg
getCPDetails
Operations:

Synch Read

Note: Click the Source tab of OrderImportConcurrentProgram
(composite.xml) to enter a value for the physical directory inputDir
for the reference getOrderDetails and getCPDetails (such as
/usr/tmp).

<property name="inputDir" type="xs:string"
many="false" override="may">/usr/tmp</property>

Run-Time Tasks for Concurrent Programs

After designing the SOA Composite application with BPEL process, the next step is to
deploy, run and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 7-50
2. Test the Deployed SOA Composite application with BPEL process, page 7-54

3. Verify records in Oracle E-Business Suite, page 7-58

Deploying the SOA Composite Application with BPEL Process

To invoke the services from the BPEL client contained in the SOA composite, the SOA
composite needs to be deployed to the Oracle WebLogic managed server. This can be
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achieved using Oracle JDeveloper. Once the composite is deployed, it can be tested
from the Oracle Enterprise Manager Fusion Middleware Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 11-1 and Creating an Application Server Connection, page 11-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name, then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy > OrderImportConcurrentProgram >
soa-serverl to deploy the process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.
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Deployment Action

-);.\- Deployment Action | Select a deployment action from the list below.

| .
/T'\ Deploy Confiquration Deploy to Application Server

Deploy to SAR
/I\

/l\

Deploy this archive to SOA configured Application server(s)

Help Mext = || Einish || Cancel

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

¢ New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

¢ Opverwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from

JDeveloper are covered in Creating an Application Server
Connection, page 11-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.
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Select Server

ieployment

ey Deployment
A Deploy Configuration

IntegratedeblogicServer (domain unconfigured)
i _
Sel Select Server

).I.\ SOA Servers

L~

Application Servers;

Qwerwrite modules of the same name

[ <Back | Mext: ][ Finish H Cancel ]

4. In the SOA Servers page, accept the default target SOA Server ('soa-serverl’)

selection.
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SOA Servers
Choose the target S0A server(s) and correspanding partitions to which you want to deploy
/I\ this archive.
AT SOA Server: Partition: Status: Server URL:
g, Select Server S03_Server efaul hd thost0l exam..
Select 5 = 1 |default RUNNING http:/} hostol
I
el SO0A Servers
|
@ Summary
|
| Help | < Back || Next = | | Finish | | Cancel |
Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

5. Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window.

Verity that the deployment is successful in the Deployment - Log window.

Testing the Deployed SOA Composite Application with BPEL Process

Once the BPEL process contained in a SOA Composite application is deployed, you can
manage and monitor the process from the Oracle Enterprise Manager Fusion
Middleware Control Console. You can also test the process and the integration interface
by manually initiating the process.

To test the deployed SOA Composite application with BPEL process:

1. Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
http://<servername>:<portnumber>/em). The composite you deployed is
displayed in the Applications Navigation tree.
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ORACLE’ Enterprise Manager Fusion Middleware Control 12¢ e

Login
Farm Farm_soainfra
* User Name [weblogic

=Passnord [es

Logn

Enterprise Manager Key Features New in this Release
o ,

v Test your applications using real world workdoad using the:
Application Replay functionality

» Automate Routine Tasks
» Stay ahead of the curve with My Oracle Support Integration
» Manage Many-as-One with Groups
» Complete, Integrated, Application-to-Disk IT Management
cover IT assets using dram lly improved Target Auto-
» Complete, Unified and Business-Driven Enterprise Cloud

Management
> SOA Management with improved dehydration diagnostics

Enter username (such as weblogic) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_serverl)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA composite application that you want to initiate (such as
'OrderImportConcurrentProgram’) from the SOA Infrastructure.
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Viewing Deployed SOA Composites

ORACLE Enterprise Manager Fusion Middleware Control 12c

Logout O

Help ~

4, weblogic ~

Target Navigation
View ~
&> [ Application Deployments
vV [ s0a
7 & soa-nfra
7 E& soa-infra (soa_server1)
7 (@ default

off§ dff_fiex_insert [1.0]
o3 GetExpenseDetails [1.0]

4 orderImportConcurrentProgram [1.0] @
o3 SOA Composite ~

g BPEL Message Recovery Required  Show Detais...

Running Instances 0 | Total 0 | Active Retire ..

Go to 8PEL Recovery Console [ | 5t Time Threshold... | Disable Alert...
shutDown... | Test

Logged in 25 weblogic| [5] 2506:b400:2010:4047:216: 3efF:fes:51e2
Page Refreshed Mar 25, 2013 12:29:29 PM PDT (s

sattings.. ~| |& [

&P Related Links ~

Dashboard Composite Definition Flow Instances

~|Component Metrics

Unit Tests

Policies

¥ [ webLogic Domain
v 4] soainfra
&l AdminServer
5l soa_server1
> [) Metadata Repositories
> [3) User Messaging Service

o3 tnsert [1.0] Name Component Type ‘ Total Instances|  Running Instancs ‘ e ‘
D‘E OrderlmportComcur relltProt ‘ REEDVE[EHE‘ Non REEDVE[EHE‘
off8 SmpleApproval [1.0] & OrderImportConcurrentProgram BPEL 0 0 0 0
o3 simpleRest [1.0]
ofd Testsimplerest [1.0]
¥/Services and References
Name [rype [usage | Fauts|  Total Messages| Average Processing Time (seq)|
@ orderimporteoncurrentprogram_dient_ep Web Service senvice 0 0 0.000
Runsertorder JCA Adapter Reference 0 0 o.000[ |
Fo=tCPDetais JCA Adapter Reference ] ] 0.000 |
RgetOrderDetaiis JCA Adapter Reference 0 0 0.000
Rimpor torderCP JCA Adapter Reference 0 0 0.000 ™

Click Test at the top of the page.

4. The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate

the process.
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Testing Web Service

Input Arguments

Tree Vielw
MName Type Value
= * payload paykad
*input string kest

Request = Responss

Task Web Serdce
The test results appear in the Response tab upon completion.
ORACLE Enterprise Manager Fusion Middleware Control 12¢ Help » | 34 weblogic v | LogOut o
Target Navigation it orderImportConcurrentProgram [1.0] @ Logged in as weblogic! 3] 2606:b400:2010: 4047:216:eff:fe52: S1ee
View = offf SOA Composite ~ Page Refreshed Mar 25, 2013 12:36:02 PM PDT

&> £3 Application Deployments

7 3 s0a Test Web Service Tesk Wieh Service =
7 {5 soainfra Use this page to test any WSDL or WADL, including WSDLs or WADLS that are nat in the farm. To testa Web service, enter the WSDL or

v fra € 9 WADL and ciick Parse WSDL or WADL. When the page refreshes with the WSDL or WADL detalls, first select the Service/Resource, then
Soadnira {soa_server select the Port/Method, and then select the Operation/Media type that you want to test. Specify any input parameters, and dick Test
7 @ default Wb Service.
offd dff flex_insert [1.0]

ol GetExpenseDetails [1.0) s -nfraservices/default OrderTmportConcurrentProramjorderimporteoncUrentprogram _cient ep?WSDL G}, -

WSDL or WADL
off Insert [1.0] PR TR e wSDL o WADL

ol [Order HTTP Basic Auth Option for WSDL or WADL Access
off] simpleApproval [1.0]

SimpleRest [1.0]
ol smpleRest [1.0] Service orderimportconcurrentprogram_dient_ep
off] TestsimpleRest [1.0] m

4 Port OrderImportConcurrentProgram_pt
'V 3 WebLogic Domain — E|
7 5] sosinfra peration |process
&l Adminserver Endpoint URL Edit Endpoint URL [0
&l soa_servert
I £3) Metadata Repositories Request Response
1> [ User Messaging Service TestStatus Request successfully recsived.
Response Time (ms) 105
Anew composite instance was generated.  Launch Flow Trace
The web service invocation was successful.
] . » s

Click Launch Flow Trace in the Test Web Service page. The Flow Trace page is
displayed.

In the Trace section, you should find the sequence of the message flow for the
service binding component (orderimportconcurrentprogram client ep),
BPEL component (OrderImportConcurrentProgram), and reference binding
components (getOrderDetails, getCPDetails, InsertOrder and
ImportOrderCP). All involved components have successfully received and
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processed messages.

Flow Trace Page
Data Refreshed Mar 5, 2009 12145145 Al

Flow Trace @
This page shows the flow of the message throwgh varkaus composite and compenent instances, @ ECID 0D0DHzLnKdESuxAp]~ LFifl9f_9n00001 =46
Sharted Mar 5, 2009 12:43:34 AM

Faults
Select a fault bo locate i in the brace view.
Errar Message Feoveny Faut Time Fauk Locakion Compasite Instance
To Faults Found

Trace
Chek 2 corponent instance to ses its detaled audic trail,
Show Instance Is [

Tnstance Type kate Tine Composite Instance
= @4 orderimportconourentprogram _dient_ep Sarvice W Completed Mar 5, 2009 12:43:34 AN adspters-appe-101-Onde
= 53,, OrderlmportConcurrentFrogram EFEL Connpanent & Completed Mar 5, 2009 12:43:36 AN adspters-apps-100-Orde
ol getcrderDetails Reference & Comgleted Mar 5, 2002 12:43:3¢ AN adapters-apps-10L-Orde
olf] getCFDetails Refererce & Completed Mar 5, 2009 12:43:34 AM adapters-apps-101-Orde
olf] Tnsertorder Reference # Completed Mar 5, 2009 12:43:35 AM adaptars-apps-101-Orde
ol TrnportOrdercP Reference & Completed Mar 5, 2009 12:43:36 AN adapers-apps-101-Onde

If any error occurred during the test, you should find it in the Faults section.

6. Click your BPEL service component instance link (such as
OrderImportConcurrentProgram) to display the Instances page where you can
view execution details for the BPEL activities in the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

Verifying Records in Oracle E-Business Suite

To validate the BPEL process, log on to Oracle E-Business Suite forms to check the
status of the Concurrent Program execution. Once it is successfully executed, the
purchase order should also be created in Oracle E-Business Suite applications.

To verify records in Oracle E-Business Suite applications:

1. Log in to Oracle E-Business Suite with the Order Management Super User, Vision
Operations (USA) responsibility.

2. Choose Orders, Return > Sales Order to open the Sales Orders form.
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B I F RSP RODER LDV QP% B ?

O Sales Orders (Vision Operations) - 64624, Business Warld

Order Information Line ltems

E! Default

Main | Others

Customer (SR

0 Order Nurnher 54624
Customer Number |1503 Order Type [Mixed

Customer PO |order_id_D1 ' Date Ordered 05-MAR-2008 04:28:18
Custorner Contact | Price List Corporate
Operating Unit [Vision Operations Salesparson 'Spragua. Mr, Howard
Ship To Location |San Jose (OPS) Status | Entered
|2391 L Street Currency USD
[San Jose, CA, 95108, US Subtotal | 0.00
Bill To Location |San Jose (OPS) Tax | 0.00
2391 L Streat Charges 0.0
I ] Total | 0.00

[San Jose, CA, 85106, US

I Actions Related lterns I Configurator [ Availability | I Book Creer }I

3. Search for an order by pressing F11 key. In the Customer PO field, enter the order
ID present in the xml file. For example, enter order id 01 and press CTRL+F11
keys to execute the query.

4. You should find the newly created order appears with order ID order id 01.
Select the Line Items tab to verify the quantity and item type of the order which

should be the same as that present in the xml file

5. Alternatively, you can also validate the result by querying the database with the
following SQL statement:

Select orig sys document ref from oe order headers all where
orig sys document ref = 'order id 01';

Troubleshooting

If you experience problems with your concurrent program integration, you can take the
following troubleshooting steps:

e If you're using complex (that is, Boolean) datatypes, ensure that PL/SQL wrappers
are applied on the target instance of the concurrent program.

e Examine your transaction data in the Open Interface Tracking Form.

e  Check the status of the concurrent programs by Request ID.
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Enable logging for Adapter to see if the issue is on the middleware side. For
information on how to enable logging, see Enabling Logging for Adapters, page 4-125.
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8

Using Interface Tables and Views

This chapter covers the following topics:

Overview of Interface Tables and Views

Design-Time Tasks for Interface Tables

Creating a New SOA Composite Application with BPEL Process
Adding a Partner Link

Adding a Partner Link for File Adapter

Configuring Invoke Activities

Configuring an Assign Activity

Run-Time Tasks for Interface Tables

Deploying the SOA Composite Application with BPEL Process
Testing the Deployed SOA Composite Application with BPEL Process
Design-Time Tasks for Views

Creating a New SOA Composite Application with BPEL Process
Adding a Partner Link

Adding a Partner Link for File Adapter

Configuring Invoke Activities

Configuring an Assign Activity

Run-Time Tasks for Views

Deploying the SOA Composite Application with BPEL Process
Testing the Deployed SOA Composite Application with BPEL Process
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Overview of Interface Tables and Views

Interface tables can be used to insert and update data in Oracle E-Business Suite, and
interface views can be used to retrieve data from Oracle E-Business Suite. This chapter
describes the following interfaces:

e Interface Tables

e Interface Views

Interface Tables

Views

Interface tables can be used to insert and update data in Oracle E-Business Suite. For
example, you can insert a purchase order into Oracle E-Business Suite to generate the
sales order automatically. Data is never loaded directly into Oracle E-Business Suite
application base tables. Instead, data is first loaded into interface tables, and then
Oracle-supplied concurrent programs move data from interface tables to base tables.
This ensures that all business logic and processing is handled using Oracle components.

Oracle E-Business Suite Adapter uses open interface tables to integrate with Oracle
E-Business Suite applications through direct database access. Oracle E-Business Suite
Adapter inserts data into the open interface tables. These interface tables can be used
only for insert operations and support only an inbound connection into Oracle
E-Business Suite.

Interface tables are intermediate tables into which the data is inserted first. Once the
data gets inserted into the interface tables, the data is validated, and then transferred to
the base tables. Base tables are real application tables that reside in the application
database. The data that resides in the interface tables is transferred to the base tables
using concurrent programs. A concurrent program is an instance of an execution file.
Concurrent programs are scheduled in Oracle E-Business Suite to move data from
interface tables to base tables. These programs perform the application-level checks and
run validation before inserting data into base tables.

Oracle E-Business Suite Adapter uses views to retrieve data from Oracle E-Business
Suite applications. For example, you can retrieve information about your customers
from the required tables in Oracle E-Business Suite.

Views allow only simple definition. By using views, you can get synchronous data
access to Oracle E-Business Suite. In Oracle E-Business Suite Adapter, views are created
on base tables as well as interface tables. These views can be used only for select
operations.

In the Oracle E-Business Suite 11.5.10 release, you cannot work on multiple views. A
work around to address this would be to create a view that spans multiple views.
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Design-Time Tasks for Interface Tables

This section describes how to configure the Oracle E-Business Suite Adapter to use
interface tables. It describes the steps to configure the adapter using the Adapter
Configuration Wizard in Oracle JDeveloper.

SOA Composite Application with BPEL Process Scenario

Take Open Interface tables (OE HEADER IFACE ALL and OE LINES IFACE ALL)as
examples.

When a request of inserting order data into Open Interface tables is received, order
details will be retrieved through synchronous read operation from an input file and
then inserted into Open Interface tables (OE HEADER IFACE ALL and

OE LINES IFACE ALL).

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you can validate the result by fetching the inserted data
using SQL statement.

Prerequisites to Configure Interface Tables

* Define primary keys on all the interface tables being used.
¢ Define parent-child relationships among all the selected interface tables.

SOA Composite Application with BPEL Process Flow
Following is a list of the procedures required to accomplish the design-time tasks.

1. Create a new SOA Composite application with BPEL process, page 8-3
2. Add a partner link, page 8-8

3. Add a partner link for File Adapter, page 8-22

4. Configure the Invoke activities, page 8-28

5. Configure the Assign activity, page 8-31

Creating a New SOA Composite Application with BPEL Process

To create a new SOA Composite application with BPEL process:
1. Open JDeveloper BPEL Designer.

2. Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.
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The New Gallery Page

[=+-Business Tier

---ADF Business Components

----- Business Rules

----- Contexts and Dependency Injecti

O New Gallery I.g
Q
Categories: Items: ["] Show All Descriptions
" nplications = oot
e ADF Java Desktop Application
""" Deployment Descriptors [4] application from EAR File
----- Deployment Profiles
..... Diagrams ?‘ Application Template
""" Java Custom Application
----- Maven
..... Projects Database Application
----- Service Constructor —
Extension Application
..... UML
----- XML Java EE Web Application

QEP Application

Service Bus Application

..... Data Controls Service Bus Application With Service Bus Project
----- EIB =
S0A Applicatiol
----- Enterprise Scheduler Metadata ppiication
_____ Security Creates a SOA (service-oriented architecture} application. The application
) conzistz of one SOA project for the SOA composite, components, and adapters.
----- TopLink/JPA
o me—ee— UML Application

Help oK Cancel
L
Click OK.

3. The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page

-
@) Create SOA Application - Step 1 of 3

Name your application
- — Application Name:
‘T’ Application Name |InsertOrder-Ap|:l| |
Project Name
/T\ Directory:
v Project SOA Setfings |C:UDeveloper‘uﬂywork‘l.lZc‘LInsertOrder—Apg Browse...

Application Package Prefix:

Help | Mext> | Finish Cancel

Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.

Enter an appropriate name for the project in the Project Name field. For example,
InsertOrder.

Notice that SOA Suite is shown in the Project Features section.
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The Create SOA Application - Name your project Page

-
@) Create SOA Application - Step 2 of 3

Name your project

Project Mame: |Inseriﬂrder |

Application Mame
\ri

Directory: |C:UDeveloper\mywork\,lZc\,Inseru]rder—App\,Inserﬂ]rder | Browse...

1

Sel Project Hame
|

' Project SOA Settings Project Features:

SOA Suite
S0A Suite is a suite of tocls to medel S0A(Service Oriented Architecture) applications.

Help < Back | Next > . Finish Cancel

5. Click Next. The Create SOA Application - Configure SOA settings page is
displayed.
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The Create SOA Application - Configure SOA settings Page
r‘a Create SOA Application - Step 3 of 3

Configure SOA settings

Composite Name:
|Ir'|sertDrder

Application Name

Project Name
I Start from: () Standard Composite () SOA Template

[_] Empty Compasite

=3 Composite With Mediator

cﬁ Composite With Human Task
8 Composite With Spring Context
.-, Composite With BPEL Process
ﬁgd Composite With Subprocess
Q Composite With Business Rule

I
i Project S0A Settings

[ ] Customizable

Help < Back Einish Cancel

6. Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
7. Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
InsertOrder.

Select Asynchronous BPEL Process in the Template field. Click OK.

An asynchronous BPEL process is created with the Receive and Reply activities.
The required source files including bpel and wsdl, using the name you specified
(for example, InsertOrder.bpel and InsertOrder.wsdl) and InsertOrder
(composite.xml) are also generated.
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Adding a Partner Link

This section describes how to add a partner link to your BPEL process. A partner link
defines the link name, type, and the role of the BPEL process that interacts with the
partner service.

To add a partner link to insert order details into selected Open Interface
tables:

1. Click BPEL Services in the Component Palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a service name in the Name field. For example, InsertOrder.
2. Click Next. The Service Connection dialog appears.

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle
E-Business Suite is running,.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 5-14.

® You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.
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Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware User’s Guide for Technology Adapters.

Click Next in the Service Connection dialog box. You can add an interface table by
browsing through the list of interface tables available in Oracle E-Business Suite.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog box appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
e C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog box indicating where your local
copy exists with the creation date and time as part of the file name.
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Using the Local Integration Repository Data File
@ Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R12 (or later) apps instance.

From R 12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDeveloper\mywork\Application 1\AppsAdapter_IrepData

IRep Data file
|veloper\mw\'ork‘lﬁ.pplicaﬁon 1\AppsAdapter_IrepDatalrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

* C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle
E-Business Suite Module Browser.

5. The Oracle E-Business Suite Module Browser combines interface data from Oracle
Integration Repository with information about the additional interfaces supported
by Oracle E-Business Suite Adapter, organized in a tree hierarchy.

Note: Oracle E-Business Suite Module Browser includes the various
product families that are available in Oracle E-Business Suite. For
example, Applications Technology or Order Management Suite are
product families in Oracle E-Business Suite. The product families
contain the individual products. For example, Order Management
Suite contains the Order Management product. The individual
products contain the business entities associated with the product.
For example, the Order Management product contains the Sales
Order business entity.
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Business entities contain the various application modules that are
exposed for integration. These modules are grouped according to
the interface they provide. concurrent programs can be found

under the Open Interfaces category.

Navigate to Order Management Suite (OM_PF) > Order Management (ONT) > Sales
Order (ONT_SALES_ORDER) > Openlnterfaces >Order Management Sales Orders Open
Interface (OEOIMP) > Tables to select OE_HEADERS IFACE ALL.

Note: You can also search for a table by entering the name of the
program in the Object Name field. Select the Tables check box,

then click Search.

Oracle E-Business Suite Adapter provides flexfield support for Open Interface
Tables. Once the selected table is displayed in the Oracle E-Business Suite Module
Browser, you can either configure flexfield mappings for the table that has flexfields
defined in Oracle E-Business Suite or use current data without further flexfield

configuration.

Displaying a Selected Interface Table from the Module Browser

© Oracle Applications Module Browser

Object Name: | []Tables [Jviews []aPls []c@ [ |¥M.Gateway [ JEDI [ ]BusinessEvents Browse
.. (5% Human Resources Suite (HR_PF) Interface Table Columns with Corresponding Flexfield Mappings
(5 Interaction Center (CC_PF) Column Type Segment Flexfield... Context Flexfield Name
- (5% Marketing Suite (MKT_PF) (ORDER_SOURCE_ID NUMBER
- (3% Marketing and Sales Suite (MAS_PF) |ORIG_SYS_DOCUMENT _REF VARCHARZ
=+ (5 Order Management Suite (OM_PF) (CHANGE_SEQUENCE VARCHARZ
(53 Transportation Execution (FTE) (CHANGE_REQUEST_CODE VARCHARZ
(58 Order Management {GNT) (ORDER_SOURCE VARCHARZ
(5 Sales Agreement (ONT_SALES_AGREEMEN | |ORG_ID NUMBER
) (53 Sales Order (ONT_SALES_ORDER) JENERAE) e
[ XMLGatenay ORDER_NUMBER HUMBER
[ Enl VERSION_NUMBER NUMBER
fRPLsQL ORDERED_DATE DATE
(5 Openinterfaces ORDER _TYPE_ID NUMBER
2 Op ORDER_TYPE VARCHARZ
- (5 Order Management Sales Orders € PRICE [15T D o
- Tables PRICE_LTIST VARCHARZ
-~ P OF_LOTSERIALS IFACE S | leonyErsION_RATE NUMBER
— [ OE_PRICE_ADIS_IFACE | |cONVERSION RATE_DATE DATE
- [FFH| OE_PRICE_ATTS IFACE_. | |CONVERSION_TYPE_CODE VARCHAR2
- FFH| OE_RESERVTNS_IFACE_A ICONVERSION_TYPE VARCHAR2
- EH OE_CUSTOMER INFO_IF+ | HERANSACTINNAL CLIBR CONE VARCHAR?
- ] OF PAYMENTS TFACE AL Configure Flexfields
- FFH OE_ACTIONS _IFACE_ALL
[ OE_CREDITS_IFACE_ALL Flexfield Definitions
1] IType Application Mame Structure or Context
- FF OE_LINES_IFACE_ALL (O
3 views
i (3 ConcurrentPrograms Flexfield Metadata
% Order Management Sales Orders € Import from File Add Mapping
(% Order Management Acknowledgme
... (5 Order Management Acknowledgme
e~ (53 Order Management Sales Orders C oK Cancel

Note: If a selected interface table has pre-configured flexfield
mappings available, a pop-up window appears allowing you to
decide if you want to use these pre-configured mappings. Click Yes
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to display these mappings as part of the flexfield definitions in the
Configure Flexfields region. You can modify them later if needed.

Click No to indicate that you will not use these mappings and the
pop-up window disappears.

Configuring Flexfield Mapping Data for the Selected Open Interface Table

Perform either one of the following tasks in the Oracle E-Business Suite Module
Browser:

® Use the current data without further configuration by clicking OK to continue.

¢ Configure flexfield mapping data by either using an existing flexfield mapping
or creating a new mapping through a flexfield wizard if desired.

¢ Creating a New Mapping

You can create a new mapping for a selected open interface table by
clicking Add Mapping in the Flexfield Metadata section. A new flexfield
mapping wizard appears guiding you through each configuration page
where you can add key and descriptive flexfields, as well as configure
flexfield mapping between the selected interface table columns and
flexfields defined in the Oracle E-Business Suite instance.

For more information on how to create a new mapping and configure key
and descriptive flexfields, see:

* Adding or Configuring a New Mapping, page 4-37

¢ Configuring Key Flexfield Mappings for an Open Interface Table, page
4-79

e Configuring Descriptive Flexfield Mappings for an Open Interface
Table, page 4-85

¢ Importing an Existing Mapping

Instead of creating a new mapping, you can use an existing mapping that
has been created earlier by clicking Import from File in the Flexfield
Metadata section. This lets you select a desired flexfield mapping for your
selected interface table. Once a desired mapping is imported, you can
modify the context values for a descriptive flexfield, and modify structure
for a key flexfield if needed to meet your needs.

See: Importing an Existing Flexfield Mapping, page 4-115.

For more information on flexfield support for open interface tables and how to
modify existing mapping configuration, see Flexfield Support for PL/SQL APIs
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and Open Interface Tables, page 4-27.

In this example, click OK to continue. The Application Interface page appears with
the selected open table.

Adapter Configuration Wizard - Application Interface Page

' B
ﬂ Oracle Applications Adapter Configuration Wizard - Step 4 of 5 @
Application Interface
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables fviews or you can add a single APIfConcurrent Program XML Gateway Map/EDI Concurrent
Program/Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.,
r Operation Objects
Get Object (3% Delete
Mame Type
ONT.OE_HEADERS_IFACE_ALL Table fview
Help < Back Mext = Cancel

Click Get Object to open the Oracle E-Business Suite Module Browser again to
select another open interface table OE_ LINES IFACE ALL using the same
navigation path Order Management Suite (OM_PF) > Order Management (ONT) > Sales
Order (ONT_SALES_ORDER) > Openlnterfaces >Order Management Sales Orders Open
Interface (OEOIMP) > Tables.

In this example, click OK to continue the partner link creation without configuring
flexfields for the selected interface table.

Note: Configuring Flexfield Mapping Data for the Selected Open
Interface Table

If a selected interface table has pre-configured flexfield mappings
available, a pop-up window appears allowing you to decide if you
want to use these pre-configured mappings.
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* (lick Yes to display these mappings as part of the flexfield
definitions in the Configure Flexfields region. You can modify
them later if needed.

* (lick No to indicate that you will not use these mappings and
the pop-up window disappears.

If you want to configure flexfield mappings without using the
pree-configured flexfield ones, you can create a new mapping
through a flexfield wizard if desired. For information on how to
configure flexfield data for the selected open interface table, see:

e Adding or Configuring a New Mapping, page 4-37

¢ Configuring Key Flexfield Mappings for an Open Interface
Table, page 4-79

¢ Configuring Descriptive Flexfield Mappings for an Open
Interface Table, page 4-85

¢ Importing an Existing Flexfield Mapping, page 4-115

The Application Interface page appears with the two selected tables.
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Adapter Configuration Wizard - Application Interface Page

r R
@) Oracle Applications Adapter Configuration Wizard - Step 4 of 5 M
Application Interface
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent ProgramXML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.
r Operation Objects
Get Object [k Delete
Marme Type
ONT.OE_HEADERS_IFACE_ALL Tableview =
ONT.OE_LINES_IFACE_ALL Tablefview
Il Help < Back | Mext = | Cancel
s E
Click OK.

Click Next. The Operation Type page is displayed.
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Adapter Configuration Wizard - Operation Type Page
@) Oracle Applications Adapter Configuration Wizard - Step 5 of 11 @

Operation Type

Select the Operation Type and dick Next to continue defining the operation.

Operation Type:  (2) Perform an Operation on a Table

Insert
[ select
[ ] select By Primary Key

Cache Usage: |r1or1e (default) "|

Help < Back Next = | Cancel |

Select the Perform an Operation on a Table radio button and then choose the
Insert check box. Ensure that the Select check box is deselected.

9. Click Next. The Select Table page appears which displays the tables that have been
previously imported in this JDeveloper project (including tables that were imported
for other partner links). This enables you to reuse configured table definitions in
multiple partner links.
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Adapter Configuration Wizard - Select Table Page
fﬂl Oracle Applications Adapter Configuration Wizard - Step 6 of 11

Select Table

Flease select the root database table for this service's guery.

[ OE_LINES_IFACE_ALL
i OF HEADERS IFACE ALL

Help

< Back Mext = Cancel

Select OE_HEADERS_IFACE_ALL as the root database table for this service's
query.

10. Click Next. The Define Primary Keys page is displayed.
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Adapter Configuration Wizard - Define Primary Keys Page for
OE_HEADERS_IFACE_ALL

ﬁ Adapter Configuration Wizard - Step 8 of 13 ﬁ

Define Primary Keys . o
R : -"""I

The [OE_HEADERS_IFACE_ALL] table does not have a primary key defined, but the Database Adapter must be able
to uniquely identify a given row. Please select the fields below that can be used as a virtual primary key (your
database table will not be altered). Once you pick a column, it is recommended to create an index on it or make sure
it has one. Otherwise every operation except insert could be signifantly slower.,

=-fE5 OE_HEADERS_IFACE_ALL ~

~#]E ORDER_SOURCE_ID
Srl=ERoRIG SYS DOCUMENT REF
~[]B CHANGE_SEQUENCE
~[]B CHANGE_REQUEST_CODE
~[1B ORDER_SOURCE

~[]8 ORG_ID

1B HEADER_ID

~[]E ORDER_MUMBER

~[]B VERSION_NUMBER

~["1E ORDERED_DATE

~[]E ORDER_TYPE_ID

~[|B ORDER_TYPE

~[18 PRICE_LIST_ID

~[ 18 PRICE_LIST

-8 CONVERSION_RATE

ol

| s |

Select the following primary keys for the OE_HEADERS_IFACE_ALL table:
e ORDER_SOURCE_ID

e ORIG_SYS_DOCUMENT_REF

Click Next.
Select the same primary keys for the OE_LINES_IFACE_ALL table.

1. Click Next. The Relationships page appears. Click Create to open the Create
Relationship dialog.
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Defining Relationships

@) Create Relationship lﬁ

Please specify the parent and child tables, relation type and relation name. You also must specify the
foreign key / primary key assodations in the table below.

Parent Table: | OE_HEADERS_IFACE_ALL >

Child Table: |OE_LINES_IFACE ALL >

(") OF_HEADERS_IFACE_ALL has a 1:1 Relationship with OF_LINES_IFACE_ALL
() OE_HEADERS_IFACE_ALL has a 1:1 Relationship with OE_LINES_IFACE_ALL {Foreign Key on Child...
(%) OF_HEADERS_IFACE_ALL has a 1:M Relationship with OF_LINES_IFACE_ALL

Private Owned

OF_HEADERS_IFACE_ALL OE_LINES_IFACE_ALL
OE_HEADERS_IFACE_ALL.ORDER_SOURCE_ID  [ORDER SOURCE ID -|
OE_HEADERS_IFACE_ALL.ORIG_SYS_DOCUMEN... [RreRS el e e = = -]

Relationship Name: |aeLinesIfaceAIICcllecﬁcn |

| Help | | oK _J | Cancel |

Enter the following information to define the relationship between the header and
the detail table:

* Select the OE_HEADERS_IFACE_ALL as the parent table and
OE_LINES_IFACE_ALL as the child table.

*  Select the mapping type: OE_HEADERS_IFACE_ALL has a 1:M Relationship
with OE_LINES_IFACE_ALL

Note: If foreign key constraints between tables already exist in
the database, then two relationships are created automatically
while importing tables. One of the relationships is 1:M
relationship from the source table, which is the table containing
the foreign key constraints, to the target table. The other
relationship is a 1:1 back pointer from the target table to the
source table.
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e Select the Private Owned check box.

e Associate the foreign key fields with the primary key fields:
e OE_HEADERS_IFACE_ALL.ORDER_SOURCE_ID: ORDER_SOURCE_ID

e OE_HEADERS_IFACE_ALL.ORIG_SYS_DOCUMENT_REEF:
ORIG_SYS_DOCUMENT_REF

® The Relationship Name field is populated automatically by default. You can
optionally specify a new name for the relationship you are creating.

Click OK. The newly created relationship information appears in the Relationships
page.
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Adapter Configuration Wizard - Relationships Page
@) Adapter Configuration Wizard - Step 10 of 13

Relationships

Shown below are the relationships that are reachable from the root database table. You can define a new

relationship by dicking the 'Create..." button, or remove a relationship by dicking the ‘Remove’ button. To rename a
relationship, select it and dick the ‘Rename..." button,

‘1—'.§ OE_HEADERS_IFACE_ALL has a 1:M relationship with OE_LINES_IFACE_ALL {oelinesIfaceAllCollection)

| <Back | Mext> || Enish || cancel

12. Click Next. The Attribute Filtering page appears. Leave default selections
unchanged.
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Adapter Configuration Wizard - Attribute Filtering Page
’ﬂ Adapter Configuration Wizard - Step 11 of 13 @

Attribute Filtering
Unchedk any attributes that you would like to exdude from the database gueries for this service. Primary key
attributes cannot be exduded.

-] changeSequence
-] changeRequestCode
-] orderSource

] ergid

-] headerld

|| orderMumber

-] wersionMNumber

-w| erderedDate

-] orderTypeld

- orderType

-] priceListld

|| priceList

[ -] conversionRate I

| Select All | | Deselect all

| Help | | < Back || Mext = || Finish || Cancel |

Click Next. The Advanced Options page appears.
Click Next.

13. Click Finish. The wizard generates the WSDL file corresponding to the selected
interface. This WSDL file is now available for the partner link.

Adding a Partner Link for File Adapter

Use this step to configure a BPEL process by synchronously reading payload from an
input file to obtain the purchase order details.

To add a Partner Link for File Adapter to read order details:

1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component
palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane before the first partner link InsertOrder. The File Adapter Reference

page appears.
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Specifying a File Reference Name
-
@ FILE Adapter Configuration Wizard - Step 1 of 4 ﬂ

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

This wizard helps you create a File Adapter. You wil be asked to spedify configuration parameters and define an
operation for the adapter.

Enter a Reference Name.

Mame: geﬁ]rderDeiﬁiIs|

Help < Back . Mext = . Finist Cancel

Enter a name for the File Adapter service, for example, getOrderDetails.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
L B
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 @

Adapter Interface

P

The adapter interface is defined by a wsdl that is generated using the operation name and schema(s) specified later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: (5] Define from operation and schema (specified later)
() Impart an existing WSDL

[Ef

Help < Back MNext =

Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.
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Specifying File Server JNDI Name

P
@) FILE Adapter Configuration Wizard - Step 3 of 4 g
File Server Connection
Specify the JNDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter
must assodate this INDI name with a set of configuration properties needed by the File Adapter to access the File
Server at runtime,
File Server JMDI Mame |Ei5,|'Fi|EAda|:ltEr| | Ck
Help < Back Next = Finish Cancel

In the Operation page, specify the operation type. For example, select the

Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation

-
ﬁ FILE Adapter Configuration Wizard - Step 4 of 8 ﬁ

Operation

g

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in spedfied locations, and & Chunked Read operation that
synchronously reads file data in chunks and can be used OMNLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: (7) Read File
() Write File
(2) Synchronous Read File
() List Files

() Chunked Read

Operation Name: |SynchRead

[ | Read File As Attachment

Help < Back | MNext = . Cancel

Click Next to access the File Directories page.

4. Select the Logical Name radio button and specify directory for incoming files, such
as inputDir.

Ensure the Delete files after successful retrieval check box is not selected.
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Configuring the Input File
FILE Adapter Configuration Wizard - Step 5 of 8 (o
p g P

File Directories

Enter directory information for the incoming file of the Synchronous Read File operation.

Directory names are specified as: () physical Path (3) Logical Name

Directory for Incoming Files (Jogical name): |ir1|:|utDir|

[] Archive processed files
Archive Directory for Processed Files (Jogical name):

Help < Back Mext = Cancel

Click Next to open the File Name page.

Enter the name of the file for the synchronous read file operation. For example,
enter order data.xml. Click Next to open the Messages page.

Select the 'browse for schema file' icon next to the URL field to open the Type
Chooser.

Click Type Explorer and select Project Schema Files > InsertOrder_table.xsd >
OeHeaderslfaceAllCollection. Click OK.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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Specifying Message Schema

‘ﬂ FILE Adapter Configuration Wizard - Step 7 of 8

Messages

e : )
Define the message for the Synchronous Read File operation. Specify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you chedk 'Schema is Opague’, then you do not need to spedfy a Schema.
Message Schema
[ ] Mative format translation is not required (Schema is Opague)
URL | .fschemasInsertOrder_table.xsd | Ck &
Schema Element |DeHeadersIfaoeAlICOIIECﬁnn v|
Help < Back MNext = Cancel

7. Click Next and then Finish. This completes the configuration and create the partner
link with the required WSDL settings for the File Adapter service. The wizard also
generates the WSDL file corresponding to the partner link. The main Create Partner
Link dialog box appears, specifying the new WSDL file getOrderDetails.wsdl.

The getOrderDetails Partner Link appears in the BPEL process diagram.

Configuring Invoke Activities

After configuring partner links, you need to configure the following two Invoke

activities:

1. To get the acknowledgement data by invoking the ViewAck partner link.

2. To write acknowledgement data to an XML file by invoking WriteAckdata

partner link for File Adapter.

To add the first Invoke activity for a partner link to get acknowledgement data:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
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Component Palette. Drag and drop the first Invoke activity from the Web Service
section into the center swim lane of the process diagram, between the receivelnput
and callbackClient activities.

Adding an Invoke Activity

7 O

Link the Invoke activity to the ViewAck service. The Edit Invoke dialog appears.

Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.

In the Output tab, ensure the Output Variable radio button is selected. Click the
Create icon next to the Output Variable field to create a new variable. The Create

Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.
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,
© Edit Invoke |

Documentation | Targets = Sources  Skip Condiion  Headers
General Correlations Properties Assertions Annotations

Mame: |Ir1'u'uke |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type: |43 Partner Link ~

Partner Link: |ge1ﬂrderDE1ﬁiIs | 4,
Port Type: [3‘ SynchRead_ptt v]
Operation: [li SynchRead "]

Input Qutput

() Arguments Mapping (=) Output Variable g
Cutput: |Inunke_5ynd’1Read_Du1:puth'ariabIe | I% Ck
Help Apply oK Cancel

Click Apply and OK in the Edit Invoke dialog box to finish configuring the Invoke
activity.

The Invoke activity appears in the process diagram.
To add the second Invoke activity for a partner link to insert order data into Open
Interface tables:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the second Invoke activity from the Web
Service section into the center swim lane of the process diagram, between the first
Invoke and callbackClient activities.

2. Link the Invoke activity to the InsertOrder service. The Edit Invoke dialog box
appears.

8-30 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



3. Repeat Step 3 and Step 4 described in the first Invoke activity procedure. Click
Apply and then OK in the Edit Invoke dialog box to finish configuring the second
Invoke activity.

© Edit Invoke )

(]

Documentation  Targets  Sources  Skip Condition  Headers
General Correlations Properties Assertions Annotations

Mame: |In'-u'nke |

Conversation ID: | |

[ ] Invoke a= Detail

Interaction Type: |r._.§ Partner Link

Partner Link: |Inser1ﬂrder | q.ﬁ
Port Type: |$° |Inser1ﬂrdeu:|tt v|
Operation: | Gy insert -
Input
() Arguments Mapping () Input Variable =1}
Input: |Invoke_insert_InputVariable |l+ Ck
Help Apply QK Cancel

Configuring an Assign Activity

The next task is to add an Assign activity to the process map. This is used to pass the
output of File Adapter's Synchronous Read (getOrderDetails) service as an input to
the Open InterfaceInsertOrder service.

To add an Assign activity:

1. In]JDeveloper BPEL Designer, expand the BPEL Constructs from the Component
Palette.
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Drag and drop the Assign activity from the Basic Activities section into the center
swim lane of the process diagram, between the first and second Invoke activities
that you just created earlier.

2. Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
SetOrderDetails.

3. Enter the following parameter information:
¢ In the From navigation tree, navigate to Variable > Process > Variables >

Invoke_SynchRead_OutputVariable and select body.

* In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_insert_InputVariable and select OeHeadersIfaceAllCollection.

Drag the source node (body) to connect to the target node
(OeHeaderslfaceAllCollection) that you just specified. This creates a line that
connects the source and target nodes. The copy rule is displayed in the From and To
sections at the bottom of the Edit Assign dialog box.

O Edit Assign -
General | Copy Rules | Annotations | Skip Conditon | Sources | Targets
Insert New Rule After ~ B s @ =2
ﬁga OrderImportConcurrentProgram, bpel OrderImportConcurre
[ Partner Links P
B3 variables
Bﬁ?‘a Process F
=3 variables Variab
() inputYariable ‘ :iut\u'ariable {
) outputivariable ’ ?;t\n'ariahle {
x) Invoke_SynchRead_InputVariable Invoke_SynchRead_Inputvariable {
x) Invoke_SynchRead_Outputyariable H B Invoke_SynchRead_Outputvariable {
biod: — rvoke_insert_Inputvariable {
[ {2) Invoke_insert_Inputiariable

DeHeadersTfacealCollection [=]-
= copy

From To
42 Invoke_SynchRead_Outputvariable/body/ {2} Invoke_insert_InputVariable /OeHeadersIfaceAllCollaction/

1
4
®

Help | Apply || Ok _” Cancel

4. Click Apply and then OK to complete the configuration of the Assign activity.
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Completed BPEL Process Diagram

@

receivelnput

P8

Invoke getOrderDetails

'% "

orderimportconcur. .. SetOrderDet ails

{®

Invaoke InsertOrder

4

callbackClient

Click the InsertOrder (composite.xml) to display the Oracle JDeveloper composite

diagram:

Note: Click the Source tab of InsertOrder (composite.xml) to enter a
value for the physical directory inputDir for the reference
getOrderDetails (such as /usr/tmp).

<property name="inputDir" type="xs:string"
many="false" override="may">/usr/tmp</property>

Run-Time Tasks for Interface Tables

After designing the SOA Composite application with BPEL process, the next step is to
deploy, run, and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 8-34

2. Test the deployed SOA Composite application with BPEL process, page 8-37
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Deploying the SOA Composite Application with BPEL Process

To invoke the services from the BPEL client contained in the SOA composite, the SOA
composite needs to be deployed to the Oracle WebLogic managed server. This can be
achieved using Oracle JDeveloper. Once the composite is deployed, it can be tested
from the Oracle Enterprise Manager Fusion Middleware Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 11-1 and Creating an Application Server Connection, page 11-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Gerver started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy > InsertOrder > soa-serverl to deploy the
process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.
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Deployment Action

-);.\- Deployment Action | Select a deployment action from the list below.

| .
/T'\ Deploy Confiquration Deploy to Application Server

Deploy to SAR
/I\

/l\

Deploy this archive to SOA configured Application server(s)

Help Mext = || Einish || Cancel

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

¢ New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

¢ Opverwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from

JDeveloper are covered in Creating an Application Server
Connection, page 11-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.
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Select Server

ieployment

/"\_u_

ELiwESL Application Servers: ﬁ %
A Deploy Configuration IntegratedeblogicServer (domain unconfigured)

i _
Sel Select Server

).I.\ SOA Servers

IS

Qwerwrite modules of the same name

[ < Back ]L Next = ][ Finish H Cancel ]

4. In the SOA Servers page, accept the default target SOA Server ('soa-serverl’)

selection.
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SOA Servers
Choose the target S0A server(s) and correspanding partitions to which you want to deploy
/I\ this archive.
AT SOA Server: Partition: Status: Server URL:
g, Select Server S03_Server efaul hd thost0l exam..
Select 5 = 1 |default RUNNING http:/} hostol
I
el SO0A Servers
|
@ Summary
|
| Help | < Back || Next = | | Finish | | Cancel |
Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

5. Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window as well as in the Deployment - Log
window.

Testing the Deployed SOA Composite Application with BPEL Process

Once the SOA Composite application with BPEL process is deployed, you can manage
and monitor the process from the Oracle Enterprise Manager Fusion Middleware
Control Console. You can also test the process and the integration interface by manually
initiating the process.

To manually initiate and monitor the deployed SOA Composite application
with BPEL process:

1. Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
http://<servername>:<portnumber>/em). The composite you deployed is
displayed in the Applications Navigation tree.
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ORACLE’ Enterprise Manager Fusion Middleware Control 12¢ e

Login
Farm Farm_soainfra
* User Name [weblogic

=Passnord [es

Logn

Enterprise Manager Key Features New in this Release

Vs v Test your applications using real world workdoad using the:
i tion Replay functionality

» Automate Routine Tasks

» Stay ahead of the curve with My Oracle Support Integration
» Manage Many-as-One with Groups

» Complete, Integrated, Application-to-Disk IT Management ney
cover IT assets using dramatically improved Target Auto-

» Complete, Unified and Business-Driven Enterprise Cloud
Management
» SOA Management with improved dehydration diagnostics

2. Enter username (such as weblogic) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

3. From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_serverl)
> default to access your deployed SOA composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA Composite application that you want to initiate (such as
'Orderlnsert') from the SOA Infrastructure.

Click Test at the top of the page.
4. The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate
the process.
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Testing Web Service
Input Arguments

Tree View »
ame Type e
= * payload paylad
*input string kest

Request | Responss

Task Web Servce

The test results appear in the Response tab upon completion.

Click Launch Flow Trace in the Test Web Service page. The Flow Trace page is
displayed.

In the Trace section, you should find the sequence of the message flow for the
service binding component (insertorder client ep), BPEL component (
InsertOrder), and reference binding components (getOrderDetails and
InsertOrder). All involved components have successfully received and processed
messages.

If any error occurred during the test, you should find it in the Faults section.
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Flow Trace Page
Data Befreshed Mar 5, 2009 1214514 Al

Flow Trace @ -
This page shows the flow of the message through various composite and compenert: instances, 24 ECID ODODHLnKdESuxApd~ LFiF19f_9n000n] Q46
Storted Mar 5, 2009 12:43:34 AM

Faults
Seleck 2 fault ko locate i inthe trace view.
Error Message Recovery Fault Time Fauk Location Composite Instance
Mo Faults Found

Trace
Chek 2 corponent instance bo see its detaled audic trail,
Show Tnskance 15 [

Instance: Type State Time Composite Instance
= @ Trsertordsr_dient_ep Sarvice # Completed Mar 5, 2009 12:93:34 AW adspters-apps InsertCn
Bl g TnsertOrdsr EPEL Component & Completed Mar 5, 2009 12:43:36 AN adapters-apps Tnserton
ol getorderDetails Reference & Completed Mar 5, 2009 12:43:34 AN adapters-apps- Tnserton
o} Trsertorder Reference W Completed Mar 5, 2009 12:43:34 AM adapters-apps- Insertorn

6. Click your BPEL service component instance link (such as InsertOrder) to
display the Instances page where you can view execution details for the BPEL
activities in the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

7. Validating Records Using SQL

To confirm that the records have been inserted into the selected Open Interface
tables, you can write SQL SELECT statements and fetch the results showing the
latest records inserted into the open interface tables.

Design-Time Tasks for Views

This section describes the steps to configure Oracle E-Business Suite Adapter using the
Adapter Configuration Wizard in Oracle JDeveloper.

SOA Composite Application with BPEL Process Scenario

In this example, Oracle E-Business Suite Adapter retrieves purchase order
acknowledgement information from Interface Views OE_HEADER ACKS_V and
OE_LINE ACKS_V.The acknowledgement information will then be written to an XML
file as an output for confirmation.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you can validate the output XML file with the same order
book reference ID once an order is approved.

Prerequisites to Configure Views
You need to define a uniqueness criteria, which could be a single key or composite keys.

SOA Composite Application with BPEL Process Flow
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Based on the scenario, the following design-time tasks are discussed in this chapter.

1.

Create a new SOA Composite application with BPEL process, page 8-41
Add a partner link, page 8-46

Add a partner link for File Adapter, page 8-58

Configure the Invoke activity, page 8-64

Configure the Assign activity, page 8-68

Creating a New SOA Composite Application with BPEL Process

To create a new SOA Composite application with BPEL process:

1.

2.

Launch Oracle JDeveloper.

Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.
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The New Gallery Page

[=+-Business Tier

---ADF Business Components

----- Business Rules

----- Contexts and Dependency Injecti

O New Gallery Iﬂ
Q
Categories: Items: ["] Show All Descriptions
" nplications = oot
e ADF Java Desktop Application
""" Deployment Descriptors [4] application from EAR File
----- Deployment Profiles
..... Diagrams ?‘ Application Template
""" Java Custom Application
----- Maven
..... Projects Database Application
----- Service Constructor —
Extension Application
..... UML
----- XML Java EE Web Application

QEP Application

Service Bus Application

..... Data Controls Service Bus Application With Service Bus Project
----- EIB =
S0A Applicatiol
----- Enterprise Scheduler Metadata ppiication
_____ Security Creates a SOA (service-oriented architecture} application. The application
) conzistz of one SOA project for the SOA composite, components, and adapters.
----- TopLink/JPA
o me—ee— UML Application

Help oK Cancel
L
Click OK.

3. The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page

-
@) Create SOA Application - Step 1 of 3

Name your application
- - Application Mame:
el Application Name |Wribendc—ﬁp|:| |
Project Mame
Directory:
« Project SOA Setfings |C:UDeveloper\mywork\lk\WriteAdi-App Browse...
Application Package Prefix:
Help < Back Mext = Einish Cancel

Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.

Enter an appropriate name for the project in the Project Name field. For example,
WriteAck.
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The Create SOA Application - Name your project Page

@) Create SOA Application - Step 2 of 3

Name your project

—
¥ Application Mame

I
oy Project Name

\l.' Project SOA Settings

Project Name: |WriteAck |

Directory: |C: UDeveloperimyworkl12c\WriteAck-AppWriteAck | Browse...

Project Features:

SOA Suite
S0A Suite is a suite of tools to model S0A(Service Oriented Architecture) applications.

<Back | Mext» Einish Cancel

Notice that SOA Suite is shown in the Project Features section.

5. Click Next. The Create SOA Application - Configure SOA settings page is

displayed.
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6.

The Create SOA Application - Configure SOA settings Page
@) Create SOA Application - Step 3 of 3

Configure SOA settings

Composite Name:
|writeadk |

Application Name

Project M
T roject Name

I
i Project S0A Settings

Start from: (%) Standard Composite () SOA Template
[_] Empty Composite

<& Composite With Mediator

&5 Composite With Human Task

%, Composite With Spring Context

.- Composite With BPEL Process

,553 Composite With Subprocess

G Composite With Business Rule

[] Customizable

Help < Back Finish Cancel

Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
WriteAck.

Select Asynchronous BPEL Process in the Template field. Click OK.

An asynchronous BPEL process is created with the Receive and Reply activities.
The required source files including bpel and wsdl, using the name you specified
(for example, WriteAck.bpel and WriteAck.wsdl)and WriteAck.bpel
(composite.xml) are also generated.

Navigate to SOA folder and click the WriteAck.bpel (composite.xml) to view the
composite diagram.
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= % @ Write Ack
writeack_client_ep
Operations:

proce ss
processResponse

Double click on the WriteAckcomponent to open the BPEL process.

Adding a Partner Link

A BPEL partner link defines the link name, type, and the role of the BPEL process that
interacts with the partner service.

In the scenario described earlier, you need to add a partner link to retrieve order
acknowledgement information from selected Open Interface Views.

To add a partner link:
1. Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a reference name in the Name field. For example, ViewAck.
2. Click Next. The Service Connection dialog appears.

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle
E-Business Suite is running.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database

Connection, page 5-14.

* You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
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information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware User’s Guide for Technology Adapters.

Click Next in the Service Connection dialog box. You can add an interface view by
browsing through the list of open interface views available in Oracle E-Business
Suite.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog box appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:
* C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog box indicating where your local
copy exists with the creation date and time as part of the file name.
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Using the Local Integration Repository Data File
ﬁ Oracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R12 (or later) apps instance.

From R 12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDeveloper\mywork\Application 1\AppsAdapter_IrepData

IRep Data file
|ve|o|:|er‘lmywork‘lﬁ.|:||:|limﬁon 1\AppsAdapter_IrepDatalrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

* C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle
E-Business Suite Module Browser.

5. Oracle E-Business Suite Module Browser includes the various product families that
are available in Oracle E-Business Suite.

Navigate to Order Management Suite (OM_PF) > Order Management (ONT) > Sales
Order (ONT_SALES_ORDER) > Interface_Views to select OE_HEADER ACKS V.
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6.

Selecting a view from the Module Browser

© Oracle Applications Module Browser

Object Name: | | [7ables [Jwiews []aPs []cP [ ]¥M.Gateway [ |EDI [ ]BusinessEvents Browse
5 ProductFamiles Name Type
-~ G Advanced Planning (SCP_PF) DELIVER_TO_ADDRESS2 VARCHAR2
(53 Applications Technology (ATG_PF) DELIVER_TO_ADDRESSZ VARCHAR2
(53 Contracts Suite (OK_PF) DELIVER_TO_ADDRESS4 VARCHARZ
(53 Disrete Manufacturing (SMF_PF) DELIVER _TO_CITY VARCHAR2
(5 Finandal Globalizations Suite (FINGB_PF) DELIVER_TO_COUNTRY VARCHAR2
(53 Finandal Payables Suite (FINAP_PF) DELIVER_TO_COUNTY VARCHARZ
(55 Financial Receivables Suite (FINAR_PF) B IR RO RS s AR R
(5 Finandial Services Applications (SEM_PF) DEVER D PRONTRE UAREL 2
- B Financils (FIN_PF) DELIVER_TO_STATE VARCHAR2
53 Human Resources Suite (HR_PF) R L bl
8 Interacton Center (CC_PF) 15_CURRENT _LOCATION_CODE VARCHAR?2
3 Marketing Suite (MKT_PF) IB_INSTALLED_AT_LOCATION_CODE VARCHAR2
(5 Marketing and Sales Suite (MAS_PF) INVOICE_CTTY e
(55 Order Management Suite (OM_PF) INVOICE_COUNTRY VARCHARZ
3 Transportation Execution (FTE) INVOICE_COUNTY VARCHARZ
- €3 Order Management (ONT) INVOICE_CUSTOMER VARCHARZ
#- (3 ales Agreement (ONT_SALES_AGREEMEN | |INVOICE_CUSTOMER NUMBER VARCHAR2
= (3 Sales Order (ONT_SALES_ORDER) INVOICE_POSTAL_CODE VARCHAR2
[ XMLGateway INVOICE_PROVINCE_INT VARCHARZ
[gEnt INVOICE_SITE VARCHARZ
[@PLsQL INVOICE_SITE_CCDE VARCHAR2
iR Openinterfaces INVOICE_STATE VARCHAR2
Fi5 CONCLRRENT_PROGRAMS INVOICE_TO_CONTACT VARCHARZ
55~ [ INTERFACE_VIEWS INVOICE_TO_CONTACT_FIRST_NAVE VARCHAR2
S This view shows information about | |[OICE_TO_CONTACTID FUMPER
= INVOICE_TO_CONTACT_LAST_NAME VARCHARZ
& I WS | Inwoice_To_ore VARCHAR2
g :3::?2?.5? _ INVOICE_TO_ORG_ID NUMEER
INVOICE_TOLERANCE_ABOVE NUMBER
€3 Shipping Execution Comman (WSH) IMVOICE_TOLERANCE_BELOW/ NUMBER
(€5 Release Management (RLM) INVOICING_RULE VARCHARZ
@ Process Manufacturing (OPM_PF) INVOICING_RULE_ID NUMBER
[ - 5§ Procurement (PRC_PF) OPEN_FLAG VARCHARZ
(53 Product Lifecyde Management (PLM_PF) (OPERATION_CODE VARCHAR2
&3 Projects Suite (P1_PF) ORDER_DATE_TYPE_CODE VARCHAR2
(53 Public Sector (PS_PF) GRDER_SOURCE VARCHAR2
(53 Sales Suite (SLS_PF) ORDER _SOURCE_ID NUMBER
(53 Service Suite (SRY_PF) ORDER_TYPE VARCHAR2
(53 Supply Chain Management (SCM_PF) e NIMEFR
(3 University (UNV_PF) ok Cancel

Click OK. The Application Interface page appears with the selected interface view.
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Adapter Configuration Wizard - Application Interface Page

— n
*0 Oracle Applications Adapter Configuration Wizard - Step 4 of 5 ﬁ
Application Interface
. ."-/I.
You are connected to & post 11.5, 10 instance. Add the database objects needed for this service, You may add
one or more tablesfviews or you can add a single API/Concurrent Programf¥ML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, itis assumed that you want to use previously
created descriptors.,
r Operation Objects
Get Object [k Delete
Mame Type
APPS.OE_HEADER_ACKS_V Table/View
Help < Back Mext > Cancel

7. Click Get Object to open the Oracle E-Business Suite Module Browser again to
select another interface viewOE LINE_ ACKS_V using the same navigation path
Order Management Suite (OM_PF) > Order Management (ONT) > Sales Order
(ONT_SALES_ORDER) > Interface_Views.

Click OK. The Application Interface page appears with the two selected views.
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Adapter Configuration Wizard - Application Interface Page

r R
@) Oracle Applications Adapter Configuration Wizard - Step 4 of 5 E
Application Interface !
You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tables/views ar you can add a single API{Cancurrent Program,XML Gateway Map,/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors,
rOperation Objects
| GetObject | [} Delete
Mame Type
APPS,0E_HEADER_ACKS_V Table/View =
APPS.OE_LINE_ACKS_V Table/View
Help < Back Mext = Cancel
- -

8. Click Next. The Operation Type page is displayed.
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Adapter Configuration Wizard - Operation Type Page

-
ﬂ Cracle Applications Adapter Configuration Wizard - Step 5 of &

Operation Type

Select the Operation Type and did: Mext to continue defining the operation.

Operation Type: () Perform an Operation on a Table

Select

[ ] select By Primary Key

Poll for New or Changed Records in a Table
Eaoll far M Ch d R ds in a Tabl

Cache Usage:  |none (default) «

Help < Back Mext =

7l

Cancel

Select the Perform an Operation on a Table radio button and then choose the

Select check box.

Note: Interface views can be used only for Select operations.

9. Click Next. The Select Table page is displayed.
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Adapter Configuration Wizard - Select Table Page

@) Oracle Applications Adapter Cenfiguration Wizard - Step 6 of 14

Select Table

Flease select the root database table for this service's guery.

[ OF_LINE_ACKS_V
{8 OF_HEADER_ACKS_V

Help < Back ' MNext =

Finish Cancel

Select OE_HEADERS_ACKS_V as the root database table for this service's query.

10. Click Next. The Define Primary Keys page is displayed.

Using Interface Tables and Views 8-53



Adapter Configuration Wizard - Define Primary Keys Page for OE_HEADERS_ACKS_V

'0 Oracle Applications Adapter Configuration Wizard - Step 8 of 14 Iﬂ

Define Primary Keys

The [OE_HEADER._ACKS_V] table does not have a primary key defined, but the Adapter must be able to uniguely
identify a given row. Please select the fields below that can be used as a virtual primary key (your database table
will not be altered), The ROWID option is only configurable with an Orade database, a single table, and polling,
insert, or select operations only. Once you pick a column, itis recommended to create an index on it or make sure it
has one. Otherwise every operation except insert could be signifantly slower.,

() Select which column(s) makes up the primary key:
=51 OE_HEADER_ACKS_V

=B HEADER_ID

SEIENORIG SYS DOCUMENT REF
~[]B ORDER_NUMBER

~[]B ORDERED_DATE

~[]B ORG_ID

~[]B CHANGE_DATE

~[]B CHANGE_SEQUENCE

~[]B ACCOUNTING_RULE_ID
~[1B ACCOUNTING_RULE

~[]B ACCOUNTING_RULE_DURATION
~[]B ACKNOWLEDGMENT_FLAG
~[1H FIRST ACK CODE

Help < Back | Mext = Einish Cancel

Select the following primary keys for the OE_HEADERS_ACKS_V table:
e ORIG_SYS_DOCUMENT_REF

e ORDER_SOURCE_ID

Click Next.
Select the same primary keys for the OE_LINE_ACKS_V table.
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Adapter Configuration Wizard - Define Primary Keys Page for OE_LINE_ACKS_V
@) Oracle Applications Adapter Configuration Wizard - Step 7 of 14 ﬁ

Define Primary Keys :
The [OE_LINE_ACKS_V] table does not have a primary key defined, but the Adapter must be able to uniguely
identify a given raw. Please select the fields below that can be used as a virtual primary key {your database table
will not be altered). The ROWID option is only configurable with an Orade database, a single table, and polling,

insert, or select operations only. Once you pick a column, it is recommended to create an index on it or make sure it
has one. Otherwise every operation except insert could be signifantly slower,

() Select which column(s) makes up the primary key:
=/ OE_LINE_ACKS_V

-8
~[¢]B ORIG_SYS_DOCUMENT_REF
-8 ORIG_SYS_LINE_REF
~[]E ORIG_SYS_SHIPMENT_REF
~[]B ORG_ID
-8 CHANGE_SEQUENCE
~[]B CHANGE_DATE
~[]E ORDER_MUMBER
-] HEADER_ID
~[]B ACCOUNTING_RULE
~[]B ACCOUNTING_RULE_ID
=B ACCOUNTING RUIE DURATION

Help < Back | Next = | Einish Cancel

11. Click Next. The Relationships page appears.

Click Create to open the Create Relationship dialog.
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Defining Relationships

ﬁ Oracle Applications Adapter Configuration Wizard - Step 9 of 14 E

Please specify the parent and child tables, relation tvpe and relation name. ¥ou also must specify the
fForeign key | primary key associations in the table below,

Parent Table: |OE_HEADER_ACKS Y '

Child Table: | OE_LIME_ACKS W -

() OE_HEADER_ACKS_Y has a 1:1 Relationship with OE_LINE_ACKS _¥
() OE_HEADER_ACKS W has a 1:1 Relationship with OE_LINE_ACKS_Y (Foreign Key on Child table)

(#) OE_HEADER_ACKS_W has a 1:M Relationship with OE_LIME_ACKS_W

Private (uwwned
OF_HEADER_ACKS OE_LINE_ACKS ¥
OF_HEADER_ACKS_¥.ORIG_S¥S_DOCUMENT REF [ORIG S5 DOCUMENT REF =

OE_HEADER_ACKS_M.ORDER_SOURCE_ID | ORDER. SOURCE ID - |

Relationship Marme: | oeLinedcksyCollection |

Help | | (0] | | Cancel |

Enter the following information to define the relationship between the header and
the detail table:

* Select the OE_HEADERS_ACKS_V as the parent table and OE_LINES_ACKS_V
as the child table.

® Select the mapping type: OE_HEADERS_ACKS_V has a 1:M Relationship with
OE_LINES_ACKS_V

Note: If foreign key constraints between tables already exist in
the database, then two relationships are created automatically
while importing tables. One of the relationships is 1:M
relationship from the source table, which is the table containing
the foreign key constraints, to the target table. The other
relationship is a 1:1 back pointer from the target table to the
source table.
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e Select the Private Owned check box.

e Associate the foreign key fields with the primary key fields:
e OE_HEADERS_ACKS_V.ORDER_SOURCE_ID: ORDER_SOURCE_ID

e OE_HEADERS_ACKS_V.ORIG_SYS_DOCUMENT_REF:
ORIG_SYS_DOCUMENT_REF

® The Relationship Name field is populated automatically by default. You can
optionally specify a new name for the relationship you are creating.

Click OK. The newly created relationship information appears in the Relationships
page.

12. Click Next. The Attribute Filtering page appears. Leave default selections
unchanged.
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Adapter Configuration Wizard - Attribute Filtering Page
ﬂ Cracle Applications Adapter Configuration Wizard - Step 10 of 14 Ig

Attribute Filtering

Uncheck any attributes that you would like to exdude from the database queries for this service. Primary key
attributes cannot be exduded.

«[w| headerld

«[w] orderMumber

-[w] orderedDate

-[w] orgld

-|w| changeDate

-|w| changeSequence
-[w] accountingRuleld
-] accountingRule
accountingRuleDuration
|| acknowledgmentFlag
-[w#] firstAckCode

-] lastAckCode

-] firstAckDate

-|w| lastAckDate

Select All Deselect Al

Help < Back Mext = Finish Cancel

Click Next. The Define Selection Criteria page appears.

Click Add to add a new parameter if necessary. Click Edit to use the graphical
expression builder to create the expression. You can define your own custom Select
SQL by modifying the predefined SQL string.

13. Click Next. The Advanced Options page appears.
Click Next.

14. Click Finish. The wizard generates the WSDL file corresponding to the selected
interface. This WSDL file is now available for the partner link.

Adding a Partner Link for File Adapter

Use this step to configure a BPEL process by adding a partner link for File Adapter. This
allows the acknowledgement data to be written to an XML file.
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To add a partner link for the file adapter:

1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component
palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane of the process diagram right after the partner link you just created. The
File Adapter Reference page appears.

Specifying a File Adapter Reference Name
| R
ﬂ FILE Adapter Configuration Wizard - Step 1 of 4 ﬂ

File Adapter Reference

Welcome to the File Adapter Configuration Wizard

This wizard helps you create a File Adapter. You will be asked to spedfy configuration parameters and define an
operation for the adapter.

Enter a Reference Mame.

Mame: |[WriteAckdata|

Help Mext > Cancel

Enter a name for the File Adapter service, for example, WriteAckdata.

2. Click Next. The Adapter Interface page appears.
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Specifying the Adapter Interface
L B
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 @

Adapter Interface

P

The adapter interface is defined by a wsdl that is generated using the operation name and schema(s) specified later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: (5] Define from operation and schema (specified later)
() Impart an existing WSDL

[Ef

Help < Back MNext =

Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.
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Specifying File Server JNDI Name

P
@) FILE Adapter Configuration Wizard - Step 3 of 4 g

File Server Connection

Specify the JNDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter

must assodate this INDI name with a set of configuration properties needed by the File Adapter to access the File
Server at runtime,

File Server JNDI Mame |EisfFi|eAda|:|ter|

| X

Help < Back | Next =

M
m

Cancel

3. In the Operation page, specify the operation type. For example, select the Write File

radio button. This automatically populates the Operation Name field.
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Specifying the Operation

]

-
@) FILE Adapter Configuration Wizard - Step 4 of 7

Operation

The File Adapter supports five operations, There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in specified locations, and a Chunked Read operation that
synchronously reads file data in chunks and can be used ONLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: (7 Read File
(%) Write File
() Synchronous Read File
(") List Files
(") Chunked Read

Operation Name: |Write

["] Add Output Header

Help < Back Next = Cancel

4. Click Next to access the File Configuration page.
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Configuring the Output File

L hl
i} FILE Adapter Configuration Wizard - Step 5 of 7 ﬁ

File Configuration

Specify the parameters for the Write File operation.

Directory specified as () Physical Path () Logical Name
Directory for Outgoing Files {(physical path):
|Duu:|utDir Browse

File Maming Convention (po_%SEQ%. tt): |Ever1tndi%wMMddHHmmss . xml

[ ] Append to existing file

Write to output file when any of these conditions are met
MNumber of Messages Equals: |1

v

Help < Back Mext = Cancel

For the Directory specified as field, select the Logical Name radio button. Enter
OutputDir as the Directory for Outgoing Files (logical name) and specify a
naming convention for the output file, such as EventAck$yyMMddHHmmss% . xm1.

Tip: When you type a percent sign (%), you can choose from a list of
date variables or a sequence number variable (SEQ) as part of the
filename.

Confirm the default write condition: Number of Messages Equals 1.

Click Next, and the Messages page appears. For the output file to be written, you
must provide a schema.

Click Browse to access the Type Chooser.

Expand the node by clicking Project Schema Files > ViewAck_table.xsd and
selecting OeHeaderAcksSelectInputParameters. Click OK.

The selected schema information will be automatically populated in the URL and
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Schema Element fields.

Populating the Selected Message Schema

ﬂ FILE Adapter Configuration Wizard - Step 6 of 7 [ﬁ
Messages : 103310 =
Define the message for the Write File operation. Specify the Schema File Location and select the Schema Element
that defines the messages in the outgaing files. Use the Browse button to find an existing schema definition. If you
checdk 'Schema is Opague’, then you do not need to specify a Schema.
Message Schema
[] Mative format translation is not required {(Schema is Opaque)
URL | .fSchemas ViewAck_table. xsd| | Q% i
Schema Element |h'iewAd<SeIectInputParameters v|
Help < Back MNext = Cancel

9. Click Next and then Finish. The wizard generates the WSDL file corresponding to
the partner link. The main Create Partner Link dialog box appears, specifying the
new WSDL file.

Configuring Invoke Activities

Based on the scenario described earlier, you need to configure the following two Invoke
activities:

1. To get the purchase order acknowledgement details by invoking the ViewAck
partner link.

2. To write the purchase order acknowledgement information to an XML file by
invoking WriteAckdata partner link for File Adapter.

To add the first Invoke activity for a partner link to get acknowledgement details:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
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Component Palette. Drag and drop the first Invoke activity from the Web Service
section into the center swim lane of the process diagram, between the receivelnput
and callbackClient activities.

Link the Invoke activity to the ViewAck service. The Edit Invoke dialog appears.

The value of the Operation field is automatically selected based on the associated
partner link. For example, this Invoke activity is associated with an interface table
partner link for 'select’ operation only, the 'ViewAckSelect' service name with
'Select’ operation is populated as the value.

Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name.

Click OK.

In the Output tab, ensure the Output Variable radio button is selected. Click the

Create icon next to the Output Variable field to create a new variable. The Create
Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name.

Click OK to close the Create Variable dialog.
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© EditInvoke - 2

Documentation  Targets  Sources  Skip Condition  Headers
General Correlations Properties Assertions Annotations

Mame: |Ir1'u'nke |

Conversation ID: | | el

[ ] Invoke as Detail

Interaction Type: | {3 Partner Link ~

Partner Link: |'l.|"|ew.ﬁ.d=; | %

Port Type: | 5" viewack_ptt -]

Operation: | 0y ViewAdSelect "'|

Input  Output

i) Arguments Mapping (3 Output Variable =)

Output: |Irwuke_'u"|ewAcheIect_Duh:rut’u'ariable_ | EF Ck

Help Apply oK Cancel

Click Apply and then OK in the Edit Invoke dialog box to finish configuring the
Invoke activity.

The Invoke activity appears in the process diagram.
To add the second Invoke activity for a File Adapter partner link to write
acknowledgement details in an XML file:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the first Invoke activity from the Web Service
section into the center swim lane of the process diagram, right after the first Invoke
activity.

2. Link the Invoke activity to the WriteAckdata service for File Adapter. The Edit
Invoke dialog appears.
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Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK to return to the Edit Invoke dialog box.
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© Edit Invoke =X

Documentation  Targets  Sources | Skip Condition = Headers

General Correlations Properties Assertions Annotations

Mame: |Ir1'u'nke |

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type: |r.,,5_1 Partner Link *

Partner Link: |WriteAck | Q

Port Type: |$° Wirite_ptt '|

Operation: | Gy Wirite -

Input

() Arguments Mapping (3 Input Variable &)

Input: (Invoke_Write_InputVariable |l+ ':k
Help Apply K Cancel

Click Apply and then OK to finish configuring the Invoke activity.

The second Invoke activity appears in the process diagram.

Configuring an Assign Activity

The next task is to add an Assign activity to the process map. This is used to provide
values to the input variables.

To configure an Assign activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette.

Drag and drop the Assign activity from the Basic Activities section into the center
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swim lane of the process diagram between the two Invoke activities that you just
created earlier.

Double-click the Assign activity to access the Edit Assign dialog.

Click the General tab to enter a name for the Assign activity. For example,
setAckdata.

Select the Copy Rules tab and expand the target trees:

¢ In the From navigation tree, navigate to Variable > Process > Variables >
Invoke_ViewAckSelect_OutputVariaable and select
ViewAckSelect_inputParameters.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invokel_Write_InputVariable and select body.

Drag the source node (ViewAckSelect_inputParameters) to connect to the target
node (body) that you just specified. This creates a line that connects the source and
target nodes. The copy rule is displayed in the From and To sections at the bottom
of the Edit Assign dialog box.

@) Edit Assign —x
General | CopyRules | Annotations = Skip Condition =~ Sources = Targets
|Insert Mew Rule After + B O =
e Wirieack. bpel Wribed
D Partner Links Partner Lir
=53 variables Wariabl
E}ﬁga Process Process 4
2[5 Variables .. Watiables (23|
#-(x) inputvariable inputvariable (x)-@
(x) outputyariable B ‘ outputyariable (x)-8
(x) Invoke_ViewackSelect_Inputtariable Ezlect_InputVariabIe x)
=) Invoke ViewhckSelect Outputyariable & lect_Outputyariable (x}---
\u'iewAckSeIect_inputParameters—':'-..‘__‘_h_ ' Invokel _Write_Inputyariable x)-2
[ x) Invokel_\Write_Inputvariable biody E
iViewackSelectInputParameters -

oy~ +Re D

From To

Click Apply and then OK.
The BPEL diagram is completed.
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BPEL Process Diagram

@

receivelnput

Viewhck

& =

o b
write ack_client SetAclkdata

.

Invokel WriksAckdata

&l

callbackClient

Click the WriteAck (composite.xml) to display the Oracle JDeveloper composite
diagram:

Note: Click the Source tab of WriteAck (composite.xml) to enter a
value for the physical directory outputDir for the reference
WriteAckdata (such as /usr/tmp).

<property name="outputDir" type="xs:string"
many="false" override="may">/usr/tmp</property>
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Oracle JDeveloper Composite Diagram

D=gy
ViewAck
Operations:
ViewAckSelect
= @

writeack_client_ep

Operations:
process ® = {%
processResponse Write Ackdata
Operations:
Wirite

Run-Time Tasks for Views

After designing the SOA Composite application with BPEL process, the next steps are
to deploy, run and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 8-71

2. Test the deployed SOA Composite application with BPEL process, page 8-74

Deploying the SOA Composite Application with BPEL Process

To invoke the service from the BPEL client contained in the SOA composite, the SOA
composite needs to be deployed to the Oracle WebLogic managed server. This can be
achieved using Oracle JDeveloper. Once the composite is deployed, it can be tested
from the Oracle Enterprise Manager Fusion Middleware Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 11-1 and Creating an Application Server Connection, page 11-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.
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To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy >WriteAck > soa-serverl to deploy the process
if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.

Deployment Action

-).'{ Deployment Action | Select a deployment action from the list below.
T

| .
/‘T'\ Deploy Confiquration Deploy to Application Server

Deploy to SAR
/I\

/l\

Deploy this archive to S0A configured Application server(s)

Help Mext = || Einish || Cancel

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

* New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

¢ Opverwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from
JDeveloper are covered in Creating an Application Server
Connection, page 11-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server

8-72 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



connection earlier. Click Next.

Select Server

Deploym

i ent Action
A Leployment Actio

A Deploy Configuration

i
Sell Select Server

|
).I.\ SOA Servers

CUMMary

Application Servers:

IntegratedWeblogicServer (domain unconfigured)

Owerwrite modules of the same name

[ < Back ]L Mext = ][ Finish ][ Cancel ]

In the SOA Servers page, accept the default target SOA Server ('soa-serverl')

selection.
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SOA Servers
Choose the target S0A server(s) and correspanding partitions to which you want to deploy
/I\ this archive.
AT SOA Server: Partition: Status: Server URL:
. Gelect Server S03_Server efaul hd thost0l exam..
A, Select 5 = 1 |default RUNNING http:/} hostol
I
el SO0A Servers
|
@ Summary
|
| Help | < Back || Next = | | Finish | | Cancel |
Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

5. The BPEL process contained in the SOA Composite application is compiled and
deployed. You can check the progress of the compilation in the Messages window.

Testing the Deployed SOA Composite Application with BPEL Process

Once the SOA Composite application is deployed, you can manage and monitor the
process from the Oracle Enterprise Manager Fusion Middleware Control Console. You
can also test the process and the integration interface by manually initiating the process.

To manually initiate and monitor the deployed SOA Composite application
with BPEL process:

1. Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
http://<servername>:<portnumber>/em). The composite you deployed is
displayed in the Applications Navigation tree.
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2.

ORACLE’ Enterprise Manager Fusion Middleware Control 12¢ e

Login
Farm Farm_soainfra
* User Name [weblogic

=Passnord [es

Logn

Enterprise Manager Key Features New in this Release

v v Test your applications using real world workdoad using the:
Application Replay functionality

» Automate Routine Tasks
» Stay ahead of the curve with My Oracle Support Integration
» Manage Many-as-One with Groups
» Complete, Integrated, Application-to-Disk IT Management
cover IT assets using dram lly improved Target Auto-
» Complete, Unified and Business-Driven Enterprise Cloud

Management
> SOA Management with improved dehydration diagnostics

Enter username (such as weblogic) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_serverl)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA Composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA Composite application that you want to initiate (such as 'WriteAck')
from the SOA Infrastructure.

Click Test at the top of the page.
The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate
the process.
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Testing Web Service
Input Arguments

Tree View »
ame Type e
= * payload paylad
*input string kest

Request | Responss

Task Web Servce

The test results appear in the Response tab upon completion.
5. Click Launch Flow Trace in the Test Web Service page. The Flow Trace page is
displayed.

In the Trace section, you should find the sequence of the message flow for the
service binding component (writeack client ep), BPEL component (
WriteAck), and reference binding components (ViewAck and WriteAckdata).
All involved components have successfully received and processed messages.

If any error occurred during the test, you should find it in the Faults section.
6. Click your BPEL service component instance link (such as WriteAck) to display

the Instances page where you can view execution details for the BPEL activities in
the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

7. Verifying Records in Oracle E-Business Suite

Log on to Oracle E-Business Suite with Purchasing, Vision Operations (USA)
responsibility and select Purchase Order from the navigation menu.

The Purchase Order forms is displayed.

8. Create a purchase order with the following header values:

* Supplier: Enter a supplier information, such as 'Advanced Network Devices'.
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10.

11.

e Site: Select a site information, such as 'SANTA CLARA-ERS'.
On the Lines tab, enter a data row with the following values:

e Type: Goods

e Jtem: CM13139

¢ Quantity: 1

® Description: Hard Drive - 8GB

* Promised: Enter any future date in the format of dd-mmm-yyyy (such as
23-JUN-2009)

Save your purchase order. The status of the purchase order is 'Incomplete’.

Click Approve. The Approve Document form appears.
Click OK to confirm the approval.

Note: Because the trading partner is set up and valid, the
transmission method is automatically set to XML.

Operating Unit ision Operations Created |07-JUN-2006 01:29:02
PO, Rev 5789 0 LTS andard Pu Orde P-Card
Supplier Advanced Network Devices Site |SANTA CLARA-ERS Contact
Ship-To |M1- Seattle My BilkTa |%1- Mew York City Currency |JSD
Buyer Stock, Ms. Pat Status | Approved Total 16039 [ ]
Desctiption
Lines Price Reference  Reference Documents Ilore Agreement Temporary Labor
i
Mum  Type ltern Rev  Joh Categary Description UOh Quantity Price |
. 1 Goods CM13139 PRODUCTN.DRI Hard Drive - 3GB Each 1 150393 =
4] 3
ltem |Ch413139 Hard Drive - 8GB

Catalog. Currency. ‘ Terms | Shipments ‘ Approve. .

The status of the purchase order is now changed to 'Approved'. For future
reference, note the value of the PO, Rev field. For example, the PO number 5789.

Once the purchase order is approved, the order details should be recorded in the
system.
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After deploying the BPEL process contained in a SOA Composite application, the
order acknowledgement information should be retrieved from the
OE_HEADER ACKS Vand OE_LINE ACKS_V interface views.

Validate the output file EventAck%$yyMMddHHmmss% . xm1 in the specified output
directory by opening the xml file to confirm the purchase order details. The
document number in the xml file should be the same number you just approved in
Oracle E-Business Suite.
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9

Using PL/SQL APIs

This chapter covers the following topics:

Overview of PL/SQL APIs

Design-Time Tasks for PL/SQL APIs

Creating a New SOA Composite Application with BPEL Process
Adding Partner Links

Adding a Partner Link for File Adapter

Defining Wrapper APIs

Declaring Parameters with a DEFAULT Clause

Configuring the Invoke Activities

Configuring a Transform Activity

Configuring an Assign Activity

Run-Time Tasks for PL/SQL APIs

Deploying the SOA Composite Application with BPEL Process
Testing the Deployed SOA Composite Application with BPEL Process

Troubleshooting

Overview of PL/SQL APIs

Oracle E-Business Suite Adapter uses PL/SQL application programming interfaces
(APIs) to insert and update data in Oracle E-Business Suite. APIs are stored procedures
that enable you to insert and update data in applications. Additionally, you can use
PL/SQL APIs to retrieve data. For example, by using PL/SQL APlIs, you can insert a
customer record in Oracle E-Business Suite.

Note: For more information about PL/SQL procedure limitations, refer
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to Oracle Fusion Middleware User’s Guide for Technology Adapters.

Design-Time Tasks for PL/SQL APIs

This section describes how to configure the Oracle E-Business Suite Adapter to use
PL/SQL APIs.

SOA Composite Application with BPEL Process Scenario

In this example, Oracle E-Business Suite Adapter exposes the following stored
procedures as Web services in a BPEL process to update the 'quantity’ field of an
existing purchase order based on user input.

* A custom Order Management stored procedure GET G MISS LINE REC
(GET_G_MISS LINE REC) to initialize the purchase order

e A PL/SQL Process Order Line (PROCESS_LINE) to update the existing purchase
order

When a change order request is received, the purchase order information including
order quantity and other line item details will be retrieved. Based on user input, a new
order quantity will be updated in Oracle Order Management.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you can validate the process by querying it directly from
Order Management tables or validate it from the Formed-based Oracle Order
Management application. The retrieved ordered quantity value from the query
table or you find in the Order Management application should be the same as the
quantity value given by the user through changeorder data.xml file.

Prerequisites to Configure PL/SQL APIs

Oracle E-Business Suite Adapter is deployed using the BPEL Process Manager (PM) in
Oracle JDeveloper. The BPEL PM creates the WSDL interfaces for the API.

Populating Applications Context Header Variables

You need to populate certain variables in the BPEL PM in order to provide context
information for Oracle E-Business Suite. The context information is required for an API
transaction in order for an Oracle E-Business Suite user that has sufficient privileges to
run the program.

The context is set taking into account the values passed for the header properties
including Username, Responsibility, Responsibility Application, Security Group, and NLS
Language. If the values for the new header properties Responsibility Application, Security
Group, and NLS Language are not passed, context information will be determined based
on Username and Responsibility.

The default Username is SYSADMIN, the default Responsibility is SYSTEM
ADMINISTRATOR, the default Security Group Key is Standard, and the default NLS
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Language is US.

You can change the default values specified in the generated WSDL. This is a static way
of changing the context information. These values would apply to all invocations of the
deployed business process. However, if you need to provide different context
information for different invocations of the business process, then you can dynamically
populate the header values. The context information can be specified by configuring an
Invoke activity.

For more information about applications context, see Supporting for Normalized
Message Properties, page 4-7.

Populating Default Values for Record Types

Certain PL/SQL APIs exposed from Oracle E-Business Suite take record types as input.
Such APIs expect default values to be populated for parameters within these record
types for successful execution.

The default values are FND API.G MISS CHAR for characters,

FND _API.G MISS DATE for dates, and FND_API.G MISS NUM for numbers. Oracle
E-Business Suite Adapter can default these values when the parameters within the
record type are passed as nil values, for example, as shown below:

<PRICE_LIST REC>
<ATTRIBUTEl xsi:nil="true"/>
<ATTRIBUTE2 xsi:nil="true"/>
<ATTRIBUTE3 xsi:nil="true"/>

</PRICE_LIST REC>

This can be achieved with the help of a function in a Transform activity, or by directly
passing the XML input with nil values and then assigning them to the record types
within an Assign activity.

Following is a list of the procedures required to accomplish the design-time tasks.

1. Create a new SOA Composite application with BPEL process, page 9-4
2. Add partner links, page 9-8

3. Add a partner link for File Adapter, page 9-19

4. Define wrapper APIs, page 9-25

5. Declare parameters with a DEFAULT clause, page 9-28

6. Configure Invoke activities, page 9-31

7. Configure a Transform activity, page 9-33

8. Configure an Assign activity, page 9-35
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Creating a New SOA Composite Application with BPEL Process

To create a new SOA Composite application with BPEL process:

1.

3.

Launch Oracle JDeveloper.

Click New Application in the Application Navigator.

The New Gallery page appears. Select SOA Application from the Items list.

The New Gallery Page
O New Gallery l&]

Q

Categories: Items: [ Show All Descriptions
----- = —
_____ Comnections ADF Java Desktop Application
""" Deployment Descriptors [ﬂ Application from EAR. File
----- Deployment Profiles
..... Diagrams F Application Template
""" pev Custom Application
----- Maven
----- Projects Database Application
----- Service Constructor —

Extension Application

..... UML
""" XML Java EE Web Application

[=}-Business Tier

----- ADF Business Components

----- Business Rules

----- Contexts and Dependency Inject

OEP Application

Service Bus Application

..... Data Controls Service Bus Application With Service Bus Project
..... EIB f—
S0A Applicati
----- Enterprise Scheduler Metadata Aot
_____ Security Creates a SOA (service-orisnted architecture} application. The application
) consists of one 50A proiect for the SOA composite, components, and adanters.
----- TopLink/IPA
Mok Somioos UML Application
Help oK Cancel
b
Click OK.

Click New Application in the Application Navigator.

The Create SOA Application - Name your application page is displayed.

9-4 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide




The Create SOA Application - Name your application Page

-
@) Create SOA Application - Step 1 of 3

Name your application

- = Application Name:

‘T" Application Hame |Change0rderAPI—Ap|:| |

Project Name

/T\ Directory:

w  Project SOA Setfings |C:UDeveIoper\ﬂywork\uc‘,changeDrderAPI-App Browse...

Application Package Prefix:
Help Next = Finish Cancel

Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.

Enter an appropriate name for the project in the Project Name field. For example,
ChangeOrderAPT.

Notice that SOA Suite is shown in the Project Features section.
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The Create SOA Application - Name your project Page

@) Create SOA Application - Step 2 of 3

Name your project

Application Name
T
s Project Name

\IJ Project SOA Settings

Project Mame: |ChangeDrderAPI| |

Dirgctory: |-'eIoper‘\mywork‘l.lZc‘\ChangeOrderAPI-App‘,ChangeOrderAPI | Browse...
Project Features:
S0A Suite

S0A Suite is a suite of tools to medel SOA(Service Oriented Architecture) applications.

Finish Cancel

6. Click Next. The Create SOA Application - Configure SOA settings page is

displayed.
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1.

The Create SOA Application - Configure SOA settings Page

@) Create SOA Application - Step 3 of 3

Configure SOA settings

Compaosite Name:
|Change0rderAPI |

Application Mame

\.|./

/T\ Broject Name Start from:  (2) Standard Composite () SOA Template
D Empty Composite

<& Composite With Mediator

{5 Composite With Human Task

'@, Composite With Spring Context

.+, Composite With BPEL Process

iw Project S0A Settings

,535 Composite With Subprocess
0 Composite With Business Rule

[] Customizable

Help < Back Finish Cancel

Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL
project that supports the BPEL 2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,
ChangeOrderAPT.

Select Asynchronous BPEL Process in the Template field. Click OK.

An asynchronous BPEL process is created with the Receive and Reply activities.
The required source files including bpel and wsdl, using the name you specified
(for example, ChangeOrderAPI.bpel and ChangeOrderAPI.wsdl) and
ChangeOrderAPI (composite.xml) are also generated.

Navigate to SOA folder and click ChangeOrderAPI (composite.xml) to view the
composite diagram.

Double click on the ChangeOrderAPI component to open the BPEL process.
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New BPEL Process

Partner Links Partner Links

: O

@

'{& receivelnput
1

changearderapi_cl. ..
Z
|

callbacklient

"

O

Adding Partner Links

The next task is to add a partner link to the BPEL process. This section describes how to
create a partner link for the application service using a BPEL process. A BPEL partner
link defines the link name, type, and the role of the BPEL process that interacts with the
partner service.

Based on the BPEL process scenario discussed earlier, the following two partner links
need to be configured:

¢ Add the first partner link (initLineRec) to initialize the purchase order

® Add the second partner link (OrderManagement) to update the existing purchase
order

To add the first partner link:
1. Click BPEL Services in the Component Palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.
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Enter a service name in the Name field. For example, initLineRec.
Click Next. The Service Connection dialog appears.

You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle
E-Business Suite is running,.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 5-14.

* You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware User’s Guide for Technology Adapters.

Once you have completed creating a new connection for the service, you can add a
PL/SQL API by browsing through the list of APIs available in Oracle E-Business
Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
to Oracle E-Business Suite in your workspace. Absence of the data file would make
browsing or searching of Integration Repository tree considerably slow. You can
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choose to extract the data file and create a local copy of the Integration Repository
data file. Once it is created successfully, Adapter will pick it up automatically next
time and retrieve data from your local Integration Repository.

You can select one of the following options:
* C(lick Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.

Using the Local Integration Repository Data File
ﬂ Cracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R12 (or later) apps instance.

From R12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDeveloper\mywork\Application 1\AppsAdapter_IrepData

IRep Data file
|veloper\myu\'ork\.ﬁ.pplicaﬁon 1\AppsAdapter_IrepDatalrep_data_sid20136_20130323_2227.dat Browse

Help < Back Next = Cancel

* C(lick No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle
E-Business Suite Module Browser.

5. The Oracle E-Business Suite Module Browser combines interface data from Oracle

Integration Repository with information about the additional interfaces supported
by Oracle E-Business Suite Adapter, organized in a tree hierarchy.
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Note: The Oracle E-Business Suite Module Browser includes the
various product families that are available in Oracle E-Business
Suite. Each product family contains the individual products. Each
product contains the business entities associated with the product.
Business entities contain the various application modules that are
exposed for integration. These modules are grouped according to
the interface they provide. PL/SQL APIs can be found under the
PL/SQL category.

Navigate to Other Interfaces > Custom Objects >PLSQL APIs > OE_ORDER_PUB to
select a custom stored procedure GET G MISS LINE REC.

Note: The GET G MISS LINE REC (GET G MISS LINE REC)
stored procedure does not take any input but has a complex data
type (PL/SQL Table) as output. Oracle E-Business Suite Adapter
design-time automatically generates a wrapper stored procedure
and loads it on the underlying database.

Oracle E-Business Suite Adapter provides flexfield support for PL/SQL APIs. Once
the selected API is displayed in the module browser, you can either configure
flexfield mappings for the API that has flexfields defined in Oracle E-Business Suite
or use current data without further flexfield configuration.

Note: If a selected API has pre-configured flexfield mappings
available, a pop-up window appears allowing you to decide if you
want to use these pre-configured mappings. Click Yes to display
these mappings as part of the flexfield definitions in the Configure
Flexfields region. You can modify them later if needed.

Click No to indicate that you will not use these mappings and the
pop-up window disappears.
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Displaying Selected API in the Oracle E-Business Suite Module Browser

GO T ==
Obecttone:[ ] [Jmks [Juews [Ias [l [Jocateney [J0r [Jusnesstvens o
7 OF ORDER_PUB (OF_ORDER_PUB) Parameters with Corresponding Flexfield Mappings
e path Type Injout Flexfield Column Name Flexield Type Context Flexfied Name
ST |55 S et m
GET:DRDER (GET:DRDER) {5l ACCOUNTING_RULE_ID NUMBER ouT
64155 CLSTONER DFO Rec o = e
G_MISS_HEADER_AD]_ATT_REC ( a AGREEMEW o - = out
G_MISS_HEADER_AD]_VAL REC ( = UNE [D’ = out
e el Omiig o
G_MISS_HEADER_REC (G_MISS_H B ATRBUTEL ey Ioor
G_MISS_HEADER_SCREDIT_REC ( & ATTRIBUTELS ey T3 I
s Tty Otz &
e e AT g srmmress = o
o Gr || -3 e vece: o
e g || 3 ez vecue2 o
ine ety || O vecue2 o
Ve o i o ¢ e | |Confoure Prtes
G_MISS_LOT_SERIAL VAL REC (¢ | |Flexfield Definitions
G Miss_PATMENT_TYPES ReC (G | frype Appication Name Datatype Structure o Context
ID_TO_VALUE (ID_TO_VALUE)
ID_TO_VALUE (ID_TO_VALUE)
LOCK_ORDER {LOCK_ORDER)
LOCK_ORDER {LOCK_ORDER)
PROCESS_HEADER (PROCESS_HE: |
PROCESS LINE (PROCESS LINE) [ ][ nportfromie_J[_Addepmng |
PROCESS_MACD_ORDER (PROCE! |
PROCESS_ORDER (PROCESS_ORL
5. PROCESS ORDER (PROCESS. ORE (o] [ i

Configuring Flexfield Mapping Data for the Selected API

Perform either one of the following tasks in the Oracle E-Business Suite Module
Browser:

e Use the current data without further configuration by clicking OK to continue.
¢ Configure flexfield mapping data by either using an existing flexfield mapping
or creating a new mapping through a flexfield wizard if desired.
* Creating a New Mapping

You can create a new mapping for a selected API by clicking Add Mapping
in the Flexfield Metadata section. A new flexfield mapping wizard appears
guiding you through each configuration page where you can add key and
descriptive flexfields, as well as configure flexfield mapping between the
selected API parameters and flexfields defined in the Oracle E-Business
Suite instance. For more information on how to create a new mapping and
configure flexfields for PL/SQL APIs, see:

¢ Adding or Configuring a New Mapping, page 4-37
* Configuring Key Flexfield Mappings for a PL/SQL API, page 4-38

¢ Configuring Descriptive Flexfield Mappings for a PL/SQL API, page 4-
59

¢ Importing an Existing Mapping

Instead of creating a new mapping, you can use an existing mapping that
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has been created earlier by clicking Import from File in the Flexfield
Metadata section. This lets you select a desired flexfield mapping for your
selected API. Once a desired mapping is imported, you can modify the
context values for a descriptive flexfield, and modify structure for a key
flexfield if needed to meet your needs.

See: Importing an Existing Flexfield Mapping, page 4-115.

For more information on flexfield support for PL/SQL APIs and how to modify
existing mappings, see Flexfield Support for PL/SQL APIs and Open Interface
Tables, page 4-27.

In this example, click OK to continue.

Please note that the input and the output parameters of the Stored Procedure
contains complex data types that are not readily mapped to JDBC types. The
Adapter wizard provides a mechanism that detects when these types are used and
then invokes Oracle JPublisher to generate the necessary wrappers automatically.
Oracle JPublisher generates two SQL files, one to create schema objects, and another
to drop them. The SQL that creates the schema objects is automatically executed
from within the wizard to create the schema objects in the database schema before
the XSD is generated.

The Adapter Service points to the wrapper Stored Procedure instead of the Process
Order Line Stored Procedure. The Adapter design-time automatically loads the
wrapper procedure onto the underlying database.

In the Application Interface page, click Next.
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Application Interface Page

@) Adapter Configuration Wizard - Step 5 of 6 @
Application Interface !
.:"‘I
¥ou are connected to & post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tablesfviews or you can add a single APT/Concurrent Program XML Gateway Map/EDI Concurrent
Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors,
rOperation Objects
E | @ Delete |
Mame Type
GET_G_MISS_LINE_REC APL
A wrapper API will be created in a package, enter a package name.
[¥X_BPEL_initlineRec |
[] Overwrite spedfied wrapper package, if it exists
| Help | | < Back || Mext = _J Cancel |
[ 4

In the Finish page, click Finish to complete the partner link creation.

The wizard also generates the WSDL file corresponding to the XML schema. This
WSDL file is now available for the partner link.

To add the second partner link:
1. Click BPEL Services in the Component Palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.

Enter a service name in the Name field. For example, OrderManagement.
2. Click Next. The Service Connection dialog appears.

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle
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E-Business Suite is running.

* You can create a new database connection by clicking Create a New Database
Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 5-14.

* You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware User’s Guide for Technology Adapters.

Once you have completed creating a new connection for the service, you can add a
PL/SQL API by browsing through the list of APIs available in Oracle E-Business
Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:

* C(lick Yes to extract the Integration Repository data file.
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After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.

Using the Local Integration Repository Data File
ﬂ Cracle Applications Adapter Configuration Wizard - Step 3 of 4 ﬁ

Operation

Connected to R12 (or later) apps instance.

From R12 release onwards , iRep metadata is shipped with instance.

As such Apps Adapter Module browser would display iRep tree corresponding to
connected instance.

Using iRep data file corresponding to database sid20136 dated Mar 23, 2013 10:27:00 PM present at
C:\IDeveloper\mywork\Application 1\AppsAdapter_IrepData

IRep Data file
|veloperhﬂyworkhﬁ.pplicaﬁon 1\AppsAdapter_IrepDatalrep_data_sid20136_20130323_2227.dat Browse

Help < Back Mext = Cancel

¢ Click No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click Next in the Operation page to open the Oracle E-Business
Suite Module Browser.

5. Select a PL/SQL API. For example, select Process Order Line
(PROCESS_LINE) API from Product Families > Supply Chain Management
(SCM_PF)> Supply Chain Trading Connector(CLN) > Sales Order
(ONT_SALES_ORDER) > PLSQL > Process Order API(OE_ORDER_PUB) > Process
Order Line (PROCESS_LINE).

Note: Use the Search option to quickly find the required objects.
Enter the required database object name in the Object Name field
and select APIs. And then, click Search to retrieve the required
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database objects. When searching for a PL/SQL AP]I, enter the
package name, and not the procedure name. In contrast, when

using the DB Adapter Wizard, the user must enter the name of the
PL/SQL API while searching.

Selected API Displayed in the Oracle E-Business Suite Module Browser

© Oracle Applications Module Browser [E5
Object pame: | | [Tables [Jviews []aPIs []CP [ |¥MLGateway [ ]EPI [ |Business Events Browse
(55 OPM Product Development (GMD) Parameters with Corresponding Flexfield Mappings
&} Interet Procurement Enterprise Connector (ITG) Path Type InjOut  Segment Flexfield... Context Flexfield Name
- 58 Supply Chain Trading Connector (CLN) .. OE_ORDER_PUB.PROCESS _LINE PROCEDURE / FUNC...
(3 Payables Invoice (AP_INVOICE) 2, P_LINE_TEL PL/SQL TABLE ™
53 Recelvables Invoice (AR_INVOICE) - §,, P_LINE_TBLSLINE_TBL_TYPE PL/SQL RECORD N
(% Goods Receipt (PO_GOODS_RECEIPT) [l ACCOUNTING_RULE_ID NUMBER N
3 Purchase Order Change (PO_CHANGE) [E PARTY_TYPE VARCHAR2 )
- G3 Supply Chain Plan Sales Order (MSC_SALES_OF -] ACTUAL_ARRIVAL DATE DATE ™
(3 Supply Chain Plan Advanced Shipment Notice (! [l ACTUAL_SHIPMENT_DATE DATE ™
3 Purchase Order Adnowledgement (PO_ACKNG [ AGREEMENT_ID NUMBER )
- 3 Advanced Shipment Notification (PO_ADVANCE ] ARRIVAL_SET_ID NUMBER. ™
ﬁ Purchasing Blanket Release (PO_BLANKET _REL [E ATO_LINE_ID NUMBER. N
- (G Inventory On Hand Balance (INV_ONHAND) - ATIRBUTEL VARCHARZ N
ﬁ Sales Order (ONT_SALES_ORDER) [E ATTRIBUTE1D VARCHAR2 N
[ i Gatenay [E ATTRIBUTE11 VARCHAR2 w
fgeor ~[E ATTRIBUTE12 VARCHARZ N
[@rsaL [El ATTRIBUTEL3 VARCHAR2 ]
3 Process Order APT (CE_ORDER_PUE) [ ATTRIBUTE14 VARCHARZ ™
-8, Delete Order Line (DELETE_LINE) ~.d ATTRIBUTE15 VARCHAR2 N
£, Delete Order (DELETE_ORDER) [E ATTRIBUTE16 VARCHAR2 N
-8, Get Sales Order (GET_ORDER) -.E ATTRIBUTE1? VARCHAR2 N
&, 1D To Value (ID_TO_VALUE) [E ATTRIBUTE18 VARCHAR2 N
£, Lock Sales Order (LOCK_ORDER) [E ATTRIBUTE1S VARCHAR2 N
-8, Process Order Header (PROCESS_ -.[B ATTRIBUTE2 VARCHARZ N
s Order Line (PR [E ATTRIBUTEZ0 VARCHAR2 N
intain Sales Order (PROCES: --E ATTRIBUTE3 VARCHARZ ™
£, Update Order Header (UPDATE_Hi =
£, Update Order Line (UPDATE_LINE) | ['Configure Flexfields
By, Value To ID (VALUE_TO_ID)
) purchase Order exe | |Flexfiekd Definitions
3 Purchase Order Change Adnowledgme | [Type Application Name Datatype Structure or Context
- ship Conformation (OE_SHIP_CONFIR!
& sales Order Services (OE_INBOUND_IM
<[ Operinterfaces
[ CONCURRENT_PROGRAMS Flexfield Metadat
[ INTERFACE_VIEWS
- G3 Purchasing Catalog (PO_CATALOG) Import from File Add Mapping
(5 Standard Purchase Order (PO_STANDARD_PUF
(53 XML Gateway Confirmation Message (ECX_CON
(4 Cataloa Item (EGO ITEM) e Bemer

Please note that Oracle E-Business Suite Adapter provides flexfield support for
PL/SQL APIs. Once the selected API is displayed in the module browser, you can
either configure flexfield mappings for the API that has flexfields defined in Oracle
E-Business Suite or use current data without further flexfield configuration.

Configuring Flexfield Mapping Data for the Selected API

Perform either one of the following tasks in the Oracle E-Business Suite Module
Browser:

* Use the current data without flexfield mapping configuration by clicking OK to
continue.

* Configure flexfield mapping data by either using an existing flexfield mapping
or creating a new mapping through a flexfield wizard if desired.

Creating a New Mapping

You can create a new mapping for a selected API by clicking Add Mapping in
the Flexfield Metadata section. A new flexfield mapping wizard appears
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guiding you through each configuration page where you can add key and
descriptive flexfields, as well as configure flexfield mapping between the
selected API parameters and flexfields defined in the Oracle E-Business Suite
instance. For more information on how to create a new mapping for PL/SQL
APIs, see:

e Adding or Configuring a New Mapping, page 4-37
¢ Configuring Key Flexfield Mappings for a PL/SQL API, page 4-38
¢ Configuring Descriptive Flexfield Mappings for a PL/SQL API, page 4-59

For more information on flexfield support for PL/SQL APIs and how to modify
existing mapping configuration, see Flexfield Support for PL/SQL APIs and
Open Interface Tables, page 4-27.

6. In this example, click OK to continue.

Please note that the input and the output parameters of the Stored Procedure
contains complex data types that are not readily mapped to JDBC types. The
Adapter wizard provides a mechanism that detects when these types are used and
then invokes Oracle JPublisher to generate the necessary wrappers automatically.
Oracle JPublisher generates two SQL files, one to create schema objects, and another
to drop them. The SQL that creates the schema objects is automatically executed
from within the wizard to create the schema objects in the database schema before
the XSD is generated.

The Adapter Service points to the wrapper Stored Procedure instead of the Process
Order Line Stored Procedure. The Adapter design-time automatically loads the
wrapper procedure onto the underlying database.

7. In the Application Interface page, click Next.
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Adapter Configuration Wizard - Application Interface Page

' B
@) Oracle Applications Adapter Cenfiguration Wizard - Step 4 of 5 @
Application Interface
_-_.'-"/I
‘You are connected to a post 11.5. 10 instance. Add the database objects needed for this service. You may add
one or more tablesviews or you can add a single API/Concurrent Program /XML Gateway Map/EDI Concurrent
Program Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors,
rOperation Objects
@ Delete
Mame Type
PROCESS_LINE APT
A wrapper API will be created in a package, enter a package name.
|>(>{_BPEL_DrderManagement
[] Overwrite specified wrapper package, if it exists
Help < Back Mext = Cancel

8. In the Finish page, click Finish to complete the process of configuring a partner link
for an application service.

The wizard generates the WSDL file corresponding to the XML schema. This WSDL
file is now available for the partner link.

Adding a Partner Link for File Adapter

Use this step to configure a BPEL process by synchronously reading an existing
purchase order to obtain the order details.

To add a Partner Link for File Adapter to read order details:

1. In Oracle JDeveloper BPEL Designer, click BPEL Services in the Component
Palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane of the process diagram. The File Adapter Reference page appears.

Enter a name for the file adapter service, such as getOrderDetails.
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2. Click Next. The Adapter Interface page appears.

Specifying the Adapter Interface
r R
@) FILE Adapter Configuration Wizard - Step 2 of 4 ﬁ

Adapter Interface

The adapter interface is defined by a wsdl that is generated using the operation name and schema(s) spedfied later
in this wizard. Cptionally, the adapter interface may be defined by importing an existing WsOL.

Interface: @ Define from operation and schema (spedfied later)

() Import an existing WSDL

@

Help < Back MNext =

Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.
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Specifying File Server JNDI Name

P
@) FILE Adapter Configuration Wizard - Step 3 of 4 g
File Server Connection
Specify the JNDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter
must assodate this INDI name with a set of configuration properties needed by the File Adapter to access the File
Server at runtime,
File Server JMDI Mame |Ei5,|'Fi|EAda|:ltEr| | Ck
Help < Back Next = Finish Cancel

In the Operation page, specify the operation type. For example, select the

Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation

-
ﬁ FILE Adapter Configuration Wizard - Step 4 of 8 ﬁ

Operation

g

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in spedfied locations, and & Chunked Read operation that
synchronously reads file data in chunks and can be used OMNLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: (7) Read File
() Write File
(2) Synchronous Read File
() List Files

() Chunked Read

Operation Name: |SynchRead

[ | Read File As Attachment

Help < Back | MNext = . Cancel

Click Next to access the File Directories page.

4. Select the Logical Name radio button and specify directory for incoming files, such
as inputDir.

Ensure the Delete files after successful retrieval check box is not selected.
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Configuring the Input File
FILE Adapter Configuration Wizard - Step 5 of 8 (o
p g P

File Directories

Enter directory information for the incoming file of the Synchronous Read File operation.

Directory names are specified as: () physical Path (3) Logical Name

Directory for Incoming Files (Jogical name): |ir1|:|utDir|

[] Archive processed files
Archive Directory for Processed Files (Jogical name):

Help < Back Mext = Cancel

Click Next to open the File Name page.

Enter the name of the file for the synchronous read file operation. For example,
enter changeorder data.xml. Click Next to open the Messages page.

Select the 'browse for schema file' icon on the top right corner to open the Type
Chooser window.

Click Type Explorer and select Project WSDL Files > OrderManagement.wsdl > Inline
Schemas > schema > InputParameters.

Note: If the selected APl is configured with flexfields, select the
flexfield schema (<servicename> sp.xsd) instead from the
Type Chooser.

For example, SynAccOrder partner link service is created with
descriptive flexfields. Select Project Schema Files >
SynAccOrder_sp.xsd > SynAccOrder_flex.xsd > InputParameters.
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P B
=3 Type Chooser : Fﬂ;

Q§ Type Explorer
BE Project Schema Files
: % BPELProcess1.xsd
ﬁ SynaccOrder_Flew, xsd
E\‘% SynaccOrder_sp.xsd
ﬁ SynaccOrder_Flew, xsd
4
: .4® DutputParameters
-7 Project WSOL Files

Type: |{htt|:|:,|',|fxmlns.orade.mmfpcbpelfada|:|terfdbfspISynAccOrder}Inpuﬂi‘arameters |
[] Show Detailed Mode Information

o (o]

Click OK. The selected SynAccOrder sp.xsd schema is
displayed as URL and InputParameters is displayed as Schema
Element.

For more information on flexfield support for PL/SQL APIs and
how to modify existing configuration, see Flexfield Support for
PL/SQL APIs, page 4-27.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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Specifying Message Schema
ﬂ FILE Adapter Configuration Wizard - Step 7 of 8 [ﬂ

Messages
o T

Define the message for the Synchronous Read File operation. Specify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you check 'Schema is Opaque’, then you do not need to specify a Schema.

Message Schema

[ Mative format translation is not required (Schema is Opaque)

URL | .ISd1emastrderManagement.xsd| | Ck id

Schema Element |In|:lutParamebers v|

Help < Back Cancel

7. Click Next and then Finish. The wizard generates the WSDL file corresponding to
the partner link. The main Create Partner Link dialog box appears, specifying the
new WSDL file getOrderDetails.wsdl.

The getOrderDetails Partner Link appears in the BPEL process diagram.

Defining Wrapper APIs

The Adapter Configuration wizard generates a wrapper API when a PL/SQL API has
arguments of data types, such as PL/SQL Boolean, PL/SQL Table, or PL/SQL Record.
For generating the wrapper API, Oracle JPublisher is automatically invoked in the
background. When a wrapper APl is created, besides the WSDL and XSD files, two SQL
files are created: one for creating the wrapper API, and necessary datatypes and another
for deleting it. The two SQL files are saved in the same directory where the WSDL and
XSD files are stored, and are available in the Project view.

Following is a sample code of a PL/SQL API that would require a wrapper to be
generated:
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package pkg is
type rec is record (...);
type tbl is table of .. index by ..;
procedure proc(r rec, t tbl, b boolean);
end;

If the preceding PL/SQL APl is selected in the wizard, then a wrapper API will be
created, and loaded into the database. This wrapper API will be used instead of the
originally selected PL/SQL API. For this reason, the content of the WSDL and XSD files
represent the wrapper procedure, not the procedure originally selected.

The following are the types that will be created for the wrapper API:
*  Object type for PL/SQL RECORD

* Nested table of the given type for PL/SQL TABLE. For example, the nested table of
NUMBER.

e INTEGER substituted for PL/SQL BOOLEAN

The generated SQL file that creates the wrapper API also creates the required schema
objects. The types of the wrapper API's parameters will be those of the new schema
object types. The wrapper package will contain conversion APIs to convert between the
base PL/SQL type and the new schema object types.

Note: The SQLJUTL package contains the BOOL2INT and INT2BOOL
conversion functions used for PL/SQL BOOLEAN arguments whose
data types have been changed to INTEGER.

The wrapper APl is created in a package. This package is named XX_BPEL_servicename.
servicename is the name of the service that you entered in Step 2 of Adding a Partner
Link, page 9-9. If this package already exists, then the wizard prompts for a different
package name, or to select a checkbox, to overwrite the existing package. Overwriting
an existing package causes all PL/SQL APIs in the specified package to be lost. When
the wizard creates a package for the wrapper, only one AP], that is, the wrapper AP, is
contained in it.

Note: Despite specifying to overwrite an existing package, if the
wrapper API already exists in the specified package, the wizard will
not re-create the wrapper AP], as it would take some time. This means
no SQL files will be created, Oracle JPublisher will not be run, and the
WSDL and XSD files will be for the existing wrapper APIL. The Finish
page of the wizard will indicate that these actions will take place, but it
is possible that they will not, depending on whether the wrapper
already exists.
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Entering a Package Name for the Wrapper API
r ™
-ﬂ Oracle Applications Adapter Configuration Wizard - Step 4 of 5 ﬁ

Application Interface :
‘fou are connected to a post 11.5. 10 instance. Add the database objects needed for this service, You may add
one or more tablesfviews or you can add a single API/Concurrent Program XML Gateway Map/EDI Concurrent

Program,Business Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.

rOperation Objects

@ Delete

Mame Type
PROCESS_LINE API

A wrapper APT will be created in a package, enter a package name.
[¥X_BPEL_APIN
[] overwrite specified wrapper package, if it exists

Help < Back Next = Cancel

Note: The package name for the wrapper has a limit of 30 characters,
and the wrapper API name has a limit of 29 characters. Thus, if the
package name or the wrapper API name is longer than the maximum
limit, it will be truncated accordingly.

The name of the wrapper API depends on whether the PL/SQL API that was originally
selected is in a package or not. If the original PL/SQL API is a root-level AP], that is, it
does not belong in a package, then the name of the wrapper API will be, TOPLEVEL$
original_api_name. If the originally selected PL/SQL APl is in a package, then the name
of the wrapper API will be original_package_name$original_api_name.

Wrapper APIs follow the naming convention of Oracle JPublisher. For example, if the
original PL/SQL API was called CREATE _EMPLOYEE and was a root-level AP, then the
wrapper API would be named TOPLEVEL$CREATE EMPLOYEE. If the original PL/SQL
APl is in a package called EMPLOYEE, then the wrapper API would be named
EMPLOYEESCREATE EMPLOYEE.

The Finish page of the wizard is different when a wrapper API needs to be created. The
Finish page informs you that a wrapper APl is needed, and in addition, lists the name
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of the wrapper package, wrapper API, and the SQL files that will be created.

Note: When a wrapper API needs to be created, it may take a while
before the wizard completes. However, the processing time for
subsequent PL/SQL APlIs in the same package would be much shorter.

The Finish Page
@) Oracle Applications Adapter Configuration Wizard - Step 5 of 3 ﬁ

Finish
ﬁ-—_

You have finished defining Oracle Application Adapter Service : API

When you dick Finish, the wizard will create the C:\IDeveloperymywork)\12c\FlexfieldkFF\API. wsdl file in your project
directory . An X5D file, C:\Developer\mywork\12c\FlexfieldkFF\Schemas fAPI_sp.xsd, which contains the schema
for the procedures arguments, will also be created.

The gelected procedure reguires that a wrapper procedure be created because it has one or moere argument(s) of
type: PL/SQL Boolean, PL/SGAL Recerd, or PLYSQL Table. SQL files will be created in vour project directory. I may
take a while to create the wrapper procedure.

Wrapper Procedure: OE_ORDER_PUBSPROCESS LINE
Wrapper Package: X¥_BPEL_APIN

Schema: APPS

5QL Files: X¥_BPEL_APIN sql

3_BPEL_APIN_drop.sql

Help < Back Einish Cancel

Note: The REF CURSOR type is not supported out of the box. However,
for detailed steps to generate an adapter service for a PL/SQL API
which takes REF CURSOR type, see the section "Support for REF
CURSOR" in Oracle BPEL Process Manager Developer’s Guide on OTN.

Overloaded APIs are not supported in release 11.5.10.

Declaring Parameters with a DEFAULT Clause

You can declare parameters of a stored procedure with a DEFAULT clause, so that
when you invoke the procedure without that parameter, BPEL Process Manager will
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supply a default value for that parameter. For example:

PROCEDURE addEmployee (name VARCHARZ2, country VARCHAR2 DEFAULT 'US')
This procedure can be invoked in the following two ways:

® addEmployee ('John Smith') // country => 'US'

® addEmployee ('John Smith', 'France') // country => 'France'

Omitting Parameters With a DEFAULT Clause

You can omit elements for parameters with default values in the instance XML. The
procedure will be invoked without these parameters, allowing their default values to be
used, as shown in the following example of input and runtime invocation.

Input

<db:InputParameters xmlns:db="..">

<name>John Smith</name>
</db:InputParameters>

Runtime Invocation
BEGIN addEmployee (name=>?); END; // country => 'US'

If the input includes a value for the defaulted parameter, the value in the input will be
used, rather than the default, as follows:
Input
<db:InputParameters xmlns:db="..">
<name>John Smith</name>

<country>France</country>
</db:InputParameters>

Runtime Invocation

BEGIN addEmployee (name=>?, country=>?); END; // country => 'France'
Omitting Parameters Without a DEFAULT Clause

The element in the XSD for parameters with a default clause is annotated with a special
tag to indicate that the parameter has a default clause, as shown in the following
example.

<element name="country" .. db:default="true" ../>

This new functionality allows elements for parameters without a default clause also to
be omitted in the instance XML. In these cases, the parameter is still included in the
invocation of the stored procedure. A value of NULL is bound by default. Following is
an example of a declaration where neither parameter has a DEFAULT clause:

PROCEDURE addEmployee (name VARCHAR2, country VARCHAR2)

In BPEL Process Manager release 10.1.2, elements for both parameters were required in
the instance XML. If an element was omitted, it was presumed to have a DEFAULT
clause, so the parameter was not included in the invocation of the procedure. In this
case, the missing parameter resulted in a PL/SQL error stating that an incorrect number
of arguments was passed to the procedure.

In the current BPEL Process Manager release, the missing parameter will be included in
the invocation of the procedure. A NULL value will be bound, as shown in the following
example:
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Input

<db:InputParameters xmlns:db="..">
<name>John Smith</name>

</db:InputParameters>

Runtime Invocation
BEGIN addEmployee (name =>?, country=>?); END; // country => NULL

Even though the element for country was not provided in the instance XML, it still
appears in the call to the procedure. In this case, country will be NULL.

DEFAULT Clause Handling in Wrapper Procedures:

If a procedure contains a special type requiring a wrapper to be generated, the
default clauses on any of the original parameters will not be carried over to the
wrapper, as shown in the following example:

PROCEDURE needsWrapper (isTrue BOOLEAN, value NUMBER DEFAULT O0)

Assuming that the procedure in the preceding example was defined at the top level,
outside of a package, the generated wrapper will appear, as shown in the following
example:

TOPLEVELSNEEDSWRAPPER (isTrue INTEGER, value NUMBER)

In the preceding example, the BOOLEAN type has been replaced by INTEGER. The
default clause on the value parameter is missing. In the current release, parameters of
generated wrapper procedures will never have a default clause, even if these
parameters did in the original procedure. If the element is missing in the instance XML,
instead of defaulting to 0, then the value of the parameter will be NULL, as shown in the
following example:

Input

<db:InputParameters xmlns:db="..">

<isTrue>1</isTrue>
</db:InputParameters>

Runtime Invocation
BEGIN TOPLEVELSNEEDSWRAPPER (isTrue =>?, value =>?); END; // value =>
NULL

To fix this, you can edit the generated SQL file, restoring the default clauses. You
should then, run the SQL file to reload the wrapper definitions into the database
schema. In addition, you should modify the generated XSD.

Following are the steps to fix the default clause with the wrapper generated for
needsWrapper ():

1. Change the signature in the following manner in the generated wrapper SQL file,
from:

TOPLEVELSNEEDSWRAPPER (isTrue INTEGER, value NUMBER)

To:

TOPLEVELSNEEDSWRAPPER (isTrue INTEGER, value NUMBER DEFAULT O0)

2. Reload the modified wrapper SQL file mentioned in the preceding example into the
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appropriate database schema. For BOOLEAN parameters with DEFAULT clause,
you need to map as follows:

DEFAULT TRUE (base) to DEFAULT 1 (wrapper)
DEFAULT FALSE (base) to DEFAULT 0 (wrapper)

For example, if the base stored procedure is PROCEDURE needsWrapper (isTrue
BOOLEAN TRUE, value NUMBER DEFAULT 0), then the generated wrapper
would be TOPLEVELSNEEDSWRAPPER (isTrue INTEGER, value NUMBER).

You should manually fix the store procedure to be TOPLEVELSNEEDSWRAPPER
(isTrue INTEGER DEFAULT 1, value NUMBER DEFAULT O0)

If a parameter has a default clause, then its corresponding element in the XSD must
have an extra attribute, db:default="true". For example, if a parameter has a
default clause TOPLEVEL$SNEEDSWRAPPER (1sTrue INTEGER DEFAULT 1,
value NUMBER DEFAULT 0), then the elements in the XSD for isTrue and
value need to have the following new attributes:

<element name="ISTRUE" ... db:default="true" .../>
<element name="VALUE" ... db:default="true" .../>

Configuring the Invoke Activities

This step is to configure three Invoke activities:

1.

To get the order details that is received from the Receive activity by invoking the
getOrderDetails partner link in an XML file.

To initialize the existing purchase order by invoking initLineRec partner link.

To update the purchase order quantity information to Oracle E-Business Suite by
invoking OrderManagement partner link.

To add the first Invoke activity for a partner link to get order details:

1.

In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the first Invoke activity from the Web Service
section into the center swim lane of the process diagram, between the receivelnput
and callbackClient activities.

Link the Invoke activity to the getOrderDetails service. The Edit Invoke dialog
appears.

Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.
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5. In the Output tab, ensure the Output Variable radio button is selected. Click the
Create icon next to the Output Variable field to create a new variable. The Create
Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.

Click Apply and then OK in the Edit Invoke dialog to finish configuring the Invoke
activity.

The Invoke activity appears in the process diagram.
To add the second Invoke activity for a partner link to initialize the existing purchase
order:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the second Invoke activity from the Web
Service section into the center swim lane of the process diagram, between the first
Invoke and callbackClient activities.

2. Link the Invoke activity to the initLineRec service. The Edit Invoke dialog box
appears.

3. Repeat Step 3 to Step 5 described in the first Invoke activity procedure to complete
the second Invoke activity.

To add the third Invoke activity for a partner link to update the order quantity
information to Oracle E-Business Suite:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the third Invoke activity from the Web Service
section into the center swim lane of the process diagram, between the second
Invoke and callbackClient activities.

2. Link the Invoke activity to the OrderManagement service. The Edit Invoke dialog
box appears.

3. Repeat Step 3 to Step 5 described in the first Invoke activity procedure.

4. Setting Header Properties for Applications Context

Use the following steps to set the header message properties required to pass
applications context required to complete the BPEL process:

1. Select the Properties tab in the Edit Invoke dialog box.
2. Click the Create icon. The To Property dialog appears.

3. Select the jca.apps.Username property from the Name drop-down list.
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4. Select the Expression radio button and enter ' OPERATIONS' as the property

value.

Click OK.

5. Repeat Step 2 to Step 4 to assign 'Order Management Super User,

Vision Operations

5. Click Apply and then OK to complete the Invoke activity.

Configuring a Transform Activity

The Transform activity can be used to configure the parameters for the input and
output variables. The Transform activity can also be used if variable values need to be
transformed before updating them in Oracle E-Business Suite.

(Usa) ' for jca.apps.Responsibility.
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To configure a Transform activity:

Before add a Transform activity, use the following steps to add variables:

1.

From the structure panel, select ChangeOrderAPI.bpel > Variables > Process >
Variables folder. Right click on Variables folder and select Create Variable from the
drop-down menu.

In the Create Variable dialog, enter temp miss line in the variable Name field.
Select the Message Type radio button and click the Browse Message Type icon to

open the Type Chooser.

Select args_in msg from Message Types > Project WSDL Files >
OrderManagement.wsdl > Message Types. Click OK to close the Type Chooser.

The selected information will be populated in the Message Type field in the Create
Variable dialog.

Use the following step to configure the Transform activity:

1.

In Oracle JDeveloper BPEL Designer, expand the Oracle Extensions from the
Component Palette. Drag and drop Transform from the Transform section into
center swim lane of the process map window. The Transform activity should be
placed in between the second and thirdInvoke activities.

This Transform activity is used to set the output of initLineRec service to the
input of the OrderManagement service.
Double-click Transform in the process map to open the Transform dialog. The

Transformation tab is selected by default.

Click the General tab to name this Transform activity as set Miss_ Line.

In the Transformation tab, click the Create icon to open the Source Variable dialog.

Select the Invoke initLineRec OutputVariable from the Source Variable
drop-down list, and select OutputParameters element as the Source Part value.

Click OK.

Select the Invoke OrderManagement InputVariable from the Target
Variable drop-down list. The Target Part value of the variable is also selected.

Click the Create icon next to the Mapper File field to create a new transformation
mapping file. Mapper File specifies the file in which you create the mappings using
the XSLT Mapper Transformation tool.

The transformation mapping file appears. The Design view appears by default.

You can define the parameter values in the Design view. Drag a string function to
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the Design area. Connect the function to the appropriate parameter for which you
want to define a value.

For example, link db:OE_ORDER PUB-24GET G MISS LINE from the source
variable to db:P_LINE TBL ITEM as the target variable.

Note: You can use an input parameter value from the source
variable, transform it using a string function, and use it as the input
parameter value for the target variable.

8. Click OK to create the mapping from source variable to target variable.

Configuring an Assign Activity

Use the Assign activity to pass the output of getOrderDetails service and
initLineRec service as an input to the OrderManagement service.

To add an Assign activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Assign activity from the Basic Activities
section into the center swim lane of the process diagram right after the Transform
activity that you just created earlier.

2. Double-click the Assign activity to access the Edit Assign dialog.
Click the General tab to enter a name for the Assign activity. For example,
setOrderChanges.

3. Select the Copy Rules tab and expand the target trees:
¢ In the From navigation tree, navigate to Variable > Process > Variables >

Temp_miss_line >Input Parameters and select ns4:P_LINE_TBL.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_OrderManagement_InputVariable > Input Parameters and select
ns4:P_LINE_TBL.

* (lick OK. The Edit Assign dialog box appears.
Drag the source node (ns4:P_LINE_TBL) to connect to the target node
(ns4:P_LINE_TBL) that you just specified. This creates a line that connects the

source and target nodes. The copy rule is displayed in the From and To sections at
the bottom of the Edit Assign dialog box.
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4. Enter the second pair of parameters:

® C(lick the Expression icon to invoke the Expression Builder dialog.
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Enter 'UPDATE' in the Expression box. Click OK. The Expression icon with the
expression value ("UPDATE') appears in the center of the Edit Assign dialog,
between the From and To navigation tree nodes.

In the To navigation tree, navigate to Variable > Process > Variables >

Invoke_OrderManagement_InputVariable > Input Parameters > P_LINE_TBL
>P_LINE_TBL_ITEM and select ns4:OPERATION.

Drag the Expression icon to connect to the target node (ns4:OPERATION) that you
just identified. This creates a line that connects the source and target nodes. The
copy rule is displayed in the From and To sections at the bottom of the Edit Assign

dialog box.
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5. Enter the third pair of parameters:

¢ (lick the Expression icon to invoke the Expression Builder dialog. Enter
'Update Order Quantity' in the Expression box. Click OK. The Expression icon
with the expression value ('Update Order Quantity') appears in the center of the
Edit Assign dialog, between the From and To navigation tree nodes.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_OrderManagement_InputVariable > P_LINE_TBL >
P_LINE_TBL_ITEM and select ns4:CHANGE_REASON.

Drag the Expression icon to connect to the target node (ns4:CHANGE_REASON)
that you just identified. This creates a line that connects the source and target nodes.
The copy rule is displayed in the From and To sections at the bottom of the Edit
Assign dialog box.

6. Enter the fourth pair of parameters:

® In the From navigation tree, navigate to Variable > Process > Variables >
Invoke_SyncRead_OutputVariable>Input Parameters > P_LINE_TBL
>P_LINE_TBL_ITEM and select ns4:LINE_ID.

¢ Inthe To navigation tree, navigate to Variable > Process > Variables >
Invoke_OrderManagement_InputVariable > P_LINE_TBL >
P_LINE_TBL_ITEM and select ns4:LINE_ID.

Drag the source node (ns4:LINE_ID) to connect to the target node (ns4:LINE_ID)
that you just specified. This creates a line that connects the source and target nodes.
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The copy rule is displayed in the From and To sections at the bottom of the Edit
Assign dialog box.

7. Enter the fifth pair of parameters:

¢ In the From navigation tree, navigate to Variable > Process > Variables >
Invoke_SyncRead_OutputVariable>Input Parameters > P_LINE_TBL
>P_LINE_TBL_ITEM and select ns4:ORDERED_QUANTITY.

* In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_OrderManagement_InputVariable > P_LINE_TBL >
P_LINE_TBL_ITEM and select ns4:ORDERED_QUANTITY.

Drag the source node (ns4:ORDERED_QUANTITY) to connect to the target node
(nns4:ORDERED_QUANTITY) that you just specified. This creates a line that
connects the source and target nodes. The copy rule is displayed in the From and To
sections at the bottom of the Edit Assign dialog box.

8. Click Apply and then OK to complete the configuration of the Assign activity.

Run-Time Tasks for PL/SQL APIs

After designing the SOA Composite application with BPEL process, the next step is to
deploy, run and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 9-39

2. Test the deployed SOA Composite application with BPEL process, page 9-42

Deploying the SOA Composite Application with BPEL Process

To invoke the services from the BPEL client contained in the SOA composite, the SOA
composite needs to be deployed to the Oracle WebLogic managed server. This can be
achieved using Oracle JDeveloper. Once the composite is deployed, it can be tested
from the Oracle Enterprise Manager Fusion Middleware Control Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 11-1 and Creating an Application Server Connection, page 11-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
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JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications window.

2. Right-click the project name, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy > ChangeOrderAPI> soa-serverl to deploy the
process if you have the connection set up appropriately.

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

* New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

* Overwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from

JDeveloper are covered in Creating an Application Server
Connection, page 11-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.
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4. In the SOA Servers page, accept the default target SOA Server ('soa-serverl’)
selection.
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SOA Servers
Choose the target S0A server(s) and correspanding partitions to which you want to deploy
/I\ this archive.
AT SOA Server: Partition: Status: Server URL:
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I
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|
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Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

5. Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window as well as in the Deployment - Log
window.

Testing the Deployed SOA Composite Application with BPEL Process

Once the BPEL process contained in a SOA Composite application is deployed, you can
manage and monitor the process from the Oracle Enterprise Manager Fusion
Middleware Control Console. You can also test the process and the integration interface
by manually initiating the process.

To test the deployed SOA Composite application with BPEL process:

1. Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
http://<servername>:<portnumber>/em). The composite you deployed is
displayed in the Applications Navigation tree.
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Enter username (such as weblogic) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_serverl)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA Composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA Composite application that you want to initiate (such as
'ChangeOrderAPI') from the SOA Infrastructure.

Click Test at the top of the page.
The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate
the process.
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The test results appear in the Response tab upon completion.

5. Click Launch Flow Trace in the Test Web Service page. The Flow Trace page is
displayed.

In the Trace section, you should find the sequence of the message flow for the
service binding component (changeorderapi client ep), BPEL component (
ChangeOrderAPI), and reference binding components (getOrderDetails,
initLineRec, and OrderManagement). All involved components have
successfully received and processed messages.
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Click your BPEL service component instance link (such as ChangeOrderAPTI) to
display the Instances page where you can view execution details for the BPEL
activities in the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

Validating Records Using SQL

To confirm that the records have been written into the Oracle E-Business Suite

applications, you can write SQL select 1l.ordered quantity from
oe order lines all 1,oe order headers all h where
h.orig sys document ref='<ORDER ID> and

h.header id=1.header id; statements and fetch the results showing the
ordered quantity should be the same as the value provided in the
changeorder data.xml document.

Verifying Records in Oracle E-Business Suite

Alternatively, you can go to the specific module in Oracle E-Business Suite with
Oracle Management Super User, Vision Operation (USA) responsibility.

To validate it in Oracle Order Management:

1. Log on to the Forms-based Oracle E-Business Suite applications with the Order
Management, Super User responsibility.

2. Select Order Returns > Sales Order. Sales Order Forms would open up.

3. Search for an order by entering the order number in the Customer PO field.
This would bring up the details of a newly created order.

4. Select the Line Items tab to check the quantity of the order. It should be the
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same as it is set in changeorder data.xml file.

Troubleshooting

If you experience problems with your PL/SQL API integration, you can take the
following troubleshooting steps:

e If you designed your PL/SQL API integration in one instance of your Oracle
E-Business Suite environment, and plan to run it in another instance, be sure to
rerun the SQL scripts in the second instance to create the necessary PL/SQL
wrappers.

e Ensure that the JNDI location in weblogic-ra.xml is properly configured.

Enable logging for Adapter to see if the issue is on the middleware side. For
information on how to enable logging, see Enabling Logging for Adapters, page 4-125.
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Using e-Commerce Gateway

This chapter covers the following topics:

¢ Opverview of e-Commerce Gateway Integration

¢ Design-Time Tasks for e-Commerce Gateway

* Creating a New SOA Composite Application with BPEL Process
e Adding a Partner Link

* Adding a Partner Link for File Adapter

¢ Configuring Invoke Activities

* Configuring an Assign Activity

® Run-Time Tasks for e-Commerce Gateway

* Deploying the SOA Composite Application with BPEL Process
® Testing the Deployed SOA Composite Application with BPEL Process

¢ Verifying Records in Oracle E-Business Suite

Overview of e-Commerce Gateway Integration

Oracle e-Commerce Gateway provides a common, standards-based approach for
Electronic Data Interchange (EDI) integration between Oracle E-Business Suite and
third party applications. EDI is the computer to computer exchange of business
documents in a standard format. The EDI format is commonly used for e-commerce
transactions between businesses.

Oracle e-Commerce Gateway is the EDI integration enabler for Oracle E-Business Suite.
It provides a single integration framework for you to conduct e-business using EDI
standards with everyone in your global supply chain. Oracle e-Commerce Gateway
provides an application integration infrastructure that is flexible enough to
accommodate the integration requirements of any and all applications that must
integrate with Oracle E-Business Suite. This allows for seamless flow of information in
an ever expanding trading partner base.
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Oracle e-Commerce Gateway includes prebuilt transactions of key business documents
that can be implemented simply by defining a trading partner and enabling the
transaction in test or production mode. You can implement a single transaction, a group
of transactions, or a business flow. You can implement the prebuilt transactions as is or
configure them to meet your specific industry needs.

Oracle e-Commerce Gateway uses a metadata driven approach to dynamically generate
outbound and consume inbound flat files based on user defined trading partner,
mapping, transformation, and data validation rules. You can change a rule by changing
the metadata stored in the repository. The updated rule takes effect at run-time without
any code modifications.

Note: For detailed information about Oracle e-Commerce Gateway, see
Oracle e-Commerce Gateway User’s Guide. This guide is part of the Oracle
E-Business Suite Documentation Library which can be accessed on the
Oracle Technology Network (OTN).

Oracle E-Business Suite Adapter can be configured to use e-Commerce Gateway to
interact with third party applications. e-Commerce Gateway, like XML Gateway, is
primarily used for Business-to-Business (B2B) integration. While XML transactions are
mostly based on a single transaction and are event based, EDI transactions are more
batch oriented.

Design-Time Tasks for e-Commerce Gateway

Oracle E-Business Suite Adapter is deployed using the BPEL Process Manager (PM) in
Oracle JDeveloper. The BPEL PM creates the WSDL interfaces for the e-Commerce
Gateway.

This section describes the tasks to configure Oracle E-Business Suite Adapter to use
e-Commerce Gateway in Oracle JDeveloper.

SOA Composite Application with BPEL Process Scenario

This example uses IN: Ship Notice/Manifest (ECASNI) EDI concurrent program
exposed as a Web service to support the inbound Ship Notice/Manifest transaction.

When a shipment request is received, the shipping details will be retrieved and then
imported to the Purchasing system to create an electronic shipment notice as a
pre-receipt.

When the SOA Composite application with BPEL process has been successfully
executed after deployment, you should be able to validate if the shipment notice has
been inserted in Oracle E-Business Suite with the same shipment identifier number.

Prerequisites to Configure e-Commerce Gateway
Populating Applications Context Header Variables

You need to populate certain variables in the BPEL PM in order to provide context
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information for Oracle E-Business Suite. The context information is required for an EDI
transaction in order for an Oracle E-Business Suite user that has sufficient privileges to
run the program.

The context is set taking into account the values passed for the header properties
including Username, Responsibility, Responsibility Application, Security Group, and NLS
Language. If the values for the new header properties Responsibility Application, Security
Group, and NLS Language are not passed, context information will be determined based
on Username and Responsibility.

The default Username is SYSADMIN, the default Responsibility is SYSTEM
ADMINISTRATOR, the default Security Group Key is Standard, and the default NLS
Language is US.

You can change the default values specified in the generated WSDL. This is a static way
of changing the context information. These values would apply to all invocations of the
deployed business process. However, if you need to provide different context
information for different invocations of the business process, then you can dynamically
populate the header values. The context information can be specified by configuring an
Invoke activity.

For more information about applications context, see Supporting for Normalized
Message Properties, page 4-7.

Based on the scenario described earlier, the following design-time tasks are discussed in
this chapter.

1. Create a new SOA Composite application with BPEL process, page 10-3
2. Add a partner link, page 10-9

3. Add a partner link for File Adapter, page 10-14

4. Configure Invoke activities, page 10-20

5. Configure an Assign activity, page 10-25

Creating a New SOA Composite Application with BPEL Process

The first configuration task is to create a new SOA Composite application with BPEL
process.

To create a new SOA Composite application with BPEL process:
1. Launch Oracle JDeveloper.

2. Click New Application in the Application Navigator.
The New Gallery page appears. Select SOA Application from the Items list.
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The New Gallery Page

[=+-Business Tier

----- ADF Business Components

----- Business Rules

----- Contexts and Dependency Injecti

O New Gallery Iﬂ
Q
Categories: Items: ["] Show All Descriptions
----- Applications — o
_____ Connections ADF Java Desktop Application
""" Deployment Descriptors [4] application from EAR File
----- Deployment Profiles
..... Diagrams ?‘ Application Template
""" ) Custom Application
----- Maven
..... Projects Database Application
----- Service Constructor —
Extension Application
..... UML
""" XML Java EE Web Application

QEP Application

Service Bus Application

..... Data Controls Service Bus Application With Service Bus Project
----- EIB =
S0A Applicatiol
----- Enterprise Scheduler Metadata ppiication
_____ Security Creates a SOA (service-oriented architecture} application. The application
) conzistz of one SOA project for the SOA composite, components, and adapters.
----- TopLink/JPA
e UML Application

Help oK Cancel
L
Click OK.

3. Click New Application in the Application Navigator.

The Create SOA Application - Name your application page is displayed.
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The Create SOA Application - Name your application Page
r*ﬂ Create SOA Application - Step 1 of 3

Name your application

= - Application Name:

'T' Application Name |Insert5hi|:iNoﬁce—Ap1:| |

Project Name

)T\ Directory:

s Project SOA Setfings |C:UDeveIoperhﬂywork‘l,lZcHnsertShipI‘doﬁce—ﬁpp Browse. ..

Application Package Prefix:
Help ' MNext = ' Einish Cancel

Enter an appropriate name for the application in the Application Name field.

Click Next. The Create SOA Application - Name your project page is displayed.

Enter an appropriate name for the project in the Project Name field. For example,
InsertShipNotice.

Notice that SOA Suite is shown in the Project Features section.
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The Create SOA Application - Name your project Page

-
@) Create SOA Application - Step 2 of 3

Name your project

Application Name
T
}'-e?.;'-\ Project Name

|
.+ Project SOA Settings

Help

Project Name: |Insert5hipNoﬁce| |

Directory: weloperimywaork\12c\InsertShiphotice-App\InsertShiphMotice | Browse...
Project Features:
SOA Suite

S0A Suite is a suite of tools to medel SOA(Service Oriented Architecture) applications.

< Back | Mext = . Finish Cancel

6. Click Next. The Create SOA Application - Configure SOA settings page is

displayed.
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The Create SOA Application - Configure SOA settings Page
rﬁ Create SOA Application - Step 3 of 3

Configure SOA settings

Compasite Name:

Application Name |Ir15ert5hipNotice

,T\ Project Name

Start from: (3) Standard Composite () SOA Template
[_] Empty Composite

<& Composite With Mediator

{5 Composite With Human Task

% Composite With Spring Context

.- Composite With BPEL Process

i Project SOA Settings

,535, Composite With Subprocess
«p Composite With Business Rule

{ ) [ ] Customizable

Leave the default Standard Composite selection unchanged for the Start from field.

Select Composite With BPEL Process from the Standard Composite list, and then
click Finish. You have created a new application, and a SOA project. This
automatically creates a SOA Composite.

The Create BPEL Process page is displayed.
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The Create BPEL Process Page
@ Create BPEL Process

BPEL Process

A BPEL process is a service orchestration, based on the BPEL specdification, used to describe/execute a
business process {or large grained service), which is implemented as a stateful service.

(@) BPEL 2.0 Specification () BPEL 1.1 Specification

Name: |Insert5hipNoﬁce|

MNamespace: |htt|:u:,|’,|'xmlns.orade.u:om,|"InsertShi|:|NoticE_Ap|:|,|'InsErtShipNoﬁceﬂnsertShipNoﬁce

Service Mame: |insertshipnoﬁce_dient

Directory: |C:UDeveIopeHmywork‘l,InsertShi|:|Notice—ﬁppﬂnsertShipNotice\SDAﬁPEL | Ck
Template: [?! Asynchronous BPEL Process "] L]
Expose as a SOAP service
Delivery: [async.persist v] 9

Input: |:H}ﬂﬂlns.orade.::omﬂnsertShipNoh'ce_ﬁu:lpﬂnsertShipNoﬁceﬂnsertShipNoﬁce}process| Ck

Output: |:rade.::am,|"InsertShipN0ﬁce_App,|"InsertShipNoﬁceﬂnsertShipNoﬁce}pmcessResponse| Ck

Help 0K

Cancel

8. Leave the default BPEL 2.0 Specification selection unchanged. This creates a BPEL

project that supports the BPEL2.0 specification.

Enter an appropriate name for the BPEL process in the Name field. For example,

InsertShipNotice.

Select Asynchronous BPEL Process in the Template field. Click OK.

An asynchronous BPEL process is created with the Receive and Reply activities.
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Partner Links Partner Links

' @)

@

receiveInpuk
&)

ol
insertshipnotice _client

callbackClient

®)

The required source files including bpel and wsdl, using the name you specified
(for example, InsertShipNotice.bpel and InsertShipNotice.wsdl)and
InsertShipNotice (composite.xml) are also generated.

&t

= &4 @ 2) InsertShipNotice

insertshipnotice_cli...
Operations:

process
processResponse

Adding a Partner Link

The next task is to add a partner link to the BPEL process. A partner link defines the
link name, type, and the role of the BPEL process that interacts with the partner service.

Based on the BPEL process scenario, you need to create a partner link to create a ship
notice.

To add a partner link:
1. Click BPEL Services in the Component palette.

Drag and drop Oracle E-Business Suite (formerly known as Oracle Applications)
from the BPEL Services list into the right Partner Link swim lane of the process
diagram. The Oracle E-Business Suite Reference page appears.
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Enter a reference name in the Name field. For example, ShipNotice.
2. Click Next. The Service Connection page appears.

3. You can perform either one of the following options for your database connection:

Note: You need to connect to the database where Oracle
E-Business Suite is running,.

* You can create a new database connection by clicking the Create a New
Database Connection icon.

How to define a new database connection, see Create a New Database
Connection, page 5-14.

* You can select an existing database connection that you have configured earlier
from the Connection drop-down list.

The Service Connection page will be displayed with the selected connection
information. The JNDI (Java Naming and Directory Interface) name
corresponding to the database connection appears automatically in the
Database Server JNDI Name field. Alternatively, you can specify a JNDI name.

Note: When you specify a JNDI name, the deployment
descriptor of the Oracle E-Business Suite Adapter must
associate this JNDI name with configuration properties
required by the adapter to access the database.

The JNDI name acts as a placeholder for the connection used when your service
is deployed to the BPEL server. This enables you to use different databases for
development and later for production.

Note: For more information about JNDI concepts, refer to
Oracle Fusion Middleware User’s Guide for Technology Adapters.

4.  Once you have completed creating a new connection for the service, you can add an
interface by browsing through the available list in Oracle E-Business Suite.

Click Next.

If you are connecting to Oracle E-Business Suite Release 12, then the IREP File not
present dialog appears indicating that Adapter could not find the Oracle
Integration Repository data file corresponding to the database you are connecting
in your workspace. Absence of the data file would make browsing or searching of
Integration Repository tree considerably slow. You can choose to extract the data
file and create a local copy of the Integration Repository data file. Once it is created
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successfully, Adapter will pick it up automatically next time and retrieve data from
your local Integration Repository.

You can select one of the following options:

Click Yes to extract the Integration Repository data file.

After the system successfully creates a local copy of the Integration Repository
data file, next time when you connect to the database, you will find the IRep
Data File field appears in the Operation dialog indicating where your local
copy exists with the creation date and time as part of the file name.

Click No to query the Integration Repository data file from the live database
you are connecting to display the Integration Repository tree.

In this example, click No. Click Next in the Operation page to open the Oracle
E-Business Suite Module Browser.

Once you have identified an existing database connection or completed a new
connection for the service, you can select an e-Commerce Gateway interface
through the Module Browser.

Note: Oracle E-Business Suite Module Browser includes the various
product families that are available in Oracle E-Business Suite. For
example, Applications Technology or Order Management Suite are
product families in Oracle E-Business Suite. The product families
contain the individual products. For example, Applications
Technology contains the e-Commerce Gateway product. The
product contains the business entities associated with the product.
For example, the e-Commerce Gateway product contains the
Advanced Shipment Notification business entity.

Business entities contain the various application modules that are
exposed for integration. These modules are grouped according to
the interface they provide. EDI programs can be found under the
EDI category.
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Specify an Interface from The Oracle E-Business Suite Module Browser

@ Oracle Applications Module Browser @
Object Name: |:| []Tables [Jviews [ |APIs [ |CP [ |¥MLGateway [ |EDI [ |BusinessEvents Browse
@ ProductFamilies Name Type InfOut
- G Advanced Planning (SCP_PF) Inbound File Path VARCHARZ In
=+~ (3 Applications Technology (ATG_PF) Inbound Data File Name VARCHARZ n
-..[53 Common Application Calendar (CAC) Execute Open Interface Flag WARCHAR2 n
158 XML Gateway (ECX) Transaction Type VARCHARZ In
[ 58 e-Commerce Gateway (EC) Map Code VARCHARZ In
E- (53 Payables Invaice (AP_INVOICE) Debug Mode For ASMI WARCHAR2 In
Fi3~ (53 Shipment / Biling Notice (PO_SHIPMENT_al | |Data File Characterset VARCHARZ In

- (53 Advanced Shipment Notification (PO_ADYA
[ xMLGateway
=-fFED
im OUT: Application Advice (824/APEl
MN: Ship MNoticeManifest (856/DES]
# [ PLSQL
[ Openinterfaces
- [ CONCURRENT_PROGRAMS
- [ INTERFACE_VIEWS
- (5 EDI Transaction Layout Definition Report (|
(58 CRM Applications Foundation (TTA)
58 Workflow (OWF)
(53 CRM Data Model (JTF)
- (53 Workflow Client (WF)
(58 Application Obiject Library (FND)
158 Support Diagnostic Tools (12U)
(58 User Management (UMX)
- &3 Contracts Suite (OK_PF)
- (3 Discrete Manufacturing (DMF_PF)
- (% Finandal Globalizations Suite (FINGE_PF)
(53 Financial Payables Suite (FINAP_PF)
(5% Finandial Receivables Suite (FINAR_PF)
- (3 Finandial Services Applications (SEM_PF)
- (€3 Finandials (FIN_PF)
- (5% Human Resources Suite (HR_PF)

N Tt bin Focboe 00 DEY

OK Cancel

Select an inbound or outbound EDI program. You can select only one EDI program
for each adapter service.

For example, navigate to Product Families > Applications Technology > e-Commerce
Gateway > Advanced Shipment Notification > EDI to select EDI > IN: Ship
Notice/Manifest (856/DESADV) (ECASNI) EDI concurrent program.

Note: You can also search for an EDI program by entering the name
of the program in the Object Name field. Select the EDI check box
and click Search.

6. Click OK.

The selected EDI concurrent program is added to Operation Objects.
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Adapter Configuration Wizard - Application Interface Page

|- -
ﬁ Oracle Applications Adapter Cenfiguration Wizard - Step 4 of 5 @
Application Interface .
You are connected to a post 11.5. 10 instance, Add the database objects needed for this service. You may add
one or more tables/views or you can add a single API/Concurrent Program/XML Gateway Map/EDI Concurrent
ProgramBusiness Event for a service. If no objects are selected, it is assumed that you want to use previously
created descriptors.,
- Operation Objects
@ Delete
Mame Type
ECASNI CONCURRENT_PROGRAM
Help < Back Next > Cancel
Click Next.

Click Finish to complete the process of configuring a partner link for an application
service. The partner link is created with the required WSDL settings. The wizard
also generates the WSDL file corresponding to the selected interface. This WSDL
file is now available for the partner link.

Note: When you click Finish, two SQL files may be added to the
project if a wrapper does not exist for the function. A wrapper is
generated the very first time you create the e-Commerce Gateway
based service. Subsequent services reuse the same wrapper.

Double click the newly generated Partner Link (ShipNotice) icon to view the details.
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Partner Link Configuration Details

@) Edit Partner Link

]

General Image Property Documentation

Idempatence

Mame: |5hipl'\lu:|ﬁce

Process: |Insert5hi|:Noti|:E

[ ] Initiglize Partner Role
WSDL Settings

WSDL URL: | JSWsDLs fShipMotice. wsdl

Partner Link Type: |n|!f5'°shipNutice_plt

Partner Role: % ShipMotice_rale
My Role: &8, -— Not Spedified ——
Help Apply

Ok

Cancel

Adding a Partner Link for File Adapter

Use this step to configure a BPEL process by synchronously reading an existing order to

obtain the shipping details.

To add a Partner Link for File Adapter to read shipping details:

1.

In JDeveloper BPEL Designer, click BPEL Services in the Component palette.

Drag and drop File Adapter from the BPEL Services list into the right Partner Link
swim lane of the process diagram before the partner link InsertShipment. The

Adapter Configuration Wizard Welcome page appears.

Click Next.

In the Service Name dialog, enter a name for the file adapter service, such as

getShippingDetails.

Click Next. The Adapter Interface page appears.

10-14 Oracle Fusion Middleware Oracle E-Business Suite Adapter User's Guide



Specifying the Adapter Interface
L B
ﬂ FILE Adapter Configuration Wizard - Step 2 of 4 ﬂ

Adapter Interface

The adapter interface is defined by a wsdl that is generated using the operation name and schema(s) specified later
in this wizard. Optionally, the adapter interface may be defined by importing an existing WSDL.

Interface: @ Define from operation and schema (spedfied later)

() Impart an existing WSDL

[Ef

Help < Back MNext = Cancel

Select the Define from operation and schema (specified later) radio button and
click Next.

The File Server Connection page appears. Leave the default value unchanged for
the File Server JNDI Name field.

Click Next
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r
@) FILE Adapter Configuration Wizard - Step 3 of 4 g

File Server Connection

Specify the JNDI name for the File Adapter. The deployment descriptor for the deployed instance of the File Adapter

must associate this JNDI name with a set of configuration properties needed by the File Adapter to access the File

Server at runtime,

File Server JMDI Mame |EiSfFi|eAda|:lter| | q
Help < Back Next = Finisk Cancel

4. In the Operation dialog, specify the operation type. For example, select the

Synchronous Read File radio button. This automatically populates the Operation
Name field.
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Specifying the Operation
- -
ﬁ FILE Adapter Configuration Wizard - Step 4 of 8 ﬁ

Operation

g

The File Adapter supports five operations. There is a Read File operation that polls for incoming files in your local file
system, a Write File operation that creates outgoing files, a Synchronous Read File operation that reads the current
contents of a file, a List Files operation that lists file names in spedfied locations, and & Chunked Read operation that
synchronously reads file data in chunks and can be used OMNLY with BPEL. Only one operation per Adapter Service
may be defined using this wizard.

Operation Type: () Read File
() Wirite File
(2) Synchronous Read File
() List Files
() Chunked Read

Operation Name: |5ynchF‘.ead |

[ | Read File As Attachment

Cancel

Help < Back | MNext =

Click Next to access the File Directories page.

Select the Physical Name radio button and specify directory for incoming files, such
as /usr/tmp.

Ensure the Delete files after successful retrieval check box is not selected.
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Configuring the Input File
ﬂ- FILE Adapter Configuration Wizard - Step 5 of 8 ﬂ

File Directories

Enter directory information for the incoming file of the Synchronous Read File operation.

Directory names are specified as: (3) Physical Path () Logical Name

Directory for Incoming Files {physical path): |Jru5rl,rh-n|;.

Browse

[ ] Archive processed files
Archive Directory for Processed Files (physical path):

Help <« Back Mext = Cancel

Click Next to open the File Name page.

6. Enter the name of the file for the synchronous read file operation. For example,
enter order data.xml. Click Next to open the Messages dialog.

7. Select the 'browse for schema file' icon to open the Type Chooser.

Click Type Explorer and select Project Schema Files > ShipNotice_sp.xsd >
InputParameters.

The selected schema information will be automatically populated in the URL and
Schema Element fields.
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Specifying Message Schema
-
@) FILE Adapter Configuration Wizard - Step 7 of 8 u

Messages

e "

Define the message for the Synchronous Read File operation. Spedify the Schema File Location and select the
Schema Element that defines the messages in the incoming files. Use the Browse button to find an existing schema
definition. If you check 'Schema is Opaque’, then you do not need to specify a Schema.

Message Schema

[ Mative format translation is not required (Schema is Opague)

URL | . /5chemas /ShipMotice_sp.xsd| | Q, o

Schema Element [InputParameters v]

Help < Back | Mext> | Cancel

Click Next and then Finish. This completes the configuration and creates the
partner link with the required WSDL settings for the File Adapter service. The
wizard also generates the getOrderXML.wsdl WSDL file corresponding to the
partner link.

The getShippingDetails Partner Link appears in the BPEL process diagram.
Double click the Partner Link service icon to open the Edit Partner Link dialog and
view the details.
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Partner Link Details

@) Edit Partner Link =

Gereral | Image  Property = Documentation  Idempotence

Mame: |get5hippingDE13iIs |

Process: |Insert5hi|:'Nnﬁ|:E |

[ ] Initialize Partner Role
W3DL Settings

Q@D W

WSDL URL: |../WSDLs/getShippingDetails. wsd| |
Partner Link Type: |:$° SynchRead_plt "'|
Partner Role: |ia SynchRead_role "'|
My Role: |48, -—— Not Specified -— -
Help Apply 0K Cancel

L /

Configuring Invoke Activities

After adding and configuring the partner link, you can configure the following two
Invoke process activities to invoke the EDI concurrent program and File Adapter
partner link:

1. To get the shipping details that is received from the Receive activity by invoking the
getShippingDetails partner link in an XML file.

2. To create a shipment notice by invoking ShipNotice partner link.

To add the first Invoke activity for a partner link to get shipping details:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the first Invoke activity into the center swim
lane of the process diagram, between the receivelnput and callbackClient
activities.

2. Link the Invoke activity to the getShippingDetails service. The Edit Invoke
dialog appears.
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3.

Enter a name for the Invoke activity. In the Input tab, ensure the Input Variable
radio button is selected. Click the Create icon next to the Input Variable field to
create a new variable. The Create Variable dialog box appears.

Create Input Variable

@) Create Variable I&

Mame: |I|W|:|kE_SyndﬁRead_Input'l.-'ariable| |

Type: |{hth:|:,.",."mlns.Drade.-:um,."pcbpel,.’adapter,."ﬁleﬂnsertshipNDﬁl:E—.ﬁ.pp,."Inser|

() Global Variable

Help QK Cancel

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.

In the Output tab, ensure the Output Variable radio button is selected. Click the
Create icon next to the Output Variable field to create a new variable. The Create

Variable dialog box appears.

Select Global Variable, then enter a name for the variable. You can also accept the
default name. Click OK.
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) Edit Invoke

=25

Documentation
General

Mame:

Targets
Correlations

Sources

Skip Condition
Properties

Headers
Assertions

Annotations

|Inu'nke

Conversation ID: | |

[ ] Invoke as Detail

Interaction Type: | ¢} Partner Link *

Partner Link: |get5hippingDe13iIs

Port Type: |7!f5"5ynd1F‘.eadJ:ltt "’l

Operation: | Gy SynchRead =)

Input Cutput

() Arguments Mapping (%) Quiput Variable )

Qutput: |In'uukE_5mﬁﬂead_ﬂumuf#ariable

Help Apply 0K Cancel

Click Apply and OK in the Edit Invoke dialog box to finish configuring the Invoke
activity.

The Invoke activity appears in the process diagram.

To add the second Invoke activity for a partner link to create a shipment notice:

1.

In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the third Invoke activity into the center swim
lane of the process diagram, between the first Invoke and callbackClient activities.

Link the Invoke activity to the ShipNotice service. The Edit Invoke dialog box
appears.

The Operation is automatically selected, depending on the EDI concurrent program
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that you chose when configuring the partner link.

Repeat Step 3 to Step 6 described in the first Invoke activity procedure.
Click Apply and OK.

© Edit Invoke S

Documentation  Targets = Sources  Skip Condition = Headers

General Correlations Properties Assertions Annotations

Mame: |In'u'nke_5eruice |

Conversation ID: | |

[ ] Invoke a= Detail

Interaction Type: |r._,§ Partrer Link =

Partmer Link: |ShipNoﬁ::e | &,
Port Type: |$° ShipMotice_ptt '|
Operation: | Gy ShipMotice v|
Input  QOutput
() Arguments Mapping| (=) Input Variable 21}
Input; |Invnke_5eruice_5hipNnﬁce_InquariabIe | EF ':k
Help Apply 0K Cancel

Setting Header Properties for Applications Context

Use the following steps to set the header message properties required to pass
applications context required to complete the BPEL process:

1. Select the Properties tab to set the Header message properties required to pass
applications context required to complete the BPEL process.

2. Click the Create icon. The To Property dialog appears.
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3. Select the jca.apps.Username property from the Name drop-down list.

-

Help

lica.apps.MLSLanguage
I:jca.apps.DF‘.G_ID

lica.apps.Respapplication
lica.apps.Responsibility
lica.apps. SecurityGroup

ﬁgca.apps.eu..ﬁ.tﬁibutﬂ

-
© Edit Invoke %
Documentation  Targets | Sources = Skip Condition = Headers
General Correlations Properties Assertions Annotations
To
From  Properties: Ei / ®
Narme Value
e
) To Property ﬂ
Mame: | v|
@ Iujca.apps.HeaderDm:ument

1I

Help

Apply

Ok Cancel

4. Select the Expression radio button and enter ' OPERATIONS' as the property

value.

Click OK.

5. Repeat Step 2 to Step 4 to assign 'Purchasing, Vision Operations

(UsA) ' for jca.apps.Responsibility.
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D) Edit Invoke

=25

jca.apps.Responsibility

"Purchasing, Vision Operations (USA)'

Documentation = Targets  Sources  Skip Condition  Headers
General Correlations Properties Assertions Annotations
To
From  Properties: EF / ®
Mame Value
jca.apps.Username 'OPERATION'

Help

Apply

0K

Cancel

5. Click Apply and then OK to complete the Invoke activity.

Configuring an Assign Activity

Use the Assign activity to pass the output of getShippingDetails service as an
input to the InsertShipment service.

To add an Assign activity:

1. In Oracle JDeveloper BPEL Designer, expand the BPEL Constructs from the
Component Palette. Drag and drop the Assign activity from the Basic Activities
section into the center swim lane of the process diagram between the two Invoke
activities that you just created earlier.

2. Double-click the Assign activity to access the Edit Assign dialog.
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Click the General tab to enter a name for the Assign activity. For example,

setShipInfo.

3. Select the Copy Rules tab and expand the source and target trees:

¢ In the From navigation tree, navigate to Variable > Process > Variables >
Invoke_SynchRead_OutputVariable > body and select ns3:InputParameters.

¢ In the To navigation tree, navigate to Variable > Process > Variables >
Invoke_Service_ShipNotice_InputVariable > Input Parameters and select

ns3:InputParameters.

Drag the source node (ns3:InputParameters) to connect to the target node
(ns3:InputParameters) that you just identified. This creates a line that connects
the source and target nodes. The copy rule is displayed in the From and To
sections at the bottom of the Edit Assign dialog box.

Assigning Parameters

O Edit Assign

=

General = CopyRules  Annotations =~ Documentation | Targets = Sources | Skip Condition
I .
Bt O =

|1r15ert New Rule After
InsertShiphlotice.bpel

InsertShiphlotice.bpel
[ Partrer Links Partner Links [
[ variables Variables [
Eﬁga Process Frocess ﬁ%B
=3 Variables Variables [£5-2

{x) inputvariable inputYariable x)

m output¥ariable output¥ariable h,‘)

m Invoke_Service_Shipiaotice_InputVariable -: Invoke_Service_ShipNotice_TnputYariable (x) =

(x) Invoke_Service_Shiphotice_OutputYariable - InputParameters |:| =]

m Invoke_SynchRead_InputVarisble ns4:InputParameters &--@

Em Invoke_SynchRead_OutputVariable woke_Service_ShipMotice_OutputVariable (x)

=[5 bod: Invoke_SynchRead_Inputyariable )

4P ns4:InputParameters Invoke_SynchRead Cubputariable h,‘)

T A

+ X @ 3

From To
B}, $Invoke_SynchRead_OutputVariable.body 8 $Invoke_Service_ShipNotice_InputVariable.InputParameters

Apply OK. Cancel

4. Click Apply and OK to complete the configuration of the Assign activity.
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Completed Concurrent Program BPEL Process Project

uew [

L4

@

receivelnput

Invoke getShippingDetails
insertshipnotice_cl. .. SetshipInfo
| |
1 1
@ %]
Invoke_service | Shiphotice -
v
o

callbackClient

Click the composite.xml to display the Oracle JDeveloper composite diagram:

ShipNotice

Operations:
ShipMotice

=&

insertshipnotice_cli...

Operations:

process
process Response

getShippingDetails

Operations:
SynchRead

Run-Time Tasks for e-Commerce Gateway

After designing the SOA Composite application with BPEL process, the next step is to
deploy, run and monitor it.

1. Deploy the SOA Composite application with BPEL process, page 10-28

2. Test the deployed SOA Composite application with BPEL process, page 10-31
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3. Verify records in Oracle E-Business Suite, page 10-33

Deploying the SOA Composite Application with BPEL Process

To invoke the service (InsertShipment) from the BPEL client contained in the SOA
composite, the SOA composite needs to be deployed to the Oracle WebLogic managed
server. This can be achieved using Oracle JDeveloper. Once the composite is deployed,
it can be tested from the Oracle Enterprise Manager Fusion Middleware Control
Console.

Prerequisites

Before deploying the SOA composite with BPEL process using Oracle JDeveloper, you
must have established the connectivity between the design-time environment and the
run-time server. For more information, see Configuring the Data Source in Oracle
WebLogic Server, page 11-1 and Creating an Application Server Connection, page 11-
10.

Note: If a local instance of the WebLogic Server is used, start the
WebLogic Server by selecting Run > Start Server Instance from Oracle
JDeveloper. Once the WebLogic Admin Server "DefaultServer" instance
is successfully started, the <Server started in Running mode> and
DefaultServer started message in the Running:DefaultServer and
Messages logs should appear.

To deploy the SOA Composite application with BPEL process:
1. Select the SOA Composite project in the Applications Navigator.

2. Right-click the project name, and then select Deploy > [project name] >
[serverConnection] from the menu that appears.

For example, you can select Deploy > InsertShipNotice > soa-serverl to deploy the
process if you have the connection set up appropriately.
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Applications £ | pel| g Insertshiphotice bpel Hﬂ i [ES ipNotice. bpel WHﬁﬁuﬁdd_lrmt | #a BPELProcess.. (2]
&) Insertshiphlotice-App TP &A@ w-S-FFR o B%
I Projects Bl @ 7%
=[5 InsertShipotice =]
£ Resources bi=a) 3 e
5-F3 504 Edit Project Source Paths... B
=[] Adapter{ 8 Delete Project o
; 15
o ™ oo
(2] Shinl g8y Find project Files
8] wee v
= Show Classpath
23 Bvents Show Overview A
Qschens | insershipNatice.. | make TR
&5 Inse
"2, shipl @) Make InsertShipNotice.jpr ‘ New Deployment Profile...
{0 testsuite i Rebuild InsertShipNotice.jpr N
2] Transfor D— {@ |?|
R
{0 wsis — insertshipnatice _client __
; ets M Debug Setshiplnfo
I
I I:z Compare With
@l o Replace With -
SlezEie T 1@ Check Code Compl Invoke_service nsertShipment
eck Code Compliance
| Recent Files
[&] Project Properties... T
-5t
Create SOA Template
—
i callbackClient
O
2 =

@)

Note: If this is the first time to set up server connection, then the
Deployment Action window appears. Select 'Deploy to Application
Server' and click Next.
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Deployment Action

-);.\- Deployment Action | Select a deployment action from the list below.

| .
/T'\ Deploy Confiquration Deploy to Application Server

Deploy to SAR
/I\

/l\

Deploy this archive to SOA configured Application server(s)

Help Mext = || Einish || Cancel

In the Deploy Configuration window, ensure the following
information is selected before clicking Next to add a new
application server:

¢ New Revision ID: 1.0
* Mark composite revision as default: Select this check box.

¢ Opverwrite any existing composites with the same revision ID:
Select this check box.

The steps to create a new Oracle WebLogic Server connection from

JDeveloper are covered in Creating an Application Server
Connection, page 11-10.

3. In the Select Server page, select 'soa-serverl' that you have established the server
connection earlier. Click Next.

4. In the SOA Servers page, accept the default target SOA Server ('soa-serverl’)
selection.
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SOA Servers
Choose the target S0A server(s) and correspanding partitions to which you want to deploy
/I\ this archive.
AT SOA Server: Partition: Status: Server URL:
g, Select Server S03_Server efaul hd thost0l exam..
Select 5 = 1 |default RUNNING http:/} hostol
I
el SO0A Servers
|
@ Summary
|
| Help | < Back || Next = | | Finish | | Cancel |
Click Next and Finish.

If you are deploying the composite for the first time from your Oracle JDeveloper
session, the Authorization Request window appears. Enter username and password
information specified during Oracle SOA Suite installation. Click OK.

5. Deployment processing starts. Monitor deployment progress and check for
successful compilation in the SOA - Log window.

Verity that the deployment is successful in the Deployment - Log window.

Testing the Deployed SOA Composite Application with BPEL Process

Once the BPEL process contained in a SOA Composite application is deployed, you can
manage and monitor the process from the Oracle Enterprise Manager Fusion
Middleware Control Console. You can also test the integration by manually initiating
the process.

To test the deployed SOA Composite application with BPEL process:

1. Navigate to Oracle Enterprise Manager Fusion Middleware Control Console (
http://<servername>:<portnumber>/em). The composite you deployed is
displayed in the Applications Navigation tree.
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ORACLE’ Enterprise Manager Fusion Middleware Control 12¢ e

Login
Farm Farm_soainfra
* User Name [weblogic

=Passnord [es

Logn

Enterprise Manager Key Features New in this Release

Vs v Test your applications using real world workdoad using the:
i tion Replay functionality

» Automate Routine Tasks

» Stay ahead of the curve with My Oracle Support Integration

» Manage Many-as-One with Groups

» Complete, Integrated, Application-to-Disk IT Management ney
cover IT assets using dramatically improved Target Auto-

» Complete, Unified and Business-Driven Enterprise Cloud

Management
> SOA Management with improved dehydration diagnostics

2. Enter username (such as weblogic) and password and click Login to log in to a
farm.

You may need to select an appropriate target instance farm if there are multiple
target Oracle Enterprise Manager Fusion Middleware Control Console farms.

3. From the Farm base domain, expand the SOA > soa-infra > soa-infra (soa_serverl)
> default to navigate through the SOA Infrastructure home page and menu to
access your deployed SOA Composite applications running in the SOA
Infrastructure for that managed server.

Note: The Farm menu always displays at the top of the navigator.
As you expand the SOA folder in the navigator and click the links
displayed beneath it, the SOA Infrastructure menu becomes
available at the top of the page.

Click the SOA Composite application that you want to initiate (such as
'InsertShipment') from the SOA Infrastructure.

Click Test at the top of the page.
4. The Test Web Service page for initiating an instance appears. You can specify the
XML payload data to use in the Input Arguments section.

Enter the input string required by the process and click Test Web Service to initiate
the process.
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Testing Web Service
Input Arguments

Tree View »
ame Type e
= * payload paylad
*input string kest

Request | Responss

Task Web Servce

The test results appear in the Response tab upon completion.

5. Click Launch Flow Trace in the Test Web Service page. The Flow Trace page is
displayed.

In the Trace section, you should find the sequence of the message flow for the
service binding component (insertshipnotice client ep), BPEL component
(ShipNotice), and reference binding components (getShippingDetails and
ShipNotice). All involved components have successfully received and processed
messages.

If any error occurred during the test, you should find it in the Faults section.
6. Click your BPEL service component instance link (such as ShipNotice) to display

the Instances page where you can view execution details for the BPEL activities in
the Audit Trail tab.

Click the Flow tab to check the BPEL process flow diagram. Click an activity of the
process diagram to view the activity details and flow of the payload through the
process.

Verifying Records in Oracle E-Business Suite

To verify retcords in Oracle E-Business Suite:
1. Login to Oracle E-Business Suite as the System Administrator.

2. Select Requests from the View menu.
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3. Search for the Request by entering the Request Id that you got from the audit trail,
then click Find.

Find Requests Dialog Box

My Completed Bequests

My Requests In Pragress

All My Requests
—® Specific Requests

I,
Request ID 2967187 ¥~

Mame |

Date Submitted
Date Completed

Status | '|
FPhase | "'|
Requestor |

Include Reguest Set Stages in Query
Order By |Request 1D "|

Select the Number of Days to Wiew: 7

Submit a flew Reguest... Clear Find
J

4. The Request details are displayed. You can check for details such as the Phase and
Status of the request.

5. If the Status of the request is Complete, you can also query the appropriate table in
Oracle E-Business Suite to search for the relevant records that have been inserted.

Querying Oracle E-Business Suite for a Record

um)  from
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Runtime Configuration for Oracle
E-Business Suite Adapter

Overview

Oracle E-Business Suite Adapter is deployed as JCA 1.5 resource adapter within the
Oracle WebLogic Server container.

Although Oracle E-Business Suite Adapter is physically deployed as JCA 1.5 resource
adapter, the logical deployment of the Adapter involves creating the connection entries
for the JCA 1.5 resource adapter. This connection information is for tying up the
database connection information provided when you create a partner link or service
and is used by iAS at run time in the background.

For the logical deployment changes to take effect, the Oracle WebLogic Server container
process must be restarted.

The following topics are included in this section:

¢ Configuring the Data Source in Oracle WebLogic Server, page 11-1
* Creating Connection Factory for Oracle E-Business Suite Adapter, page 11-7

* Creating the Application Server Connection, page 11-10

Configuring the Data Source in Oracle WebLogic Server

Oracle WebLogic Server consists of a JCA container for hosting JCA resource adapters.
JCA defines standard Java interfaces for simplifying the integration of a J2EE server
with various back-end applications. All client applications run within the Oracle
WebLogic Server environment.

The JCA resource adapter is a WebLogic Server component contained in a Resource
Adapter Archive (RAR) file within the applications/directory. An RAR file contains a
correctly formatted deployment descriptor. In addition, it contains declarative
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information about the contract between the Oracle WebLogic Server and resource
adapter.

The weblogic-ra.xml file is the deployment descriptor for a WebLogic resource
adapter. It contains deployment configurations for deploying resource adapters to
Oracle WebLogic Server, which includes the back-end application connection
information as specified in the deployment descriptor of the resource adapter, Java
Naming and Directory Interface (JNDI) name to be used, connection pooling
parameters, security identities, Work Manager properties, logging, and resource
principal mapping mechanism and configurations.

Note: A WebLogic resource adapter also uses ra.xml descriptor that
describes the resource adapter-related attributes type and its
deployment properties using the standard XML schema specified by
the JCA 1.5 Specification.

After successfully installing Oracle WebLogic Server, use the following steps to
configure the data sources in the Oracle WebLogic Server Administration Console:

Note: How to install Oracle WebLogic Server and create connection
factory, see Oracle WebLogic Server Installation Guide for details.
1. Navigate to http://servername:portnumber/console.

2. Enter the server administrator's username and password to log on to the Oracle
WebLogic Server Administration Console.

The Home page of the Oracle WebLogic Server Administration Console appears.
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Oracle WebLogic Server Administration Console Home Page
ORACLE webLogic Server Administration Console 12c - T -

Change Center @ rome Log Out Preferences (& Record el | Q Welcome, weblogic| connected t: soainfra
View changes and restarts Home

Configuration editing is enabled. Future Home Page

changes wil automaticaly be actvated 2s you

modiy, acdor delete t=ms n ths domain. ] e

Domain Structure

soainfra = Configure applications = Common Administration Task Descriptions
BH-Environment u Configure GridLink for RAC Data Source = Read the documentation
~Deployments
-Services = Configure a Dynamic Cluster = Aska question on My Oracle Support
-Security Realms u Recent Task Status
BHInteroperability u Setyour console preferences
-Diagnostis

= Orack Enterprise Manager

Domain Configurations

+ Domain + Messaging o WTC Servers
= M5 Servers + Jolt Connection Poals
= Store-and-Forward Agents
Honals = iy — = M5 Modules
+ Search the configuration + Clusters u Path Services « LogFiles
+ Use the Change Center = Server Templates = Bridges + Diagnostic Modules
+ Record WLST Saripts u Migratabie Targets + DataSources + Buitn Diagnostic Modes
+ Change Console preferences « Coherence Clusters « Persistent Stores + Diagnostic Images
+ Manage Console extensions « Machines + XML Registries + Request Performance
« Monitor servers + Virtual Hosts + XML Entity Caches o Archives
« Work Managers « Foreign JNDI Providers * Context
System Status. =] « Startup And Shutdown Classes * Work Contexts « SNMP
Health of Running Servers * jcoM
I Failed (0) + Mail Sessions
[ Critical (0) + Deployments « FileT2 + Moritoring Dashboard &
Overloaded (0) ° i
[ Warning (0) + OSGiFramenorks
I O« (2) - Sariby Dasime

Under the Domain Structure section, select Services and then DataSources.

The Summary of JDBC Data Sources page is displayed.

The Summary of JDBC Data Sources Page
ORACLE' WebLogic Server Administration Cansole 12¢ —

P &) Home Log Out Preferences [ Record Help ‘ Q Welcome, weblogic ‘ Connected to: soainfra
View changes and restarts Homs >Summary of JDBC Data Sources

Configuration editing is enabled. Future Summary of JDBC Data Sources

changes will automatically be activated as you

modiy, add or delete items i this domain Configuration | Moritoring

Domain Structure

i o A IDBC data source is an to the JNDI tree through a pool of JDBC connections. Applications can lock up a data source on the JNDI tree and then
R borrow a database connection from a data source

eployments This page summarizes the JDBC data source objects that have been created in this domain.
-Serices
" B-messaging
| Data Sources b Customize this table
| i~Persistent Stores
| “Forsign JNDI Providers Data Sources (Filtered - More Columns Exist)
| Work Contexts New She 1to 0of 12 P | Next
| L Regisries 5] v owing of 12 Previous | Nex
| XML Entity Caches
i jcom [C]| Name & Type JNDI Name Targets
; i:a“f:“‘m < [ | atqa2138 Generic jdbe/AppsDataSource soa_server 1
[C] | ephiDatasource Generic Jdbc/EDNDatas0UTCE S0a_server 1
How do L. a
] | EphLocamipatasource Generic Jdbe/EDNLoCaITxDatasowrce Soa_server 1
0 Gt dneT [E] | Localsverbinatasource Generic Jdbe/LocalsveTbibataSource Adminserver
« Create JDBC Gridtink data sources
[ | mas-owsm Generic jdbc/mas/owsm Adminserver, soa_serverl
- Create JDBC muti data sources
« Delete IDBC data sources [ | mds—s0a Generic jdbe/mds/MDS_LocalTxDataSource AdminServer, soa_serverl
« Delete JDBC multi data sources [T | opss-audit-DBDS Generic jdbe/AuditDe Adminserver, soa_serverl
[C1 | opss-aud Generic jdbe/AuditVienDB AdminServer, soa_server1
S e =} 01 | opss-data-source Generic dbc/OpssDS AdminServer, soa_server1
Health of Running Servers [C] | orasppMDatasource Generic jdbe/orasDPMDataSource s0a_server i
Failed (0) New

Showing 1to 10 of 12 Previous | Next

Critical (3)
Overloaded (0)

In the Summary of JDBC Data Sources section, click New and select the option
Generic Data Source to create a new data source. The Create a New JDBC Data
Source page is displayed.

Enter the values for the properties to be used to identify your new JDBC data
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source.

The Create a New JDBC Data Source - JDBC Data Source Properties Page

ORACLE webLogic Server Administration Consale 12¢

Change Center
View changes and restarts
Configuration editing s enabled. Future

changes wil automatically be activated as you
modify, add o delete items in this domin.

Domain Structure
soainfra -
E-Environment,
t-Deployments
~-Services
| BMessaging
| Data Sources
i~Persistent Stores
~Foreign JNDI Providers
“Work Contexts
“XML Registries

~XML Entity Caches

~-jcom

~Mail Sessions

~File T3 - ‘
How do L. =

« Create JDBC generic data sources
« Create LLR-enabled JDBC data sources

System Status =]
Health of Running Servers

| Failed (0)
[ Critical (0)
Overloaded (0)

[ Warning (0)

& Home LogOut Preferences [2] Record Help ‘

Create a New JDBC Data Source
Hext | ‘ cancal

JDBC Data Source Properties

The following properties will be used to identify your new JDBC data source.

* Indicates required fields

Wihat would you ke to name your new JDBC data source?

4]~ Hame:

XASOADataSource
What JNDI name would you ke to assign to your new JDBC Data Source?
5] INDI Name:
XASOADataSource B

Wihat database type would you like to select?

Database Type: Oracle

Nex||

‘ Cancel

Q Welcome, weblogic | Connected to: soainfra

nvironment =Summary of Depioyments >
=r »Summary of JDBC Data Sources

r >Summary of

e Name: Enter a desired new JDBC data source name.

e JNDI Name: Enter a JNDI name that you like to assign to your new JDBC Data

Source.

e Database Type: Select Oracle as database type from the drop-down list.

Click Next.

6. The selected value for Database Type field is displayed. In the Database Driver
field, select Oracle's Driver (Oracle's Driver (Thin or Thin XA) for instance
connections) from the drop-down list.
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ORACLE WebLogic Server Administration Console 12¢

Change Center
View changes and restarts
Configuration editing is enabled. Future

changes will automatically be activated as you
modify, add or delete items in this domain.

Domain Structure
base_domain
E-Environment
~-Deployments
E-Services
~Security Realms
BI-Interoperabilty
[-Diagnostics

@ Home Log Out Preferences Record Help Q Wzkx)me,wehlogic‘cnnnethad to: base_domain

Home =Summary of Services >Summary of JDBC Data Sources

Create a New JDBC Data Source

Back | | Next ‘ ‘ Cancel

JDBC Data Source Properties

The following properties will be used to identify your new JDBEC data source.

Database Oradle
Type:

What database driver would you like to use to create database connections? Note: * indicates that the driver is explicitly supported by Oracle WebLogic Server.

Database

*Oracle's Driver (Thin) for Instance connections; Versions-An:
Databa (Thin) : v =]

Back | | Next ‘ ‘ Cancel

Note: A driver name with "' indicates that the driver is explicitly
supported by Oracle WebLogic Server.

The required Oracle E-Business Suite database version for Oracle
E-Business Suite Adapter 12¢ (12.2.1) is listed in the following table:

Oracle Oracle Oracle Oracle
Database Database 11g Database 11g Database 12¢
Release Release 1 Release 2 Release 1
Minimum 11.1.0.7 or 11.2.0.3 or 12.1.0.1 or
Required higher higher higher
Database

Version

Click Next. The Create a New JDBC Data Source - Transaction Options page is

displayed.

Click Next. The Create a New JDBC Data Source - Connection Properties page is

displayed.

Runtime Configuration for Oracle E-Business Suite Adapter 11-5



The Create a New JDBC Data Source - Connection Properties page

ORACLE webLogic Server sdministration Console 12¢ ‘

Changd Center &) Home Log Out Preferences [22] Record Help | Welcome,weblogic|cunnected t0: soainfra

vironment = Summary of Deployment

View changes and restarts >Summary of JDBC Data Sources

ppsadapter »Summary of
Deployment:

Configuration editing is enabled. Future
changes will automatically be activated as you Create a New JDBC Data Source

modify, add or delete items in this domain.

Back| | Next| | ‘ Cancel
Domain Structure
soainfia = Connection Properties
E-Environment
i~ Deployments
rvices What is the name of the database you would like to connect to?
H-Messaging
Data Sources Database Name:
ersistent Stores
oreign JNDI Providers
ity What is the name or TP address of the database server?

XML Registries L

Define Connection Properties.

orcl

~-XML Entity Caches HoctRaene: dbhost us_oracle com
~—iCoM
~Mal Sessions What is the port on the database server used to connect to the database?
—File T3 -
Port:
How do L. = 1521
+ Create JDBC generic data sources Vhat database account user name do you want to use to create database connections?
+ Create LLR-enabled DBC data sources
User Name:

apps
System Status =]

What is the database account password to use to create database connections?
Health of Running Servers

| Failed (0) Password: sesssssssssssssens
| Critical (0)

Qverloaded (0) Confirm Password: sessssssessssneee
| Warning (0)
I o« (2 Additional Connection Properties:

oracle.jdbc.DRCPConnectionClass:

Back| | Next| | || cancel

9. Enter the connection properties in the Connection Properties page.

* Database Name: Enter a database name that you would like to connect.
e Host Name: Enter a host name or IP address of the database server.

e Port: Enter a database port on the database server used to connect to the
database.

* Database User Name: Enter the database account username that you want to
use to create the database connections.

* Password: Enter the database account password that you want to use to create
the database connections.

¢ Confirm Password: Enter the same password for confirmation.

10. Click Next. The Create a New JDBC Data Source - Test Database Connection page is
displayed.

1. Click Test Configuration to test the database availability and the connection
properties you provided.

A 'Connection test succeeded' message appears at the top of the Create a New JDBC
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12,

Data Source - Test Database Connection page.

Click Next. The Create a New JDBC Data Source - Select Targets page is displayed.

The Create a New JDBC Data Source - Select Targets Page

ORACLE WebLogic Server Administration Console 12¢

Gl i (& Home Log Out Preferences @] Record Help | Q WEIcomE,weblogic‘Cunnected to: soainfra

View changes and restarts B e

Deployments >Ora

ary of Environment >Summary of Deployments >OracieAppsAdapter >Summary of
~Summa ry of IDBC Data Sourcas

Configuration editing is enabled, Future
changes wil automatically be activated as you

modify, add or delete items in this domain.

Create a New JDBC Data Source

Back ‘ Finish | cancel
Domain Structure
soainfra -
BF-Environment

~Deployments

Select Targets

You can select one or more targets to deploy your new IDBC data source. If you don't select a target, the data source wil be created but not deployed.
You wil need to deploy the data source at a later tine.

rvice:
[-Messaging

~-Data Sources

--Persistent Stores

~Foreign JNDI Providers

~Work Contexts

XML Registries —

Servers

[l Adminserver

soa_serverl

13.

XML Entity Caches

—-jCoM

~Mall Sessions

~File T3 M

Back ‘ Finish | Cancel

Select the 'soa_serverl' check box, and then click Finish.

The Summary of JDBC Data Sources page is displayed. This page summarizes the
JDBC data source objects that have been created in this domain. The Data Source
that you created appears in this list.

Creating Connection Factory for Oracle E-Business Suite Adapter

The deployment descriptor of the Oracle E-Business Suite Adapter must associate with
the Java Naming and Directory Interface (JNDI) name with configuration properties
required by the adapter to access the database.

Use the following steps to configure the JNDI and additional settings for Oracle
E-Business Suite Adapter through the Oracle WebLogic Server Administration Console:

1.

Navigate to http://servername:portnumber/console.

Enter the server administrator's username and password to log on to the Oracle
WebLogic Server Administration Console.

The Home page of the Oracle WebLogic Server Administration Console appears.

Under the Domain Structure section, select Deployment.

The Summary of Deployments page appears where you can find a list of Java EE
applications and standalone application modules that have been installed to this
domain.

Locate an appropriate link for Oracle E-Business Suite Adapter from the summary
of deployment table first and then click the link.
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Summary of Deployments
ORACLE' WebLogic Server Administration Console 12¢ _

Change Center @ Home LogOut Preferences [ Record Help Welcome, weblogic ‘ Comnected to: soainfra
e TS Home »Summary of IDEC Dak Summary of Beplayments >Summary of Enviranment »Summary of Deplayments > >Summary of Deployments
Configuration editing is enabled. Future Summary of Deployments
changes wil automatically be activated as you
modify, add or delete items in this domain. Control | Monitoring
Domain Structure
sosinfra = This page displays a st of Java EE appications and stand-slone application modues that! [ to this domain. Instaled appicati be started, stopped, updated
(redeployed), or deleted from the domain by first selecting the application name and using the contrals on this page.
E-Environment
[~ Deployments To installa new appication or module for deployment to targets in this domain, cick the Instal button.
“Services
B Messaging
Data Sources B Customize this table
~Persistent Stores
~Foreign JNDI Providers Deployments
~Work Contexts
XML Registries = ol 2 5 Shoning 10 39 0f 39 Frevious | Next
XML Entity Caches
~jcoM ]| name & State | Health | Type Targets Deployment Order
~Mail Sessions
FleT2 - [F] | @ AaAdapter Active | OK | Resource Adapter | soa_serverl 324
HowdolL.. = [ | = Eb2bui Active |« QK | Enterprise Application | soa_serverl 313
« Install an enterprise applcation [ | = FRePMcomposer Active | ¥ OK | Enterprise Application | soa_server1 384
i [ | @ CRCMTestur Active | oK | Enterprise Application | soa_serverl 386
« Update (redeploy) an enter licati =
« Start and stop a deployed enterprise [0 | Geherencerdapter s Resource Adapter e
appiication [ | Dbadapter Active |[¥OK |Resource Adapter [ soa_serverl 32
« Monitor the madules of an enterprise
‘appiication [0)| ® ERpefaultToDoTaskFlon Active |¥OK | Enterprise Application | soa_server1 314
« Deplay 38 mod
e [ | B (gDMS Appiication (11.1.1,1.0) Acive | P OK | Web Application AdminServer, soa_serverl | 5
« Install a Web application =
0| &M Instaled Resource Adapter 327
System Status =) [ | @Msvadapter Instaled Resource Adapter 334
Health of Runring Servers [ | @orederppsadapter Actve | POK | Resource Adapter | soa_servert B
[ Faled@ []| @oradegamadzpter Installed Resource Adapter E]
I cieam

The Overview Settings for the selected application name appears.

5. Click the Configuration tab and the Outbound Connection Pools subtab to display
the Outbound Connection Pool groups and instances for this selected resource
adapter.

Outbound Connection Pool Configuration Table

ORACLE WebLogic Servar Adminissation Console 12¢ -

Change Center @) Home Log Out Preferences

Record Help ‘ e e e d s ‘ SrreiE e

View changes and restarts Home >Summary of JDBC Ds Summary s >Summary of Envir nts >OracleAppsAdapter
Configuration editing is enabled. Future Settings for OracleAppsAdapter

changes wil automatically be activated as you

modify, add or delete items in this domain. Overview | DeploymentPlan | Configuration | Security | Targets | Control | Testing | Monitoring | MNotes

DR e General | Properties | Outbound Connection Pools | Admin Objects | Workload | Instrumentation

soainfra B

Environment

[ — This page displays a table of Outbound Connection Pool groups and instances for this resource adapter, The top level entries in the table represent Cutbound
i Connection Pool groups. Groups are isted by connection factory interface and the instances are listed by their JNDI names. Expand a group to obtain configuration
v information for a Connection Pool instance within an Outbound Connection Pool group. Click the name of a group or instance to configure it. Automatically generated
[B-Messaging Connection Pools are not displayed in the table below.
~Data Sources
ersistent Stores Outbound Connection Pool Configuration Table
~Foreign INDI Providers
~Work Contexts Hew Showing 1to 10f 1 Previous | Next
XML Registries —
~XML Entity Caches [] | Groups and Instances ¢ Connection Factory Interface
~jCOM
~Mail Sessions javax.resource.cd, ConnectionFactory javax.resource.cd. CannectionFactory
~Fila T3 -
New Showing 1to 10f 1 Previous | Next
How do I... =]

+ Configure outbound connection pool

You can click the javax.resource.cci.ConnectionFactory link to expand
this group and obtain configuration information for a Connection Pool instance.

6. Click New and select the javax.resource.cci.ConnectionFactory radio
button to create an instance. Click Next to create a new outbound connection.

7. Enter a JNDI name that you want to use to obtain the new connection instance. For
example, enter eis/Apps/Ebiz.
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The Outbound Connection instance represents a connection pool. The JNDI name
can be used to obtain the pool at run time.

Click Finish.

This opens the Save Deployment Plan Assistant page where you can find the new
deployment plan information including plan path with an XML extension (. xm1),
recently used paths, and current location.

Note: The plan path must have an XML extension (. xml). Itis
recommended that this file be called P1an.xml, and that each plan
be located in a unique directory. If the plan file exists it will be
overwritten. Other files in the plan directory may be overwritten as
well.

Click OK to save the configuration change for a deployment plan.

You may find some unexpected exception messages populated while processing the
request. Use the following steps to resolve the issue:

1. Click the Adapter link that you selected earlier on the breadcrumb navigation
path.
2. Click the Configuration tab and the Outbound Connection Pools subtab to

display the Outbound Connection Pool groups and instances.

Click the javax.resource.cci.ConnectionFactory expand node to
display the newly configured JNDI (such as eis/Apps/Ebiz) for the
outbound instance in the configuration table.

3. Click the outbound instance name (such as eis/Apps/Ebiz) to display the
outbound connection properties.

4. Place your mouse in the Property Value column for the 'XADataSourceName'
property name and click to enable the input text box.

Enter jdbc/AppsDataSource in the text box, press [Enter] key, and then click
Save to update the deployment plan.

The Summary of JDBC Data Source page appears with
jdbc/AppsDataSource listed in the table.
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Outbound Connection Properties Page

Change Center
View chiffiges and restarts
Configuration editing is enabled. Future

changes will automatically be activated as you
mocify, add or delete items i this domain.

ORACLE' WebLogic Server Administration Console 12c

&) Home Log Out Preferences [22] Record Help ‘

Settings for javax.resource.cci.ConnectionFactory

Domain Structure

soainfra =
B-Environment

~-Deployments

rvices

E}Messaging

~Data Sources

i~-Persistent Stores

~Fareign JNDI Providers

~Work Contexts

~XML Registries —
XML Entity Caches

~COM

~Mail Sessions

—File T3 -

How do L. =]

General perti

This page allows vou to view and madify the configuration propertes of this autbound connectan paol. Properties you madify here are saved ta a

deployment plan.

Transaction | Authentication

‘Outbound Connection Properties

Save

Q

= > Summary of JDBC Data Sources > Summary of Deplayments »Summary of Environment > Summary of Deplayments >0
ts >OracleAppsAdapter

Connection Pool | Logging

Welcome, weblogic | Connected to: soainfra

leAppsAdapter >Summary of

Showing 1to 20f 2 Previous | Next

Property Name &%

Property Type

Property Value

Supports Dynamic Updates

DataSourceName java.lang String
XADataSourceName java.lang String jdbc/AppsDataSource
Save

Showing 1to 20f 2 Previous | Next

5. Select 'OracleAppsAdapter’' from Deployments and click Update to complete
the update wizard. The new Connection Factory settings would be applied

without restarting.

Creating the Application Server Connection

You must establish a connectivity between the design-time environment and the server

you want to deploy it to. In order to establish such a connectivity, you must create the
application server connection.

Use the following steps to create the application server connection:

1. From Oracle JDeveloper, select Window > Application Servers to open the

Application Servers tab.

2. Right-click on the Application Servers node and select New Application Server to
open the Create Application Server Connection wizard.
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Create a New Application Server Connection

m_mcle IDeveloper 12c Dewelupmntm

3. Inthe Usage page, leave the default Standard Server selection unchanged.
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Select the Server Usage

L hl
@) Create Application Server Connection - Step 1 of 3 ﬂ

Usage

)T"\ Usage
)+\ Name and Type

Help

Indicate how the application server will be used.

() Standalone Server

A standalone server is not started, stopped, nor configured by JDeveloper. An
application must be manually deployed to a standalone server.

() Integrated Server

An integrated server can be started and stopped by JDeveloper. Applications can
be automatically deployed to the server by the Run or Debug commands. Only
WeblLogic servers can be used in this way.

Mext = Cancel

Click Next.

4. Enter an appropriate name in the Connection Name field. Select WebLogic 12.x as

the connection type.
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Select the Server Name and Type

r -
@) Create Application Server Connection - Step 2 of 3 ﬂ
Name and Type
Usa Specify a unigue name and type for the connection. The name must be a valid Java
308 : :
)T'\ identifier.
el Name and Type
i L :
& Emsh Create connection in:  IDE Connections
Connection Mame:
|5erver1
Connection Type:
| webLogic 12.x -
Help « Back | Mextx | Finish Cancel
. -
Click Next.

Enter the username (such as weblogic) and password specified during installation
and click Next.
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Enter Server Authentication Information

F hl
@) Create Application Server Connection - Step 3 of 6 u

Authentication

P Specify a username and passwaord to authenticate the connection.

/I\ SEadiE

,—.I,-\ Mame and Type Username:

@ Authentication [weblogic |

+ Configuration Eoe=:

Help = Back | Mextx | Finish Cancel
L

6. Enter the WebLogic Server connection host name and port information. Leave the
default domain name unchanged in the WebLogic Domain field.

Click Next.
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Specifying Server Configuration Information

-
ﬁ Create Application Server Connection - Step 4 of 6

Configuration

WebLogic Server connections use a host name and port to establish a connection. The
Domain of the target will be verified

WebLogic Hostname (Administration Server):

T Authentication |Iot3|host |
T Configuration Part: 551 Port:
T Test |7001 | |?002 |
. [ Always use S5L
Weblogic Domain:
|base_domain |
Help < Back Mext = Cancel
L
Click Next.

Click Test Connection to validate your server configuration. You should find

success messages populated in the Status window.

Click Next and Finish to complete the application server connection.
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Troubleshooting and Workarounds

General Issues and Workarounds

This section describes the following issues and workarounds:

Sequence of Elements in XML and XSD Files Should Match

Order of elements passed as input to an API using Oracle E-Business Suite Adapter
should strictly be the same as the order in which those elements appear under the
sequence tag of the corresponding schema.

Please note that in previous releases, Oracle E-Business Suite Adapter was
non-restrictive and these elements could be passed in any order. However, the
sequence of elements should now match the sequence in the corresponding schema.

Support for Business Events through Existing Partner Links

With the additional support for business event groups, perform the following steps
to modify all existing partner links for outbound business events contained in an
event group that is being listened to:

Important: This workaround is applicable only if Oracle E-Business
Suite Adapter is being used for listening to Event Groups. It is NOT
needed if the Business Event is not part of any Event Group that is
being listened to.

1. Updating the JCA property "MessageSelectorRule" for the existing Business
Event partner links. This can be achieved by performing either one of the
following steps:

® Rerunning the Adapter Configuration (Recommended)

Rerunning or editing the configuration wizard for an existing partner link
of an outbound business event would update the artifacts with the
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appropriate MessageSelectorRule.

e Manually Updating the JCA Properties

Alternatively, modify the JCA property "MessageSelectorRule" for the
business event partner link located in the file XXX apps.Jjca, as stated
below:

Note: <EVENT NAME> is to be replaced with the name of
the Business Event.

Change existing property from:

<property name="MessageSelectorRule"
value="tab.user data.event name = '<EVENT NAME>'"/>
To the following;:

<property name="MessageSelectorRule"
value="tab.user data.event name = '<EVENT NAME>' AND
tab.user data.getvalueforparameter ('GROUP') IS NULL"/>

2. Delete the existing subscriber on WF_BPEL_Q of the corresponding Oracle
E-Business Suite applications.

1. Undeploy the SOA Composite application containing the Business Event
partner link.

2. Delete the subscriber using the following snippet:

Note: <CONSUMER NAME> is to be replaced with the name
of the subscriber. It can be found in the XXX apps.jca file
as the value for the JCA property 'Consumer'.

begin

subscriber := sys.aqg$ agent ('<CONSUMER NAME>', NULL, NULL);
dbms agadm.remove subscriber (queue name => 'WF BPEL Q',
subscriber => subscriber);

end;

3. Redeploy the SOA Composite application.

For more information about business event groups, see Business Event Groups,
page 6-3.

e "DataSecurityCheck" Requires "IRepOverloadSeq" to be Passed for Overloaded
Functions

Oracle E-Business Suite Adapter uses the following two new JCA properties to
handle access control for overloaded PL/SQL APIs. This feature works in
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conjunction with the grants created from the Integration Repository user interface,
and it does not depend on any profile options.

® DataSecurityCheck
e TIRepOverloadSeg

If a user wants the Function Security Authorization check to be performed, the
following property information needs to be added in the WSDL file XX apps.jca:

<property name="DataSecurityCheck" value="yes"/>

However, the other property IRepOverloadSeq is derived automatically by
Oracle E-Business Suite Adapter at the design time during creation of the partner
link. Based on these two properties, the function security check would be
performed for the username, which is passed as a header property.

Please note that this security support would work with all interfaces which are
available in the Integration Repository. For other interfaces, you need to enable the
function security through the profile option "EBS Adapter for BPEL, Function
Security Enabled"” (EBS_ADAPTER_FUNCTION_SEC_ENABLED).

For more information about security support for overloaded functions, see Function
Security Support for Overloaded Functions, page 4-21.

Populating Default Values for Record Types While Using PL/SQL APIs

Certain PL/SQL APIs exposed from Oracle E-Business Suite take record types as
input. Such APIs expect default values to be populated for parameters within these
record types for successful execution.

The default values are FND API.G MISS CHAR for characters,

FND API.G MISS DATE for dates, and FND API.G MISS NUM for numbers.
Oracle E-Business Suite Adapter can default these values when the parameters
within the record type are passed as nil values, for example, as shown below:
<PRICE_LIST REC>

<ATTRIBUTEl xsi:nil="true"/>

<ATTRIBUTE2 xsi:nil="true"/>
<ATTRIBUTE3 xsi:nil="true"/>

</PRICE_LIST REC>

When such a PL/SQL API is invoked at run time, the values being passed for the
record type parameters should have the attribute xsi:nil="true". This can be
achieved in more than one way at design time by using a function in a Transform
activity or by directly passing the XML input with nil values and then assigning
them to the record types within an Assign activity.

Additionally, the value for each parameter can be checked at design time. For
example, if the attribute value is not passed in a Transform activity, the parameter
can be set with xsi:nil="true" using a function. If the value xsi:nil="true"
is passed in the payload, Oracle E-Business Suite Adapter automatically populates
the default value for the attribute. This applies to the parameters within or outside a
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record type.

* Re-creating Wrapper Packages While Using Existing PL/SQL SOA Composites
Against a Different Release Instance

When a user has a SOA composite of a PL/SQL API created against an Oracle
E-Business Suite Release 11i instance and intends to use it against the Release 12
instance or vice versa, for the compatibility in the target instance, the wrapper
package of the SOA composite must be re-created. This approach updates the
signature in the generated wrapper SQL file for the target instance and avoids the
possible confusion whether the signature is the same or has changed in the target
instance.

e  WSDL Context Information Default Values

Applications context is used in passing header variables that may be required in a
business activity or to complete a BPEL process. When setting the context, it takes
into account the values passed for the header properties including Username,
Responsibility, Responsibility Application, Security Group, and NLS Language.

If the values for the new header properties Responsibility Application, Security Group,
and NLS Language are not passed, context information will be determined based on
Username and Responsibility.

The default Username is SYSADMIN, the default Responsibility is SYSTEM
ADMINISTRATOR, the default Security Group Key is Standard, and the default
NLS Language is US.

You can change the default values specified in the generated WSDL. This is a static
way of changing the context information. These values would apply to all
invocations of the deployed business process. However, if you need to provide
different context information for different invocations of the business process, then
you can dynamically populate the header values. The context information can be
specified by configuring an Invoke activity.

For more information about applications context, see Supporting for Normalized
Message Properties, page 4-7.

e Correlation ID Defaults to BPEL for XML Gateway Transactions

The Adapter Configuration wizard of Oracle E-Business Suite Adapter does not
specify a correlation ID for XML Gateway transactions for inbound or outbound
interfaces. Instead, a default correlation ID of BPEL is automatically set in the
WSDL file. To make this configuration work, you must configure Oracle E-Business
Suite to set the same correlation ID value of BPEL for the corresponding XML
Gateway transactions.

If you want the Adapter to use a different correlation ID than the default, you need
to configure a correlation ID in Oracle E-Business Suite, then edit the
Correlation="BPEL" line contained in the <jca:operation> section of the
adapter service WSDL. Replace BPEL with the string value of the correlation ID you
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specified in Oracle E-Business Suite.

Workaround for Stored Procedures Using Complex Types and the DEFAULT
Clause

When working with stored procedures for which the Adapter Configuration wizard

must generate wrapper SQL stored procedures, there is a current limitation on
DEFAULT clauses not being carried over to the generated wrapper stored
procedures.

As a workaround, perform the following steps one time only for a given stored
procedure:

1. Open the generated wrapper SQL script.

2. Copy all default clauses from the base-stored procedure into the corresponding
wrapper.

3. Use SQL*Plus to reload the wrapper SQL script into the database.

4. Edit the generated XSD. If a parameter has a DEFAULT clause, its

corresponding element in the XSD must have the extra attribute:
db:default="true"

For example, with the following SQL.:

FINANCESINVOICE (isTrue INTEGER DEFAULT 1, value NUMBER DEFAULT 0)

The elements in the XSD for isTrue and value must have the new attribute:

<element name="ISTRUE" ... db:default="true" .../>
<element name="VALUE" ... db:default="true" .../>

Cannot Create a Partner Link If the Underlying API Has Been Re-created

The generation of a wrapper for an API that was re-created with the same name,
but with a different set of parameters, will fail.

Note: This can happen for both packaged procedures and top-level
or root procedures that require generated wrappers.

The following example illustrates the problem:

1. Create the initial API that, in this case, is defined at the top level:

SQL> create procedure test (a number, b varchar2, c BOOLEAN)

The BOOLEAN parameter indicates that a wrapper is necessary.

2. Use the database adapter for stored procedures in the Adapter Configuration
Wizard to generate and load the wrapper for this APL

3. Drop the AP], then re-create it with a different set of parameters:
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SQL> drop procedure test
SQL> create procedure test (a number, b varchar2, c¢ number, d
BOOLEAN)

4. An attempt to generate a partner link for this API using the Adapter
Configuration Wizard will fail with the following message:

The wrapper procedure, TOPLEVELSTEST, could not be found

5. Asaworkaround, exit J]Developer BPEL Designer and restart it after recreating
the stored procedure, but before attempting to create the second partner link.
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Oracle E-Business Suite Adapter Properties

Overview

This appendix describes the properties applicable to the Oracle E-Business Suite
Adapter, including:

e JCA Properties for Oracle E-Business Suite Adapter, page B-1

e JCA Properties for Oracle E-Business Suite Adapter: Normalized Properties, page B-
4

¢ Binding Properties for Oracle E-Business Suite Adapter, page B-7

For more information about JCA properties, see:

® Section A.7, Generic Oracle JCA Adapter Properties, Oracle Fusion Middleware User's
Guide for Technology Adapters for properties applicable to all Oracle JCA Adapters

¢ Section 33.1.2.8, Oracle JCA Adapters Endpoint Properties, Oracle Fusion Middleware
Administrator’s Guide for Oracle SOA Suite and Oracle Business Process Management

Suite

e Appendix H, Normalized Message Properties, Oracle Fusion Middleware Developer’s
Guide for Oracle SOA Suite

JCA Properties for Oracle E-Business Suite Adapter
The following table lists the JCA properties used for Oracle E-Business Suite Adapter:
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Property

Description

SchemaName

PackageName

ProcedureName

DataSecurityCheck

QueryTimeout

APIErrorHandler

GetActiveUnitOfWork

The schema of the Oracle E-Business Suite.
Usually points to the "Apps" or
Apps-equivalent schema.

Name of the PL/SQL package or the wrapper
package.

Name of the procedure or function to be
invoked. Points to Wrapper procedure /
function if present.

Passing this property with a value of "yes"
enables function security check for PL/SQL
APIs and Concurrent Programs.

This property specifies the maximum number
of seconds that the JDBC driver should wait
for the specified stored procedure or function
to execute. When the threshold is exceeded,
SQLException is thrown. If the value is zero,
then the driver waits indefinitely.

Passing this property enables the caller to
retrieve error messages from FND_MSG_PUB
message stack, without the need for another
explicit call to retrieve them.

If it is set to "true", this advanced setting
forces all invoked activities in the same global
transaction to use the same SQL connection if
going to the same database. This guarantees
that later invoked activities can see the
changes of earlier invoked activities.

(However, this may not be needed if using
emulated two-phase commit, which
automatically uses the same connection.)
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Property

Description

IRepOverloadSeq

IRepInternalName

This is automatically populated and is not
user-configurable. It works in conjunction
with "DataSecurityCheck" property.

Note: This property should not be altered
by end users and modification might lead
to undesirable results.

Holds an internal value used by Oracle
E-Business Suite Adapter.

Note: This property should not be altered
by end users and modification might lead
to undesirable results.

The following JCA properties are specific to Enqueue and Dequeue operations that are
applicable for XML Gateway and Business Event Outbound interfaces:

Property Description

QueueName The name of the AQ Queue being read from
or written to.

DatabaseSchema The schema of the Oracle E-Business Suite.
Usually points to the "Apps" or
Apps-equivalent schema.

Consumer Name of the AQ Consumer, which dequeues

MessageSelectorRule

the messages from the AQ Queue.

Specifies the condition based on payload or
queue header values, to screen the messages
and accept only those that meet the condition.

Note: This property should not be altered
by end users and modification might lead
to undesirable results.
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Property

Description

AppsEventSchema

Passing one of the following event schema
selection options to be used for the business
event payload:

®  No Schema

Any Schema

Specify Schema

For information on each schema selection
option, see Specifying Event Schema, page 6-
16.

JCA Properties for Oracle E-Business Suite Adapter: Normalized Properties

The following table lists the normalized message properties used for Oracle E-Business

Suite Adapter:
Property Description
jca.apps.Username This property specifies the Oracle E-Business

jca.

jca.

jca.

apps.Responsibility

apps.ORG_ID

apps.RespApplication

Suite application username information. In the
case of a null or empty value, the default
Username is SYSADMIN,

This property specifies the Oracle E-Business
Suite application responsibility information
for setting applications context. The default
Responsibility is System Administrator.

This property specifies the organization ID
used in Oracle E-Business Suite application.

This property specifies the responsibility
application short name information for setting
applications context. It accepts Application
Short Name (such as FND) as its value.
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Property

Description

jca.apps.SecurityGroup

jca.apps.NLSLanguage

jca.apps.ecx.TransactionType

jca.apps.ecx.TransactionSubtype

jca.apps.ecx.PartySitelId

jca.apps.ecx.MessageType

This property specifies the security group
information for setting applications context.
The default Security Group Key is Standard,

This property specifies the NLS language
information. The default NLS Language is US,

It is used for multiple language support (MLS)
feature for Oracle E-Business Suite.

This property specifies External Transaction
Type for the business document from the
Trading Partner table. The transaction type for
an inbound XML document must be the same
as the transaction type defined in the Trading
Partner form.

This property sets XML Gateway message
header information required for XML
Gateway inbound transactions.

This property specifies External Transaction
Subtype for the business document from the
Trading Partner table. The transaction subtype
for an inbound XML document must be the
same as the transaction subtype defined in the
Trading Partner form.

Similar to
jca.apps.ecx.TransactionType, this
property sets XML Gateway message header
for XML Gateway inbound transactions

This property specifies the party site identifier
for an inbound XML document. The party site
must be the same as the Source Trading
Partner location defined in the Trading
Partner form.

This property is used to set XML Gateway
message header.

This property sets XML Gateway message
header for payload message format. This
defaults to XML.
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Property

Description

jca.apps.ecx.MessageStandard

jca.

jca.

jca.

jca.

jca.

jca.

jca.

apps.

apps.

apps.

apps.

apps.

apps.

apps.

ecx.

ecx.

ecx.

ecx.

ecx.

ecx

ecx

DocumentNumber

ProtocolType

ProtocolAddress

Username

Password

Attributel

Attribute?2

This property sets XML Gateway message
standard.

Message format standard as displayed in the
Define Transactions form and entered in the
Define XML Standards form. This defaults to
OAG. The message standard entered for an
inbound XML document must be the same as
the message standard in the trading partner
setup.

This property sets document number for XML
Gateway.

The document identifier used to identify the
transaction, such as a purchase order or
invoice number.

This property specifies the protocol type for
setting XML Gateway message header.

This property specifies the protocol address
for setting XML Gateway message header.

This property specifies the username for
setting XML Gateway message header.
USERNAME is defined in the Trading Partner
table.

This property specifies the password
associated with the USERNAME that is defined
in the Trading Partner table.

This property specifies the Attributel
parameter that may be defined by the base
application.

This property specifies the Attribute2
parameter that may be defined by the base
application.
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Property

Description

jca.apps.ecx.Attribute3

jca.apps.ecx.Attributed

jca.apps.ecx.Attributeb

jca.apps.ecx.Payload

This property specifies the Attribute3
parameter.

For outbound messages, this parameter has
the value from the Destination Trading
Partner Location Code in the Trading Partner
table. For inbound messages, the presence of
this value generates another XML message
that is sent to the trading partner identified in
the Destination Trading Partner Location
Code in the Trading Partner table. This value
must be recognized by the hub to forward the
XML message to the final recipient of the XML
Message.

For more information, see Destination Trading
Partner Location Code, Oracle XML Gateway
User’s Guide.

This property specifies the Attribute4
parameter that may be defined by the base
application.

This property specifies the Attribute5
parameter that may be defined by the base
application.

This property specifies the payload
information for XML Gateway transactions.

Binding Properties for Oracle E-Business Suite Adapter

The following table lists the binding properties used for Oracle E-Business Suite

Adapter:
Property Description
DequeueTimeOut It is the interval after which the dequeue() API

will time out if no message is received on the
inbound queue. The default value is 1s.
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Property Description

ConnectionRetryDelay The time for which Oracle E-Business Suite
Adapter will wait before trying to re-create a
connection after a connection is lost. The
default value is 15s
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